afran]n
CISCO.

[ ]
g
-
=
=
H-
.-
z
(-1
(1
i
&

Cisco APIC Basic Configuration Guide, Release 4.2(x)

First Published: 2019-10-08
Last Modified: 2024-01-19

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 527-0883



©2019-2024 Cisco Systems, Inc. All rights reserved.



Trademarks

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS REFERENCED IN THIS
DOCUMENTATION ARE SUBJECT TO CHANGE WITHOUT NOTICE. EXCEPT AS MAY OTHERWISE
BE AGREED BY CISCO IN WRITING, ALL STATEMENTS, INFORMATION, AND
RECOMMENDATIONS IN THIS DOCUMENTATION ARE PRESENTED WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED.

The Cisco End User License Agreement and any supplemental license terms govern your use of any Cisco
software, including this product documentation, and are located at:
http://www.cisco.com/go/softwareterms.Cisco product warranty information is available at
http://www.cisco.com/go/warranty. US Federal Communications Commission Notices are found here
http://www.cisco.com/c/en/us/products/us-fcc-notice.html.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST
PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE
THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

Any products and features described herein as in development or available at a future date remain in varying
stages of development and will be offered on a when-and if-available basis. Any such product or feature
roadmaps are subject to change at the sole discretion of Cisco and Cisco will have no liability for delay in the
delivery or failure to deliver any products or feature roadmap items that may be set forth in this document.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual
addresses and phone numbers. Any examples, command display output, network topology diagrams, and
other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses
or phone numbers in illustrative content is unintentional and coincidental.

The documentation set for this product strives to use bias-free language. For the purposes of this documentation
set, bias-free is defined as language that does not imply discrimination based on age, disability, gender, racial
identity, ethnic identity, sexual orientation, socioeconomic status, and intersectionality. Exceptions may be
present in the documentation due to language that is hardcoded in the user interfaces of the product software,
language used based on RFP documentation, or language that is used by a referenced third-party product.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and
other countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com go trademarks. Third-party
trademarks mentioned are the property of their respective owners. The use of the word partner does not imply
a partnership relationship between Cisco and any other company. (1721R)

Cisco APIC Basic Configuration Guide, Release 4.2(x) .


http://www.cisco.com/go/softwareterms
http://www.cisco.com/go/warranty
http://www.cisco.com/c/en/us/products/us-fcc-notice.html
https://www.cisco.com/c/en/us/about/legal/trademarks.html

Trademarks |
. Trademarks

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



PREFACE

CHAPTER 1

CHAPTER 2

CHAPTER 3

CHAPTER 4

CONTENTS

Trademarks iii

New and Changed Information 1

New and Changed Information 1

About Cisco ACI/APIC Configuration 3

Recommended Settings for the Cisco Application Policy Infrastructure Controller 3
About ACI/APIC Interfaces 5
Mixing the NX-OS Style CLI and the APIC GUI 6

About the Modes of Configuring Layer 3 External Connectivity 7

Configuration Validation 8

First Time Setup Wizard 9
About the First Time Setup Wizard 9
Fabric Membership 9
BGP 1
Out-of-Band Management 11
DNS 12
NTP 12
Global Configurations 13

User Access, Authentication, and Accounting 17
Access Rights Workflow Dependencies 17
User Access, Authorization, and Accounting 17
Multiple Tenant Support 18

User Access: Roles, Privileges, and Security Domains 18

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

Configuring a Local User 19

Configuring a Local User Using the GUI 19

Configuring SSH Public Key Authentication Using the GUI 20
Configuring a Remote User 21

AV Pair on the External Authentication Server 21

Configuring an AV Pair on the External Authentication Server 22
Configuring APIC for TACACS+ Access 23
Configuring APIC for RADIUS Access 24

Configuring a Cisco Secure Access Control Server for RADIUS and TACACS+ Access to the APIC
25

Configuring Windows Server 2008 LDAP for APIC Access with Cisco AVPair 26
Configuring APIC for LDAP Access 28
Changing the Default Behavior for Remote Users with Missing or Bad Cisco AV Pairs 29
About Signature-Based Transactions 30
Guidelines and Limitations 30
Generating an X.509 Certificate and a Private Key 30
Configuring a Local User 32
Creating a Local User and Adding a User Certificate Using the GUI 32
Creating a Local User Using Python SDK 32
Using a Private Key to Calculate a Signature 34
Accounting 36

Routed Connectivity to External Networks as a Shared Service Billing and Statistics 37

CHAPTER 5 Management 39

Management Workflows 39
ACI Management Access Workflows 39

Adding Management Access 40
Adding Management Access in the GUI 40
IPv4/IPv6 Addresses and In-Band Policies 41
IPv4/IPv6 Addresses in Out-of-Band Policies 41
IPv6 Table Modifications to Mirror the Existing IP Tables Functionality 41
Management Access Guidelines and Restrictions 42
Configuring In-Band and Out-of-Band Management Access with Wizards 43
Configuring In-Band Management Access Using the Cisco APIC GUI 43

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



Contents .

Configuring Out-of-Band Management Access Using the Cisco APIC GUI 46
Exporting Tech Support, Statistics, and Core Files 47
About Exporting Files 47
File Export Guidelines and Restrictions 47
Creating a Remote Location for Exporting Files 48
Sending an On-Demand Tech Support File Using the GUI 49
Overview 49
Configuration File Encryption 50
Configuring a Remote Location Using the GUI 51
Configuring an Export Policy Using the GUI 51
Configuring an Import Policy Using the GUI 52
Encrypting Configuration Files Using the GUI 53
Backing up, Restoring, and Rolling Back Controller Configuration 56
Backing Up, Restoring, and Rolling Back Configuration Files Workflow 56
About the fileRemotePath Object 57
Configuration Export to Controller 57
Configuration Import to Controller 59
Snapshots 62
Snapshot Manager Policy 62
Rollback 64
Using Syslog 66
About Syslog 66
Creating a Syslog Destination and Destination Group 66
Creating a Syslog Source 68
Using Atomic Counters 69
About Atomic Counters 69
Atomic Counters Guidelines and Restrictions 70
Configuring Atomic Counters 72
Using SNMP 72
About SNMP 72
SNMP Access Support in Cisco ACI 73
SNMP Trap Aggregation 73
Configuring SNMP 74
Configuring the SNMP Policy Using the GUI 74

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

CHAPTER 6

Configuring an SNMP Trap Destination Using the GUI 76
Configuring an SNMP Trap Source Using the GUI 77
Monitoring the System Using SNMP 77

Using SPAN 78

About SPAN 78
SPAN Guidelines and Restrictions 79
Configuring a Tenant SPAN Session Using the Cisco APIC GUI 82

Using Traceroute 83

About Traceroute 83
Traceroute Guidelines and Restrictions 83

Performing a Traceroute Between Endpoints 84

Provisioning Core ACI Fabric Services 87

Link Level Policies 87

Electromagnetic Interference Retrain 87
Configuring a Link Level Policy Using the GUI 87
Port Bring-up Delay 88

Link Debounce Interval 88

Link-Level Flow Control 88

About Link-Level Flow Control 88

About Link-Level Flow Control and Slow Drain Policies 89

Guidelines and Limitations of Link-Level Flow Control 89

Configuring Link-Level Flow Control on a Leaf Switch Using the GUI 90

Configuring Link-Level Flow Control by Binding a Policy Group to a Switch Selector Profile Using
the GUI 90

Configuring a Slow Drain Policy Using the GUI 91
Configuring Link-Level Flow Control Using the NX-OS-Style CLI 91
Configuring a Slow Drain Policy Using the NX-OS-Style CLI 92

Link Flap Policies 93

Configuring a Link Flap Policy Using the GUI 94
Configuring a Fabric Link Flap Policy Using the GUI 94

Time Synchronization and NTP 94

In-Band Management NTP 95
NTP over [IPv6 95

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



Contents .

Configuring NTP Using the GUI 95
Configuring NTP Using the REST API 96
Verifying NTP Operation Using the GUI 97
NTP Server 98
Enabling the NTP Server Using the GUI 98
Configuring the Datetime Format Using the GUI 100
Configuring a DHCP Relay Policy 100
Guidelines and Limitations for a DHCP Relay Policy 101
Configuring a DHCP Server Policy for the APIC Infrastructure Using the GUI 101
Configuring a DNS Service Policy 102
Configuring External Destinations with an In-Band DNS Service Policy 102
Dual Stack IPv4 and IPv6 DNS Servers 104
Dual-Stack IPv4 and IPv6 Environment 104
Policy for Priority of IPv4 or IPv6 in a DNS Profile 104
Configuring a DNS Service Policy to Connect with DNS Providers Using the GUI 105
Configuring Custom Certificates 106
Configuring Custom Certificate Guidelines 106
Configuring a Custom Certificate for Cisco ACI HTTPS Access Using the GUI 107
Provisioning Fabric Wide System Settings 109
Configuring APIC In-Band or Out-of-Band Connectivity Preferences 109
Configure Quota Management Policies 110
Create an Enforced BD Exception List 110
Create a BGP Route Reflector Policy and Route Reflector Node Endpoints 111
Configure a Fabric Wide Control Plane MTU Policy 111
Configure Endpoint Loop Protection 112
Rogue Endpoint Control Policy 113
About the Rogue Endpoint Control Policy 113
Limitations of the Rogue Endpoint Control Policy 113
Configuring the Rogue Endpoint Control Policy Using the GUI 114
About Max IP Address Flow Control 114
Configure COOP 115
About COOP 115
Viewing COOP Dampened Endpoints Using the GUI 116
Viewing COOP Dampened Endpoints Using the Switch CLI 117

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

Clearing COOP Dampened Endpoints Using the GUI 117
Clearing a COOP Dampened Endpoint Using the Switch CLI 117
Disabling COOP Endpoint Dampening Using the REST API 117
Configuring COOP Authentication Using the APIC GUI 118
Configuring COOP Authentication Using the Cisco NX-OS-Style CLI
Configuring COOP Authentication Using the REST API 119
Configure IP Aging 119
Disable Remote Endpoint Learning 119
Globally Enforce Subnet Checks 120
Reallocate a GIPo 120
Globally Enforce Domain Validation 121
Enable OpFlex Client Authentication 121
Endpoint Listen Policy 122
About the Endpoint Listen Policy 122
Configuring the Endpoint Listen Policy Using the GUI 122
Fabric Load Balancing 123
Creating a Load Balancer Policy Using the Cisco APIC GUI 125
Creating a Load Balancer Policy Using the CLI 126
Creating a Load Balancer Policy Using the REST API 127
Enable a Time Precision Policy 127
Enable a Global System GIPo Policy 128
Configure a Fabric Port Tracking Policy 128

Provisioning Global Fabric Access Policies 129

Create a Global Attachable Access Entity Profile 129
Configure the Global QoS Class Policy 130

Create a Global DHCP Relay Policy 130

Enable a Global MCP Instance Policy 131

Create an Error Disabled Recovery Policy 131

Per Port Policies 132

About Per Port Policies 132

Configuring a Per Port Policy Using the GUI 132
Validating a Per Port Policy Using the GUI 133
Showing the Hidden Policies Using the GUI 133

. Cisco APIC Basic Configuration Guide, Release 4.2(x)

118



Contents .

CHAPTER 7 Basic User Tenant Configuration 135
Tenants 135
Routing Within the Tenant 136
Layer 3 VNIDs Facilitate Transporting Inter-subnet Tenant Traffic 137
Router Peering and Route Distribution 138
Bridged Interface to an External Router 139
Configuring Route Reflectors 140
Configuring External Connectivity Using a Layer 3 Out 141
Configuring an MP-BGP Route Reflector Using the GUI 141
Configuring an MP-BGP Route Reflector for the ACI Fabric 141
Configuring an MP-BGP Route Reflector Using the REST API 142
Verifying the MP-BGP Route Reflector Configuration 143
Creating an OSPF L3Out for Management Tenant Using the GUI 143
Creating an OSPF External Routed Network for a Tenant Using the NX-OS CLI 145
Creating Tenants, VRFs, and Bridge Domains 147
Tenants Overview 147
Tenant Creation 147
VRF and Bridge Domains 147
Creating a Tenant, VRF, and Bridge Domain Using the GUI 147
Deploying EPGs 149
Statically Deploying an EPG on a Specific Port 149
Deploying an EPG on a Specific Node or Port Using the GUI 149
Deploying an EPG on a Specific Port with APIC Using the NX-OS Style CLI 150
Deploying an EPG on a Specific Port with APIC Using the REST API 151
Creating Domains, Attach Entity Profiles, and VLANs to Deploy an EPG on a Specific Port 152
Creating Domains, and VLANS to Deploy an EPG on a Specific Port Using the GUI 152

Creating AEP, Domains, and VLANSs to Deploy an EPG on a Specific Port Using the NX-OS Style
CLI 154

Creating AEP, Domains, and VLANSs to Deploy an EPG on a Specific Port Using the REST
APl 155

Deploying an Application EPG through an AEP or Interface Policy Group to Multiple Ports 156
Deploying an EPG through an AEP to Multiple Interfaces Using the APIC GUI 156

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

Deploying an EPG through an Interface Policy Group to Multiple Interfaces Using the NX-OS
Style CLI 157

Deploying an EPG through an AEP to Multiple Interfaces Using the REST API 158
Microsegmented EPGs 159
Using Microsegmentation with Network-based Attributes on Bare Metal 159

Configuring Network-based Microsegmented EPGs in a Bare-Metal environment Using the
GUI 160

Configuring a Network-Based Microsegmented EPG in a Bare-Metal Environment Using the
NX-OS Style CLI 162

Configuring a Network-Based Microsegmented EPG in a Bare-Metal Environment Using the
REST API 163

IP Address-Based Microsegmented EPG as a Shared Resource 165
Configuring an IP-based Microsegmented EPG as a Shared Resource Using the GUI 165
Configuring an IP-based Microsegmented EPG as a Shared Resource Using the NX-OS CLI 166
Configuring an IP-based Microsegmented EPG as a Shared Resource Using the REST API 167
Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the GUI 167

Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the NX-OS Style
CLI 168

Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the REST API 169
Deploying Application Profiles and Contracts 169
Security Policy Enforcement 169
Contracts Contain Security Policy Specifications 170
Three-Tier Application Deployment 172
Parameters to Create a Filter for http 173
Parameters to Create Filters for rmi and sql 174
Example Application Profile Database 174
Creating an Application Profile Using the GUI 174
Creating EPGs Using the GUI 175
Configuring Contracts Using the APIC GUI 176
Guidelines and Limitations for Contracts and Filters 176
Creating a Filter Using the GUI 176
Creating a Contract Using the GUI 177
Consuming and Providing Contracts Using the GUI 177
Configuring Contracts Using the NX-OS Style CLI 178
Configuring Contracts 178

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



Contents .

Exporting a Contract to Another Tenant 181
Configuring Contracts Using the REST API 183
Configuring a Contract Using the REST API 183
Configuring a Taboo Contract Using the REST API 183
Verifying Contracts, Taboo Contracts, and Filters Using the REST API 184
Optimize Contract Performance 185
Optimize Contract Performance 185
Configure a Contract with Optimized TCAM Usage Using the GUI 187
Configure a Contract with Optimized TCAM Usage Using the REST API 188
Contract and Subject Exceptions 188
Configuring Contract or Subject Exceptions for Contracts 188
Configure a Contract or Subject Exception Using the GUI 190
Configure a Contract or Subject Exception Using the NX-OS Style CLI 190
Configure a Contract or Subject Exception Using the REST API 191
Intra-EPG Contracts 192
Intra-EPG Contracts 192
Guidelines and Limitations for Intra-EPG Contracts 192
Adding an Intra-EPG Contract to an Application EPG Using the GUI 193
Adding an Intra-EPG Contract to an Application EPG Using the NX-OS-Style CLI 194
Adding an Intra-EPG Contract to an Application EPG Using the REST API 195
EPG Contract Inheritance 199
About Contract Inheritance 199
Configuring EPG Contract Inheritance Using the GUI 201
Configuring Application EPG Contract Inheritance Using the GUI = 201
Configuring uSeg EPG Contract Inheritance Using the GUI 201
Configuring L20ut EPG Contract Inheritance Using the GUI 202
Configuring External L30Out EPG Contract Inheritance Using the Advanced GUI 203
Configuring Contract Inheritance Using the NX-OS Style CLI 203
Configuring Application or uSeg EPG Contract Inheritance Using the NX-OS Style CLI 203
Configuring L20ut EPG Contract Inheritance Using the NX-OS Style CLI 207
Configuring External L30ut EPG Contract Inheritance Using the NX-OS Style CLI 210
Configuring EPG Contract Inheritance Using the REST API 212
Configuring Application EPG Contract Inheritance Using the REST API 212
Configuring uSeg EPG Contract Inheritance Using the REST API 212

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

APPENDIX A

APPENDIX B

Configuring L20ut EPG Contract Inheritance Using the REST API 213
Configuring L30ut EPG Contract Inheritance Using the REST API 214
Contract Preferred Groups 216
About Contract Preferred Groups 216
Guidelines for Contract Preferred Groups 218
Configuring Contract Preferred Groups Using the GUI 218
Configuring Contract Preferred Groups Using the NX-OS Style CLI 219
Configuring Contract Preferred Groups Using the REST API 221
Creating an L4-L7 Service EPG Policy Using the GUI 221
Contracts with Permit and Deny Rules 222
About Contracts with Permit and Deny Rules 222

Configuring the Cisco APIC Using the CLI 225
Configuring the Cisco APIC Cluster 225

Cluster Management Guidelines 225
Replacing a Cisco APIC in a Cluster Using the CLI 226
Switching Over Active APIC with Standby APIC Using CLI 227
Verifying Cold Standby Status Using the CLI 227
Fabric Initialization and Switch Discovery 228
Switch Discovery 228
Registering an Unregistered Switch Using the CLI 228
Adding a Switch Before Discovery Using the CLI 228
Graceful Insertion and Removal (GIR) Mode 229
Removing a Switch to Maintenance Mode Using the CLI 229
Inserting a Switch to Operation Mode Using the CLI 229

Configuring the Cisco APIC Using the REST APl 231
Configuring the Cisco APIC Cluster 231

Expanding the APIC Cluster Using the REST APl 231
Contracting the APIC Cluster Using the REST API 231
Switching Over Active APIC with Standby APIC Using REST API 232
Fabric Initialization and Switch Discovery 232
Switch Discovery 232
Registering an Unregistered Switch Using the REST API 232

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



Contents .

Adding a Switch Before Discovery Using the REST API 233
Graceful Insertion and Removal (GIR) Mode 234

Removing a Switch to Maintenance Mode Using the REST API 234

Inserting a Switch to Operational Mode Using the REST API 234

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Contents

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



CHAPTER 1

New and Changed Information

This chapter contains the following sections:

* New and Changed Information, on page 1

New and Changed Information

The following tables provide an overview of the significant changes to this guide up to this current release.
The table does not provide an exhaustive list of all changes made to the guide or of the new features up to

this release.

Table 1: New Features and Changed Information for Cisco APIC Release 4.2(6)

Feature

Description

Where Documented

Support for SNMPv3 trap
aggregation and forwarding

SNMPv3 trap aggregation and
forwarding is supported.

SNMP Trap Aggregation, on page
73

Support for SHA-2 with SNMPv3

SNMPvV3 supports the Secure Hash
Algorithm-2 (SHA-2)
authentication type.

About SNMP, on page 72

Link-level flow control

Link-level flow control is a
congestion management technique
that pauses data transmission until
the congestion in the system is
resolved.

About Link-Level Flow Control,
on page 88

Table 2: New Features and Changed Information for Cisco APIC Release 4.2(5)

Feature

Description

Where Documented

Link Flap Policies

A link flap policy specifies when
to disable a switch port due to link
flapping errors.

Link Flap Policies, on page 93
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Table 3: New Features and Changed Information for Cisco APIC Release 4.2(3)

New and Changed Information |

Feature

Description

Where Documented

First Time Setup Wizard introduced

The First Time Setup Wizard, with
the Rogue EP Control option, is
now available.

First Time Setup Wizard, on page
9

COOP Endpoint Dampening

To relieve pressure on COOP
traffic, the spine asks all leaf
switches to ignore updates from a
misbehaving EP for a specified
period.

Configure COOP, on page 115

Table 4: New Features and Changed Information for Cisco APIC Release 4.2(1)

Feature

Description

Where Documented

First release of this guide
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CHAPTER 2

About Cisco ACI/APIC Configuration

* Recommended Settings for the Cisco Application Policy Infrastructure Controller, on page 3
» About ACI/APIC Interfaces, on page 5

» Mixing the NX-OS Style CLI and the APIC GUI, on page 6

* Configuration Validation, on page 8

Recommended Settings for the Cisco Application Policy
Infrastructure Controller

We recommend the following settings for the Cisco Application Policy Infrastructure Controller (Cisco APIC):
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. Recommended Settings for the Cisco Application Policy Infrastructure Controller

Table 5: Recommended Settings for the Cisco APIC

Navigation Path Property Value Description

System > System Enforce Subnet Check Put a check in the box. This feature enforces

Settings > Fabric Wide subnet checks at the VRF

Setting instance level, when the
Cisco Application Centric
Infrastructure (Cisco ACI)

learns the IP address as an
endpoint from the data
plane. Although the
subnet check scope is the
VRF instance, this feature
can be enabled and
disabled only globally
under the fabric-wide
setting policy. You cannot
enable this option only in
one VRF instance. If you
put a check in the box for
this option, the fabric will
not learn IP addresses
from a subnet other than
the one configured on the
bridge domain. This
feature prevents the fabric
from learning endpoint
information in this

scenario.
System > System IP Aging Policy Enabled The IP aging policy tracks
Settings > Endpoint and ages unused IP
Controls addresses on an endpoint.

Tracking is performed by
using the endpoint
retention policy, which is
configured for the bridge
domain to send ARP
requests (for IPv4) and
neighbor solicitations (for
IPv6) at 75% of the local
endpoint aging interval.
When no response is
received from an IP
address, that IP address is
aged out.
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About ACI/APIC Interfaces [J]

Navigation Path Property Value Description

Fabric > External Admin State Enabled This enables the

Access Policies > Mis-cabling Protocol

Policies > Global > (MCP)

MCP Instance Policy

default Controls: Enable MCP | Put a check in the box. | MCP detects other types
PDU per VLAN of loops that can be

caused by various issues,
such as misconfiguration,
that LLDP and STP
cannot discover. This
option enables MCP to
send packets on a
per-EPG basis.

About ACI/APIC Interfaces

The single point of management within the Cisco Application Centric Infrastructure (ACI) architecture is
known as the Application Policy Infrastructure Controller (APIC). This controller provides access to all
configuration, management, monitoring, and health functions. Having a centralized controller with an application
programming interface (API) means that all functions configured or accessed through the fabric can be
approached through the following interfaces:

* APIC GUI

The APIC GUI is a browser-based graphical interface to the APIC that communicates internally with
the APIC engine by exchanging REST API messages. It includes two modes:

* Formerly called Advanced Mode, now simply the APIC GUI—Used for large scale configurations,
deployments, and operations; enables granular policy controls such as in switch profiles, interface
profiles, policy groups, or access entity profiles (AEPs) for automating mass fabric configuration
and deployment.

* Formerly Basic Mode—Up to release 3.1(x), but now removed, this was a simple interface to enable
common workflows, the GUI operational mode enables administrators to get started easily with
ACI with a minimal knowledge of the object model. The simplified GUI allows the configuration
of leaf ports and tenants without the need to configure advanced policies.

For more information about the APIC GUI, see Cisco APIC Getting Sarted Guide, Release 3.x and Cisco
APIC Basic Configuration Guide, Release 3.x.

* NX-OS Style CLI—The NX-OS style Command-Line Interface (CLI) can be used for APIC configuration,
deployment, and operation. It is organized in a hierarchy of command modes with EXEC mode as the
root, containing a tree of configuration submodes beginning with global configuration mode. The
commands available to you depend on the mode you are in.

For important guidelines to use both the NX-OS style CLI and the APIC GUI to configure Cisco APIC,
see Mixing the NX-OS Style CLI and the APIC GUI, on page 6.

For more information about the NX-OS style CLI, see Cisco APIC NX-OS Style Command-Line Interface
Configuration Guide.
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. Mixing the NX-0S Style CLI and the APIC GUI

* APIC REST API—The REST API is responsible for accepting configuration, as well as providing access
to management functions for the controller. This interface is a crucial component for the GUI and CLI,
and also provides a touch point for automation tools, provisioning scripts and third party monitoring and
management tools.

The APIC REST API is a programmatic interface that uses REST architecture. The API accepts and
returns HTTP (not enabled by default) or HTTPS messages that contain JavaScript Object Notation
(JSON) or Extensible Markup Language (XML) documents. You can use any programming language
to generate the messages and the JSON or XML documents that contain the API methods or MO
descriptions.

For more information about the REST API, see the Cisco APIC REST API Configuration Guide.

Mixing the NX-0S Style CLI and the APIC GUI

Basic mode is deprecated since Cisco APIC Release 3.0(1). There is only one GUI as of that release.

A

Caution  Configurations done through the NX-OS style CLI are rendered in the APIC GUI. They can be seen, but
sometimes may not be editable in the GUI. Also changes made in the APIC GUI may be seen in the NX-OS
style CLI, but may only partially work. See the following examples:

* Do not mix the GUI and the CLI, when doing per-interface configuration on APIC. Configurations
performed in the GUI, may only partially work in the NX-OS CLI.

For example, if you configure a switch port in the GUI at Tenants > tenant-name> Application Profiles >
application-profile-name > Application EPGs > EPG-name > Static Ports > Deploy Static EPG on
PC, VPC, or Interface

Then you use the show running-config command in the NX-OS style CLI, you receive output such as:

leaf 102

interface ethernet 1/15

switchport trunk allowed vlan 201 tenant tl application apl epg epl
exit

exit

If you use these commands to configure a static port in the NX-OS style CLI, the following error occurs:

apicl (config)# leaf 102

apicl (config-leaf)# interface ethernet 1/15

apicl (config-leaf-if)# switchport trunk allowed vlan 201 tenant tl application apl epg
epl

No vlan-domain associated to node 102 interface ethernetl/15 encap vlan-201

This occurs because the CLI has validations that are not performed by the APIC GUI. For the commands
from the show running-config command to function in the NX-OS CLI, a vlan-domain must have been
previously configured. The order of configuration is not enforced in the GUI.

For the steps to remove such objects, see Troubleshooting Unwanted _ui_ Objectsin the APIC Troubleshooting
Guide.
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About the Modes of Configuring Layer 3 External Connectivity .

About the Modes of Configuring Layer 3 External Connectivity

Because APIC supports multiple user interfaces (Uls) for configuration, the potential exists for unintended
interactions when you create a configuration with one Ul and later modify the configuration with another UL
This section describes considerations for configuring Layer 3 external connectivity with the APIC NX-OS
style CLI, when you may also be using other APIC user interfaces.

When you configure Layer 3 external connectivity with the APIC NX-OS style CLI, you have the choice of
two modes:

* Implicit mode, a simpler mode, is not compatible with the APIC GUI or the REST API.
» Named (or Explicit) mode is compatible with the APIC GUI and the REST API.

In either case, the configuration should be considered read-only in the incompatible UI.

How the Modes Differ

In both modes, the configuration settings are defined within an internal container object, the "L3 Outside" (or
"L30ut"), which is an instance of the 13extOut class in the API. The main difference between the two modes
is in the naming of this container object instance:

* Implicit mode—the naming of the container is implicit and does not appear in the CLI commands. The
CLI creates and maintains these objects internally.

» Named mode—the naming is provided by the user. CLI commands in the Named Mode have an additional
I130ut field. To configure the named L3Out correctly and avoid faults, the user is expected to understand
the API object model for external Layer 3 configuration.

)

Note Except for the procedures in the Configuring Layer 3 External Connectivity Using the Named Mode section,
this guide describes Implicit mode procedures.

Guidelines and Restrictions

* In the same APIC instance, both modes can be used together for configuring Layer 3 external connectivity
with the following restriction: The Layer 3 external connectivity configuration for a given combination
of tenant, VRF, and leaf can be done only through one mode.

* For a given tenant VREF, the policy domain where the External-13 EPG can be placed can be in either the
Named mode or in the Implicit mode. The recommended configuration method is to use only one mode
for a given tenant VRF combination across all the nodes where the given tenant VRF is deployed for
Layer 3 external connectivity. The modes can be different across different tenants or different VRFs and
no restrictions apply.

* In some cases, an incoming configuration to a Cisco APIC cluster will be validated against inconsistencies,
where the validations involve externally-visible configurations (northbound traffic through the L3Outs).
An Invalid Configuration error message will appear for those situations where the configuration is invalid.

* The external Layer 3 features are supported in both configuration modes, with the following exception:

* Route-peering and Route Health Injection (RHI) with a L4-L7 Service Appliance is supported only
in the Named mode. The Named mode should be used across all border leaf switches for the tenant
VRF where route-peering is involved.
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* Layer 3 external network objects (I13extOut) created using the Implicit mode CLI procedures are identified
by names starting with “_ui_” and are marked as read-only in the GUI. The CLI partitions these
external-13 networks by function, such as interfaces, protocols, route-map, and EPG. Configuration
modifications performed through the REST API can break this structure, preventing further modification
through the CLI.

For the steps to remove such objects, see Troubleshooting Unwanted _ui_ Objectsin the APIC Troubleshooting
Guide.

Configuration Validation

When the administrator enters a configuration in the Cisco Application Policy Infrastructure Controller (Cisco
APIC), the Cisco APIC performs checks to make sure that the configuration is valid, which is known as
validation. If the configuration is accepted, but it conflicts with other previous configurations, Cisco APIC
or the leaf switches might raise faults. The amount of checks performed by the Cisco APIC before accepting
a configuration varies depending on the release. Newer releases have been enhanced to perform more checks
before the configuration is accepted instead of only raising faults asynchronously.

The release with the greatest amount of changes in terms of additional validations is the Cisco APIC release
2.3. Cisco APIC release 3.0 further enhances validations at the VRF instance level. As an example, in Cisco
APIC release 2.3, for the same VRF instance and the same L3Out, you can define multiple Switch Virtual
Interface (SVI) logical interface profiles for the same SVI (encap) with different IP addresses. You can define
IP address 10.10.10.1/24 on path nodel, port 1/41, VLAN (encap) 10, and IP address 10.10.10.2/24 for path
nodel, port 1/43, VLAN (encap) 10.

This results in only one IP address being used for SVI 10 on the leaf switch despite the fact that you configured
multiple IP addresses, and depending on which IP address is used as the next hop for routing or whether you
have IGP configured, the configuration might function properly.

Starting with Cisco APIC release 3.0, the above configuration would not be accepted, because even if in the
Cisco Application Centric Infrastructure (Cisco ACI) object model the SV1 is defined per path (logical interface
profile), a given VRF instance on a given leaf switch can only have one IP address for an SVI and potentially
a secondary [P address. Several other validations were also introduced in Cisco APIC release 3.0.

The objective of these validations is to reduce or eliminate configuration errors by informing the user of the
errors at the configuration time instead of accepting the configuration and raising faults asynchronously.

As a result of these improvements, if you POST a configuration that was incorrect, but was considered valid
prior to the 2.3 release, this POST would not result in the configuration being posted and the Cisco APIC will
return an error message.

There might be existing Cisco APIC deployments that are functioning correctly with versions prior to Cisco
APIC release 2.3 despite the fact that the configurations might not be valid. To reduce the impact of a firmware
upgrade in such scenarios, after you upgrade to the 2.3 release or later, the Cisco APIC relaxes the validation
checks on existing configurations.

Cisco APIC also offers the option to import an existing configuration with the "Best Effort" mode instead of
the "Atomic" mode. This option offers the ability to accept a configuration even if there are portions that are
not valid. The Cisco APIC pushes the valid portions of the configuration and ignores the portions that are not
consistent with the validation. For the inconsistent portions, the Cisco APIC issues an error message that is
visible when you use the following command:

show snapshot jobs import job
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CHAPTER 3

First Time Setup Wizard

This chapter contains the following sections:

* About the First Time Setup Wizard, on page 9

About the First Time Setup Wizard

Use the First Time Setup wizard to set up your Cisco APIC for the first time.

* You can access the First Time Setup wizard when it automatically appears the first time you log into
your Cisco APIC through the GUI.

* For Cisco APIC Releases 4.2(3) and later, you can also access the First Time Setup wizard when you

click the System Tools icon ( € ) in the upper right corner of the Cisco APIC GUI window, then select
What's New in APIC_release number.

The Welcome to APIC window appears, providing information on the new features that are part of this
particular release.

To access the First Time Setup wizard, click Begin First Time Setup or Review First Time Setup at the
bottom right of the window. The Let's Configure the Basics window appears, with links to the individual
pages that you can use to set up your Cisco APIC.

The following sections provide more information for each of the first-time setup pages available from this
window.

Fabric Membership

Use the Fabric Membership window to register the leaf and spine switches detected by the ACI fabric. You
can also manually add leaf and spine switches to the fabric using the serial number listed on the box.

)

Note We recommend registering at least two leaf switches and two spine switches. You must register at least one
leaf switch and one spine switch in order to proceed through the First Time Setup wizard.

The Fabric Membership window contains two sections:
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« Discovered: This section provides information on newly-discovered but unregistered switches. These
nodes will have a node ID of 0 and will have no IP address.

* Registered: This section provides information on all of the registered switches in your ACI fabric.

You can register a switch using either of these methods:

» If the switch is shown in the Discovered section, click the Register button next to that switch to open
the Create Fabric Node Member window. Note that the Pod 1D and Serial Number fields will be
automatically populated in the Create Fabric Node Member window in this case.

« If the switch is not shown in the Discovered section, click the Action icon ( “~ ), then select Create
Fabric Node Member from the drop-down list.

In the Create Fabric Node Member window, enter the following information:

Field Setting

Pod ID Identify the pod where the node is located.

Serial Number Required: Enter the serial number of the switch.

Node ID Required: Enter a number greater than 100. The first 100 IDs are reserved for APIC

appliance nodes.

Note We recommend that leaf nodes and spine nodes be numbered
differently. For example, number leafs in the 100 range (such as 101,
102) and number spines in the 200 range (such as 201, 202).

Note After the node ID is assigned, it cannot be updated. After the node
has been added to the Registered Nodes tab table, you can update
the node name by right-clicking the table row and choosing Edit Node
and Rack Name.

Switch Name The node name, such as leafl or spine3.
Node Type Choose the assigned node role. The options are:
* leaf

Check one of the following boxes if applicable:
* Is Remote
* Is Virtual

e |s Tier-2 Leaf

* Spine
Check the following box if applicable:

* |Is Virtual

« unknown
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Click Submit when you have completed the information in the Create Fabric Node Member window, then
click Continue in the Fabric Membership to continue to the next window in the First Time Setup wizard.

BGP

Use the BGP window to configure ACI fabric route reflectors, which use multiprotocol BGP (MP-BGP) to
distribute external routes within the fabric. Once you have enabled the route reflectors in the ACI fabric, you
can configure connectivity to external networks.

)

Note Select spine switches to configure as route reflectors. You must configure at least one route reflector in order
to proceed through the First Time Setup wizard. If you do not see any spine switches in the table in this
window, verify that the switch is registered with the correct type or has been discovered by APIC.

In the BGP window, check the box next to the spine switches that you want to use as route reflectors and
enter the ASN for this spine switch in the Autonomous System Number field. Click Save and Continue to
continue to the next window in the First Time Setup wizard.

Out-of-Band Management

Use the Out Of Band Management window to configure the management interface IP address for leaf
switches, spine switches, and APIC nodes to connect to the Out of Band (OOB) network. Select several nodes
to begin assigning IP addresses to them.

\ )

Note The First Time Setup wizard helps with configuring nodes that have not already been configured for Out of
Band management.

Click the box next to the nodes that you want to configure for Out of Band management, or click the box next
to Select All to select all the nodes in the list. Then click Configure OOB IPs for selected nodes to configure
the nodes for Out of Band management.

Enter the necessary information in the following fields:

« IPv4 Starting Address: The IPv4 address and netmask that you use to access the switches through the
GUI, CLI, or API.

* IPv4 Gateway: The IPv4 default gateway address for communication to external networks using
out-of-band management.

« IPv6 Starting Address: The IPv6 address and netmask that you use to access the switches through the
GUI, CLI, or API.

* IPv6 Gateway: The IPv6 default gateway address for communication to external networks using
out-of-band management.

The fields in the Selected Nodes area are automatically populated, based on the information that you enter in
the fields above. For example, if you entered 192.0.2.1/24 in the IPv4 Starting Address field above,
the values in the IPv4 Address column in the Selected Nodes area would be automatically populated with
these values:
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DNS

NTP
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* First node: 192.0.2.1/24

* Second node: 192.0.2.2/24
* Third node: 192.0.2.3/24

* Fourth node: 192.0.2.4/24

Double-click on an entry in the table to change any of the automatically-populated entries.

Click Edit Node Selection if you want to change the nodes that you had selected to configure for Out of Band
management.

Click Save and Continue to continue to the next window in the First Time Setup wizard.

Use the DNS window to configure DNS servers and search domains to allow leaf switches, spine switches
and APIC nodes to query DNS names. The OOB connection will be used for DNS communication.

\}

Note The First Time Setup wizard configures DNS servers and DNS domains under the default DNS Policy.

To configure the DNS servers, click + in the DNS Servers area, then enter the following information:
* Address: Enter the provider address.
* Preferred: Check the check box if you want to have this address as the preferred provider.

» Status: Provides the status of the configuration request.

Click Update, then repeat this process to configure additional DNS servers, if necessary.
To configure the search domains, click + in the Search Domains area, then enter the following information:

» Name: Enter the domain name (cisco.com).

* Default: Check the check box to make this domain the default domain. You can have only one domain
name as the default.

» Status: Provides the status of the configuration request.

Click Update, then repeat this process to configure additional search domains, if necessary.

To delete an entry either from the DNS Servers table or from the Search Domains table, select the entry that
you would like to delete, then click the trash can icon in that table.

Click Save and Continue to continue to the next window in the First Time Setup wizard.

Use the NTP window to configure a timezone and assign NTP servers to synchronize leaf switches, spine
switches, and APIC nodes to a valid time source. The OOB connection will be used for NTP communication.
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Note

The First Time Setup wizard configures servers under the default NTP Policy.

In the Display Format area, click local to display the date and time in a local time zone format, or click utc
to display the date and time in the UTC time zone format. The default is local.

If you selected local above, in the Time Zone area, click the drop-down arrow to choose the time zone for
your domain. You can also type in the drop down menu area to filter the drop down options. The default is
Coordinated Universal Time.

To configure the NTP servers, click + in the NTP Servers area, then enter the following information:

» Host Name/IPAddress: Enter the host name and IP address of the NTP server.

* Preferred: If you are creating multiple providers, check the Preferred check box for the most reliable
NTP source.

« Status: Provides the status of the configuration request.

Click Update, then repeat this process to configure additional NTP servers, if necessary.

To delete an entry from the NTP Servers table, select the entry that you would like to delete, then click the
trash can icon in that table.

Click Save and Continue to continue to the next window in the First Time Setup wizard.

Global Configurations

Use the Global Configurations window to configure certain areas, which we recommend as best practices
during the first time set up of your ACI fabric. Click Okay, Got it! when you are ready to configure these
areas:

* Subnet Check, on page 14

» Domain Validation, on page 14

* Intermediate System to Intermediate System for redistributed routes, on page 14
* [P Aging Administrative State, on page 14

* Rogue EP Control, on page 14

* COOP Group Policy, on page 15

)

Note

Some settings in this window are configurable after the First Time Setup, such as the Subnet Check and
Domain Validation settings, which can be configured in the Fabric Wide Setting Policy page (System >
System Settings > Fabric-Wide Settings). However, configuring those settings after the First Time Setup
might cause issues with other existing configurations. For example, enabling the Enforce Subnet Check and
Enforce Domain Validation settings in the Fabric Wide Setting Policy page could break a configured
L3Out connection without the proper policy chain in place for the interface or for a statically-assigned port
to an EPG.
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Subnet Check
This feature disables IP address learning outside of subnets configured in a VREF, for all other VRFs.

This feature enforces subnet checks at the VRF level, when the Cisco Application Centric Infrastructure (Cisco
ACI) learns the IP address as an endpoint from the data plane. If you put a check in the box for this option,
the fabric will not learn IP addresses from a subnet other than the one configured on the bridge domain. This
feature prevents the fabric from learning endpoint information in this scenario.

Check the box next to Enforce to enable the subnet check feature, which is highly recommended.

Domain Validation
This feature enforces a validation check if a static path is added but no domain is associated to an EPG.

When enabled, a validation check is performed when a static path is added to an EPG, to determine if the path
is part of a domain that is associated with the EPG. The scope of this policy is fabric-wide. After configuration,
a policy is pushed to each leaf switch as it comes up.

Check the box next to Enforce to enable the domain validation feature, which is highly recommended.

Intermediate System to Intermediate System for redistributed routes

This is the IS-IS metric that is used for all imported routes into IS-IS. Configuring a metric lower than 64
(max) with this option, such as 63, allows ACI switches to prefer routes from stable spines until the routing
convergence is achieved on a new spine.

Enter the appropriate value in the 1S-1S metric field.

IP Aging Administrative State

Enabling this policy allows ACI to track each IP individually and age out unused IPs efficiently. Otherwise,
unused IPs remain learned until the base MAC address ages out. This does not affect remote endpoints.

When enabled, the IP aging policy ages unused IPs on an endpoint. In this situation, the IP aging policy sends
ARP requests (for IPv4) and neighbor solicitations (for IPv6) to track IPs on endpoints. If no response is
given, the policy ages the unused IPs.

Following are the options for this field:

» Disabled: The default setting. APIC disregards the IP aging policy.
 Enabled: APIC observes the IP aging policy.

We highly recommend enabling this feature.

Rogue EP Control

A rogue endpoint can attack top of rack (ToR) switches through frequently, repeatedly injecting packets on
different ToR ports and changing 802.1Q tags (emulating endpoint moves), resulting in [P and MAC addresses
being learned rapidly in different EPGs and ports. Misconfigurations can also cause frequent IP and MAC
address changes (moves).

The Rogue EP Control feature addresses this vulnerability. Enabling this policy allows ACI to detect and
delete unauthorized endpoints.

Following are the options for this field:

* Disabled: The default setting. APIC disregards the Rogue EP Control policy.
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 Enabled: APIC observes the Rogue EP Control policy.

We highly recommend enabling this feature.

Additional settings for Rogue EP Control, such as Rogue EP Detection Interval, Rogue EP Detection
Multiplication Factor, and Hold Interval, are available through the Endpoint Controls panel. To access the
Endpoint Controls panel, on the menu bar, click System > System Settings > Endpoint Controls, then click
the Rogue EP Control tab.

Following are the valid and default settings for the fields in the Rogue EP Control tab in the Endpoint
Controls window:

* Rogue EP Detection Interval: Valid values are from 0 to 65535 seconds. Default value is 60.
» Rogue EP Detection Multiplication Factor: Valid values are from 2 to 65535. Default value is 4.

« Hold Interval: Valid values are from 1800 to 3600 seconds. Default value is 1800.

COOP Group Policy

Council of Oracle Protocol (COOP) is used to communicate the mapping information (location and identity)
to the spine proxy. A leaf switch forwards endpoint address information to the spine switch 'Oracle’ using
Zero Message Queue (ZMQ). COOP running on the spine nodes will ensure all spine nodes maintain a
consistent copy of endpoints and location information in the mapping database.

COOP protocol supports two ZMQ authentication modes:

» Compatible Type: The default setting. COOP accepts both MD5 authenticated and non-authenticated
ZMQ connections for message transportation.

\}

Note The APIC manages the token used as MD5 password for COOP. This token is
automatically rotated by APIC every hour. This token cannot be displayed.

« Strict Type: COOP allows MD5 authenticated ZMQ connections only.

We highly recommend the Strict Type setting for the COOP Group Policy.
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CHAPTER 4

User Access, Authentication, and Accounting

This chapter contains the following sections:

* Access Rights Workflow Dependencies, on page 17

* User Access, Authorization, and Accounting, on page 17

* Configuring a Local User, on page 19

* Configuring a Remote User, on page 21

* Configuring Windows Server 2008 LDAP for APIC Access with Cisco AVPair, on page 26

* Configuring APIC for LDAP Access, on page 28

 Changing the Default Behavior for Remote Users with Missing or Bad Cisco AV Pairs, on page 29
 About Signature-Based Transactions, on page 30

 Accounting, on page 36

* Routed Connectivity to External Networks as a Shared Service Billing and Statistics, on page 37

Access Rights Workflow Dependencies

The Cisco Application Centric Infrastructure (ACI) RBAC rules enable or restrict access to some or all of the
fabric. For example, in order to configure a leaf switch for bare metal server access, the logged in administrator
must have rights to the infra domain. By default, a tenant administrator does not have rights to the infra
domain. In this case, a tenant administrator who plans to use a bare metal server connected to a leaf switch
could not complete all the necessary steps to do so. The tenant administrator would have to coordinate with
a fabric administrator who has rights to the infra domain. The fabric administrator would set up the switch
configuration policies that the tenant administrator would use to deploy an application policy that uses the
bare metal server attached to an ACI leaf switch.

User Access, Authorization, and Accounting

Application Policy Infrastructure Controller (APIC) policies manage the authentication, authorization, and
accounting (AAA) functions of the Cisco Application Centric Infrastructure (ACI) fabric. The combination
of user privileges, roles, and domains with access rights inheritance enables administrators to configure AAA

functions at the managed object level in a granular fashion. These configurations can be implemented using
the REST API, the CLI, or the GUI.
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. Multiple Tenant Support

\)

Note There is a known limitation where you cannot have more than 32 characters for the login domain name. In

addition, the combined number of characters for the login domain name and the user name cannot exceed 64
characters.

Multiple Tenant Support

User Access:

A core Application Policy Infrastructure Controller (APIC) internal data access control system provides
multitenant isolation and prevents information privacy from being compromised across tenants. Read/write
restrictions prevent any tenant from seeing any other tenant's configuration, statistics, faults, or event data.
Unless the administrator assigns permissions to do so, tenants are restricted from reading fabric configuration,
policies, statistics, faults, or events.

Roles, Privileges, and Security Domains

The APIC provides access according to a user’s role through role-based access control (RBAC). An Cisco
Application Centric Infrastructure (ACI) fabric user is associated with the following:

* A set of roles
* For each role, a privilege type: no access, read-only, or read-write

* One or more security domain tags that identify the portions of the management information tree (MIT)
that a user can access

The ACI fabric manages access privileges at the managed object (MO) level. A privilege is an MO that enables
or restricts access to a particular function within the system. For example, fabric-equipment is a privilege bit.
This bit is set by the Application Policy Infrastructure Controller (APIC) on all objects that correspond to
equipment in the physical fabric.

A role is a collection of privilege bits. For example, because an “admin” role is configured with privilege bits
for “fabric-equipment” and “tenant-security,” the “admin” role has access to all objects that correspond to
equipment of the fabric and tenant security.

A security domain is a tag associated with a certain subtree in the ACI MIT object hierarchy. For example,
the default tenant “common” has a domain tag common. Similarly, the special domain tag a11 includes the
entire MIT object tree. An administrator can assign custom domain tags to the MIT object hierarchy. For
example, an administrator could assign the “solar” domain tag to the tenant named solar. Within the MIT,
only certain objects can be tagged as security domains. For example, a tenant can be tagged as a security
domain but objects within a tenant cannot.

)

Note Security Domain password strength parameters can be configured by creating Custom Conditions or by
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selecting Any Three Conditions that are provided.

Creating a user and assigning a role to that user does not enable access rights. It is necessary to also assign
the user to one or more security domains. By default, the ACI fabric includes two special pre-created domains:

» a11—allows access to the entire MIT
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* 1nfra— allows access to fabric infrastructure objects/subtrees, such as fabric access policies

\)

Note For read operations to the managed objects that a user's credentials do not allow, a "DN/Class Not Found"
error is returned, not "DN/Class Unauthorized to read." For write operations to a managed object that a user's

credentials do not allow, an HTTP 401 Unauthorized error is returned. In the GUI, actions that a user's
credentials do not allow, either they are not presented, or they are grayed out.

A set of predefined managed object classes can be associated with domains. These classes should not have
overlapping containment. Examples of classes that support domain association are as follows:

 Layer 2 and Layer 3 network managed objects

* Network profiles (such as physical, Layer 2, Layer 3, management)

* QoS policies
When an object that can be associated with a domain is created, the user must assign domain(s) to the object
within the limits of the user's access rights. Domain assignment can be modified at any time.

If a virtual machine management (VMM) domain is tagged as a security domain, the users contained in the
security domain can access the correspondingly tagged VMM domain. For example, if a tenant named solar
is tagged with the security domain called sun and a VMM domain is also tagged with the security domain
called sun, then users in the solar tenant can access the VMM domain according to their access rights.

Configuring a Local User

In the initial configuration script, the admin account is configured and the admin is the only user when the
system starts. The APIC supports a granular, role-based access control system where user accounts can be
created with various roles including non-admin users with fewer privileges.

Configuring a Local User Using the GUI

Before you begin

» The ACI fabric is installed, APIC controllers are online, and the APIC cluster is formed and healthy.

* As appropriate, the security domain(s) that the user will access are defined. For example, if the new use
account will be restricted to accessing a tenant, the tenant domain is tagged accordingly.

* An APIC user account is available that will enable the following:

* Creating the TACACS+ provider.

* Creating the local user account in the target security domain(s). If the target domain is a11, the login
account used to create the new local user must be a fabric-wide administrator that has access to a11.
If the target domain is a tenant, the login account used to create the new local user must be a tenant
administrator that has full read write access rights to the target tenant domain.
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. Configuring SSH Public Key Authentication Using the GUI

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

Step 8

Procedure

On the menu bar, choose ADMIN > AAA.
In the Navigation pane, click Users and Local Users in the Work pane.
In the Work pane, verify that you are in the Local Users tab.

The admin user is present by default

In the Work pane, click on task icon drop-down list and select Create Local User.
In the User ldentity dialog box, perform the following actions:

a) Inthe Login ID field, add an ID.

b) Inthe Password field, enter the password.

At the time a user sets their password, the APIC validates it against the following criteria:

¢) Inthe Confirm Password field, confirm the password.

d) (Optional) For Certificate based authentication, in the User Certificate Attribute field, enter the user
identity from the authentication certificate.

e) Click Finish.

In the Security dialog box, choose the desired security domain for the user, and click Next.

In the Roles dialog box, click the radio buttons to choose the roles for your user, and click Next.

You can provide read-only or read/write privileges.

In the Navigation pane, click the name of the user that you created. In the Work pane, expand the + sign next

to your user in the Security Domains area.
The access privileges for your user are displayed.

Configuring SSH Public Key Authentication Using the GUI

Step 1
Step 2
Step 3

Before you begin

* Create a local user account in the target security domain(s). If the target domain is a11, the login account
used to create the new local user must be a fabric-wide administrator that has access to a11. If the target
domain is a tenant, the login account used to create the new local user must be a tenant administrator
that has full read write access rights to the target tenant domain.

* Generate a public key using the Unix command ssh-keygen.

The default login domain must be set to local

Procedure

On the menu bar, choose ADMIN > Users and confirm you are in the Local Users tab.
In the Navigation pane, click the name of the user that you previously created.
In the Work pane, expand the SSH Keys table, and insert the following information:
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a) In the Name field, enter a name for the key.
b) In the Key field, insert the public key previously created. Click Update.

Note To create the SSH Private Key File for downloading to a remote location then in the menu
bar, expand Firmware > Download Tasks.

Configuring a Remote User

Instead of configuring local users, you can point the APIC at the centralized enterprise credential datacenter.
The APIC supports Lightweight Directory Access Protocol (LDAP), active directory, RADIUS, and TACACS+.

)

Note When an APIC is in minority (disconnected from the cluster), remote logins can fail because the ACl is a
distributed system and the user information is distributed across APICS. Local logins, however, continue to
work because they are local to the APIC.

Starting with the 3.1(1) release, Server Monitoring can be configured through RADIUS, TACACS+, LDAP,
and RSA to determine whether the respective AAA servers are alive or not. Server monitoring feature uses
the respective protocol login to check for server aliveness. For example, a LDAP server will use ldap login
and a Radius server will use radius login with server monitoring to determine server aliveness.

To configure a remote user authenticated through an external authentication provider, you must meet the
following prerequisites:

» The DNS configuration should have already been resolved with the hostname of the RADIUS server.

* You must configure the management subnet.

AV Pair on the External Authentication Server

The Cisco APIC requires that an administrator configure a Cisco AV Pair on an external authentication server.
The Cisco AV pair specifies the APIC required RBAC roles and privileges for the user. The Cisco AV Pair
format is the same for RADIUS, LDAP, or TACACS+.

To configure a Cisco AV Pair on an external authentication server, an administrator adds a Cisco AV pair to
the existing user record. The Cisco AV pair format is as follows:

shell:domains =
domainA/writeRolel |writeRole2 |writeRole3/readRolel |readRole?2,
domainB/writeRolel|writeRole2|writeRole3/readRolel |readRole2
shell:domains =
domainA/writeRolel |writeRole2 |writeRole3/readRolel |readRole?2,
domainB/writeRolel |writeRole2 |writeRole3/readRolel |readRole2 (16003)

Starting with Cisco APIC release 2.1, if no UNIX ID is provided in AV Pair, the APIC allocates the unique
UNIX user ID internally.
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Note The APIC Cisco AV-pair format is compatible and can co-exist with other Cisco AV-pair formats. APIC will
pick up the first matching AV-pair from all the AV-pairs.

Starting with release 3.1(x), the AV Pair shell:domains=all//admin allows you to assign Read-only privileges
to users and provide them access to the switches and run commands.

The APIC supports the following regexes:

shell:domains\\s* [=:]\\s* ((\\S+2/\\S*2/\\S*?) (, \\S+2/\\S*2/\\S*?) {0,31})

(AN (\\d+\\)) $
shell:domains\\s* [=:]\\s* ((\\S+2/\\S*2/\\S*?) (, \\S+2/\\S*2/\\S*?) {0,31})S

Examples:

» Example 1: A Cisco AV Pair that contains a single Security domain with only writeRoles:

shell:domains=domainA/writeRolel|writeRole2/

» Example 2: A Cisco AV Pair that contains a single Security domain with only readRoles:

shell:domains=domainA//readRolel|readRole?2

\}

Note The "/" character is a separator between writeRoles and readRoles per Security domain and is required even
if only one type of role is to be used.

The Cisco AVpair string is case sensitive. Although a fault may not be seen, using mismatching cases for the
domain name or roles could lead to unexpected privileges being given.

An example configuration for an open RADIUS server (/etc/raddb/users) is as follows:

aaa-network-admin Cleartext-Password := "<password>"
Cisco-avpair = "shell:domains = all/aaa/read-all(16001)"

Configuring an AV Pair on the External Authentication Server

The numerical value within the parentheses in the attribute/value (AV) pair string is used as the UNIX user
ID of the user who is logged in using Secure Shell (SSH) or Telnet.

Procedure

Configure an AV pair on the external authentication server.
The Cisco AV pair definition is as follows (Cisco supports AV pairs with and without UNIX user IDs specified):

Example:

* shell:domains =
domainA/writeRolel |writeRole2|writeRole3/readRolel|readRole2,domainB/writeRolel |writeRole2|writeRole3/readRolel |readRole2

* shell:domains =
domainA/writeRolel |writeRole2|writeRole3/readRolel |readRole2,domainB/writeRolel |writeRole2|writeRole3/readRolel |readRole2 (8101)
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These are the boost regexes supported by APIC:
uid_regex("shell:domains\\s* [=:]\\s* ((\\S+2/\\S*2/\\5*?) (, \\S+2/\\S*2/\\S*?2) {0,31}) (\\ (\\d+\\))$");
regex ("shell:domains\\s* [=:]\\s* ((\\S+2/\\S*2/\\S*?) (,\\S+2/\\S*2/\\sS*?) {0,31})s");

The following is an example:

shell:domains = coke/tenant-admin/read-all,pepsi//read-all(16001)

Configuring APIC for TACACS+ Access

Before you begin

* The Cisco Application Centric Infrastructure (ACI) fabric is installed, Application Policy Infrastructure
Controllers (APICs) are online, and the APIC cluster is formed and healthy.

» The TACACS+ server host name or IP address, port, and key are available.

* The APIC management endpoint group is available.

Procedure

Step 1 In the APIC, create the TACACS+ Provider.
a) On the menu bar, choose Admin > AAA.
b) In the Navigation pane, choose TACACS+ Management > TACACS+ Providers.
¢) Inthe Work pane, choose Actions > Create TACACS+ Provider.
d) Specify the TACACS+ host name (or IP address), port, authorization protocol, key, and management
endpoint group.

Note If the APIC is configured for in-band management connectivity, out-of-band management
does not work for authentication. With the APIC release2.1(1x), you can set a global toggle
between In-band and out-of-band as the default management connectivity between the APIC
server and other external management devices.

For toggling in-band or out-of-band management in the APIC GUI:

* Prior to Release 2.2(1x): In the Navigation pane, choose Fabric > Fabric Policies >
Global Policies > Connectivity Preferences. In the Work Pane select either inband
or ooband.

* For Release 2.2(x) and 2.3(x): In the Navigation pane, choose Fabric > Fabric Policies >
Global Policies > APIC Connectivity Preferences. In the Work Pane select either
inband or ooband.

* For Release 3.0(1x) or later: In the Navigation pane, choose System > System Settings >
APIC Connectivity Preferences. In the Work Pane select either inband or ooband.

Step 2 Create the Login Domain for TACACS+.

a) In the Navigation pane, choose AAA Authentication > Login Domains.
b) In the Work pane, choose Actions > Create Login Domain.
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¢) Specify the login domain name, description, realm, and provider group as appropriate.

What to do next

This completes the APIC TACACS+ configuration steps. Next, if a RAIDUS server will also be used, configure
the APIC for RADIUS. If only a TACACS+ server will be used, go to the ACS server configuration topic
below.

Configuring APIC for RADIUS Access

Before you begin

» The ACI fabric is installed, Application Policy Infrastructure Controllers (APICs) are online, and the
APIC cluster is formed and healthy.

» The RADIUS server host name or IP address, port, authorization protocol, and key are available.

* The APIC management endpoint group is available.

Procedure

Step 1 In the APIC, create the RADIUS provider.
a) On the menu bar, choose Admin > AAA.
b) Inthe Navigation pane, click on Authentication and then click on the RADIUS tab.
¢) Inthe Work pane, choose Actions > Create RADIUS Provider.
d) Specify the RADIUS host name (or IP address), port, protocol, and management endpoint group.
Note If the APIC is configured for in-band management connectivity, out-of-band management
does not work for authentication. With the APIC release2.1(1x), you can set a global toggle

between In-band and out-of-band as the default management connectivity between the APIC
server and other external management devices.

For toggling in-band or out-of-band management in the APIC GUI:

* Prior to Release 2.2(1x): In the Navigation pane, choose Fabric > Fabric Policies >
Global Policies > Connectivity Preferences. In the Work Pane select either inband
or ooband.

* For Release 2.2(x) and 2.3(x): In the Navigation pane, choose Fabric > Fabric Policies >
Global Policies > APIC Connectivity Preferences. In the Work Pane select either
inband or ooband.

* For Release 3.0(1x) or later: In the Navigation pane, choose System > System Settings >
APIC Connectivity Preferences. In the Work Pane select either inband or ooband.

Step 2 Create the login domain for RADIUS.

a) In the Navigation pane, choose AAA Authentication > Login Domains.
b) In the Work pane, choose Actions > Create Login Domain.
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¢) Specify the login domain name, description, realm, and provider group as appropriate.

What to do next
This completes the APIC RADIUS configuration steps. Next, configure the RADIUS server.

Configuring a Cisco Secure Access Control Server for RADIUS and TACACS+
Access to the APIC

Before you begin

* The Cisco Secure Access Control Server (ACS) version 5.5 is installed and online.

N

Note ACS v5.5 was used to document these steps. Other versions of ACS might support
this task but the GUI procedures might vary accordingly.

* The Cisco Application Policy Infrastructure Controller (Cisco APIC) RADIUS or TACACS+ keys are
available (or keys for both if both will be configured).

* The APICs are installed and online; the APIC cluster is formed and healthy.

* The RADIUS or TACACS+ port, authorization protocol, and key are available.

Procedure

Step 1 Log in to the ACS server to configure the APIC as a client.
a) Navigate to Network Resources > Network Devices Groups > Network Devices and AAA Clients.

b) Specify the client name, the APIC in-band IP address, select the TACACS+ or RADIUS (or both)
authentication options.

Note If the only RADIUS or TACACS+ authentication is needed, select only the needed option.

¢) Specify the authentication details such as Shared Secret (key), and port as appropriate for the authentication
option(s).

Note The Shared Secret(s) must match the APIC Provider key(s).

Step 2 Create the Identity Group.
a) Navigate to Users and Identity Stores > Internal Groups option.
b) Specify the Name, and Parent Group as appropriate.

Step 3 Map users to the Identity Group.

a) Inthe Navigation pane, click the Users and Identity Stores > Internal Identity Stores > Users option.
b) Specify the user Name, and Identity Group as appropriate.
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Step 4

Step 5

Create the Policy Element.

a)
b)

¢)

Navigate to the Policy Elements option.

For RADIUS, specify the Authorization and Permissions > Network Access > Authorization Profiles
Name. For TACACS+, specify the Authorization and Permissions > Device Administration > Shell Profile
Name as appropriate.

For RADIUS, specify the Attribute as cisco-av-pair, Type as string, and the Value as
shell:domains = <domain>/<role>/,<domain>// role as appropriate. For TACACS+,
specify the Attribute as cisco-av-pair, Requirement as Mandatory, and the Value as
shell:domains = <domain>/<role>/,<domain>// role as appropriate.

The syntax of the Value field determines whether write privileges are granted:

* For read/write privileges, the syntax is shell:domains = <domain>/<role>/.

* For read-only privileges, the syntax is shell:domains = <domain>// <role>.
For example, if the cisco—av—pair has a value of shell:domains = solar/admin/,common// read-all,
then solar is the security domain, admin is the role that gives write privileges to this user in the security

domain called solar, common is the tenant common, and read-al1 is the role with read privileges that
gives this user read privileges to all of the tenant common.

Create a service selection rule.

a)

b)

For RADIUS, create a service selection rule to associate the Identity Group with the Policy Element by
navigating to Access Policies > Default Device Network Access ldentity > Authorization and specifying
the rule Name, Status, and Conditions as appropriate, and Add the Internal Users:UserIdentityGroup
in ALL Groups:<identity group name>.

For TACACSH, create a service selection rule to associate the Identity Group with the Shell Profile by
navigating to Access Policies > Default Device Admin Identity > Authorization. Specify the rule Name,
Conditions, and Select the Shell Profile as appropriate.

What to do next

Use the newly created RADIUS and TACACS+ users to log in to the APIC. Verify that the users have access
to the correct APIC security domain according to the assigned RBAC roles and privileges. The users should
not have access to items that have not been explicitly permitted. Read and write access rights should match
those configured for that user.

Configuring Windows Server 2008 LDAP for APIC Access with
Cisco AVPair

Before you begin

» First, configure the LDAP server, then configure the Cisco Application Policy Infrastructure Controller
(Cisco APIC) for LDAP access.

* The Microsoft Windows Server 2008 is installed and online.
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Step 1
Step 2

Step 3

Step 4

Configuring Windows Server 2008 LDAP for APIC Access with Cisco AVPair .

* The Microsoft Windows Server 2008 Server Manager ADSI Edit tool is installed. To install ADSI Edit,
follow the instructions in the Windows Server 2008 Server Manager help.

* CiscoAVPair attribute specifications: Common Name = CiscoAVPair, LDAP Display Name =
CiscoAVPair, Unique X500 Object ID =1.3.6.1.4.1.9.22.1, Description = CiscoAVPair, Syntax
=Case Sensitive String.

)

Note For LDAP configurations, best practice is to use CiscoAVPair as the attribute

string. If customer faces the issue using Object ID 1.3.6.1.4.1.9.22.1, an additional
Object ID 1.3.6.1.4.1.9.2742.1-5 can also be used in the LDAP server.

* A Microsoft Windows Server 2008 user account is available that will enable the following:

* Running ADSI Edit to add the ciscoavpair attribute to the Active Directory (AD) Schema.

* Configuring an Active Directory LDAP user to have ciscoavrair attribute permissions.

* Port 636 is required for configuring LDAP integration with SSL/TLS.

Procedure

Log in to an Active Directory (AD) server as a domain administrator.
Add the ciscoavrair attribute to the AD schema.

a)

b)
©)

d)

f)

Navigate to Start > Run, type mmc and press Enter.

The Microsoft Management Console (MMC) opens.

Navigate to File > Add/Remove Sanp-in > Add.

In the Add Standalonee Snap-in dialog box, select the Active Directory Schema and click Add.
The MMC Console opens.

Right-click the Attributes folder, select the Create Attribute option.

The Create New Attribute dialog box opens.

Enter CiscoAVPair for the Common Name , CiscoAVPair for the LDAP Display Name,
1.3.6.1.4.1.9.22.1 for the Unique X500 Object ID, and select Case Sensitive String
for the Syntax.

Click OK to save the attribute.

Update the User Properties class to include the CiscoOAVPair attribute.

a)

b)

<)
d)

In the MMC Console, expand the Classes folder, right-click the user class, and choose Properties.
The user Properties dialog box opens.

Click the Attributes tab, and click Add to open the Select Schema Object window.
In the Select a schema object: list, choose CiscoAVPair, and click Apply.
In the MMC Console, right-click the Active Directory Schema, and select Reload the Schema.

Configure the CiscoAVPair attribute permissions.

Now that the LDAP includes the CiscoAVPair attributes, LDAP users need to be granted Cisco APIC
permission by assigning them Cisco APIC RBAC roles.

a)
b)

In the ADSI Edit dialog box, locate a user who needs access to the Cisco APIC.
Right-click on the user name, and choose Properties.
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d)

The <user> Properties dialog box opens.
Click the Attribute Editor tab, select the CiscOAVPair attribute, and enter the Value as
shell:domains = <domain>/<role>/,<domain>// role.

For example, if the CiscOAVPair has a value of shell:domains = solar/admin/, common//
read-all (16001), then solar is the security domain, admin is the role for this user that gives write
privileges to this user in the security domain called solar, common is the Cisco Application Centric
Infrastructure (Cisco ACI) tenant common, and read-a11(16001) is the role with read privileges that
gives this user read privileges to all of the Cisco ACI tenant common.

Click OK to save the changes and close the <user> Properties dialog box.

The LDAP server is configured to access the Cisco APIC.

What to do next
Configure the Cisco APIC for LDAP access.

Configuring APIC for LDAP Access

Before you begin

Step 1

* The Cisco Application Centric Infrastructure (ACI) fabric is installed, Application Policy Infrastructure
Controllers (APICs) are online, and the APIC cluster is formed and healthy.

» The LDAP server host name or IP address, port, bind DN, Base DN, and password are available.

* The APIC management endpoint group is available.

Procedure

In the APIC, configure the LDAP Provider.

a)
b)
<)
d)

On the menu bar, choose Admin > AAA.

In the Navigation pane, choose Authentication and in the Work pane click on the LDAP tab.

In the Work pane, choose Actions > Create LDAP Provider.

Specify the LDAP host name (or IP address), port, bind DN, base DN, password, attribute, and management
endpoint group.
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Step 2

Changing the Default Behavior for Remote Users with Missing or Bad Cisco AV Pairs .

Note * The bind DN is the string that the APIC uses to log in to the LDAP server. The APIC
uses this account to validate the remote user attempting to log in. The base DN is the
container name and path in the LDAP server where the APIC searches for the remote
user account. This is where the password is validated. Filter is used to locate the attribute
that the APIC requests to use for the cisco-av-pair. This contains the user authorization
and assigned RBAC roles for use on the APIC. The APIC requests the attribute from
the LDAP server.

» Attribute field—Enter one of the following:

* For LDAP server configurations with a Cisco AVPair, enter CiscoAVPair.

* For LDAP server configurations with an LDAP group map, enter memberOf£.

» If the APIC is configured for in-band management connectivity, choosing an out-of-band
management endpoint group for LDAP access does not take effect. Alternatively, an
out-of-band over an in-band management endpoint group can connect a LDAP server,
but requires configuring a static route for the LDAP server. The sample configuration
procedures in this document use an APIC in-band management endpoint group.

On the APIC, configure the login domain for LDAP.

a) In the Navigation pane, choose Authentication > Login Domains.

b) In the Work pane, choose Actions > Create Login Domain.

c) Specify the login domain name, description, realm, and provider group as appropriate.

What to do next
This completes the APIC LDAP configuration steps. Next, test the APIC LDAP login access.

Changing the Default Behavior for Remote Users with Missing
or Bad Cisco AV Pairs

Step 1
Step 2
Step 3

Procedure

On the menu bar, click ADMIN > AAA.
In the Navigation pane, click Users.

In the Work pane, in the Remote Users area, from the Remote user login policy drop-down list, choose
Assign Default Role.

The default value is No Login. The Assign Default Role option assigns the minimal read-only privileges to
users that have missing or bad Cisco AV Pairs. Bad AV Pairs are those AV Pairs that fail the parsing rules.
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About Signature-Based Transactions

The APIC controllers in a Cisco ACI fabric offer different methods to authenticate users.

The primary authentication method uses a username and password and the APIC REST API returns an
authentication token that can be used for future access to the APIC. This may be considered insecure in a
situation where HTTPS is not available or enabled.

Another form of authentication that is offered utilizes a signature that is calculated for every transaction. The
calculation of that signature uses a private key that must be kept secret in a secure location. When the APIC
receives a request with a signature rather than a token, the APIC utilizes an X.509 certificate to verify the
signature. In signature-based authentication, every transaction to the APIC must have a newly calculated
signature. This is not a task that a user should do manually for each transaction. Ideally this function should
be utilized by a script or an application that communicates with the APIC. This method is the most secure as
it requires an attacker to crack the RSA/DSA key to forge or impersonate the user credentials.

\)

Note Additionally, you must use HTTPS to prevent replay attacks.

Before you can use X.509 certificate-based signatures for authentication, verify that the following pre-requisite
tasks are completed:

1. Create an X.509 certificate and private key using OpenSSL or a similar tool.
2. Create a local user on the APIC. (If a local user is already available, this task is optional).

3. Add the X.509 certificate to the local user on the APIC.

Guidelines and Limitations

Follow these guidelines and limitations:

* Local users are supported. Remote AAA users are not supported.
» The APIC GUI does not support the certificate authentication method.
» WebSockets and eventchannels do not work for X.509 requests.

* Certificates signed by a third party are not supported. Use a self-signed certificate.

Generating an X.509 Certificate and a Private Key

Procedure

Step 1 Enter an OpenSSL command to generate an X.509 certificate and private key.

Example:

$ openssl req -new -newkey rsa:1024 -days 36500 -nodes -x509 -keyout userabc.key -out
userabc.crt -subj '/CN=User ABC/O=Cisco Systems/C=US'
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Note * Once the X.509 certificate is generated, it will be added to the users profile on the APIC,
and it is used to verify signatures. The private key is used by the client to generate the
signatures.

* The certificate contains a public key but not the private key. The public key is the primary
information used by the APIC to verify the calculated signature. The private key is never
stored on the APIC. You must keep it secret.

Step 2 Display the fields in the certificate using OpenSSL.

Example:

$ openssl x509 -text -in userabc.crt
Certificate:
Data:
Version: 3 (0x2)
Serial Number:
c4:27:6c:4d:69:7c:d2:b6
Signature Algorithm: shalWithRSAEncryption
Issuer: CN=User ABC, O=Cisco Systems, C=US
Validity
Not Before: Jan 12 16:36:14 2015 GMT
Not After : Dec 19 16:36:14 2114 GMT
Subject: CN=User ABC, O=Cisco Systems, C=US
Subject Public Key Info:
Public Key Algorithm: rsaEncryption
RSA Public Key: (1024 bit)

Modulus (1024 bit):
00:92:35:12:cd:2b:78:ef:9d:ca:0e:11:77:77:3a:
99:d3:25:42:94:b5:3e:8a:32:55:ce:e9:21:2a:ff:
e0:24:22:58:6d:40:98:b1:0d:42:21:db:cd:44:26:
50:77:e5:fa:b6:10:57:dl:ec:95:e9:86:d7:3c:99:
ce:c4:7f£:61:1d:3c:9%9e:ae:d8:88:be:80:a0:4a:90:
d2:22:e9:1b:25:27:cd:7d:£3:a5:8f:cf:16:a8:el:
3a:3f:68:0b:9c:7c:cb:70:09:c7:3f:e8:db:85:d8:
98:£6:e3:70:4e:47:€2:59:03:49:01:83:8e:50:4a:
5f:bc:35:d2:b1:07:be:ec:el

Exponent: 65537 (0x10001)

X509v3 extensions:
X509v3 Subject Key Identifier:
0B:E4:11:C7:23:46:10:4F:D1:10:4C:C1:58:C2:1E:18:E8:6D:85:34
X509v3 Authority Key Identifier:
keyid:0B:E4:11:C7:23:46:10:4F:D1:10:4C:C1:58:C2:1E:18:E8:6D:85:34

DirName:/CN=User ABC/O=Cisco Systems/C=US

serial:C4:27:6C:4D:69:7C:D2:B6

X509v3 Basic Constraints:
CA:TRUE
Signature Algorithm: shalWithRSAEncryption
8f:c4:9f:84:06:30:59:0c:d2:8a:09:96:a22:69:3d:cf:ef:79:
9l:ea:cd:ae:80:16:df:16:31:3b:69:89:£7:5a:24:1£f:£fd:9f:
dl:d9:b2:02:41:01:b9:e9:8d:da:a8:4c:1e:e5:9b:3e:1d:65:
84:ff:e8:ad:55:3e:90:a0:a2:fb:3e:3e:ef:c2:11:3d:1b:eb6:
f4:5€:d2:92:e8:24:61:43:59:ec:ea:d2:bb:c9:9a:7a:04:91:
8e:91:bb:9d:33:d4:28:b5:13:ce:dc:fe:c3:e5:33:97:5d:37:
cc:5f:ad:af:5a:aa:f4:a3:a8:50:66:7d:£f4:fb:78:72:9d:56:
91:2c
[snip]
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Configuring a Local User

Creating a Local User and Adding a User Certificate Using the GUI

Procedure

Step 1 On the menu bar, choose ADMIN > AAA.
Step 2 In the Navigation pane, click Users and Local Users in the Work pane.
Step 3 In the Work pane, verify that you in the Local Users tab.

The admin user is present by default

Step 4 In the Work pane, click on task icon drop-down list and select Create Local User.
Step 5 In the Security dialog box, choose the desired security domain for the user, and click Next.
Step 6 In the Roles dialog box, click the radio buttons to choose the roles for your user, and click Next.

You can provide read-only or read/write privileges.

Step 7 In the User ldentity dialog box, perform the following actions:
a) Inthe Login ID field, add an ID.
b) In the Password field, enter the password.
¢) In the Confirm Password field, confirm the password.

d) (Optional) For Certificate based authentication, in the User Certificate Attribute field, enter the user
identity from the authentication certificate.

e) Click Finish.

Step 8 In the Navigation pane, click the name of the user that you created. In the Work pane, expand the + sign next
to your user in the Security Domains area.
The access privileges for your user are displayed.

Step 9 In the Work pane, in the User Certificates area, click the user certificates + sign, and in the Create X509
Certificate dialog box, perform the following actions:

a) In the Name field, enter a certificate name.
b) In the Data field, enter the user certificate details.
¢) Click Submit.

The X509 certificate is created for the local user.

Creating a Local User Using Python SDK

Procedure

Create a local user.

Example:

#!/usr/bin/env python
from cobra.model.pol import Uni as PolUni
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from cobra.model.aaa
from cobra.model.aaa
from cobra.model.aaa
from cobra.model.aaa
from cobra.model.aaa

import
import
import
import
import

UserEp as AaaUserEp

User as AaaUser

UserCert as AaaUserCert
UserDomain as AaaUserDomain
UserRole as AaaUserRole

from
from

from cobra.internal.codec.jsoncodec import toJSONStr
APIC = 'http://10.10.10.1"'
username = ‘admin’
password = ‘p@s$SwOrd’
session = LoginSession (APIC, username, password)
modir = MoDirectory (session)
modir.login()
def readFile (fileName=None, mode="r"):

if fileName is None:

return ""
fileData = ""

wi

re

our

HH = H H

rol

userR

uni =
aaaUs
aaaUs

aaaUs
aaaUs
aaaUs
aaaUs

cobra.mit.access import MoDirectory
cobra.mit.session import LoginSession

th open(fileName, mode) as aFile:
fileData = aFile.read()
turn fileData

aaaUserRoles (roleName, privType)
es, that is what the GUI does

oles = {'all': [

('aaa', 'writePriv'),
('access-admin', 'writePriv'),
('admin', 'writePriv'),
('fabric-admin', 'writePriv'),
('nw-svc-admin', 'writePriv'),
('ops', 'writePriv'),
(
(
(
(

o

'read-all', 'writePriv'),
'tenant-admin', 'writePriv'),

'vmm-admin', 'writePriv'),

] r

PolUni('") # '' is the Dn string for topRoot

erEp = AaaUserEp (uni)

er = AaaUser (aaaUserEp, 'userabc', firstName='Adam',

email="userabc@cisco.com")

er.lastName = 'BC'
er.phone = '555-111-2222"

erCert = AaaUserCert (aaaUser, 'userabc.crt')
erCert.data = readFile("/tmp/userabc.crt")

'tenant-ext-admin', 'writePriv'),

Creating a Local User Using Python SDK .

Use a dictionary to define the domain and a list of tuples to define

This can further be abstracted by doing a query to get the valid

# Now add each aaaUserRole to the aaaUserDomains which are added to the

# aaa

UserCert

for domain,roles in userRoles.items() :

aa
fo

print

cr =

aUserDomain = AaaUserDomain (aaaUser, domain)

r roleName, privType in roles:

aaaUserRole = AaaUserRole (aaaUserDomain,
privType=privType)

toJSONStr (aaaUser, prettyPrint=True)

ConfigRequest ()

cr.addMo (aaaUser)
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modir.commit (cr)
# End of Script to create a user

Using a Private Key to Calculate a Signature

Before you begin
You must have the following information available:

* HTTP method - GET, POST, DELETE

* REST API URI being requested, including any query options

* For POST requests, the actual payload being sent to the APIC

* The private key used to generate the X.509 certificate for the user

* The distinguished name for the user X.509 certificate on the APIC

Procedure

Step 1 Concatenate the HTTP method, REST API URI, and payload together in this order and save them to a file.

This concatenated data must be saved to a file for OpenSSL to calculate the signature. In this example, we
use a filename of payload.txt. Remember that the private key is in a file called userabc.key.

Example:

GET example:

GET http://10.10.10.1/api/class/fvTenant.json?rsp-subtree=children
POST example:

POST http://10.10.10.1/api/mo/tn-test.json{"fvTenant": {"attributes": {"status": "deleted",
"name": "test"}}}

Step 2 Verify that the payload.txt file contains the correct information.
For example, using the GET example shown in the previous step:
GET http://10.10.10.1/api/class/fvTenant.json?rsp-subtree=children
Your payload.txt file should contain only the following information:
GET/api/class/fvTenant.json?rsp-subtree=children
Step 3 Verify that you didn't inadvertently create a new line when you created the payload file.

Example:
# cat —e payload.txt

Determine if there is a $ symbol at the end of the output, similar to the following:

GET/api/class/fvTenant.json?rsp=subtree=children$
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Step 4

Step 5

Step 6

Step 7

Step 8

Using a Private Key to Calculate a Signature .

If so, then that means that a new line was created when you created the payload file. To prevent creating a
new line when generating the payload file, use a command similar to the following:

echo -n "GET/api/class/fvTenant.json?rsp-subtree=children" >payload.txt

Calculate a signature using the private key and the payload file using OpenSSL.

Example:
openssl dgst -sha256 -sign userabc.key payload.txt > payload sig.bin

The resulting file has the signature printed on multiple lines.

Convert the signature to base64 format:

Example:

openssl base64 -A -in payload sig.bin -out payload sig.base64

Strip the signature of the new lines using Bash.

Example:

$ tr -d '\n' < payload sig.base64
P+OTgKO0CeAZj17+Gute2R1IWw80GgtzEOwsL1x8fIXX14V79Z17
Ou8IdJHICBAW6CEVAICXgkv3KaQszCIC0+Bn0703qgF//BsIplZmYChD6gCX3£f7q
IcjGX+R6HAQGeK7k97cNhX1WEoobFPe/oajtPjoudtdOjhf/ujGeJveRo=

Note This is the signature that will be sent to the APIC for this specific request. Other requests will
require to have their own signatures calculated.

Place the signature inside a string to enable the APIC to verify the signature against the payload.
This complete signature is sent to the APIC as a cookie in the header of the request.

Example:

APIC-Request-Signature=P+0OTgKOCeAZjl7+Gute2R1Ww80GgtzEOwsL1x8f
IXX14V79Z170u8IdJHICBAW6CEVAICXgkv3KaQszCICO0+Bn07039F//BsIplZmYChD6gCX3f
79IciGX+R6HAQGeK7k97cNhX1WEoobFPe/o0ajtPjOou3tdOjhf/9ujG6JIveRo=;
APIC-Certificate-Algorithm=v1.0; APIC-Certificate-Fingerprint=fingerprint;
APIC-Certificate-DN=uni/userext/user-userabc/usercert-userabc.crt

Note The DN used here must match the DN of the user certified object containing the x509 certificate
in the next step.

Use the CertSession class in the Python SDK to communicate with an APIC using signatures.

The following script is an example of how to use the CertSession class in the ACI Python SDK to make
requests to an APIC using signatures.

Example:

#!/usr/bin/env python

# It is assumed the user has the X.509 certificate already added to
# their local user configuration on the APIC

from cobra.mit.session import CertSession

from cobra.mit.access import MoDirectory

def readFile (fileName=None, mode="zr"):
if fileName is None:
return ""
fileData = ""
with open(fileName, mode) as aFile:
fileData = aFile.read()
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return fileData

pkey = readFile ("/tmp/userabc.key")
csession = CertSession ("https://ApicIPOrHostname/",
"uni/userext/user-userabc/usercert-userabc", pkey)

modir = MoDirectory (csession)
resp = modir.lookupByDn ('uni/fabric")
pring resp.dn

# End of script

Note The DN used in the earlier step must match the DN of the user certified object containing the
x509 certificate in this step.

Accounting

ACI fabric accounting is handled by these two managed objects (MO) that are processed by the same mechanism
as faults and events:

* The aaasessionLr MO tracks user account login and logout sessions on the APIC and switches, and
token refresh. The ACI fabric session alert feature stores information such as the following:

» Username

* [P address initiating the session
* Type (telnet, https, REST etc.)
* Session time and length

* Token refresh — a user account login event generates a valid active token which is required in order
for the user account to exercise its rights in the ACI fabric.

\}

Note Token expiration is independent of login; a user could log out but the token
expires according to the duration of the timer value it contains.

* The aaaModrLr MO tracks the changes users make to objects and when the changes occurred.

* [f the AAA server is not pingable, it is marked unavailable and a fault is seen.

Both the aaasessionLr and aaaModLR event logs are stored in APIC shards. Once the data exceeds the pre-set
storage allocation size, it overwrites records on a first-in first-out basis.

)

Note In the event of a destructive event such as a disk crash or a fire that destroys an APIC cluster node, the event
logs are lost; event logs are not replicated across the cluster.

The aaaModLr and aaasessionL.R MOs can be queried by class or by distinguished name (DN). A class query
provides all the log records for the whole fabric. All aaaModir records for the whole fabric are available from
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Routed Connectivity to External Networks as a Shared Service Billing and Statistics .

the GUI at the Fabric > Inventory > POD > History > Audit Log section, The APIC GUI History > Audit
Log options enable viewing event logs for a specific object identified in the GUL

The standard syslog, callhome, REST query, and CLI export mechanisms are fully supported for aaaModrr
and aaasessionL.R MO query data. There is no default policy to export this data.

There are no pre-configured queries in the APIC that report on aggregations of data across a set of objects or
for the entire system. A fabric administrator can configure export policies that periodically export aaaModL.r
and aaasessionLR query data to a syslog server. Exported data can be archived periodically and used to
generate custom reports from portions of the system or across the entire set of system logs.

Routed Connectivity to External Networks as a Shared Service
Billing and Statistics

The APIC can be configured to collect byte count and packet count billing statistics from a port configured
for routed connectivity to external networks (an 13ext Instp EPQG) as a shared service. Any EPG in any tenant
can share an 13extInstP EPG for routed connectivity to external networks. Billing statistics can be collected
for each EPG in any tenant that uses an 13extInstP EPG as a shared service. The leaf switch where the
13extInstP is provisioned forwards the billing statistics to the APIC where they are aggregated. Accounting
policies can be configured to periodically export these billing statics to a server.
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This chapter contains the following sections:

* Management Workflows, on page 39

» Adding Management Access, on page 40

CHAPTER 5

» Exporting Tech Support, Statistics, and Core Files, on page 47

* Overview, on page 49

* Backing up, Restoring, and Rolling Back Controller Configuration, on page 56

* Using Syslog, on page 66

» Using Atomic Counters, on page 69

» Using SNMP, on page 72
» Using SPAN, on page 78
* Using Traceroute, on page 83

Management Workflows

in the ACI fabric.

ACIl Management Access Workflows

This workflow provides an overview of the steps required to configure management connectivity to switches
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. Adding Management Access

1. Prerequisites

* Ensure that you have read/write access privileges to the infra security domain.
* Ensure that the target leaf switches with the necessary interfaces are available.

2. Configure the ACI Leaf Switch Access Ports

Choose which of these management access scenarios you will use:

« For in-band management, follow the suggested topics for in-band configuration in the ACI Configuration
Guide.

* For out-of-band management, follow the suggested topics for out-of-band configuration in the ACI
Configuration Guide .
Suggested topics
For additional information, see the following topics in the ACI Basic Configuration Guide :
* Configuring In-Band Management Access Using the Advanced GUI
* Configuring In-Band Management Access Using the NX-OS Style CLI
* Configuring In-Band Management Access Using the REST API
* Configuring Out-of-Band Management Access Using the Advanced GUI
* Configuring Out-of-Band Management Access Using the NX-OS Style CLI

* Configuring Out-of-Band Management Access Using the REST API

Adding Management Access

Configuring the external management instance profile under the management tenant for in-band has no effect
on the protocols that are configured under the fabric-wide communication policies. The subnets and contracts
specified under the external management instance profile do not affect HTTP/HTTPS or SSH/Telnet.

Adding Management Access in the GUI

A Cisco Application Policy Infrastructure Controller (APIC) has two routes to reach the management network:
one is by using the in-band management interface and the other is by using the out-of-band management
interface.

The in-band management network allows Cisco APIC to communicate with the leaf switches and with the
outside using the Cisco Application Centric Infrastructure (ACI) fabric, and it makes it possible for external
management devices to communicate with the Cisco APIC or the leaf switches and spine switches using the
fabric itself.

The out-of-band management network configuration defines the configuration of the management port on the
controllers, the leaf switches and the spine switches.
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IPv4/IPv6 Addresses and In-Band Policies .

The Cisco APIC controller always selects the in-band management interface over the out-of-band management
interface, if the in-band management interface is configured. The out-of-band management interface is used
only when the in-band management interface is not configured or if the destination address is on the same
subnet as the out-of-band management subnet of the Cisco APIC.

Cisco ACI has the ability to program routes for in-band management based on the subnet configuration on
the bridge domains in the management tenant and in-band VRF instance. These routes will be deleted when
the subnet configuration is deleted from the bridge domains.

The Cisco APIC out-of-band management connection link must be 1 Gbps.

\)

Note Duplicate IP addresses and firewalls that cache ARP information are not supported on the management
network. The presence of these conditions can result in the complete loss of Cisco APIC management access
following an upgrade.

IPv4/IPv6 Addresses and In-Band Policies

In-band management addresses can be provisioned on the APIC controller only through a policy (Postman
REST API, NX-OS Style CLI, or GUI). Additionally, the in-band management addresses must be configured
statically on each node.

IPv4/IPv6 Addresses in Out-of-Band Policies

Out-of-band management addresses can be provisioned on the APIC controller either at the time of bootstrap
or by using a policy (Postman REST API, NX-OS Style CLI, GUI). Additionally, the out-of-band management
addresses must be configured statically on each node or by specifying a range of addresses (IPv4/IPv6) to the
entire cluster. IP addresses are randomly assigned from a range to the nodes in the cluster.

IPv6 Table Modifications to Mirror the Existing IP Tables Functionality

All IPv6 tables mirror the existing IP tables functionality, except for Network Address Translation (NAT).

Existing IP Tables

1. Earlier, every rule in the IPv6 tables were executed one at a time and a system call was made for every
rule addition or deletion.

2. Whenever a new policy was added, rules were appended to the existing IP tables file and no extra
modifications were done to the file.

3. When a new source port was configured in the out-of-band policy, it added source and destination rules
with the same port number.

Modifications to IP Tables

1. When IP tables are created, they are first written into hash maps that are then written into intermediate
file IP tables-new which are restored. When saved, a new IP tables file is created in the /etc/sysconfig/
folder. You can find both these files at the same location. Instead of making a system call for every rule,
you must make a system call only while restoring and saving the file.

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



Management |

. Management Access Guidelines and Restrictions

\}

When a new policy is added instead of appending it to the file, an IP table is created from scratch, that is
by loading default policies into the hashmaps, checking for new policies, and adding them to hashmaps.
Later, they are written to the intermediate file (/etc/sysconfig/iptables-new) and saved.

It is not possible to configure source ports alone for a rule in out-of-band policy. Either destination port
or source port along with a destination port can be added to the rules.

When a new policy is added, a new rule will be added to the IP tables file. This rule changes the access
flow of IP tables default rules.

-A INPUT -s <OOB Address Ipv4/Ipv6> -j apic-default
When a new rule is added, it presents in the IP tables-new file and not in the IP tables file, and it signifies

that there is some error in the IP tables-new file. Only if the restoration is successful, the file is saved and
new rules are seen in the IP tables file.

Note

* If only IPv4 is enabled, do not configure an IPv6 policy.

* If only IPv6 is enabled, do not configure an IPv4 policy.

* [f both IPv4 and IPv6 are enabled and a policy is added, it will be configured to both the versions . So
when you add an IPv4 subnet, it will be added to IP tables and similarly an IPv6 subnet is added to IPv6

tables.

Management Access Guidelines and Restrictions

* vzAny is supported as a consumer of a shared service but is not supported as a provider of a shared
service. vzAny shared service consumer and vzAny provider is not supported.

* When configuring out-of-band management access, logging options for an out-of-band contract (enabling
and viewing ACL contract and permit/deny logs) is not supported.

* An in-band management address must be configured for a leaf node in order to push the in-band
management VRF to a leaf node.

* A bridge domain subnet IP address in the in-band management VRF can be assigned as a secondary IP
address unless "Make this IP address primary" is selected for a gateway subnet.

* The following ports cannot be denied in an out-of-band contract:

* 5010
* 5012
* 5013
* 5020
* 5021
» 5025
7777
* 32768 through 60999
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Configuring In-Band and Out-of-Band Management Access with Wizards .

* A spine switch does not resolve ARP on the in-band mangement IP address. Due to this, any device in
the in-band management network cannot communicate with the spine switch. Access to a spine switch
is only possible over a Layer 3 network.

» With out-of-band management, the ICMP port is opened by default for all subnets.

Configuring In-Band and Out-of-Band Management Access with Wizards

Step 1

Step 2

In APIC, release 3.1(x), wizards were added to simplify configuring management access. You can still use
the other methods of configuring management access included in this document.

Procedure

To configure In-Band Management Access, perform the following steps:

a) On the menu bar, click Tenants > mgmt.

b) Expand Quick Start.

¢) Click In-Band Management Access > Configure In-Band Management Access > Start.

d) Follow the instructions to add the Nodes in the management network, the 1P addresses for the nodes,
communication filters for the Connected Devices, and communication filters for Remote Attached
Devices.

To configure Out-of-Band Management Access, perform the following steps:

a) On the menu bar, click Tenants > mgmt.

b) Expand Quick Start.

¢) Click Out-of-Band Management Access > Configure Out-of-Band Management Access > Start.

d) Follow the instructions to add the Nodes in the out-of-band management network, the IP addresses for
the nodes, subnets allowed for the External Hosts, and communication filters that will determine
communication for Access.

Configuring In-Band Management Access Using the Cisco APIC GUI

Step 1
Step 2
Step 3

)

Note [Pv4 and IPv6 addresses are supported for in-band management access. IPv6 configurations are supported
using static configurations (for both in-band and out-of-band). IPv4 and IPv6 dual in-band and out-of-band
configurations are supported only through static configuration. For more information, see the KB
article,Configuring Static Management Accessin Cisco APIC.

Procedure

On the menu bar, choose Fabric > Access Policies.
In the Navigation pane, right-click Interfaces and choose Configure Interface, PC and VPC.

In the Configure Interface, PC, and VPC dialog box, to configure switch ports connected to Cisco Application
Policy Infrastructure Controllers (APICs), perform the following actions:
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. Configuring In-Band Management Access Using the Cisco APIC GUI

Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

a) Click the large + icon next to the switch diagram to create a new profile and configure VLANS for the
Cisco APIC.

b) From the Switches field drop-down list, check the check boxes for the switches to which the Cisco APICs
are connected. (leafl and leaf2).

¢) Inthe Switch Profile Name field, enter a name for the profile (apicConnectedLeaves).

d) Click the + icon to configure the ports.

e) Verify that in the Interface Type area, the Individual radio button is selected.

f) In the Interfaces field, enter the ports to which the Cisco APICs are connected.

g) In the Interface Selector Name field, enter the name of the port profile (apicConnectedPorts).

h) In the Interface Policy Group field, click the Create One radio button.

i) In the Attached Device Type field, choose the appropriate device type to configure the domain (Bare
Metal).

j) In the Domain field, click the Create One radio button.

k) Inthe Domain Name field, enter the domain name. (inband)

1) Inthe VLAN field, choose the Create One radio button.

m) In the VLAN Range field, enter the VLAN range. Click Save, and click Save again. Click Submit.

In the Navigation pane, right-click Switch Policies and choose Configure Interface, PC and VPC.

In the Configure Interface, PC, and VPC dialog box, perform the following actions:

a) Click the large + icon next to the switch diagram to create a new profile and configure VLANS for the
server.

b) In the Switches field, from drop-down list, check the check boxes for the switches to which the servers
are connected. (leafl).

¢) In the Switch Profile Name field, enter a name for the profile (vmmConnectedLeaves).

d) Click the + icon to configure the ports.

e) Verify that in the Interface Type area, the Individual radio button is selected.

f) In the Interfaces field, enter the ports to which the servers are connected (1/40).

g) In the Interface Selector Name field, enter the name of the port profile.

h) In the Interface Policy Group field, click the Create One radio button.

i) Inthe Attached Device Type field, choose the appropriate device type to configure the domain (Bare
Metal).

j) Inthe Domain field, from the drop-down list click the Choose One radio button

k) From the Physical Domain drop-down list, choose the domain created earlier.

1) Inthe Domain Name field, enter the domain name.

m) Click Save, and click Save again.

In the Configure Interface, PC, and VPC dialog box, click Submit.

On the menu bar, click TENANTS > mgmt. In the Navigation pane, expand Tenant mgmt > Networking >

Bridge Domains to configure the bridge domain on the in-band connection.

Expand the in-band bridge domain (inb). Right-click Subnets. Click Create Subnet and perform the following

actions to configure the in-band gateway:

a) In the Create Subnet dialog box, in the Gateway IP field, enter the in-band management gateway IP
address and mask.

b) Click Submit.

In the Navigation pane, expand Tenant mgmt > Node Management EPGs. Right-click Node Management
EPGs and choose Create In-Band Management EPG. Perform the following actions to set the VLAN on
the in-band EPG used to communicate with the Cisco APIC:
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Step 10

Step 11

Step 12

Step 13

Configuring In-Band Management Access Using the Cisco APIC GUI .

a) In the Name field, enter the in-band management EPG name.

b) In the Encap field, enter the VLAN (vlan-10).

¢) From the Bridge Domain drop-down field, choose the bridge domain. Click Submit.

d) Inthe Navigation pane, choose the newly created in-band EPG.

e) Expand Provided Contracts. In the Name field, from the drop-down list, choose the default contract to

enable EPG to provide the default contract that will be consumed by the EPGs on which the VMM servers
are located.

f) Click Update, and click Submit.

In the Navigation pane, right-click Node Management Addresses and click Create Node Management

Addresses, and perform the following actions to configure the IP addresses to be assigned to the Cisco APICs

in the fabric:

a) Inthe Create Node Management Addresses dialog box, in the Policy Name field, enter the policy name
(apiclnb).

b) In the Nodes field, Select column, check the check boxes for the nodes that will be part of this fabric
(apicl, apic2, apic3).

¢) In the Config field, check the In-Band Addresses check box.

d) In the Node Range fields, enter the range.

e) Inthe In-Band IP Addresses area, in the In-Band Management EPG field, from the drop-down list,
choose default. This associates the default in-band Management EPG.

f) Inthe In-Band IP Addresses and Gateway fields, enter the IPv4 or IPv6 addresses as desired.

g) Click Submit. The IP addresses for the Cisco APICs are now configured.

In the Navigation pane, right-click Node Management Addresses. Click Create Node Management

Addresses, and perform the following actions to configure the IP addresses for the leaf and spine switches

in the fabric:

a) Inthe Create Node Management Addresses dialog box, in the Policy Name field, enter the policy name
(switchInb).

b) In the Nodes field, Select column, check the check boxes next to the nodes that will be part of this fabric
(leafl, leaf2, spinel, spine2).

¢) Inthe Config field, click the In-Band Addresses checkbox.

d) In the Node Range fields, enter the range.

e) Inthe In-Band IP Addresses area, in the In-Band Management EPG field, from the drop-down list,
choose default. The default in-band management EPG is now associated.

f) Inthe In-Band IP Addresses and Gateway fields, enter the IPv4 or IPv6 addresses as desired.

g) Click Submit. In the Confirm dialog box, click Yes. The IP addresses for the leaf and spine switches are
now configured.

In the Navigation pane, under Node Management Addresses, click the Cisco APIC policy name (apiclnb)
to verify the configurations. In the Work pane, the IP addresses assigned to various nodes are displayed.

In the Navigation pane, under Node Management Addresses, click the switches policy name (switchInb).
In the Work pane, the IP addresses that are assigned to switches and the gateway addresses they are using
are displayed.

Note You can make out-of-band management access the default management connectivity mode for
the Cisco APIC server by clicking System > System Settings > APIC Connectivity Preferences.
Then on the Connectivity Preferences page, click inband.
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Configuring Out-of-Band Management Access Using the Cisco APIC GUI

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7

Step 8
Step 9

\}

Note IPv4 and IPv6 addresses are supported for out-of-band management access.

You must configure out-of-band management access addresses for the leaf and spine switches as well as for
APIC

Before you begin

The APIC out-of-band management connection link must be 1 Gbps.

Procedure

On the menu bar, choose Tenants > mgmt. In the Navigation pane, expand Tenant mgmt.
Right-click Node Management Addresses, and click Create Node Management Addresses.
In the Create Node Management Addresses dialog box, perform the following actions:

a) In the Policy Name field, enter a policy name (switchOob).

b) In the Nodes field, check the check boxes next to the appropriate leaf and spine switches (leafl, leaf2,
spinel).
¢) In the Config field, check the check box for Out of-Band Addresses.

Note The Out-of-Band IP addresses area is displayed.

d) In the Out-of-Band Management EPG field, choose the EPG from the drop-down list (default).

e) Inthe Out-Of-Band Gateway field, enter the IP address and network mask for the external out-of-band
management network.

f) In the Out-of-Band IP Addresses field, enter the range of desired IPv4 or IPv6 addresses that will be
assigned to the switches. Click Submit.

The node management IP addresses are configured.

In the Navigation pane, expand Node Management Addresses, and click the policy that you created.
In the Work pane, the out-of-band management addresses are displayed against the switches.

In the Navigation pane, expand Contracts > Out-of-Band Contracts.
Right-click Out-of-Band Contracts, and click Create Out-of-Band Contract.
In the Create Out-of-Band Contract dialog box, perform the following tasks:

a) Inthe Name field, enter a name for the contract (oob-default).

b) Expand Subjects. In the Create Contract Subject dialog box, in the Name field, enter a subject name
(oob-default).

¢) Expand Filter Chain, and in the Name field, from the drop-down list, choose the name of the filter
(default). Click Update, and click OK.

d) In the Create Out-of-Band Contract dialog box, click Submit.

An out-of-band contract that can be applied to the out-of-band EPG is created.

In the Navigation pane, expand Node Management EPGs > Out-of-Band EPG - default.
In the Work pane, expand Provided Out-of-Band Contracts.
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Step 10

Step 11

Step 12

Exporting Tech Support, Statistics, and Core Files .

In the OOB Contract column, from the drop-down list, choose the out-of-band contract that you created
(oob-default). Click Update, and click Submit.
The contract is associated with the node management EPG.

In the Navigation pane, right-click External Network Instance Profile, and click Create External
Management Entity Instance.

In the Create External Management Entity Instance dialog box, perform the following actions:

a) In the Name field, enter a name (oob-mgmt-ext).
b) Expand the Consumed Out-of-Band Contracts field. From the Out-of-Band Contract drop-down list,
choose the contract that you created (oob-default). Click Update.

Choose the same contract that was provided by the out-of-band management.

¢) In the Subnets field, enter the subnet address. Click Submit.
Only the subnet addresses you choose here will be used to manage the switches. The subnet addresses
that are not included cannot be used to manage the switches.

The node management EPG is attached to the external network instance profile. The out-of-band management
connectivity is configured.

Note You can make out-of-band management access the default management connectivity mode for
the APIC server by clicking System > System Settings > AP1C Connectivity Preferences. Then
on the Connectivity Preferences page, click ooband.

Exporting Tech Support, Statistics, and Core Files

About Exporting Files

An administrator can configure export policies in the APIC to export statistics, technical support collections,
faults and events, to process core files and debug data from the fabric (the APIC as well as the switch) to any
external host. The exports can be in a variety of formats, including XML, JSON, web sockets, secure copy
protocol (SCP), or HTTP. You can subscribe to exports in streaming, periodic, or on-demand formats.

An administrator can configure policy details such as the transfer protocol, compression algorithm, and
frequency of transfer. Policies can be configured by users who are authenticated using AAA. A security
mechanism for the actual transfer is based on a username and password. Internally, a policy element handles
the triggering of data.

File Export Guidelines and Restrictions

* HTTP export and the streaming API format is supported only with statistics information. Core and tech
support data are not supported.

* The destination IP address for exported files cannot be an IPv6 address.

* Do not trigger tech support from more than five nodes simultaneously, especially if they are to be exported
into the Cisco Application Policy Infrastructure Controller (APIC) or to an external server with insufficient
bandwidth and compute resources.
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* To collect tech support from all of the nodes in the fabric periodically, you must create multiple policies.
Each policy must cover a subset of the nodes and should be scheduled to trigger in a staggered way (at
least 30 minutes apart).

* Do not schedule more than one tech support policy for the same node on the Cisco APIC. Running
multiple instances of tech support policies on the same node at the same time can result in a huge
consumption of Cisco APIC or switch CPU cycles and the other resources.

» We recommend that you use the regular tech support policy for the nodes placed in maintenance mode
instead of the on-demand tech support policy.

* The status of an on-going tech support for the nodes in maintenance mode will not be available in the
Cisco APIC GUI in the Admin > Tech Support > policy_name> Operational > Status section. Based
on your selection of Export to Controller or Export Destination in the tech support policy, you can
verify the controller (/data/techsupport) or the destination server to confirm that the tech support
is being captured.

* Tech support collection from the Cisco APIC can time out when the cores on a leaf switch are busy. The
cores can become busy if routing processes such as BGP and platform processes such as HAL hog the
CPU. If the tech support collection times out, check for the CPU utilization to see if there is a CPU hog.
If there is, you can collect the tech support on the leaf switch directly to avoid the timeout issues.

Creating a Remote Location for Exporting Files

Step 1
Step 2
Step 3
Step 4
Step 5

This procedure configures the host information and file transfer settings for a remote host that will receive
exported files.

Procedure

In the menu bar, click Admin.

In the submenu bar, click Import/Export.

In the Navigation pane, expand Export Policies.

Right-click Remote Locations and choose Create Remote Path of a File.

In the Create Remote Path of a File dialog box, perform the following actions:

a) In the Name field, enter a name for the remote location.

b) Inthe Host Name/IP field, enter an IP address or a fully qualified domain name for the destination host.
¢) In the Protocol field, click the radio button for the desired file transfer protocol.

d) In the Remote Path field, type the path where the file will be stored on the remote host.

e) Enter a username and password for logging in to the remote host and confirm the Password.
f) From the Management EPG drop-down list, choose the management EPG.

g) Click Submit.
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Sending an On-Demand Tech Support File Using the GUI

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7
Step 8

Overview

Procedure

In the menu bar, click Admin.

In the submenu bar, click Import/Export.

In the Navigation pane, expand Export Policies.

Right-click On-demand Tech Support and choose Create On-demand Tech Support.

The Create On-demand Tech Support dialog box appears.

Enter the appropriate values in the fields of the Create On-demand Tech Support dialog box.

Note For an explanation of a field, click the help icon in the Create On-demand Tech Support dialog
box. The help file opens to a properties description page.

Click Submit to send the tech support file.

Note On-demand tech support files can be saved to another APIC to balance storage and CPU
requirements. To verify the location, click on the On-demand Tech Support policy in the
Navigation pane, then click the OPERATIONAL tab in the Work pane. The controller is
displayed in the EXPORT LOCATION field.

Right-click the policy name and choose Collect Tech Support.

Choose Yes to begin collecting tech support information.

This topic provides information on:

* How to use configuration Import and Export to recover configuration states to the last known good state
using the Cisco APIC

* How to encrypt secure properties of Cisco APIC configuration files

You can do both scheduled and on-demand backups of user configuration. Recovering configuration states
(also known as "roll-back") allows you to go back to a known state that was good before. The option for that
is called an Atomic Replace. The configuration import policy (configlmportP) supports atomic + replace
(importMode=atomic, importType=replace). When set to these values, the imported configuration overwrites
the existing configuration, and any existing configuration that is not present in the imported file is deleted.
As long as you do periodic configuration backups and exports, or explicitly trigger export with a known good
configuration, then you can later restore back to this configuration using the following procedures for the CLI,
REST API, and GUL

For more detailed conceptual information about recovering configuration states using the Cisco APIC, please
refer to the Cisco Application Centric Infrastructure Fundamentals Guide.

The following section provides conceptual information about encrypting secure properties of configuration
files:
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Configuration File Encryption

As of release 1.1(2), the secure properties of APIC configuration files can be encrypted by enabling AES-256
encryption. AES encryption is a global configuration option; all secure properties conform to the AES
configuration setting. It is not possible to export a subset of the ACI fabric configuration such as a tenant
configuration with AES encryption while not encrypting the remainder of the fabric configuration. See the
Cisco Application Centric Infrastructure Fundamentals, "Secure Properties" chapter for the list of secure
properties.

The APIC uses a 16 to 32 character passphrase to generate the AES-256 keys. The APIC GUI displays a hash
of the AES passphrase. This hash can be used to see if the same passphrases was used on two ACI fabrics.
This hash can be copied to a client computer where it can be compared to the passphrase hash of another ACI
fabric to see if they were generated with the same passphrase. The hash cannot be used to reconstruct the
original passphrase or the AES-256 keys.

Observe the following guidelines when working with encrypted configuration files:

» Backward compatibility is supported for importing old ACI configurations into ACI fabrics that use the
AES encryption configuration option.

N

Note Reverse compatibility is not supported; configurations exported from ACI fabrics
that have enabled AES encryption cannot be imported into older versions of the
APIC software.

* Always enable AES encryption when performing fabric backup configuration exports. Doing so will
assure that all the secure properties of the configuration will be successfully imported when restoring
the fabric.

\}

Note If a fabric backup configuration is exported without AES encryption enabled,
none of the secure properties will be included in the export. Since such an
unencrypted backup would not include any of the secure properties, it is possible
that importing such a file to restore a system could result in the administrator
along with all users of the fabric being locked out of the system.

» The AES passphrase that generates the encryption keys cannot be recovered or read by an ACI
administrator or any other user. The AES passphrase is not stored. The APIC uses the AES passphrase
to generate the AES keys, then discards the passphrase. The AES keys are not exported. The AES keys
cannot be recovered since they are not exported and cannot be retrieved via the REST APIL

*» The same AES-256 passphrase always generates the same AES-256 keys. Configuration export files can
be imported into other ACI fabrics that use the same AES passphrase.

* For troubleshooting purposes, export a configuration file that does not contain the encrypted data of the
secure properties. Temporarily turning off encryption before performing the configuration export removes
the values of all secure properties from the exported configuration. To import such a configuration file
that has all secure properties removed, use the import merge mode; do not use the import replace mode.
Using the import merge mode will preserve the existing secure properties in the ACI fabric.

* By default, the APIC rejects configuration imports of files that contain fields that cannot be decrypted.
Use caution when turning off this setting. Performing a configuration import inappropriately when this
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default setting is turned off could result in all the passwords of the ACI fabric to be removed upon the
import of a configuration file that does not match the AES encryption settings of the fabric.

\}

Note Failure to observe this guideline could result in all users, including fabric
administrations, being locked out of the system.

Configuring a Remote Location Using the GUI

This procedure explains how to create a remote location using the APIC GUI.

Procedure

Step 1 On the menu bar, choose ADMIN > Import/Export.

Step 2 In the navigation pane, right-click Remote Locations and choose Create Remote Location.
The Create Remote Location dialog appears.

Step 3 Enter the appropriate values in the Create Remote Location dialog fields.
Note For an explanation of a field, click the 'i' icon to display the help file.

Step 4 When finished entering values in the Create Remote Location dialog fields, click Submit.
You have now created a remote location for backing up your data.

Configuring an Export Policy Using the GUI

This procedure explains how to configure an Export policy using the APIC GUI. Follow these steps to trigger
a backup of your data.

\)

Note The Maximum Concurrent Nodes value that is configured in a scheduler policy determines the number of
configuration export policies to act at the time that is specified in the scheduler policy.

For example, if the Maximum Concurrent Nodes is set to 1 in a scheduler policy and you have configured
two export policies, both utilizing the same scheduler policy, one export policy is successful and other fails.
However, if the Maximum Concurrent Nodes is set to 2, both configurations are successful.

Note  When the user is logged in with Read-only privileges, Tech Support data can still be exported by right-clicking
on the On-Demand Tech Support or Configuration Export polices and selecting Trigger.
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Step 1
Step 2

Step 3

Step 4

Procedure

On the menu bar, choose Admin > Import/Export.

In the navigation pane, right-click Export Policies and choose Create Configuration Export Policy.
The Create Configuration Export Policy dialog appears.

Enter the appropriate values in the Create Configuration Export Policy dialog fields.

Note For an explanation of a field, click the help (?) icon to display the help file.

When finished entering values in the Create Configuration Export Policy dialog fields, click Submit.
You have now created a backup. You can view this under the Configuration tab (The backup file will appear
in the Configuration pane on the right).

Note When deployed, and configured to do so, the Cisco Network Assurance Engine (NAE) creates
export policies in the Cisco APIC for collecting data at timed intervals. You can identify an NAE
export policy by its name, which is based on the assurance control configuration. If you delete
an NAE export policy in the Cisco APIC, the NAE export policy will reappear in the Cisco APIC.
We recommend not deleting the NAE export policies.

There's an Operational tab where you can see if it's running, successful, or failed. If you didn't trigger it yet,
it is empty. If you created a backup, it creates a file that is shown in the Operational view of the backup file
that was created. If you want to then import that data, you must create an Import policy.

Configuring an Import Policy Using the GUI

Step 1
Step 2

Step 3

Step 4

This procedure explains how to configure an Import policy using the APIC GUI. Follow these steps to import
your backed up data:

Procedure

On the menu bar, choose ADMIN > Import/Export.

In the navigation pane, right-click Import Policies and click Create Configuration Import Policy.
The Create Configuration Import Policy dialog appears.

Enter the appropriate values in the Create Configuration Import Policy dialog fields.
Note For an explanation of a field, click the '1' icon to display the help file. For more detailed information

on import types and modes including (Replace, Merge, Best Effort, and Atomic), refer to the
Cisco Application Centric Infrastructure Fundamentals Guide .

When finished entering values in the Create Configuration Import Policy dialog fields, click Submit.

Note If you perform a clean reload of the fabric and import a previously-saved configuration, the time
zone will change to UTC by default. Reset the time zone to your local time zone after the
configuration import for the APIC cluster in these situations.
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Encrypting Configuration Files Using the GUI

Step 1
Step 2

Step 3

Step 4

Step 5

AES-256 encryption is a global configuration option. When enabled, all secure properties conform to the AES
configuration setting. A portion of the ACI fabric configuration can be exported using configuration export
with a specific targetDn. However, it is not possible to use REST API to export just a portion of the ACI
fabric such as a tenant configuration with secure properties and AES encryption. The secure properties do not
get included during REST API requests.

This section explains how to enable AES-256 encryption.

Procedure

On the menu bar, choose ADMIN > AAA.

In the navigation pane, click AES Encryption Passphrase and Keys for Config Export (and Import).
The Global AES Encryption Settings for all Configurations Import and Export window appears in the
right pane.

Create a passphrase, which can be between 16 and 32 characters long. There are no restrictions on the type
of characters used.

Click SUBMIT.
Note Once you have created and posted the passphrase, the keys are then generated in the back-end
and the passphrase is not recoverable. Therefore, your passphrase is not visible to anyone because

the key is automatically generated then deleted. Your backup only works if you know the
passphrase (no one else can open it).

The Key Configured field now shows yes. You now see an encrypted hash (which is not the actual passphrase,
but just a hash of it) in the Encrpyted Passphrase field.

After setting and confirming your passphrase, check the check box next to Enable Encryption to turn the
AES encryption feature on (checked).

The Global AES Encryption Settings field in your export and import policies will now be enabled by default.
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Note
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* Be sure that the Fail Import if secure fields cannot be decrypted check box is checked
(which is the default selection) in your import and export policies. We highly recommend
that you do not uncheck this box when you import configurations. If you uncheck this box,
the system attempts to import all the fields However, any fields that it cannot encrypt are
blank/missing. As a result, you could lock yourself out of the system because the admin
passwords could go blank/missing (if you lock yourself out of the system, refer to Cisco
APIC Troubleshooting Guide). Unchecking the box launches a warning message. If the box
is checked, there are security checks that prevent lockouts and the configuration does not
import.

When the Enable Encryption check box is unchecked (off), encryption is disabled and all
exported configurations (exports) are missing the secure fields (such as passwords and
certificates). When this box is checked (on), encryption is enabled and all exports show the
secure fields.

After enabling encryption, you cannot configure a passphrase when creating a new import
or export policy. The passphrase you previously set is now global across all configurations
in this box and across all tenants. If you export a configuration from this tab (you have
configured a passphrase and enabled encryption) you get a complete backup file. If encryption
is not enabled, you get a backup file with the secure properties removed. These backup files
are useful when exporting to TAC support engineers, for example, because all the secure
fields are missing. This is true for any secure properties in the configuration. There is also
a clear option that clears the encryption key.

Note the list of the configuration import behaviors and associated results in the following table:

Configuration Import Behavior Scenario

Result

Old configuration from previous release

Import of configurations from old
releases is fully supported and
successfully imports all secure fields
stored in old configurations.

Configuration import when AES encryption is not
configured

If the import is for a configuration
without secure fields, it is successful
with the behavior previously
described. If the imported
configuration has secure fields, it is
rejected.

Configuration import when AES passphrases do not match

If the import is for a configuration
without secure fields, it is successful
with the behavior previously
described. If the imported
configuration has secure fields, it is
rejected.

Configuration import when AES passphrases match

Import is successful

Configuration import when AES passphrases do not match
for copy/pasted fields

This specific case occurs when you
have copied and pasted secure fields
from other configurations that were
exported with a different passphrase.
During the first pass parsing of the

imported backup file, if any property
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Configuration Import Behavior Scenario Result

fails to decrypt correctly, the import
fails without importing any shards.

Therefore, if a shard fails to decrypt
all properties, all shards are rejected.

Backing up, Restoring, and Rolling Back Controller
Configuration

This section describes the set of features for backing up (creating snapshots), restoring, and rolling back a
controller configuration.

Backing Up, Restoring, and Rolling Back Configuration Files Workflow

This section describes the workflow of the features for backing up, restoring, and rolling back configuration
files. All of the features described in this document follow the same workflow pattern. Once the corresponding
policy is configured, admintSt must be set to triggered in order to trigger the job.

Once triggered, an object of type configJob (representing that run) is created under a container object of type
configdobCont. (The naming property value is set to the policy DN.) The container's lastJobName field can
be used to determine the last job that was triggered for that policy.

\)

Note Up to five configJob objects are kept under a single job container at a time, with each new job triggered. The
oldest job is removed to ensure this.

The configJob object contains the following information:
» Execution time
» Name of the file being processed/generated
« Status, as follows:
* Pending
* Running
* Failed
* Fail-no-data
* Success

* Success-with-warnings

* Details string (failure messages and warnings)
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* Progress percentage = 100 * lastStepIndex/totalStepCount

* Field lastStepDescr indicating what was being done last

About the fileRemotePath Object

The fileRemotePath object holds the following remote location-path parameters:

* Hostname or IP

* Port

* Protocol: FTP, SCP, and others
* Remote directory (not file path)
» Username

» Password

N

Note The password must be resubmitted every time changes are made.

Sample Configuration
The following is a sample configuration:
Under fabriclnst (uni/fabric), enter:

<fileRemotePath name="path-name" host="host name or ip" protocol="scp"
remotePath="path/to/some/folder" userName="user-name" userpasswd="password" />

Configuration Export to Controller

The configuration export extracts user-configurable managed object (MO) trees from all thirty-two shards in
the cluster, writes them into separate files, then compresses them into a tar gzip. The configuration export
then uploads the tar gzip to a pre-configured remote location (configured via configRsRemotePath pointing
to a fileRemotePath object) or stores it as a Snapshot on the controller(s).

\}

Note Sece the Snapshots section for more details.

The configExportP policy is configured as follows:
* name - policy name
» format - format in which the data is stored inside the exported archive (xml or json)
» targetDn - the domain name (DN) of the specific object you want to export (empty means everything)

* snapshot - when true, the file is stored on the controller, no remote location configuration is needed
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« includeSecureFields - Set to true by default, indicates whether the encrypted fields (passwords, etc.)
should be included in the export archive.

N

Note The configSnapshot object is created holding the information about this snapshot (see the Snapshots section).

Scheduling Exports

An export policy can be linked with a scheduler, which triggers the export automatically based on a
pre-configured schedule. This is done via the configRsSExportScheduler relation from the policy to a
trigSchedP object (see the following Sample Configuration section).

\}

Note A scheduler is optional. A policy can be triggered at any time by setting the adminSt to triggered.

Troubleshooting

If you get an error message indicating that the generated archive could not be uploaded to the remote location,
refer to the Connectivity Issues section.

Sample Configuration Using the NX-0S Style CLI
The following is a sample configuration using the NX-OS Style CLI:

apicl (config)# snapshot
download Configuration snapshot download setup mode

export Configuration export setup mode

import Configuration import setup mode

rollback Configuration rollback setup mode

upload Configuration snapshot upload setup mode

apicl (config) # snapshot export policy-name
apicl (config-export) #

format Snapshot format: xml or json

no Negate a command or set its defaults

remote Set the remote path configuration will get exported to

schedule Schedule snapshot export

target Snapshot target

bash bash shell for unix commands

end Exit to the exec mode

exit Exit from current mode

fabric show fabric related information

show Show running system information

where show the current mode

apicl (config-export)# format xml

apicl (config-export) # no remote path [If no remote path is specified, the file
is exported locally to a folder in the controller]

apicl (config-export) # target [Assigns the target of the export, which

can be fabric, infra, a specific tenant, or none. If no target is specified, all configuration
information is exported.]

WORD infra, fabric or tenant-x

apicl (config-export) #

apicl# trigger snapshot export policy-name [Executes the snapshot export task]

apicl# 1ls /data2 [If no remote path is specified, the
configuration export file is saved locally to the controller under the folder dataZ2]

ce Dailybackup.tgz
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Sample Configuration Using the GUI
The following is a sample configuration using the GUI:

1.  On the menu bar, click the ADMIN tab.

2 Select IMPORT/EXPORT.

3. Under Export Policies, select Configuration.

4 Under Configuration, click the configuration that you would like to roll back to. For example, you can

click defaultOneTime, which is the default.

Next to Format, select a button for either JSON or XML format.

6.  Next to Start Now, select a button for either No or Yes to indicate whether you want to trigger now or
trigger based on a schedule. (The easiest method is to choose to trigger immediately.)

7.  For the Target DN field, enter the name of the tenant configuration you are exporting.

8.  Ifyou want to store the configuration on the controller itself, check the Snapshot option. If you want
to configure a remote location, uncheck this option.

9.  For the Scheduler field, you have the option to create a scheduler instructing when and how often to
export the configuration.

10. For the Encryption field, you have the option to enable or disable the encryption

o

of your configuration file.
11.  When you have finished your configuration, click Start Now.
12.  Click SUBMIT to trigger your configuration export.

Sample Configuration Using REST API
The following is a sample configuration using the REST API:

<configExportP name="policy-name" format="xml" targetDn="/some/dn or empty which means
everything"

snapshot="false" adminSt="triggered">

<configRsRemotePath tnFileRemotePathName="some remote path name" />
<configRsExportScheduler tnTrigSchedPName="some scheduler name" />

</configExportP>

\)

Note When providing a remote location, if you set the snapshot to True, the backup ignores the remote path and
stores the file on the controller.

Configuration Import to Controller

Configuration import downloads, extracts, parses, analyzes and applies the specified, previously exported
archive one shard at a time in the following order: infra, fabric, tn-common, then everything else. The
fileRemotePath configuration is performed the same way as for export (via configRsRemotePath). Importing
snapshots is also supported.

The configlmportP policy is configured as follows:
* name - policy name
« fileName - name of the archive file (not the path file) to be imported

» importMode
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* Best-effort mode: each MO is applied individually, and errors only cause the invalid MOs to be
skipped.

Note If the object is not present on the controller, none of the children of the object
get configured. Best-effort mode attempts to configure the children of the object.

» Atomic mode: configuration is applied by whole shards. A single error causes whole shard to be
rolled back to its original state.

* importType

« replace - Current system configuration is replaced with the contents or the archive being imported
(only atomic mode is supported)

» merge - Nothing is deleted, archive content is applied on top the existing system configuration.

* snapshot - when true, the file is taken from the controller and no remote location configuration is needed.

» failOnDecryptErrors - (true by default) the file fails to import if the archive was encrypted with a
different key than the one that is currently set up in the system.

Troubleshooting
The following scenarios may need troubleshooting:

» If the generated archive could not be downloaded from the remote location, refer to the Connectivity
Issues section.

* If the import succeeded with warnings, check the details.
« If a file could not be parsed, refer to the following scenarios:

* [f the file is not a valid XML or JSON file, check whether or not the files from the exported archive
were manually modified.

* If an object property has an unknown property or property value, it may be because:
* The property was removed or an unknown property value was manually entered
* The model type range was modified (non-backward compatible model change)

* The naming property list was modified

* If an MO could not be configured, note the following:
* Best-effort mode logs the error and skips the MO

» Atomic mode logs the error and skips the shard

Sample Configuration Using the NX-0S Style CLI
The following is a sample configuration using the NX-OS Style CLI:
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apicl# configure
apicl (config)# snapshot
download Configuration snapshot download setup mode

export Configuration export setup mode

import Configuration import setup mode

rollback Configuration rollback setup mode

upload Configuration snapshot upload setup mode
apicl (config)# snapshot import

WORD Import configuration name

default

rest-user

apicl (config)# snapshot import policy-name
apicl (config-import) #

action Snapshot import action merge|replace

file Snapshot file name
mode Snapshot import mode atomic|best-effort
no Negate a command or set its defaults

remote Set the remote path configuration will get imported from

bash bash shell for unix commands
end Exit to the exec mode

exit Exit from current mode

fabric show fabric related information
show Show running system information
where show the current mode

apicl (config-import)# file < from "show snapshot files" >

apicl (config-import) # no remote path

apicl (config-import) #

apicl# trigger snapshot import policy-name [Executes the snapshot import task]
Sample Configuration Using the GUI

The following is a sample configuration using the GUI:

1. On the menu bar, click the ADMIN tab.

2 Select IMPORT/EXPORT.

3. Under Import Policies, select Configuration.

4

Under Configuration, select Create Configuration Import Policy. The CREATE CONFIGURATION
IMPORT POLICY window appears.

5.  In the Name field, the file name must match whatever was backed up and will have a very specific
format. The file name is known to whoever did the backup.

6.  The next two options relate to recovering configuration states (also known as "roll-back"). The options
are Input Type and Input Mode. When you recover a configuration state, you want to roll back to a
known state that was good before. The option for that is an Atomic Replace.

7. Ifyou want to store the configuration on the controller itself, check the Snapshot option. If you want
to configure a remote location, uncheck this option.

8.  Inthe Import Source field, specify the same remote location that you already created.

9.  For the Encryption field, you have the option to enable or disable the encryption

of your configuration file.
10. Click SUBMIT to trigger your configuration import.
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Sample Configuration Using the REST API
The following shows a sample configuration using the REST API:

<configImportP name="policy-name" fileName="someexportfile.tgz" importMode="atomic"
importType="replace" snapshot="false" adminSt="triggered">

<configRsRemotePath tnFileRemotePathName="some remote path name" />
</configImportP>

Snapshots are configuration backup archives, stored (and replicated) in a controller managed folder. To create
one, an export can be performed with the snapshot property set to true. In this case, no remote path
configuration is needed. An object of configSnapshot type is created to expose the snapshot to the user.

You can create recurring snapshots, which are saved to Admin > Import/Export > Export Policies >
Configuration > defaultAuto.

configSnapshot objects provide the following:

» file name

* file size

* creation date

« root DN indicating what the snapshot is of (fabric, infra, specific tenant, and so on)

» ability to remove a snapshot (by setting the retire field to true)

To import a snapshot, first create an import policy. Navigate to Admin > Import/Export and click Import
Policies. Right click and choose Create Configuration Import Policy to set the import policy attributes.

Snapshot Manager Policy

The configSnapshotManagerP policy allows you to create snapshots from remotely stored export archives.
You can attach a remote path to the policy, provide the file name (same as with configlmportP), set the mode
to download, and trigger. The manager downloads the file, analyzes it to make sure the archive is valid, stores
it on the controller, and creates the corresponding configSnapshot object.

You can also create a recurring snapshot.

)

Note When enabled, recurring snapshots are saved to Admin > Import/Export > Export Policies > Configuration >

defaultAuto.

The snapshot manager also allows you to upload a snapshot archive to a remote location. In this case, the
mode must be set to upload.

Troubleshooting

For troubleshooting, refer to the Connectivity Issues section.
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Snapshot Upload from Controller to Remote Path Using the NX-0S CLI

apicl (config) # snapshot upload policy-name
apicl (config-upload) #
file Snapshot file name
no Negate a command or set its defaults
remote Set the remote path configuration will get uploaded to

bash bash shell for unix commands
end Exit to the exec mode

exit Exit from current mode

fabric show fabric related information
show Show running system information
where show the current mode

apicl (config-upload)# file <file name from "show snapshot files">
apicl (config-upload) # remote path remote-path-name
apicl# trigger snapshot upload policy-name [Executes the snapshot upload task]

Snapshot Download from Controller to Remote Path Using the NX-0S CLI

apicl (config) # snapshot download policy-name
apicl (config-download) #
file Snapshot file name
no Negate a command or set its defaults
remote Set the remote path configuration will get downloaded from

bash bash shell for unix commands
end Exit to the exec mode

exit Exit from current mode

fabric show fabric related information
show Show running system information
where show the current mode

apicl (config-download)# file < file from remote path>

apicl (config-download) # remote path remote-path-name

apicl# trigger snapshot download policy-name [Executes the snapshot download task]
Snapshot Upload and Download Using the GUI

To upload a snapshot file to a remote location:

1. Right-click on the snapshot file listed in the Config Rollbacks pane, and select the Upload to Remote
Location option. The Upload snapshot to remote location box appears.

2. Click SUBMIT.

To download a snapshot file from a remote location:

1. Click the import icon on the upper right side of the screen. The Import remotely stored export archive
to snapshot box appears.

2. Enter the file name in the File Name field.

3. Select a remote location from the Import Source pull-down, or check the box next to Or create a new
one to create a new remote location.

4. Click SUBMIT.

Snapshot Upload and Download Using the REST API

<configSnapshotManagerP name="policy-name" fileName="someexportfile.tgz"
mode="upload|download" adminSt="triggered">

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



B roiback

Rollback

Management |

<configRsRemotePath tnFileRemotePathName="some remote path name" />
</configSnapshotManagerP>

The configRollbackP policy enables you to undo the changes made between two snapshots, effectively rolling
back any configuration changes that were made to the snapshot that was saved earlier. When the policy is
triggered, objects are processed as follows:

* Deleted MOs are recreated
* Created MOs are deleted
* Modified MOs are reverted

)

Note * The rollback feature only operates on snapshots.

» Remote archives are not supported directly. However, you can turn a remotely saved export into a snapshot
using the snapshot manager policy (configSnapshotMgrP). For more information, see the Snapshot
Manager Policy, on page 62

* The configRollbackP policy does not require a remote path configuration. If a remote path is provided,
it will be ignored.

Rollback Workflow

The policy snapshotOneDN and snapshotTwoDn fields must be set with the first snapshot (S1) preceding
snapshot two (S2). When triggered, the snapshots are extracted and analyzed to calculate and apply the
differences between the snapshots.

The MOs are handled as follows:

* MOs are present in S1 but not present in S2 — These MOs were deleted before S2. The rollback will
recreate these MOs.

* MOs are present in S2 but not present in S1 — These MOs were created after S1. The rollback will delete
these MOs under the following circumstances:

* These MOs were not modified after S2 was taken.

* No MO descendants were created or modified after S2 was taken.

* MOs are present in both S1 and S2 but with different property values — If the property was modified to
a different value after S2 was taken, the property is left as is. Otherwise, the rollback will revert these
properties to S1.

The rollback feature also generates a diff file that contains the confiuration generated as a result of these
calculations. Applying this configuration is the last step of the rollback process. The content of this file can
be retrieved through a special REST API called readiff:
apichost/mqapi2/snapshots.readiff.xml1?jobdn=SNAPSHOT JOB DN.
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Rollback, which is difficult to predict, also has a preview mode (set preview to true), which prevents rollback
from making any actual changes. It simply calculates and generates the diff file, allowing you to preview what
exactly is going to happen once the rollback is actually performed.

Diff Tool

Another special REST API is available, which provides diff functionality between two snapshots:
apichost/mqapi2/snapshots.diff.xml?s1dn=SNAPSHOT ONE_DN&s2dn=SNAPSHOT TWO_DN.

Sample Configuration Using the NX-0S Style CLI
This example shows how to configure and execute a rollback using the NX-OS Style CLI:

apicl# show snapshot files

File : ce2 DailyAutoBackup-2015-11-21T01-00-17.tar.gz
Created : 2015-11-21T01:00:21.167+00:00

Root

Size : 22926

File : ce2 DailyAutoBackup-2015-11-21T09-00-21.tar.gz
Created : 2015-11-21T09:00:24.025+00:00

Root

Size : 23588

apicl# configure

apicl (config) # snapshot rollback myRollbackPolicy

apicl (config-rollback)# first-file ce2_ DailyAutoBackup-2015-11-21T01-00-17.tar.gz
apicl (config-rollback) # second-file ce2 DailyAutoBackup-2015-11-21T09-00-21.tar.gz
apicl (config-rollback) # preview

apicl (config-rollback) # end

apicl# trigger snapshot rollback myRollbackPolicy

Sample Configuration Using the GUI

This example shows how to configure and execute a rollback using the GUI:

1. On the menu bar, click the Admin tab.

2. Click Config Rollbacks, located under the Admin tab.

3. Select the first configuration file from the Config Rollbacks list (in the left-side pane).
4

Select the second configuration file in the Configuration for selected snapshot pane (in the right-side
pane).

5. Click the Compare with previous snapshot drop-down menu (at the bottom of the right-side pane), then
select the second configuration file from that list. A diff file is then generated so that you can compare
the differences between the two snapshots.

)

Note  After the file generates, there is an option to undo these changes.

Sample Configuration Using the REST API

This example shows how to configure and execute a rollback using the REST API:

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



Management |
. Using Syslog

<configRollbackP name="policy-name" snapshotOneDn="dn/of/snapshot/one"
snapshotOneDn="dn/of/snapshot/two" preview="false" adminSt="triggered" />

Using Syslog

About Syslog

During operation, a fault or event in the Cisco Application Centric Infrastructure (ACI) system can trigger
the sending of a system log (syslog) message to the console, to a local file, and to a logging server on another
system. A system log message typically contains a subset of information about the fault or event. A system
log message can also contain audit log and session log entries.

)

Note For a list of syslog messages that the APIC and the fabric nodes can generate, see http://www.cisco.com/c/
en/us/td/docs/switches/datacenter/aci/apic/sw/1-x/syslog/guide/aci_syslog/ACI_SysMsg.html.

Many system log messages are specific to the action that a user is performing or the object that a user is
configuring or administering. These messages can be the following:

* Informational messages, providing assistance and tips about the action being performed

» Warning messages, providing information about system errors related to an object, such as a user account
or service profile, that the user is configuring or administering

In order to receive and monitor system log messages, you must specify a syslog destination, which can be the
console, a local file, or one or more remote hosts running a syslog server. In addition, you can specify the
minimum severity level of messages to be displayed on the console or captured by the file or host. The local
file for receiving syslog messages is /var/log/external /messages.

A syslog source can be any object for which an object monitoring policy can be applied. You can specify the
minimum severity level of messages to be sent, the items to be included in the syslog messages, and the syslog
destination.

You can change the display format for the Syslogs to NX-OS style format.

Additional details about the faults or events that generate these system messages are described in the Cisco
APIC Faults, Events, and System Messages Management Guide, and system log messages are listed in the
Cisco ACI System Messages Reference Guide.

\}

Note Not all system log messages indicate problems with your system. Some messages are purely informational,
while others may help diagnose problems with communications lines, internal hardware, or the system software.

Creating a Syslog Destination and Destination Group

This procedure configures syslog data destinations for logging and evaluation. You can export syslog data to
the console, to a local file, or to one or more syslog servers in a destination group.
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Creating a Syslog Destination and Destination Group .

Procedure

In the menu bar, click Admin.

In the submenu bar, click External Data Collectors.

In the Navigation pane, expand Monitoring Destinations.
Right-click Syslog and choose Create Syslog Monitoring Destination Group.
In the Create Syslog Monitoring Destination Group dialog box, perform the following actions:

a)
b)

¢)

d)

e)

f)
2

In the group and profile Name field, enter a name for the monitoring destination group and profile.
In the group and profile Format field, choose the format for Syslog messages.

The default is aci, or the RFC 3164 compliant message format, but you can choose to set it to the NX-OS
style format instead.

In the group and profile Admin State drop-down list, choose enabled.

To enable sending of syslog messages to a local file, choose enabled from the Local File Destination
Admin State drop-down list and choose a minimum severity from the Local File Destination Severity
drop-down list.

The local file for receiving syslog messages is /var/log/external/messages.

To enable sending of syslog messages to the console, choose enabled from the Console Destination
Admin State drop-down list and choose a minimum severity from the Console Destination Severity
drop-down list.

Click Next.

In the Create Remote Destinations area, click + to add a remote destination.

Caution There is a risk of hostname resolution failure for remote syslog destinations if the DNS server

that you specify is configured to be reachable over in-band connectivity. To avoid the issue,
configure the syslog server using the IP address, or if you use a hostname, ensure that the DNS
server is reachable over an out-of-band interface.

In the Create Syslog Remote Destination dialog box, perform the following actions:

a)
b)
©)
d)

In the Host field, enter an IP address or a fully qualified domain name for the destination host.
(Optional) In the Name field, enter a name for the destination host.

In the Admin State field, click the enabled radio button.

(Optional) Choose a minimum severity Severity, a Port number, and a syslog Facility.

The Facility is a number that you can optionally use to indicate which process generated the message,
and can then be used to determine how the message will be handled at the receiving end.

In the 5.2(3) release and later, in the Transport field, choose the transport protocol to use for the messages.

* For releases prior to release 5.2(4), choose either tcp or udp as the transport protocol to use for the
messages.

* In the 5.2(4) release and later, ssl is also an option for the transport protocol to use for the messages.
This feature enables a Cisco ACI switch (acting as a client) to make a secure, encrypted outbound
connection to remote syslog servers (acting as a server) supporting secure connectivity for logging.
With authentication and encryption, this feature allows for a secure communication over an insecure
network.
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Step 7

Step 8

Note that you must also upload the necessary SSL certificate if you select ssl as the transport protocol
to use for the messages. You can upload the necessary SSL certificate by navigating to the Create
Certificate Authority window:

Admin > AAA > Security > Public Key Management > Certificate Authorities, then Actions >
Create Certificate Authority

The default option for the transport protocol is udp.

f) From the Management EPG drop-down list, choose the management endpoint group.
g) Click OK.

(Optional) To add more remote destinations to the remote destination group, click + again and repeat the steps
in the Create Syslog Remote Destination dialog box

Click Finish.

Creating a Syslog Source

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

A syslog source can be any object for which an object monitoring policy can be applied.

Before you begin

Create a syslog monitoring destination group.

Procedure

From the menu bar and the navigation frame, navigate to a Monitoring Policies menu for the area of interest.

You can configure monitoring policies for tenants, fabric, and access.

Expand Monitoring Policies, then select and expand a monitoring policy.

Under Fabric > Fabric Policies > Monitoring Policies > Common Policy is a basic monitoring policy that
applies to all faults and events and is automatically deployed to all nodes and controllers in the fabric.
Alternatively, you can specify an existing policy with a more limited scope.

Under the monitoring policy, click Callhome/SNMP/Syslog.

In the Work pane, choose Syslog from the Source Type drop-down list.

From the Monitoring Object list, choose a managed object to be monitored.

If the desired object does not appear in the list, follow these steps:

a) Click the Edit icon to the right of the Monitoring Object drop-down list.

b) From the Select Monitoring Package drop-down list, choose an object class package.
c) Select the checkbox for each object that you want to monitor.

d) Click Submit.

In a tenant monitoring policy, if you select a specific object instead of All, a Scope selection appears.
In the Scope field, select a radio button to specify the system log messages to send for this object:

» all—Send all events and faults related to this object
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« specific event—Send only the specified event related to this object. From the Event drop-down list,
choose the event policy.

« specific fault—Send only the specified fault related to this object. From the Fault drop-down list, choose

the fault policy.
Step 7 Click + to create a syslog source.
Step 8 In the Create Syslog Source dialog box, perform the following actions:

a) Inthe Name field, enter a name for the syslog source.

b) From the Min Severity drop-down list, choose the minimum severity of system log messages to be sent.

¢) Inthe Include field, check the checkboxes for the type of messages to be sent.

d) From the Dest Group drop-down list, choose the syslog destination group to which the system log
messages will be sent.

e) Click Submit.

Step 9 (Optional) To add more syslog sources, click + again and repeat the steps in the Create Syslog Source dialog
box

Using Atomic Counters

About Atomic Counters

Atomic counters allow you to gather statistics about traffic between flows. Using atomic counters, you can
detect drops and misrouting in the fabric, enabling quick debugging and isolation of application connectivity
issues. For example, an administrator can enable atomic counters on all leaf switches to trace packets from
endpoint 1 to endpoint 2. If any leaf switches have nonzero counters, other than the source and destination
leaf switches, an administrator can drill down to those leafs.

In conventional settings, it is nearly impossible to monitor the amount of traffic from a bare metal NIC to a
specific IP address (an endpoint) or to any IP address. Atomic counters allow an administrator to count the
number of packets that are received from a bare metal endpoint without any interference to its data path. In
addition, atomic counters can monitor per-protocol traffic that is sent to and from an endpoint or an application
group.
Leaf-to-leaf (TEP-to-TEP) atomic counters can provide the following:

* Counts of sent, received, dropped, and excess packets

* Sent packets: The sent number reflects how many packets were sent from the source TEP (tunnel
endpoint) to the destination TEP.

* Received packets: The received number reflects how many packets the destination TEP received
from the source TEP.

* Dropped packets: The dropped number reflects how many packets were dropped during transmission.
This number is the difference in the amount of packets sent and the amount of packets received.

*» Excess packets: The excess number reflects how many extra packets were received during
transmission. This number is the amount of packets that were unexpectedly received due to a
forwarding mismatch or a misrouting to the wrong place.
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* Short-term data collection such as the last 30 seconds, and long-term data collection such as 5 minutes,
15 minutes, or more

* A breakdown of per-spine traffic (available when the number of TEPs, leaf or VPC, is less than 64)

* Ongoing monitoring

)

Note Leaf-to-leaf (TEP to TEP) atomic counters are cumulative and cannot be cleared. However, because 30-second
atomic counters reset at 30-second intervals, they can be used to isolate intermittent or recurring problems.
Atomic counters require an active fabric Network Time Protocol (NTP) policy.

Tenant atomic counters can provide the following:

* Application-specific counters for traffic across the fabric, including sent, received, dropped, and excess
packets

* Modes include the following:
» EPtoEP (endpoint to endpoint)

* EPGtoEPG (endpoint group to endpoint group)

N

Note For EPGtoEPG, the options include ipv4 only, ipv6 only, and ipv4, ipv6. Any
time there is an ipv6 option, you use twice the TCAM entries, which means the
scale numbers may be less than expected for pure ipv4 policies.

* EPGtoEP (endpoint group to endpoint)

* EPtoAny (endpoint to any)

* AnytoEP (any to endpoint)

* EPGtolP (endpoint group to IP, used only for external IP address)

» EPtoExternalIP (endpoint to external IP address)

Atomic Counters Guidelines and Restrictions

+ Use of atomic counters is not supported when the endpoints are in different tenants or in different contexts
(VRFs) within the same tenant.

* In Cisco APIC release 3.1(2m) and later, if no statistics have been generated on a path in the lifetime of
the fabric, no atomic counters are generated for the path. Also, the Traffic Map in the Visualization tab
(Operations > Visualization in the Cisco APIC GUI) does not show all paths, only the active paths
(paths that had traffic at some point in the fabric lifetime).

* In pure Layer 2 configurations where the IP address is not learned (the IP address is 0.0.0.0),
endpoint-to-EPG and EPG-to-endpoint atomic counter policies are not supported. In these cases,
endpoint-to-endpoint and EPG-to-EPG policies are supported. External policies are virtual routing and
forwarding (VRF)-based, requiring learned IP addresses, and are supported.
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* When the atomic counter source or destination is an endpoint, the endpoint must be dynamic and not
static. Unlike a dynamic endpoint (fv:CEp), a static endpoint (fv:StCEp) does not have a child object
(fv:RsCEpToPathEp) that is required by the atomic counter.

* In a transit topology, where leaf switches are not in full mesh with all spine switches, then leaf-to-leaf
(TEP to TEP) counters do not work as expected.

* For leaf-to-leaf (TEP to TEP) atomic counters, once the number of tunnels increases the hardware limit,
the system changes the mode from trail mode to path mode and the user is no longer presented with
per-spine traffic.

* The atomic counter does not count spine proxy traffic.

* Packets dropped before entering the fabric or before being forwarded to a leaf port are ignored by atomic
counters.

* Packets that are switched in the hypervisor (same Port Group and Host) are not counted.
» Atomic counters require an active fabric Network Time Protocol (NTP) policy.

* Atomic counters work for IPv6 sources and destinations, but configuring source and destination IP
addresses across IPv4 and IPv6 addresses is not allowed.

* An atomic counter policy configured with fvCEp as the source or destination counts only the traffic that
is from/to the MAC and IP addresses that are present in the fvCEp managed objects. If the fvCEp managed
object has an empty IP address field, then all traffic to/from that MAC address would be counted regardless
of the IP address. If the Cisco APIC has learned multiple IP addresses for an fvCEp, then traffic from
only the one IP address in the fvCEp managed object itself is counted as previously stated. To configure
an atomic counter policy to or from a specific IP address, use the fvlp managed object as the source or
destination.

* If there is an fvIp behind an fvCEp, you must add fvIP-based policies and not fvCEp-based policies.

* Endpoint-to-endpoint atomic counter statistics are not reported for Layer 2 bridged traffic with IPv6
headers when the endpoints belong to the same EPG.

* For atomic counters to work for traffic flowing from an EPG or ESG to an L30Out EPG, configure the
L30ut EPG with 0/1 and 128/1 to match all prefixes instead of 0/0.

* If your Cisco APIC has the traffic map mode set to "trial" and the Cisco APIC generated the F1545 fault,
the only way that you can clear this fault is by setting the traffic map mode to "path." To change the
traffic map mode, go to Operations > Visualization, click Settings, choose path for Mode, then click
Submit. This will give you tunnel stats per port in both ingress and egress.

The trial mode has a greater chance of reaching the maximum scale index of tunnel logical interfaces.
This mode consumes more software and hardware resources. A logical interface is the ID that is associated
with the tunnel in the hardware.

If you have a single tunnel between a tunnel endpoint (TEP) you specified the trail mode, it will consume
more hardware resources as well. For example, if you have 6 fabric ports and a single tunnel, then
hardware consumes a number of entries equal to the number of tunnels multiplied by the number of fabric
ports.

For software, if the number of logical interfaces allocated is greater than 2048, you will fail to have an
entry in the hardware. As a result, you cannot get the stats. In the case of the atomic counter, this issue
may show as drops or excesses.
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The path mode has only entries for the TEP. For a vPC, two entries will be installed. Therefore, you have
a lower chance of reaching to the maximum limit.

Configuring Atomic Counters

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

Step 8

Procedure

In the menu bar, click Tenants.

In the submenu bar, click the desired tenant.

In the Navigation pane, expand the tenant and expand Policies and then expand Troubleshoot.

Under Troubleshoot, expand Atomic Counter Policy and choose a traffic topology.

You can measure traffic between a combination of endpoints, endpoint groups, external interfaces, and IP
addresses.

Right-click the desired topology and choose Add topology Policy to open an Add Policy dialog box.

In the Add Policy dialog box, perform the following actions:

a) Inthe Name field, enter a name for the policy.
b) choose or enter the identifying information for the traffic source.

The required identifying information differs depending on the type of source (endpoint, endpoint group,
external interface, or IP address).

¢) choose or enter the identifying information for the traffic destination.
d) (Optional) (Optional) In the Filters table, click the + icon to specify filtering of the traffic to be counted.

In the resulting Create Atomic Counter Filter dialog box, you can specify filtering by the IP protocol
number (TCP=6, for example) and by source and destination IP port numbers.

e) Click Submit to save the atomic counter policy.

In the Navigation pane, under the selected topology, choose the new atomic counter policy.

The policy configuration is displayed in the Work pane.

In the Work pane, click the Operational tab and click the Traffic subtab to view the atomic counter statistics.

Using SNMP

About SNMP

The Cisco Application Centric Infrastructure (ACI) provides extensive SNMPv1, v2, and v3 support, including
Management Information Bases (MIBs) and notifications (traps). The SNMP standard allows any third-party
applications that support the different MIBs to manage and monitor the Cisco ACI fabric.

SNMPv3 provides extended security. Each SNMPv3 device can be selectively enabled or disabled for SNMP
service. In addition, each device can be configured with a method of handling SNMPv1 and v2 requests.

Beginning in the 4.2(6) release, SNMPv3 supports the Secure Hash Algorithm-2 (SHA-2) authentication type.
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For more information about using SNMP, see the Cisco ACI MIB Quick Reference.
SNMP Access Support in Cisco ACI
D

Note For the complete list of MIBs supported in Cisco Application Centric Infrastructure (ACI), see
http://www.cisco.com/c/en/us/td/docs/switches/datacenter/aci/apic/sw/1-x/mib/list/mib-support.html.

SNMP support in Cisco ACI is as follows:

* SNMP read queries (Get, Next, Bulk, Walk) are supported by leaf and spine switches and by the Cisco
Application Policy Infrastructure Controller (APIC).

* SNMP write commands (Set) are not supported by leaf and spine switches or by the Cisco APIC.

* SNMP traps (v1, v2c, and v3) are supported by leaf and spine switches and by the Cisco APIC.

)

Note Cisco ACI supports a maximum of 10 trap receivers.

* SNMPvV3 is supported by leaf and spine switches and by the Cisco APIC.
* SNMP using a Cisco APIC IPv6 address is not supported.

Table 6: SNMP Support Changes by Cisco APIC Release

Release Description

1.2(2) IPv6 support is added for SNMP trap destinations.

1.2(1) SNMP support for the Cisco APIC controller is added. Previous releases support SNMP
only for leaf and spine switches.

SNMP Trap Aggregation

The SNMP Trap Aggregation feature allows SNMP traps from the fabric nodes to be aggregated by Cisco
Application Policy Infrastructure Controllers (APICs) and allows the forwarding of SNMP traps received
from the fabric nodes to the external destination by the APICs.

Use this feature if you expect traps to come from APIC instead of from individual fabric nodes. With this
feature enabled, APIC acts as an SNMP proxy.

We highly recommend that you configure all APICs in the cluster as SNMP trap aggregators to handle possible
failures. You can configure multiple trap destinations in the SNMP policy. To configure trap aggregation and
forwarding, follow these steps:

1. Configure each APIC controller to receive traps from the switches. Follow the procedure in Configuring
an SNMP Trap Destination Using the GUI, on page 76 using the following settings:

* In the Host Name/IP field, specify the IPv4 or IPv6 address of the APIC.

* From the Management EPG list, select the out-of-band or inband management EPG.
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Repeat this procedure to configure each APIC in the cluster as a trap destination.

2. Configure the APIC to forward aggregated traps to an external server. Follow the procedure in Configuring
the SNMP Policy Using the GUI, on page 74 using the following settings:

« In the Trap Forward Servers table, add the IP Address of the external server.

With trap aggregation and forwarding, the source IP address of the forwarded trap is the address of the
aggregator (in this case, the APIC) and not the actual source node. To determine the actual source, you must
search in the OID. In the following example, the address 10.202.0.1 is the APIC IP address, and the address
10.202.0.201 is the IP address of the original source leaf switch.

08:53:10.372378 IP

(tos 0x0, ttl 60, id 59067, offset 0, flags [DF], proto UDP (17), length 300)
10.202.0.1.45419 > 192.168.254.200.162: [udp sum ok]
{ SNMPv2c C="SNMP-ACI" { V2Trap(252) R=609795065

1.3.6.1.2.1.1.3.0=25847714 .1.3.6.1.6.3.1.1.4.1.0=.1.3.6.1.4.1.9.9.276.0.1
1.3.6.1.2.1.2.2.1.1.436207616=436207616 .1.3.6.1.2.1.2.2.1.7.436207616=2
1.3.6.1.2.1.2.2.1.8.436207616=2 .1.3.6.1.2.1.31.1.1.1.1.436207616="ethl/1"
1.3.6.1.2.1.2.2.1.3.436207616=6 .1.3.6.1.2.1.2.2.1.2.436207616="ethl/1"
1.3.6.1.2.1.31.1.1.1.18.436207616=""
1.3.6.1.4.1.9.10.22.1.4.1.1.6="10.202.0.201" } }

The SNMP Trap Aggregation feature was introduced in the Cisco APIC release 3.1(1) with support for
SNMPV2 trap aggregation and forwarding. Beginning in the Cisco APIC releases 4.2(6) and 5.1(1), SNMPv3
trap aggregation and forwarding is supported.

\)

Note Ifan APIC is decommissioned, the user is expected to clean reboot the decommissioned APIC. Since SNMP
Trap Aggregation functionality is active on decommissioned APICs, the user could receive duplicate traps
on the trap destination if the decommissioned APIC is not clean rebooted.

Configuring SNMP

Configuring the SNMP Policy Using the GUI

This procedure configures and enables the SNMP policy on Cisco ACI-mode switches.

Before you begin
To allow SNMP communications, you must configure the following:

* Configure an out-of-band contract allowing SNMP traffic. SNMP traffic typically uses UDP port 161
for SNMP requests.

* Configure the Cisco APIC out-of-band IP addresses in the "mgmt" tenant. If you configured the
out-of-band addresses during the Cisco APIC setup, do not the configure the addresses in the "mgmt"
tenant again.
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Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Step 8
Step 9
Step 10

Step 11

Configuring the SNMP Policy Using the GUI .

Procedure

In the menu bar, click Fabric.

In the submenu bar, click Fabric Policies.

In the Navigation pane, expand Pod Policies.

Under Pod Policies, expand Policies.

Right-click SNMP and choose Create SNMP Policy.

As an alternative to creating a new SNMP policy, you can edit the default policy fields in the same manner
as described in the following steps.

In the SNMP policy dialog box, perform the following actions:
a) Inthe Name field, enter an SNMP policy name.
b) In the Admin State field, select Enabled.

¢) (Optional) In the SNMP v3 Users table, click the + icon, enter a Name, enter the user's authentication
data, and click Update.

This step is needed only if SNMPv3 access is required.
d) Inthe Community Policies table, click the + icon, enter a Name, and click Update.

The community policy name can be a maximum of 32 characters in length. The name can contain only
letters, numbers and the special characters of underscore (), hyphen (-), or period (.). The name cannot
contain the @ symbol.

e) Inthe Trap Forward Servers table, click the + icon, enter the IP Address of the external server and
click Update.

Required: To configure allowed SNMP management stations, perform the following actions in the SNMP

policy dialog box:

a) In the Client Group Policies table, click the + icon to open the Create SNMP Client Group Profile
dialog box.

b) Inthe Name field, enter an SNMP client group profile name.

¢) From the Associated Management EPG drop-down list, choose the management EPG.

d) In the Client Entries table, click the + icon.

e) Enter a client's name in the Name field, enter the client's IP address in the Address field, and click Update.

Note When an SNMP management station connects with APIC using SNMPv3, APIC does not
enforce the client IP address specified in the SNMP client group profile. For SNMPv3, the
management station must exist in the Client Entries list, but the IP address need not match,
as the SNMPv3 credentials alone are sufficient for access.

Click OK.
Click Submit.

Under Pod Policies, expand Policy Groups and choose a policy group or right-click Policy Groups and
choose Create POD Policy Group.

You can create a new pod policy group or you can use an existing group. The pod policy group can contain
other pod policies in addition to the SNMP policy.

In the pod policy group dialog box, perform the following actions:
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Step 12
Step 13

Step 14
Step 15

a) Inthe Name field, enter a pod policy group name.
b) From the SNMP Policy drop-down list, choose the SNMP policy that you configured and click Submit.
Under Pod Policies, expand Profiles and click default.

In the Work pane, from the Fabric Policy Group drop-down list, choose the pod policy group that you
created.

Click Submit.
Click OK.

Configuring an SNMP Trap Destination Using the GUI

Step 1
Step 2
Step 3
Step 4
Step 5

This procedure configures the host information for an SNMP manager that will receive SNMP trap notifications.

\)

Note ACI supports a maximum of 10 trap receivers. If you configure more than 10, some will not receive
notifications.

Procedure

In the menu bar, click Admin.

In the submenu bar, click External Data Collectors.

In the Navigation pane, expand Monitoring Destinations.

Right-click SNMP and choose Create SNMP Monitoring Destination Group.

In the Create SNMP Monitoring Destination Group dialog box, perform the following actions:

a) In the Name field, enter an SNMP destination name and click Next.

b) In the Create Destinations table, click the + icon to open the Create SNMP Trap Destination dialog
box.

¢) Inthe Host Name/IP field, enter an IPv4 or IPv6 address or a fully qualified domain name for the
destination host.

d) Choose the Port number and SNMP Version for the destination.

e) For SNMP v1 or v2c¢ destinations, enter one of the configured community names as the Security Name
and choose noauth as v3 Security Level.

An SNMP vl or v2c security name can be a maximum of 32 characters in length. The name can contain
only letters, numbers and the special characters of underscore (_), hyphen (-), or period (.). For SNMP
v1, the name cannot contain the @ symbol.

For SNMP v2c, in the 4.2(6) release and earlier, the name cannot contain the @ symbol. In the 4.2(7)
release and later, the name can contain the @ symbol.

f) For SNMP v3 destinations, enter one of the configured SNMP v3 user names as Security Name and
choose the desired v3 Security Level.

An SNMP v3 security name can be a maximum of 32 characters in length. The name must begin with an
uppercase or lowercase letter, and can contain only letters, numbers, and the special characters of underscore
(), hyphen (-), or period (.). In the 4.2(6) release and earlier, the name cannot contain the @ symbol. In
the 4.2(7) release and later, the name can contain the @ symbol.
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g) From the Management EPG drop-down list, choose the management EPG.
h) Click OK.
i) Click Finish.

Configuring an SNMP Trap Source Using the GUI

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

This procedure selects and enables a source object within the fabric to generate SNMP trap notifications.

Procedure

In the menu bar, click Fabric.

In the submenu bar, click Fabric Policies.

In the Navigation pane, expand Monitoring Policies.

You can create an SNMP source in the Common Policy, the default policy, or you can create a new monitoring
policy.

Expand the desired monitoring policy and choose Callhome/SNMP/Syslog.

If you chose the Common Policy, right-click Common Policy, choose Create SNMP Source, and follow
the instructions below for that dialog box.

In the Work pane, from the Monitoring Object drop-down list, choose ALL.

From the Source Type drop-down list, choose SNMP.

In the table, click the + icon to open the Create SNMP Source dialog box.

In the Create SNMP Source dialog box, perform the following actions:

a) In the Name field, enter an SNMP policy name.
b) From the Dest Group drop-down list, choose an existing destination for sending notifications or choose
Create SNMP Monitoring Destination Group to create a new destination.

The steps for creating an SNMP destination group are described in a separate procedure.

¢) Click Submit.

Monitoring the System Using SNMP

You can remotely monitor individual hosts (APIC or another host) and find out the state of any particular
node.

You can check the system's CPU and memory usage using SNMP to find out if the CPU is spiking or not.
The SNMP, a network management system, uses an SNMP client and accesses information over the APIC
and retrieves information back from it.

You can remotely access the system to figure out if the information is in the context of the network management
system and you can learn whether or not it is taking too much CPU or memory, or if there are any system or
performance issues. Once you learn the source of the issue, you can check the system health and verify whether
or not it is using too much memory or CPU.

Refer to the Cisco ACI MIB Quick Reference Manual for additional information.
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Using SPAN

About SPAN

You can use the Switched Port Analyzer (SPAN) utility to perform detailed troubleshooting or to take a sample
of traffic from a particular application host for proactive monitoring and analysis.

SPAN copies traffic from one or more ports, VLANS, or endpoint groups (EPGs) and sends the copied traffic
to one or more destinations for analysis by a network analyzer. The process is nondisruptive to any connected
devices and is facilitated in the hardware, which prevents any unnecessary CPU load.

You can configure SPAN sessions to monitor traffic received by the source (ingress traffic), traffic transmitted
from the source (egress traffic), or both. By default, SPAN monitors all traffic, but you can configure filters
to monitor only selected traffic.

You can configure SPAN on a tenant or on a switch. When configured on a switch, you can configure SPAN
as a fabric policy or an access policy.

APIC supports the encapsulated remote extension of SPAN (ERSPAN).
Beginning with Release 4.1(11), the following features are now supported:

* Support for local SPAN with static port-channels as the destination, as long as the sources and the
port-channel are local on the same switch.

\}

Note If you are running APIC release 4.1(1i) or later and you configure a static
port-channel as the destination, but then downgrade to a release prior to 4.1(11),
then the SPAN session will go into the administrator disabled state because this
feature was not available prior to release 4.1.(11). There is no other functionality
1impact.

* You no longer have to include the IP prefix of the Layer 3 interface when configuring source SPAN with
Layer 3 interface filtering.

* Support for configuring filter groups, which is a grouping of one or more filter entries. Use the filter
group to specify the matching criteria that will be used to determine if a received packet should be
analyzed using SPAN.

» The SPAN-on-drop feature, which captures packets that are dropped due to forwarding at the ingress in
the ASIC and sends them to a pre-configured SPAN destination. There are 3 types of SPAN-on-drop
configuration: access drop using access ports as a SPAN source, fabric drop using fabric ports as a SPAN
source, and global drop using all ports on a node as a SPAN source. SPAN-on-drop is configured using
regular SPAN (through the CLI, GUI, and REST API) and using troubleshooting SPAN (CLI and REST
API, only). For more information about configuring this feature, see Configuring SPAN Using the GUI,
Configuring SPAN Using the NX-OS Style CLI, and Configuring SPAN Using the REST API.
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SPAN Guidelines and Restrictions
A

Note Many guidelines and restrictions depend on whether the switch is a generation 1 or generation 2 switch. The
generation of the switch is defined as follows:

* Generation 1 switches are identified by the lack of a suffix, such as "EX", "FX", or "FX2," at the end of
the switch name (for example, N9K-9312TX).

* Generation 2 switches are identified with a suffix, such as "EX", "FX", or "FX2," at the end of the switch
name.

* The type of SPAN supported varies:

* For generation 1 switches, tenant and access SPAN use the encapsulated remote extension of SPAN
(ERSPAN) type I (Version 1 option in the Cisco Application Policy Infrastructure Controller (APIC)
GUI).

* For generation 2 switches, tenant and access SPAN use the encapsulated remote extension of SPAN
(ERSPAN) type II (Version 2 option in the Cisco APIC GUI).

* Fabric SPAN uses ERSPAN type I1.
» When configuring ERSPAN session, if the SPAN source contains a destination and interfaces from a

spine switch within a GOLF VRF instance, an L3Out prefix is sent to the GOLF router with the wrong
BGP next-hop, breaking connectivity from GOLF to that L3Out.

» A uSeg EPG or ESG cannot be used as a SPAN source EPG because the SPAN source filter is based on
the VLAN ID. Thus, even if an endpoint is classified to a uSeg EPG or an ESG, traffic from the endpoint
is mirrored if its VLAN is the VLAN of the SPAN source EPG.

* You cannot specify an 13extLIfP Layer 3 subinterface as a SPAN source. You must use the entire port
for monitoring traffic from external sources.

* In local SPAN for FEX interfaces, the FEX interfaces can only be used as SPAN sources, not SPAN
destinations.

* On generation 1 switches, Tx SPAN does not work for any Layer 3 switched traffic.

* On generation 2 switches, Tx SPAN does not work whether traffic is Layer 2 or Layer 3 switched.

There are no limitations for Rx SPAN.

* For SPAN of FEX fabric port-channel (NIF), the member interfaces are supported as SPAN source
interfaces on generation 1 leaf switches.

)

Note While it is also possible to configure FEX fabric port-channel (NIF) member
interfaces as SPAN source interfaces on generation 2 switches, this is not
supported for releases prior to Cisco APIC release 4.1.

* For information regarding ERSPAN headers, refer to the IETF Internet Draft at this URL:
https://tools.ietf.org/html/draft-foschiano-erspan-00.
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* ERSPAN destination IP addresses must be learned in the fabric as an endpoint.
* SPAN supports IPv6 traffic but the destination IP address for the ERSPAN cannot be an IPv6 address.

* The individual port member of a port channel or a vPC cannot be configured as the source. Use the port
channel, vPC, or vPC component as the source in the SPAN session.

* A fault is not raised on the ERSPAN source group when the destination EPG is deleted or unavailable.
*» SPAN filters are supported on generation 2 leaf switches only.
* An access SPAN source supports only one of the following filters at a given time:
* EPG
* Routed outside (L3Out)
* When deploying the access SPAN source with an L3Out filter, ensure that the L3Out is also deployed
on the matching interface:
« If an L3Out is deployed on a port, a SPAN source must be deployed on the same port.
* If an L3Out is deployed on a PC, a SPAN source must be deployed on the same PC.
* If an L3Out is deployed on a vPC, a SPAN source must be deployed on the same vPC.
» An L3Out routed interface and routed sub-interface can be deployed on a port or a PC, but an L3Out

SVI can be deployed on a port, PC, or vPC. A SPAN source with an L3Out filter must be deployed
accordingly.

* An L3Out filter is not supported in fabric SPAN or tenant SPAN sessions.

* The correct L30ut must be selected in the L3 configuration tab of the EPG bridge domain; otherwise,
packet flow for basic L3Out will not work.

 An encapsulation value is mandatory for a routed sub-interface and SVI, but is not applicable for a routed
interface. The L3Out sub-interface or SVI encapsulation value must be different from the EPG
encapsulation value.

* When an EPG filter is enabled within a SPAN session, ARP packets, which are sent out of the interface
in the transit, or tx, direction, will not be spanned.

» SPAN filters are not supported in the following:
* Fabric ports
« Fabric and tenant SPAN sessions
* Spine switches
* L4 port range filter entries will not be added if you attempt to add more L4 port ranges than are officially
supported.

* A SPAN session will not come up if you attempt to associate more than the supported filter entries at
the SPAN source group level or at the individual SPAN source level.

* Deleted filter entries will remain in TCAM if you add or delete more filters entries than are officially
supported.
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* See the Verified Scalability Guidefor Cisco ACI document for SPAN-related limits, such as the maximum
number of active SPAN sessions and SPAN filter limitations.

* For the SPAN-on-drop feature, the following guidelines and restrictions apply:

» The SPAN-on-drop feature is supported on generation 2 leaf switches.

* The SPAN-on-drop feature only captures packets with forwarding drops in the LUX block, which
captures forwarding drop packets at the ingress. The SPAN-on-drop feature cannot capture the BMX
(buffer) and RWX (egress) drops.

* When using the troubleshooting CLI to create a SPAN session with SPAN-on-drop enabled and
Cisco APIC as the destination, the session is disabled when 100 MB of data is captured.

* On a modular chassis, the SPAN-on-drop feature will only work for the packets dropped on the line
cards. Packets that are dropped on the fabric card will not be spanned.

* SPAN-on-drop ACLs with other SPAN ACLs are not merged. If a SPAN-on-drop session is
configured on an interface along with ACL-based SPAN, then any packets dropped on that interface
will only be sent to the SPAN-on-drop session.

* You cannot confgure SPAN on drop and SPAN ACL on the same session.

* When an access or fabric port-drop session and a global-drop session are configured, the access or
fabric port-drop session takes the priority over the global-drop session.

* The number of filter entries supported in TCAM = (M * S1 * 1 + N * S2 * 2) + (S3 * 2). This is
applicable to rx SPAN or tx SPAN, separately. Currently, the maximum filter entries supported in
tx or rx SPAN is 480 in each direction when following this formula (and assuming there are no
other sources that are configured without filter-group association [means S3 = 0] and with 16
port-ranges included). When the number of filter entries exceed the maximum number allowed, a
fault will be raised. Note that you can specify Layer 4 port ranges in the filter entry. However,
sixteen Layer 4 ports are programmed into the hardware as a single filter entry.

N

Note * M=The number of IPv4 filters

* S1=The number of sources with IPv4 filters
* N=The number of IPv6 filters
¢ S2=The number of sources with IPv6 filters

* S3=The number of sources with no filter group association

» With MAC pinning configured in the LACP policy for a PC or vPC, the PC member ports will be placed
in the LACP individual port mode and the PC is operationally non-existent. Hence, a SPAN source
configuration with such a PC will fail, resulting in the generation of the "No operational src/dst" fault.
With the MAC pinning mode configured, SPAN can be configured only on individual ports.

* A packet that is received on a Cisco Application Centric Infrastructure (ACI) leaf switch will be spanned
only once, even if span sessions are configured on both the ingress and egress interfaces.

* When you use a routed outside SPAN source filter, you see only unicast in the Tx direction. In the Rx
direction, you can see unicast, broadcast, and multicast.
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* An L3Out filter is not supported for transmit multicast SPAN. An L3Out is represented as a combination
of sclass/dclass in the ingress ACL filters and can therefore match unicast traffic only. Transmit multicast
traffic can be spanned only on ports and port-channels.

* You can use a port channel interface as a SPAN destination only on -EX and later switches.

* You cannot configure multiple SPAN sessions with the same source interface when a SPAN filter (5-tuple
filter) is applied.

* The local SPAN destination port of a leaf switch does not expect incoming traffic. You can ensure that
the switch drops incoming SPAN destination port traffic by configuring a Layer 2 interface policy and
setting the VL AN Scope property to Port Local scope instead of Global scope. Apply this policy to the
SPAN destination ports. You can configure an Layer 2 interface policy by going to the following location
in the GUI: Fabric > Access Policies > Policies > Interface > L2 Interface.

* When you configure SPAN for a given packet, SPAN is supported for the packet only once. If traffic is
selected by SPAN in Rx for the first SSN, the traffic will not selected by SPAN again in Tx for a second
SSN. Thus, when the SPAN session ingress and egress port sits on a single switch, the SPAN session
capture will be one-way only. The SPAN session cannot display two-way traffic.

» A SPAN ACL filter configured in the filter group does not filter the broadcast, unknown-unicast and
multicast (BUM) traffic that egresses the access interface. A SPAN ACL in the egress direction works
only for unicast [IPv4 or IPv6 traffic.

» When configuring a SPAN destination as a local port, EPGs cannot be deployed to that interface.

* In a leaf switch, a SPAN source with a VREF filter will match all regular bridge domains and all Layer 3
SVIs under the VRF instance.

* In a spine switch, a SPAN source with a VRF matches only the configured VRF VNID traffic and a
bridge domain filter will match only the bridge domain VNID traffic.

Configuring a Tenant SPAN Session Using the Cisco APIC GUI

Step 1
Step 2
Step 3

Step 4

Step 5

SPAN can be configured on a switch or on a tenant. This section guides you through the Cisco APIC GUI to
configure a SPAN policy on a tenant to forward replicated source packets to a remote traffic analyzer. The
configuration procedure requires entering values in the fields of one or more GUI dialog boxes. To understand
a field and determine a valid value, view the help file by clicking the help icon (?) at the top-right corner of
the dialog box.

Procedure

In the menu bar, click Tenants.
In the submenu bar, click the tenant that contains the source endpoint.
In the Navigation pane, expand the tenant, expand Policies > Troubleshooting > SPAN.

Two nodes appear under SPAN: SPAN Destination Groups and SPAN Source Groups.

From the Navigation pane, right-click SPAN Source Groups and choose Create SPAN Source Group.
The Create SPAN Source Group dialog appears.

Enter the appropriate values in the required fields of the Create SPAN Source Group dialog box.
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Step 6
Step 7

Step 8

Step 9

Using Traceroute .

Note For a description of a field, click the information icon (?) at the top-right corner of the dialog box
to display the help file.

Expand the Create Sources table to open the Create SPAN Source dialog box.
Enter the appropriate values in the Create SPAN Source dialog box fields.

Note For the explanation of a field, click the help icon (?) to view the help file.

When finished creating the SPAN source, click OK.

You return to the Create SPAN Source Group dialog box.

When finished entering values in the Create SPAN Source Group dialog box fields, click Submit.

What to do next

Using a traffic analyzer at the SPAN destination, you can observe the data packets from the SPAN source
EPG to verify the packet format, addresses, protocols, and other information.

Using Traceroute

About Traceroute

The traceroute tool is used to discover the routes that packets actually take when traveling to their destination.
Traceroute identifies the path taken on a hop-by-hop basis and includes a time stamp at each hop in both
directions. You can use traceroute to test the connectivity of ports along the path between the generating
device and the device closest to the destination. If the destination cannot be reached, the path discovery traces
the path up to the point of failure.

A traceroute that is initiated from the tenant endpoints shows the default gateway as an intermediate hop that
appears at the ingress leaf switch.

Traceroute supports a variety of modes, including:
* Endpoint-to-endpoint, and leaf-to-leaf (tunnel endpoint, or TEP to TEP)
* Endpoint-to-external-IP
* External-IP-to-endpoint

 External-IP-to-external-IP

Traceroute discovers all paths across the fabric, discovers point of exits for external endpoints, and helps to
detect if any path is blocked.

Traceroute Guidelines and Restrictions

» When the traceroute source or destination is an endpoint, the endpoint must be dynamic and not static.
Unlike a dynamic endpoint (fv:CEp), a static endpoint (fv:StCEp) does not have a child object
(fv:RsCEpToPathEp) that is required for traceroute.
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* Traceroute works for IPv6 source and destinations but configuring source and destination IP addresses
across IPv4 and IPv6 addresses is not allowed.

* See the Verified Scalability Guide for Cisco ACl document for traceroute-related limits.

* When an endpoint moves from one ToR switch to a different ToR switch that has a new MAC address
(one that is different than the MAC address that you specified while configuring the traceroute policy),
the traceroute policy shows "missing-target" for the endpoint. In this scenario you must configure a new
traceroute policy with the new MAC address.

* When performing a traceroute for a flow involving the policy-based redirect feature, the IP address used
by the leaf switch to source the time-to-live (TTL) expired message when the packet goes from the service
device to the leaf switch may not always be the IP address of the bridge domain’s switch virtual interface
(SVI) of the service device. This behavior is cosmetic and does not indicate that the traffic is not taking
the expected path.

Performing a Traceroute Between Endpoints

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7
Step 8

Procedure

In the menu bar, click Tenants.

In the submenu bar, click the tenant that contains the source endpoint.

In the Navigation pane, expand the tenant and expand Policies > Troubleshoot.
Under Troubleshoot, right-click on one of the following traceroute policies:

 Endpoint-to-Endpoint Traceroute Policies and choose Create Endpoint-to-Endpoint Traceroute
Policy

» Endpoint-to-External-IP Traceroute Policies and choose Create Endpoint-to-External-1P Traceroute
Policy

« External-1P-to-Endpoint Traceroute Policies and choose Create External-1P-to-Endpoint Traceroute
Policy

» External-1P-to-External-1P Traceroute Policies and choose Create External-1P-to-External-1P
Traceroute Policy

Enter the appropriate values in the dialog box fields and click Submit.

Note For the description of a field, click the help icon (?) in the top-right corner of the dialog box.

In the Navigation pane or the Traceroute Policies table, click the traceroute policy.
The traceroute policy is displayed in the Work pane.

In the Work pane, click the Operational tab, click the Source Endpoints tab, and click the Results tab.
In the Traceroute Results table, verify the path or paths that were used in the trace.
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Note * More than one path might have been traversed from the source node to the destination node.

* For readability, you can increase the width of one or more columns, such as the Name
column.
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CHAPTER 6

Provisioning Core ACI Fabric Services

This chapter contains the following sections:

* Link Level Policies, on page 87

* Link-Level Flow Control, on page 88

* Link Flap Policies, on page 93

* Time Synchronization and NTP, on page 94

* Configuring a DHCP Relay Policy, on page 100

* Configuring a DNS Service Policy, on page 102

* Configuring Custom Certificates, on page 106

* Provisioning Fabric Wide System Settings, on page 109
* Provisioning Global Fabric Access Policies, on page 129
* Per Port Policies, on page 132

Link Level Policies

You can configure link level policies, which are a type of access policy. A link level policy includes the
physical layer (Layer 1) interface configurations, such as auto-negotiation, port speed, and link debounce.

Electromagnetic Interference Retrain

In the 4.2(7) release (only), the electromagnetic interference (EMI) retrain feature filters any noise on a link
due to electromagnetic interference, and retrains the link to avoid a link flap. Enable EMI retrain if your data
center environment has a lot of EMI noise.

You can enable EMI retrain when you configure a link level policy by choosing enable for the EMI Retrain
property. This feature is supported only with the Cisco N9K-C93108TC-EX and N9K-C93108TC-FX leaf
switches using copper cables.

Configuring a Link Level Policy Using the GUI

Procedure

Step 1 On the menu bar, choose Fabric > Access Policies.
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Step 2
Step 3
Step 4

Step 5

Provisioning Core ACI Fabric Services |

In the Navigation pane, choose Policies > Interface > Link Level.
Right-click Link Level and choose Create Link Level Policy.
In the Create Link Level Policy dialog, fill out the fields as appropriate for your desired configuration.

For Speed, we recommend that you choose inherit, which is the default value. With this value, the Cisco
APIC determines the speed based on the transceiver that is inserted into a switch.

See the tooltips for more information about the fields.

Click Submit.

Port Bring-up Delay

Beginning with the 4.2(5) release, when you configure a link level policy, you can set the Port bring-up
delay (milliseconds) parameter, which specifies a time in milliseconds that the decision feedback equalizer
(DFE) tuning is delayed when a port is coming up. The delay is used to help avoid CRC errors during link
bringup when using some third-party adapters. You should set the delay only as required; in most cases, you
do not need to set a delay.

\)

Note The Port bring-up delay (milliseconds) parameter is not honored on fabric extender (FEX) ports.

Link Debounce Interval

A link level policy applies to the fabric interfaces (leaf switch uplink ports and spine switch ports) at the link
level and you use this policy where there might be link noise or transient flaps. In this policy, you can configure
the link debounce interval, which specifies a wait time for the fabric interfaces when there is a flap in the link.
After the interval passes, Cisco Application Centric Infrastructure (ACI) checks the link status again to
re-confirm the event. If the link is okay at this time, then the interfaces will remain up.

Set the interval in a link level policy using the Link debounce interval (msec) field in the Cisco Application
Policy Infrastructure Controller (APIC) GUI or the [no] link debounce time <time> CLI command. The
default debounce interval is 0 ms. We recommend a value of 100 ms, but you should choose a value that is
appropriate to your fabric.

Link-Level Flow Control

About Link-Level Flow Control

Link-level flow control is a congestion management technique that pauses data transmission until the congestion
in the system is resolved. When a receiving device becomes congested, the device communicates with the
transmitter by sending a pause frame. When the transmitting device receives a pause frame, the device stops
the transmission of any further data frames based on the pause quanta value received in the link-level flow
control feature pause frame. In Cisco Application Centric Infrastructure (ACI), the pause quanta value is not
configurable; the default value is 65535.
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The link-level flow control feature applies to all of the traffic on the link. The transmit and receive directions
are separately configurable. By default, link-level flow control is disabled for both directions.

About Link-Level Flow Control and Slow Drain Policies

You can optionally configure a slow drain policy to use with link-level flow control, which protects the system
from too many pause frames. Link-level flow control frames received on a port are monitored and stored
every second. The delta stats are checked every second to validate against the slow drain policy threshold. If
the number of frames exceeds the configured congestion timeout threshold, then the Cisco Application Policy
Infrastructure Controller (APIC) takes the necessary action as configured in the slow drain policy. The possible
actions are as follows:

» err-disable: The Cisco APIC changes the state of the leaf switch's port to error disabled, which prevents
traffic from flowing through that port.

* log: The Cisco APIC makes a record in the logs that the number of pause frames exceeded the threshold.
However, traffic is allowed to continue flowing through that port.

» disable: Disables the slow drain policy.

)

Note Using link-level flow control with slow drain is not related to using Fibre Channel (FC) or Fibre Channel over
Ethernet (FCoE) with slow drain, and is not related to SAN congestion.

Guidelines and Limitations of Link-Level Flow Control
The following guidelines and limitations apply when using link-level flow control:
* Link-level flow control is supported only on leaf switch front panel ports, including breakout ports.

* An ingress/egress leaf switch front panel port can be enabled for either priority flow control or link-level
flow control, but not both.

* Link-level flow control is not supported on Cisco Nexus N9K-C93128TX, N9K-C9396PX, and
NIK-C9396TX leaf switches.

* To achieve end-to-end flow control, you must configure the global QoS class with the priority flow
control no-drop class.

* The no-drop behavior can be achieved for both intra- and inter-leaf switch-level traffic.

* The inter- and intra-traffic no-drop behavior can be achieved based on the global priority flow control
(PFC) configuration, in which you can specify intra-leaf switch or fabric-wide traffic.

* When used with Cisco ACI Multi-Pod, a remote leaf switch, or Cisco ACI Multi-Site, end-to-end flow
control is not guaranteed because the class of service and IPN or ISN treatment might not be always
same.

* The slow drain policy can be used for CPU protection with continuous link-level flow control pauses.

* FEX link-level flow control is not supported.
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* Link-level flow control is supported on port channel member ports, and must be enabled on the port
channel.

When auto-negotiation is enabled, the following guidelines and limitations apply:

* Link-level flow control advertisement/decoding is not supported during auto-negotiation.

* The link-level flow control send and receive parameters must be explicitly configured to be on or off.

Configuring Link-Level Flow Control on a Leaf Switch Using the GUI

The following procedure describes how to configure link-level flow control on a leaf switch by using the GUI.

\)

Note We recommend that you do not mix using the GUI and CLI when you configure an interface and link-level
flow control. If you configured an interface from the GUI, you should configure link-level flow control on
the interface from the GUI, and likewise if you used the CLI instead.

Procedure
Step 1 On the menu bar, choose Fabric > Inventory
Step 2 In the Navigation pane, choose pod_# > leaf _name

Step 3 In the Work pane, click the Interface tab.

Step 4 In the Mode drop-down list, choose Configuration.

Step 5 Click the number of an interface for which you want to enable link-level flow control.
Step 6 Click the L2 button to modify the Layer 2 configuration for that interface.

Step 7 Under the Physical Interface subtab, which is selected by default, choose On for Receive Flow Control and
Send Flow Control.

Step 8 Click Submit.

Configuring Link-Level Flow Control by Binding a Policy Group to a Switch
Selector Profile Using the GUI

The following procedure describes how to configure link-level flow control by binding a policy group to a
switch selector profile using the GUI.

\)

Note We recommend that you do not mix using the GUI and CLI when you configure an interface and link-level
flow control. If you configured an interface from the GUI, you should configure link-level flow control on
the interface from the GUI, and likewise if you used the CLI instead.
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Step 1
Step 2

Step 3
Step 4

Step 5

Configuring a Slow Drain Policy Using the GUI .

Before you begin

You must first create a switch selector profile and interface selector profile.

Procedure

On the menu bar, choose Fabric > Access Policies

In the Navigation pane, choose one of the following paths, depending on whether you want to configure
link-level flow control to a leaf access port, PC interface, or vPC interface:

« Interfaces > Leaf Interfaces > Policy Groups > Leaf Access Port > access port_policy group_name
« Interfaces > Leaf Interfaces > Policy Groups > PC Interface > interface policy group _name

« Interfaces > Leaf Interfaces > Policy Groups > VVPC Interface > interface policy_group_name

In the Work pane, in the Link Level Flow Control drop-down list, choose an existing link-level flow control
policy or create a new policy.

If you chose to create a new policy, in the Create Interface Link Level Flow Control Policy dialog, fill out
the fields as necessary for your desired configuration, then click Submit.

Click Submit.

Configuring a Slow Drain Policy Using the GUI

Step 1
Step 2

Step 3

Step 4

Step 5

Optionally, you can configure a slow drain policy to use with link-level flow control to protect the system
from too many pause frames by using the GUI. You can configure the policy before or after configuring
link-level flow control, although we recommend that you configure the slow drain policy first.

Procedure

On the menu bar, choose Fabric > Access Policies

In the Navigation pane, choose Interfaces > Leaf Interfaces > Policy Groups > Leaf Access Port >
leaf _access port_name

In the Work pane, in the Slow Drain drop-down list, choose an existing slow drain policy or choose Create
Slow Drain Policy to create a new policy.

If you chose Create Slow Drain Policy, fill out the fields in the Create Slow Drain Policy dialog as
appropriate, then click Submit.

See the online help for information about the fields.

Click Submit.

Configuring Link-Level Flow Control Using the NX-0S-Style CLI

You can enable link-level flow control on a leaf switch by using the NX-OS-style CLI.
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\)

Note We recommend that you do not mix using the GUI and CLI when you configure an interface and link-level
flow control. If you configured an interface from the CLI, you should configure link-level flow control on
the interface from the CLI, and likewise if you used the GUI instead.

Procedure

Step 1 Enter the configuration mode.
Example:
apicl# configure
Step 2 Enter the leaf switch configuration mode.

Example:
apicl (config)# leaf 101

This example configures the leaf switch with the ID of 101.

Step 3 Enter the interface level configuration mode.
Example:
apicl (config-leaf) # interface ethernet 1/1
Step 4 Enable the link-level flow control receiving and sending.

Example:

apicl (config-leaf-if)# flowcontrol receive on
apicl (config-leaf-if)# flowcontrol send on

You can disable the send and receive parameters by configuring them as off.
These commands are mutually exclusive from the priority flow control command.
Step 5 Connect to the leaf switch and display the pause stats of the interface to ensure that you enabled link-level

flow control, as well as to see the number of link-level flow control pause frames that were transmitted or
received on that interface.

Example:
leafl01l# show interface ethernet 1/16 flowcontrol

Port Send FlowControl Receive FlowControl RxPause TxPause
admin oper admin oper
Ethl/16 on on on on 10032 30004

Configuring a Slow Drain Policy Using the NX-0S-Style CLI

Optionally, you can configure a slow drain policy to use with link-level flow control to protect the system
from too many pause frames by using the NX-OS-style CLI. You can configure the policy before or after
configuring link-level flow control, although we recommend that you configure the slow drain policy first.
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Step 1

Step 2

Step 3

Step 4

Step 5

Link Flap Policies [JJj

Procedure

Enter the configuration mode.

Example:

apicl# configure

Enter the leaf switch configuration mode.

Example:
apicl (config)# leaf 101

This example configures the leaf switch with the ID of 101.

Enter the interface level configuration mode.

Example:

apicl (config-leaf) # interface ethernet 1/1

Configure the congestion timeout threshold.
The congestion timeout threshold is in frames per second. The valid range is from 1 to 10000.

Example:

apicl (config-leaf-if)# slow-drain congestion-timeout count 12
Configure the congestion timeout action.

The possible actions are as follows:

« err-disable: The Cisco APIC changes the state of the leaf switch's port to error disabled, which prevents
traffic from flowing through that port.

* log: The Cisco APIC makes a record in the logs that the number of pause frames exceeded the threshold.
However, traffic is allowed to continue flowing through that port.

» disable: Disables the slow drain policy.

Example:

apicl (config-leaf-if)# slow-drain congestion-timeout action err-disable

Link Flap Policies

Link flap is a situation in which a physical interface on a switch continually goes up and down over a period
of time. The cause is usually related to a bad, unsupported, or non-standard cable or Small Form-Factor
Pluggable (SFP), or is related to other link synchronization issues, and the cause can be intermittent or
permanent.

A link flap policy specifies when to disable a switch port due to link flapping errors. In a link flap policy, you
specify maximum number of times that a port of a switch can flap within a specified time span. If the port
flaps more than the specified number of times in the specified time span, the port is given the "error-disable"
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state. The port remains in this state until you perform a manual flap on the port using the Cisco Application
Policy Infrastructure Controller (APIC) to disable and enable the port.

\)

Note A link flap policy is not honored on fabric extender (FEX) host interface (HIF) ports nor on leaf switch models
without -EX, -FX, -FX2, -GX, or later designations in the product ID.

Configuring a Link Flap Policy Using the GUI

Procedure
Step 1 On the menu bar, choose Fabric > Access Policies.
Step 2 In the Navigation pane, choose Policies > Interface > Link Flap.

Step 3 Right-click Link Flap and choose Create Link Flap Policy.
Step 4 In the Create Link Level Policy dialog, fill out the fields as appropriate for your desired configuration.

See the tooltips and online help for more information about the fields.

Step 5 Click Submit.

Configuring a Fabric Link Flap Policy Using the GUI

The following procedure configures a fabric link flap policy using the GUI, which you can then attach to any
leaf or spine node interface policy to deploy the fabric link flap policy on the node's fabric ports.

Procedure
Step 1 On the menu bar, choose Fabric > Fabric Policies.
Step 2 In the Navigation pane, choose Policies > Interface > Link Flap.

Step 3 Right-click Link Flap and choose Create Link Flap Policy.
Step 4 In the Create Fabric Link Level Policy dialog, fill out the fields as appropriate for your desired configuration.

See the tooltips and online help for more information about the fields.

Step 5 Click Submit.

Time Synchronization and NTP

Within the Cisco Application Centric Infrastructure (ACI) fabric, time synchronization is a crucial capability
upon which many of the monitoring, operational, and troubleshooting tasks depend. Clock synchronization
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is important for proper analysis of traffic flows as well as for correlating debug and fault time stamps across
multiple fabric nodes.

An offset present on one or more devices can hamper the ability to properly diagnose and resolve many
common operational issues. In addition, clock synchronization allows for the full utilization of the atomic
counter capability that is built into the ACI upon which the application health scores depend. Nonexistent or
improper configuration of time synchronization does not necessarily trigger a fault or a low health score. You
should configure time synchronization before deploying a full fabric or applications so as to enable proper
usage of these features. The most widely adapted method for synchronizing a device clock is to use Network
Time Protocol (NTP).

Prior to configuring NTP, consider what management IP address scheme is in place within the ACI fabric.
There are two options for configuring management of all ACI nodes and Application Policy Infrastructure
Controllers (APICs), in-band management and/or out-of-band management. Depending upon which management
option is chosen for the fabric, configuration of NTP will vary. Another consideration in deploying time
synchronization is where the time source is located. The reliability of the source must be carefully considered
when determining if you will use a private internal clock or an external public clock.

In-Band Management NTP
A\

Note See the Adding Management Access section in this guide for information about in-band management access.

* In-Band Management NTP—When an ACI fabric is deployed with in-band management, consider the
reachability of the NTP server from within the ACI in-band management network. In-band IP addressing
used within the ACI fabric is not reachable from anywhere outside the fabric. To leverage an NTP server
external to the fabric with in-band management, construct a policy to enable this communication..

NTP over IPv6

NTP over IPv6 addresses is supported in hostnames and peer addresses. The gai.conf can also be set up to
prefer the IPv6 address of a provider or a peer over an IPv4 address. The user can provide a hostname that
can be resolved by providing an IP address (both IPv4 or IPv6, depending on the installation or preference).

Configuring NTP Using the GUI
A\

Note There is a risk of hostname resolution failure for hostname based NTP servers if the DNS server used is
configured to be reachable over in-band or out-of-band connectivity. If you use a hostname, ensure that the
DNS service policy to connect with the DNS providers is configured. Also ensure that the appropriate DNS
label is configured for the in-band or out-of-band VRF instances of the management EPG that you chose when
you configured the DNS profile policy.
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Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8
Step 9
Step 10

Procedure

On the menu bar, choose FABRIC > Fabric Policies.
In the Navigation pane, choose Pod Policies > Policies.
In the Work pane, choose Actions > Create Date and Time Policy.

In the Create Date and Time Policy dialog box, perform the following actions:

a)
b)

<)
d)

Enter a name for the policy to distinguish between the different NTP configurations in your environment..
Click enabled for the Authentication State field and expand the NTP Client Authentication Keys table
and enter the key information. Click Update and Next.

Click the + sign to specify the NTP server information (provider) to be used.

In the Create Providers dialog box, enter all relevant information, including the following fields: Name,
Description, Minimum Polling Intervals, and Maximum Polling Intervals.

* If you are creating multiple providers, check the Preferred check box for the most reliable NTP
source.

* In the Management EPG drop-down list, if the NTP server is reachable by all nodes on the fabric
through out-of-band management, choose Out-of-Band. If you have deployed in-band management,
see the details about In-Band Management NTP. Click OK.

Repeat the steps for each provider that you want to create.

In the Navigation pane, choose Pod Policies > Policy Groups.
In the Work pane, choose Actions > Create Pod Policy Group.

In the Create Pod Policy Group dialog box, perform the following actions:

a)
b)

Enter a name for the policy group.

In the Date Time Policy field, from the drop down list, choose the NTP policy that you created earlier.
Click Submit.
The pod policy group is created. Alternatively, you can use the default pod policy group.

In the Navigation pane, choose Pod Policies > Profiles.

In the Work pane, double-click the desired pod selector name.

In the Properties area, from the Fabric Policy Group drop down list, choose the pod policy group you created.
Click Submit.

Configuring NTP Using the REST API

\}

Note

There is a risk of hostname resolution failure for hostname based NTP servers if the DNS server used is
configured to be reachable over in-band or out-of-band connectivity. If you use a hostname, ensure that the
DNS service policy to connect with the DNS providers is configured. Also ensure that the appropriate DNS
label is configured for the in-band or out-of-band VRF instances of the management EPG that you chose when
you configured the DNS profile policy.
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Step 1

Step 2

Step 3

Verifying NTP Operation Using the GUI .

Procedure

Configure NTP.

Example:
POST url: https://APIC-IP/api/node/mo/uni/fabric/time-test.xml

<imdata totalCount="1">

<datetimePol adminSt="enabled" authSt="disabled" descr="" dn="uni/fabric/time-CiscoNTPPol"
name="CiscoNTPPol" ownerKey="" ownerTag="">
<datetimeNtpProv descr="" keyId="0" maxPoll="6" minPoll="4" name="10.10.10.11"

preferred="yes">
<datetimeRsNtpProvToEpg tDn="uni/tn-mgmt/mgmtp-default/inb-default"/>
</datetimeNtpProv>
</datetimePol>
</imdata>

Add the default Date Time Policy to the pod policy group.

Example:

POST url: https://APIC-IP/api/node/mo/uni/fabric/funcprof/podpgrp-calol/rsTimePol.xml

POST payload: <imdata totalCount="1">
<fabricRsTimePol tnDatetimePolName=“CiscoNTPPol”>
</fabricRsTimePol>

</imdata>

Add the pod policy group to the default pod profile.

Example:

POST url:
https://APIC-IP/api/node/mo/uni/fabric/podprof-default/pods-default-typ-ALL/rspodPGrp.xml

payload: <imdata totalCount="1">

<fabricRsPodPGrp tDn="uni/fabric/funcprof/podpgrp-calol” status="created">
</fabricRsPodPGrp>

</imdata>

Verifying NTP Operation Using the GUI

Step 1
Step 2

Step 3

Procedure

On the menu bar, choose FABRIC > Fabric Policies.
In the Navigation pane, choose Pod Policies > Policies > Date and Time > ntp_policy > server_name.

The ntp_policy is the previously created policy. An IPv6 address is supported in the Host Name/IP address
field. If you enter a hostname and it has an IPv6 address set, you must implement the priority of IPv6 address
over [Pv4 address.

In the Work pane, verify the details of the server.
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NTP Server

The NTP server enables client switches to also act as NTP servers to provide NTP time information to
downstream clients. When the NTP server is enabled, the NTP daemon on the switch responds with time
information to all unicast (IPv4/IPv6) requests from NTP clients. NTP server implementation is complaint to
NTP RFCv3. As per the NTP RFC, the server will not maintain any state related to the clients.

» The NTP server enables IP addresses in all tenant VRFs and the in-band/out-of-band management VRFs
to serve NTP clients.

» The NTP server responds to incoming NTP requests on both Management VRFs or tenant VRFs, and
responds back using the same VRF.

» The NTP server supports both [Pv4/IPv6.
* Switches can sync as an IPv4 client and serve as an IPv6 server, and vice versa.

* Switches can sync as an NTP client using either the out-of-band management or in-band management
VRF and serve NTP clients from either management VRF or tenant VRF.

* No additional contracts or IP table configurations are required.

» [fthe switch is synced to the upstream server, then the server will send time info with the stratum number,
and increment to its system peer's stratum.

* If the switch clock is undisciplined (not synced to the upstream server), then the server will send time
information with stratum 16. Clients will not be able to sync to this server.

By default, NTP server functionality is disabled. It needs to be enabled explicitly by the configuration policy.

\}

Note Clients can use the in-band, out-of-band IP address of the leaf switch as the NTP server IP address. Clients
can also use the bridge domain SVI of the EPG of which they are part or any L3Out IP address as the NTP
server IP address for clients outside of the fabric.

Fabric switches should not sync to other switches of the same fabric. The fabric switches should always sync
to external NTP servers.

Enabling the NTP Server Using the GUI
This section explains how to enable an NTP server when configuring NTP in the APIC GUI.

Procedure
Step 1 On the menu bar, choose FABRIC > Fabric Policies.
Step 2 In the Navigation pane, choose Pod Policies > Policies .

The Date and Time option appears in the Navigation pane.

Step 3 From the Navigation pane, right-click on Date and Time and choose Create Date and Time Policy.

The Create Date and Time Policy dialog appears in the Work pane.
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Step 4

Step 5

Step 6
Step 7

Enabling the NTP Server Using the GUI .

In the Create Date and Time Policy dialog box, perform the following actions:

a)

Enter a name for the policy to distinguish between the different NTP configurations in your environment.

b) For the Server State option, click enabled.

d)
e)

2

Server State enables switches to act as NTP servers to provide NTP time information to downstream
clients.

Note To support the server functionality, it is always recommended to have a peer setup for the
server. This enables the server to have a consistent time to provide to the clients.

When Server State is enabled:

» The NTP server sends time info with a stratum number, an increment to the system peer's
stratum number, to switches that are synched to the upstream server.

* The server sends time info with stratum 16 if the switch clock is not synched to the
upstream server. Clients are not able to sync to this server.

Note To support the server functionality, it is always recommended to have a peer setup for the
server. The peer setup allows for a consistent time to provide to the clients.

For the Master Mode option, click enabled.

Master Mode enables the designated NTP server to provide undisciplined local clock time to downstream
clients with a configured stratum number. For example, a leaf switch that is acting as the NTP server can
provide undisciplined local clock time to leaf switches acting as clients.

Note » Master Mode is only applicable when the server clock is undisciplined.

 The default master mode Stratum Value is 8.

For the Stratum Value field, specify the stratum level from which NTP clients will get their time
synchronized. The range is from 1 to 14.

Click Next.

Click the + sign to specify the NTP server information (provider) to be used.

In the Create Providers dialog box, enter all relevant information, including the following fields: Name,
Description, Minimum Polling Intervals, and Maximum Polling Intervals.

* If you are creating multiple providers, check the Preferred check box for the most reliable NTP
source.

* In the Management EPG drop-down list, if the NTP server is reachable by all nodes on the fabric
through out-of-band management, choose Out-of-Band. If you have deployed in-band management,
see the details about In-Band Management NTP. Click OK.

Repeat the steps for each provider that you want to create.

In the Navigation pane, choose Pod Policies then right-click on Policy Groups.

The Create Pod Policy Group dialog appears.

In the Work pane, choose Actions > Create Pod Policy Group.
In the Create Pod Policy Group dialog box, perform the following actions:

a)

Enter a name for the policy group.
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b) In the Date Time Policy field, from the drop down list, choose the NTP policy that you created earlier.
Click Submit.

The pod policy group is created. Alternatively, you can use the default pod policy group.

Step 8 In the Navigation pane, choose Pod Policies > Profiles.

Step 9 In the Work pane, double-click the desired pod selector name.

Step 10 In the Properties area, from the Fabric Policy Group drop down list, choose the pod policy group you created.
Step 11 Click Submit.

Configuring the Datetime Format Using the GUI

This section demonstrates how to configure the datetime format using the Cisco APIC GUL

Procedure

Step 1 On the menu bar, click System > System Settings .
Step 2 In the Navigation pane, click Date and Time.
Step 3 In the Work pane, choose from the following options:

+ Display Format—Click local to display the date and time in local time, or click utc to display the date
and time in UTC. The default is local.

 Time Zone—<Click the drop-down arrow to choose the time zone for your domain. The default is
Coordinated Universal Time.

« Offset State—Click enable or disable. When enabled, the difference between the local time and the
reference time is displayed. The default is enable.

Configuring a DHCP Relay Policy

A DHCP relay policy may be used when the DHCP client and server are in different subnets. If the client is
on an ESX hypervisor with a deployed vShield Domain profile, then the use of a DHCP relay policy
configuration is mandatory.

When a vShield controller deploys a Virtual Extensible Local Area Network (VXLAN), the hypervisor hosts
create a kernel (vmkN, virtual tunnel end-point [VTEP]) interface. These interfaces need an IP address in the
infrastructure tenant that uses DHCP. Therefore, you must configure a DHCP relay policy so that the Cisco

Application Policy Infrastructure Controller (APIC) can act as the DHCP server and provide these IP addresses.

When a Cisco Application Centric Infrastructure (ACI) fabric acts as a DHCP relay, it inserts the DHCP
Option 82 (the DHCP Relay Agent Information Option) in DHCP requests that it proxies on behalf of clients.
If a response (DHCP offer) comes back from a DHCP server without Option 82, it is silently dropped by the
fabric. Therefore, when the Cisco ACI fabric acts as a DHCP relay, DHCP servers providing IP addresses to
compute nodes attached to the Cisco ACI fabric must support Option 82.
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Guidelines and Limitations for a DHCP Relay Policy

* A DHCP relay policy created under the infra or common tenant is not available to other tenants when
configuring DHCP relay in a bridge domain. For inter-tenant DHCP relay communications, create a
global DHCP relay policy, as described in Create a Global DHCP Relay Policy, on page 130.

» The DHCP relay IP address will always be set to the primary SVI IP address.

* You cannot use a DHCP relay policy if the clients and servers are connected through an L30ut EPG.
Either the clients or servers (or both) must be in a regular (non-L3Out) EPG.

Configuring a DHCP Server Policy for the APIC Infrastructure Using the GUI

This procedure deploys a DHCP relay policy for an endpoint group (EPG).
Observe the following guidelines and restrictions:

* The port and the encapsulation used by the application Endpoint Group must belong to a physical or VM
Manager (VMM) domain. If no such association with a domain is established, the APIC continues to
deploy the EPG but raises a fault.

* Cisco APIC supports DHCP relay for both IPv4 and IPv6 tenant subnets. DHCP server addresses can
be IPv4 or IPv6. DHCPv6 relay will occur only if IPv6 is enabled on the fabric interface and one or more
DHCPv6 relay servers are configured.

* Cisco APIC supports DHCP relay for only the primary IP address pool.

Before you begin

Make sure that Layer 2 or Layer 3 management connectivity is configured.

Procedure
Step 1 On the menu bar, choose Tenants > infra.
Step 2 In the Navigation pane, under Tenant infra, expand Networking > Policies > Protocol > DHCP.

Step 3 Right-click Relay Policies and click Create DHCP Relay Policy.
Step 4 In the Create DHCP Relay Policy dialog box, perform the following actions:
a) In the Name field, enter the DHCP relay profile name (DhcpRelayP).
b) Expand Providers. In the Create DHCP Provider dialog box, in the EPG Type field, click the appropriate
radio button depending upon where the DHCP server is connected.
¢) Inthe Application EPG area, in the Tenant field, from the drop-down list, choose the tenant. (infra)
d) In the Application Profile field, from the drop-down list, choose the application. (access)
e) Inthe EPG field, from the drop-down list, choose the EPG. (default)
f) Inthe DHCP Server Address field, enter the IP address for the infra DHCP server. Click Update.

Note The infra DHCP IP address is the infra IP address of APIC1. You must enter the default IP
address of 10.0.0.1 if deploying for vShield controller configuration.

g) Click Submit.
The DHCP relay policy is created.
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Step 5
Step 6
Step 7

Step 8

In the Navigation pane, expand Networking > Bridge Domains > default > DHCP Relay Labels.

Right-click DHCP Relay Labels, and click Create DHCP Relay Label.

In the Create DHCP Relay Label dialog box, perform the following actions:

a) In the Scope field, click the tenant radio button.
This action displays, in the Name field drop-down list, the DHCP relay policy created earlier.

b) In the Name field, from the drop-down list, choose the name of the DHCP policy created (DhcpRelayP)
or create a new relay policy by choosing Create DHCP Relay Policy.

¢) Inthe DHCP Option Policy, select an existing option policy, or create a new one by choosing Create
DHCP Option Policy.

d) Click Submit.

The DHCP server is associated with the bridge domain.

In the Navigation pane, expand Networking > Bridge Domains > default > DHCP Relay Labels to view
the DHCP server created.

Configuring a DNS Service Policy

A DNS policy is required to connect to external servers, for example AAA, RADIUS, vCenter, and services
by hostname. A DNS service policy is a shared policy, so any tenant and VRF that uses this service must be
configured with the specific DNS profile label. To configure a DNS policy for the ACI fabric, you must
complete the following tasks:

* Ensure that the management EPG is configured for the DNS policy, otherwise this policy will not take
into effect on the switches.

N

Note For the management EPG, only the default DNS policy is supported.

* Create a DNS profile (default) that contains the information about DNS providers and DNS domains.

* Associate the DNS profile (default or another DNS profile) name to a DNS label under the required
tenant.

It is possible to configure a per-tenant, per-VRF DNS profile configuration. Additional DNS profiles can be
created and applied to specific VRFs of specific tenants using the appropriate DNS label. For example, if you
create a DNS profile with a name of acme, you can add a DNS label of acme to the appropriate Networking >
VRF policy configuration in the tenants configuration.

Configuring External Destinations with an In-Band DNS Service Policy

Configure the external destinations for the services as follows:

Source In-Band Management Out-of-Band Management | External Server Location
APIC IP address or Fully IP address or FQDN Anywhere

Qualified domain name

(FQDN)
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Source In-Band Management Out-of-Band Management | External Server Location

Leaf switches IP address IP address or FQDN Anywhere

Note The DNS
policy must
specify the
out-of-band
management
EPG for
reachability
of the DNS
server.

Spine switches IP address IP address or FQDN Directly connected to a

Note The DNS leaf switch
policy must
specify the
out-of-band
management
EPG for
reachability
of the DNS
server.

The following is a list of external servers:

* Call Home SMTP server

* Syslog server

* SNMP Trap destination

* Statistics Export destination

* Configuration Export destination
* Techsupport Export destination

* Core Export destination

The recommended guidelines are as follows:
* The external servers must be atatched to the leaf access ports.
« Use in-band connectivity for the leaf switches to avoid extra cabling for the management port.

+ Use out-of-band management connectivity for the spine switches. Connect this out-of-band network for
spine switches to one of the leaf ports with in-band management virtual routing and forwarding (VRF)
so that the spine switches and the leaf switches can reach the same set of external servers.

 Use IP addresses for the external servers.
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Dual Stack IPv4 and IPv6 DNS Servers

DNS servers have primary DNS records which can be A records (IPV4) or AAAA records (IPV6). Both A
and AAAA records associate domain name with a specific IP address (IPv4 or IPv6).

The ACI fabric can be configured to use reputable public DNS servers that run on IPv4. These servers are
able to resolve and respond with A record (IPv4) or AAAA record (IPv6).

In a pure IPv6 environment, the system administrators must use IPv6 DNS servers. The IPv6 DNS servers
are enabled by adding them to /etc/resolv.conf.

A more common environment is to have dual-stack IPv4 and IPv6 DNS servers. In the dual-stack case, both
IPv4 and IPv6 name servers are listed in /etc/resolv.conf. However, in a dual-stack environment, simply
appending the IPv6 DNS servers to the list may cause a large delay in DNS resolutions. This is because the
IPv6 protocol takes precedence by default, and it is unable to connect to the IPv4 DNS servers (if they are
listed first in /etc/resolv.conf). The solution is to list IPv6 DNS servers ahead of IPv4 DNS servers. Also add
“options single-request-reopen” to enable the same socket to be used for both IPv4 and IPv6 lookups.

Here is an example of resolv.conf in dual-stack IPv4 and IPv6 DNS servers where the IPv6 DNS servers are
listed first. Also note the “single-request-reopen” option:

options single-request-reopen

nameserver 2001:4860:4680::8888

nameserver 2001:4860:4680::8844

nameserver 8.8.8.8
nameserver 8.8.4.4

Dual-Stack IPv4 and IPv6 Environment

If the management network in the ACI fabric supports both [Pv4 and IPv6, the Linux system application
(glibc) will use the IPv6 network by default because getaddrinfo() will return IPv6 first.

Under certain conditions however, an [Pv4 address may be preferred over an IPv6 address. The Linux IPv6
stack has a feature which allows an IPv4 address mapped as an [Pv6 address using IPv6 mapped IPv4 address
(::Afff/96). This allows an I[Pv6 capable application to use only a single socket to accept or connect both [Pv4
and IPv6. This is controlled by the glibc IPv6 selection preference for getaddrinfo() in /etc/gai.conf.

In order to allow glibc to return multiple addresses when using /etc/hosts, “multi on” should be added to the
/etc/hosts file. Otherwise, it may return only the first match.

If an application is not aware whether both IPv4 and IPv6 exist, it may not perform fallback attempts using
different address families. Such applications may require a fallback implementation.

Policy for Priority of IPv4 or IPv6 in a DNS Profile

The DNS profile supports version preference choices between IPv4 and IPv6. Using the user interface, you
can enable your preference. IPv4 is the default.

The following is an example of a policy based configuration using Postman REST API:

<?xml version="1.0" encoding="UTF-8"7?7>

<!— api/node/mo/uni/fabric/dnsp-default.xml —>

<dnsProfile dn="uni/fabric/dnsp-default" IPVerPreference="IPv6" childAction="" descr="" >
</dnsProfile>

The gai.conf settings control destination address selection. The file has a label table, precedence table, and
an IPv4 scopes table. The changes for prioritizing IPv4 or IPv6 over the other need to go into the precedence
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Configuring a DNS Service Policy to Connect with DNS Providers Using the GUI .

table entries. Given below are sample contents of the standard file as it is used in Linux systems for many
flavors. A single line of precedence label in the file overrides any default settings.

The following is an example of a gai.conf to prioritize IPv4 over IPv6:

# Generated by APIC
label ::1/128

label ::/0

label 2002::/16
label ::/96

label ::ffff:0:0/96 4

w N = O

precedence ::1/128 50
precedence ::/0 40
precedence 2002::/16 30
precedence ::/96 20

# For APICs prefering IPv4 connections, change the value to 100.
precedence ::ffff:0:0/96 10

Configuring a DNS Service Policy to Connect with DNS Providers Using the

GUI

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Before you begin

Make sure that Layer 2 or Layer 3 management connectivity is configured.

Procedure

On the menu bar, choose FABRIC > Fabric Policies. In the Navigation pane, expand Global Policies >
DNS Profiles, and click the default DNS profile.

In the Work pane, in the Management EPG field, from the drop-down list, choose the appropriate management
EPG (default (Out-of-Band)).

Expand DNS Providers, and perform the following actions:

a) In the Address field, enter the provider address.

b) In the Preferred column, check the check box if you want to have this address as the preferred provider.
You can have only one preferred provider.

¢) Click Update.

d) (Optional) To add a secondary DNS provider, expand DNS Providers, and in the Address field, type the
provider address. Click Update.

Expand DNS Domains, and perform the following actions:

a) In the Name field, enter the domain name (cisco.com).

b) In the Default column, check the check box to make this domain the default domain.
You can have only one domain name as the default.

¢) Click Update.

d) (Optional) To add a secondary DNS domain, expand DNS Domains. In the Address field, enter the
secondary domain name. Click Update.

Click Submit.
The DNS server is configured.

On the menu bar, click TENANTS > mgmt.
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Step 7 In the Navigation pane, expand Networking > VRF > oob, and click oob.

Step 8 In the Work pane, under Properties, in the DNS labels field, enter the appropriate DNS label (default). Click
Submit.
The DNS profile label is now configured on the tenant and VRF.

Configuring Custom Certificates

Configuring Custom Certificate Guidelines

 Exporting a private key that is used to generate a Certificate Signing Request (CSR) on the Cisco
Application Policy Infrastructure Controller (APIC) is not supported. If you want to use the same certificate
on multiple servers through a wildcard in the Subject Alternative Name (SAN) field, such as "*cisco.com,"
by sharing the private key that was used to generate the CSR for the certificate, generate the private key
outside of Cisco Application Centric Infrastructure (ACI) fabric and import it to the Cisco ACI fabric.

* You must download and install the public intermediate and root CA certificates before generating a
Certificate Signing Request (CSR). Although a root CA Certificate is not technically required to generate
a CSR, Cisco requires the root CA certificate before generating the CSR to prevent mismatches between
the intended CA authority and the actual one used to sign the CSR. The Cisco APIC verifies that the
certificate submitted is signed by the configured CA.

* To use the same public and private keys for a renewed certificate generation, you must satisfy the following
guidelines:

* You must preserve the originating CSR as it contains the public key that pairs with the private key
in the key ring.

* The same CSR used for the originating certificate must be resubmitted for the renewed certificate
if you want to re-use the public and private keys on the Cisco APIC.

* Do not delete the original key ring when using the same public and private keys for the renewed
certificate. Deleting the key ring will automatically delete the associated private key used with
CSRs.

* Cisco ACI Multi-Site, VCPIugin, VRA, and SCVMM are not supported for certificate-based authentication.
* Only one SSL certificate is allowed per Cisco APIC cluster.

* You must disable certificate-based authentication before downgrading to release 4.0(1) from any later
release.

* To terminate the certificate-based authentication session, you must log out and then remove the CAC
card.

* The custom certificate configured for the Cisco APIC will be deployed to the leaf and spine switches. If
the URL or DN that is used to connect to the fabric node is within the Subject or Subject Alternative
Name field, the fabric node will be covered under the certificate.

* The Cisco APIC GUI can accept a certificate with a maximum size of 4k bytes.
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Configuring a Custom Certificate for Cisco ACI HTTPS Access Using the GUI

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6
Step 7
Step 8

Step 9
Step 10

Step 11
Step 12

CAUTION: PERFORM THIS TASK ONLY DURING A MAINTENANCE WINDOW AS THERE IS A
POTENTIAL FOR DOWNTIME. The downtime affects access to the Cisco Application Policy Infrastructure
Controller (APIC) cluster and switches from external users or systems and not the Cisco APIC to switch
connectivity. The NGINX process on the switches will also be impacted, but that will be only for external
connectivity and not for the fabric data plane. Access to the Cisco APIC, configuration, management,
troubleshooting, and such will be impacted. The NGINX web server running on the Cisco APIC and switches
will be restarted during this operation.

Before you begin

Determine from which authority you will obtain the trusted certification so that you can create the appropriate
Certificate Authority.

Procedure

On the menu bar, choose Admin > AAA.
In the Navigation pane, choose Security.

In the Work pane, choose Public Key Management > Certificate Authorities > Create Certificate
Authority.

In the Create Certificate Authority dialog box, in the Name field, enter a name for the certificate authority.
In the Certificate Chain field, copy the intermediate and root certificates for the certificate authority that will
sign the Certificate Signing Request (CSR) for the Cisco APIC.

The certificate should be in Base64 encoded X.509 (CER) format. The intermediate certificate is placed before
the root CA certificate. It should look similar to the following example:

Click Submit.
In the Navigation pane, choose Public Key Management > Key Rings.
In the Work pane, choose Actions > Create Key Ring.

The key ring enables you to manage a private key (imported from external device or internally generated on
APIC), a CSR generated by the private key, and the certificate signed via the CSR.

In the Create Key Ring dialog box, in the Name field, enter a name.

In the Certificate field, do not add any content if you will generate a CSR using the Cisco APIC through the
key ring. Alternately, add the signed certificate content if you already have one that was signed by the CA
from the previous steps by generating a private key and CSR outside of the Cisco APIC,

In the Modulus field, click the radio button for the desired key strength.

In the Certificate Authority field, from the drop-down list, choose the certificate authority that you created
earlier, then click Submit.
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Step 13

Step 14
Step 15
Step 16

Step 17

Step 18

Step 19

Step 20
Step 21

Step 22

In the Private Key field, do not add any content if you will generate a CSR using the Cisco APIC through
the key ring. Alternately, add the private key used to generate the CSR for the signed certificate that you
entered in step 10.

Note Do not delete the key ring. Deleting the key ring will automatically delete the associated private
key used with CSRs.

If you have not entered the signed certificate and the private key, in the Work pane, in the Key Rings area,
the Admin State for the key ring created displays Started, waiting for you to generate a CSR. Proceed to
step 14.

If you entered both the signed certificate and the private key, in the Key Rings area, the Admin State for the
key ring created displays Completed. Proceed to step 23.

In the Navigation pane, choose Public Key Management > Key Rings > key _ring_name.

In the Work pane, choose Actions > Create Certificate Request.

In the Subject field, enter the common name (CN) of the CSR.

You can enter the fully qualified domain name (FQDN) of the Cisco APICs using a wildcard, but in a modern
certificate, we generally recommend that you enter an identifiable name of the certificate and enter the FQDN

of all Cisco APICs in the Alternate Subject Name field (also known as the SAN — Subject Alternative Name)
because many modern browsers expect the FQDN in the SAN field.

In the Alternate Subject Name field, enter the FQDN of all Cisco APICs, such as
"DNS:apicl.example.com,DNS:apic2.example.com,DNS:apic3.example.com" or "DNS:*example.com".

Alternatively, if you want SAN to match an IP address, enter the Cisco APICs' IP addresses with the following
format:

IP:192.168.2.1

You can use DNS names, [Pv4 addresses, or a mixture of both in this field. IPv6 addresses are not supported.

Fill in the remaining fields as appropriate.

Note Check the online help information available in the Create Certificate Request dialog box for a
description of the available parameters.

Click Submit.

Inside the same key ring, the Associated Certificate Request area is now displayed with the Subject, Alternate
Subject Name and other fields you entered in the previous steps along with the new field Request, which
contains the content of the CSR that is tied to this key ring. Copy the content from the Request field to submit
the content to the same certificate authority that is tied to this key ring for signing.

In the Navigation pane, choose Public Key Management > Key Rings > key _ring_name.

In the Work pane, in the Certificate field, paste the signed certificate that you received from the certificate
authority.

Click Submit.

Note If the CSR was not signed by the Certificate Authority indicated in the key ring, or if the certificate
has MS-DOS line endings, an error message is displayed and the certificate is not accepted.
Remove the MS-DOS line endings.

The key is verified, and in the Work pane, the Admin State changes to Completed and is now ready for use
in the HTTP policy.
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Step 23
Step 24
Step 25
Step 26

Step 27

Provisioning Fabric Wide System Settings .

On the menu bar, choose Fabric > Fabric Policies.

In the Navigation pane, choose Pod Policies > Policies > Management Access > default.

In the Work pane, in the Admin Key Ring drop-down list, choose the desired key ring.

(Optional) For Certificate based authentication, in the Client Certificate TP drop-down list, choose the
previously created Local User policy and click Enabled for Client Certificate Authentication state.
Click Submit.

All web servers restart. The certificate is activated, and the non-default key ring is associated with HTTPS
access.

What to do next

You must remain aware of the expiration date of the certificate and take action before it expires. To preserve
the same key pair for the renewed certificate, you must preserve the CSR as it contains the public key that
pairs with the private key in the key ring. Before the certificate expires, the same CSR must be resubmitted.
Do not delete or create a new key ring as deleting the key ring will delete the private key stored internally on
the Cisco APIC.

Provisioning Fabric Wide System Settings

Configuring APIC In-Band or Out-of-Band Connectivity Preferences

Step 1
Step 2
Step 3
Step 4

This topic describes how to toggle between in-band and out-of-band connectivity on the APIC server for
management access to devices such as authentication servers or SNMP servers external to the ACI fabric.
Enabling inband executes in-band management connectivity between the APIC server to external devices
through leaf switches on the ACI fabric. Enabling ooband executes out-of-band management connectivity
between the APIC server to external devices through connections external to the ACI fabric.

Before you begin

Configure in-band and out-of-band management networks. For more information, see Management in the
Cisco APIC Basic Configuration Guide, Release 3.x.

Procedure
On the menu bar, click System > System Settings.
On the Navigation bar, click APIC Connectivity Preferences.

To enable the policy, click inband or coband.
Click Submit.
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Configure Quota Management Policies

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

Starting in the Cisco Application Policy Infrastructure Controller (APIC) Release 2.3(1), there are limits on
number of objects a tenant admin can configure. This enables the admin to limit the number of managed
objects that can be added globally across tenants.

This feature is useful when you want to limit any tenant or group of tenants from exceeding ACI maximums
per leaf or per fabric or unfairly consuming a majority of available resources, potentially affecting other tenants
on the same fabric.

Procedure

On the menu bar, click System > System Settings.

Right-click Quota and choose Create Quota Configuration..

In the Class field, choose the object type to limit with the quota.

In the Container Dn field, enter the distinguished name (DN) that describes the class.

In the Exceed Action field, choose either Fail Transaction Action or Raise Fault Action.

In the Max Number field, enter the maximum number of the managed objects that can be created after which
the exceed action will be applied.

Click Submit.

Create an Enforced BD Exception List

Step 1
Step 2
Step 3
Step 4

This topic describes how to create a global exception list of subnets which are not subject to an enforced
bridge domain. With the Enforced BD feature configured, the endpoints in a subject endpoint group (EPG)
can only ping subnet gateways within the associated bridge domain.

The exception IP addresses can ping all of the BD gateways across all of your VRFs.

A loopback interface configured for an L3Out does not enforce reachability to the IP address that is configured
for the subject loopback interface.

When an eBGP peer IP address exists in a different subnet than the subnet of the L3Out interface, the peer
subnet must be added to the allowed exception subnets. Otherwise, eBGP traffic is blocked because the source
IP address exists in a different subnet than the L3Out interface subnet.

Before you begin

Create an enforced bridge domain (BD).

Procedure

On the menu bar, click System > System Settings.

Click BD Enforced Exception List.

Click the + on Exception List.

Add the IP address and network mask for the subnet that can ping any subnet gateway.
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Step 5
Step 6

Create a BGP Route Reflector Policy and Route Reflector Node Endpoints .

Repeat to add more subnets that are exceptions to the enforced bridge domain.
Click Submit.

Create a BGP Route Reflector Policy and Route Reflector Node Endpoints

Step 1

Step 2

This topic describes how to create ACI fabric route reflectors, which use multiprotocol BGP (MP-BGP) to
distribute external routes within the fabric. To enable route reflectors in the ACI fabric, the fabric administrator
must select the spine switches that will be the route reflectors, and provide the autonomous system (AS)
number. Once route reflectors are enabled in the ACI fabric, administrators can configure connectivity to
external networks.

Before you begin
Required:

* To connect external routers to the ACI fabric, the fabric infrastructure administrator must configure spine
nodes as Border Gateway Protocol (BGP) route reflectors.

* For redundancy purposes, more than one spine is configured as a router reflector node (one primary and
one secondary reflector).

Procedure

To create a BGP Route Reflector policy, perform the following steps:

a) On the menu bar, click System > System Settings.

b) Click BGP Route Reflector.

c) Enter the Autonomous System Number.

d) Click the + on Route Reflector Nodes.

e) Enter the spine route reflector node ID endpoint, and click Submit.,

To create external route reflector node endpoints, perform the following steps:

a) Click the + on External Route Reflector Nodes.

b) Choose the spine to serve as external route reflector node endpoint.

c) If'this is a site managed by Multi-Site, you can also specify an intersite spine route reflector.
d) Click Submit.

Configure a Fabric Wide Control Plane MTU Policy

This topic describes how to create a fabric-wide Control Plane (CP) MTU policy, that sets the global MTU
size for control plane packets sent by the nodes (APIC and the switches) in the fabric.

In a multipod topology, the MTU setting for the fabric external ports must be greater than or equal to the CP
MTU value set. Otherwise, the fabric external ports might drop the CP MTU packets.
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Step 1
Step 2
Step 3
Step 4

\)

Note Ifyou set the L30ut Interface Profile to inherit the MTU from the IPN, it will be 9150. If you want the MTU

to be used across the IPN to be 9216, you must explicitly configure it in the L3Out Interface Profile (at
Tenants > tenant-name > Networking > External Routed Networks > Create Routed Outside > Nodes
and Interface Protocol Profiles > Create Node Profile > Create Interface Profile).

If you change the IPN or CP MTU, Cisco recommends changing the CP MTU value first, then changing the
MTU value on the spine of the remote pod. This reduces the risk of losing connectivity between the pods due
to MTU mismatch.

Procedure

On the menu bar, click System > System Settings.
Click Control Plane MTU.

Enter the MTU for fabric ports.

Click Submit.

Configure Endpoint Loop Protection

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

The endpoint loop protection policy specifies how loops detected by frequent MAC moves are handled. To
configure EP loop protection perform the following steps:

Procedure

On the menu bar, click System > System Settings.

Click Endpoint Controls.

Click the Ep Loop Protection tab.

To enable the policy, click Enabled in the Administrative State field.

Optional. Set the loop detection interval, which specifies the time to detect a loop. The interval range is from
30 to 300 seconds. The default setting is 60 seconds.

Set the loop detection multiplication factor, which is the number of times a single EP moves between ports
within the loop detection interval. The range is from 1 to 255. The default is 4.

Choose the action to take when detecting a loop.
The action can be:

« BD Learn Disable

« Port Disable

The default is Port Disable.

Click Submit.
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Rogue Endpoint Control Policy

About the Rogue Endpoint Control Policy

A rogue endpoint attacks leaf switches through frequently, repeatedly injecting packets on different leaf switch
ports and changing 802.1Q tags (thus, emulating endpoint moves) causing learned class and EPG port changes.
Misconfigurations can also cause frequent IP and MAC address changes (moves).

Such rapid movement in the fabric causes significant network instability, high CPU usage, and in rare instances,
endpoint mapper (EPM) and EPM client (EPMC) crashes due to significant and prolonged messaging and
transaction service (MTS) buffer consumption. Also, such frequent moves may result in the EPM and EPMC
logs rolling over very quickly, hampering debugging for unrelated endpoints.

The rogue endpoint control feature addresses this vulnerability by quickly:
* Identifying such rapidly moving MAC and IP endpoints.
* Stopping the movement by temporarily making endpoints static, thus quarantining the endpoint.

* Prior to 3.2(6) release: Keeping the endpoint static for the Rogue EP Detection Interval and dropping
the traffic to and from the rogue endpoint. After this time expires, deleting the unauthorized MAC or IP
address.

* In the 3.2(6) release and later: Keeping the endpoint static for the Rogue EP Detection Interval (this
feature no longer drops the traffic). After this time expires, deleting the unauthorized MAC or IP address.

* Generating a host tracking packet to enable the system to re-learn the impacted MAC or IP address.

* Raising a fault to enable corrective action.

The rogue endpoint control policy is configured globally and, unlike other loop prevention methods, functions
at the level of individual endpoints (IP and MAC addresses). It does not distinguish between local or remote
moves; any type of interface change is considered a move in determining if an endpoint should be quarantined.

The rogue endpoint control feature is disabled by default.

Limitations of the Rogue Endpoint Control Policy
The following limitations apply when using a rogue endpoint control policy:
* Changing rogue endpoint control policy parameters will not affect existing rogue endpoints.
* If a rogue endpoint is enabled, loop detection and bridge domain move frequency will not take effect.
* Disabling the rogue endpoint feature clears all rogue endpoints.

* You must disable the rogue endpoint feature prior to upgrading or downgrading the Cisco Application
Policy Infrastructure Controller (APIC).

* The endpoint mapper (EPM) has value limits for rogue endpoint parameters. If you set the parameter
values outside of this range, the Cisco APIC raises a fault for each mismatched parameter.

* Support for rogue endpoint detection is limited to endpoints that are connected to the fabric and not to
those that are connected to remote leaf nodes.

* The rogue endpoint feature can be used within each site of a Cisco ACI Multi-Site deployment to help
with misconfigurations of servers that cause an endpoint to move within the site. The rogue endpoint
feature is not designed for scenarios where the endpoint may move between sites.
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* You must disable rogue endpoint control before you upgrade to or from Cisco APIC release 4.1.

Configuring the Rogue Endpoint Control Policy Using the GUI

Step 1
Step 2
Step 3
Step 4

Step 5

You can configure the Rogue EP Control policy for the fabric, to detect and delete unauthorized endpoints,
using the Cisco Application Policy Infrastructure Controller (Cisco APIC) GUI. This topic also includes the
steps to clear rogue endpoints on a TOR switch, ad-hoc.

The policy options have the following valid and supported values:

* Rogue EP Detection Interval—Sets the rogue endpoint detection interval, which specifies the time to
detect rogue endpoints. Valid values are from 0 to 65535 seconds. The default is 60.

* Hold Interval (sec)—Interval in seconds after the endpoint is declared rogue, where it is kept static so
learning is prevented and the traffic to and from the Rogue endpoint is dropped. After this interval, the
endpoint is deleted. Valid values are from 1800 to 3600. The default is 1800.

 Rogue EP Detection Multiplication Factor—Sets the rogue endpoint detection multiplication factor
for determining if an endpoint is unauthorized. If the endpoint moves more times than this number, within
the EP detection interval, the endpoint is declared rogue. Valid values are from 2 to 10. The default is 6.

Procedure

On the menu bar, click System > System Settings.

On the navigation bar, click Endpoint Controls and click the Rogue EP Control tab.

Set the Administrative State to Enabled.

Optional. Reset the Rogue EP Detection Interval (sec), Rogue EP Detection Multiplication Factor, or the
Hold Interval (sec).

(Optional) To clear rogue endpoints on a TOR switch, perform the following steps:

a) On the Cisco APIC menu bar, click Fabric > Inventory.

b) On the Navigation bar, expand the Pod and click the leaf switch where you want to clear rogue endpoints.

¢) When the leaf switch summary appears in the work pane, right-click the leaf switch name in the Navigation
bar, and choose Clear Rogue Endpoints.

d) Click Yes.

About Max IP Address Flow Control

The 3.2(6) release adds the max IP address flow control feature, which identifies endpoints that are misbehaving
and flags them as rogue based on the number of learned IP addresses that are associated with a MAC address.
The Cisco Application Centric Infrastructure (ACI) fabric supports a maximum of 4,096 IP addresses on a
MAC address. If a leaf switch learns more than 4,096 IP addresses that are associated with a MAC address,
then the MAC address and all of the IP addresses are classified as rogue.

After the max IP address flow control feature identifies an endpoint as rogue, the endpoint is quarantined, a
fault is raised in the APIC, and there will not be any further learning of new IP Addresses on this endpoint.
The quarantine period is 1 hour. If the standard rogue feature is enabled, then the quarantine period is the
same as the period configured by the standard rogue configuration.
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While the rogue endpoint control policy feature (rogue due to moves) can be configured to be enabled or
disabled, the max IP address flow control feature does not require explicit configuration to be enabled.

Prior to this feature, the ACI fabric identified an endpoint as rogue if it kept moving its location for a
configurable number of times within a configurable time period. With this feature, the ACI fabric can identify
an endpoint as rogue based on the number of moves or if a leaf switch learns more than 4,096 IP addresses
on a MAC address.

Configure COOP

About COOP

Council of Oracle Protocol (COOP) is used to communicate the mapping information (location and identity)
to the spine switch proxy. A leaf switch (the "citizen") forwards endpoint address information to the spine
switch (the "oracle") using Zero Message Queue (ZMQ). COOP running on the spine nodes will ensure all
spine nodes maintain a consistent copy of endpoint address and location information and additionally maintain
the distributed hash table (DHT) repository of endpoint identity to location mapping database.

COOP Endpoint Dampening

When malicious or erroneous behavior causes unnecessary endpoint updates, the COOP process can become
overwhelmed, preventing the processing of valid endpoint updates. The rogue endpoint detection feature of
the leaf switch can prevent many erroneous updates from reaching the spine switch. In cases where the rogue
endpoint detection is inadequate, the COOP process invokes endpoint dampening. To relieve pressure on
COOP, the spine switch asks all leaf switches to ignore updates from the misbehaving endpoint for a specified
period. When this occurs, the dampening state of the endpoint is 'Freeze,' and a fault is generated.

\}

Note COOP endpoint dampening is introduced and enabled by default in Cisco Application Policy Infrastructure

Controller (APIC) release 4.2(3).

Detection criteria is based on the penalty value calculations that are based on the types of endpoint-related
events, as shown in the following table:

Event Penalty Notes
Value

Learn a new IP address 0 The new IP address is learned.

Learn an additional IP 2 The additional IP address is learned with an existing endpoint

address MAC address.

Delete an IP address 50 The remote endpoint IP address gets deleted after the IP address
is learned.

Learn the deleted IP address |50 Learn the remote endpoint IP address after the IP address is
deleted.

Delete an IP address 400 Delete the local endpoint IP address after the IP address is
learned.
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Event Penalty Notes
Value

Learn the deleted IP address | 400 Learn the local endpoint IP address after the IP address is
deleted.

Endpoint move 200 An endpoint moves to a different interface.

IP address move 200 An IP address moves to a different MAC address.
The penalty is high for this event because it causes two route
updates to BGP.

URIB programming 50 Spine switch tunnel interface status change (up/down) for an
endpoint.

The penalty value is calculated per IP address and is decreased by 50% every five minutes. For example, if
the penalty value of the endpoint is 4000 and number of IP addresses in the endpoint is 2, the penalty value
per IP address is 4000/2 = 2000. When the penalty value per IP address exceeds the critical threshold (4000),
the endpoint state is changed to Critical from Normal. If an endpoint stays in the Critical state more than
five minutes or the penalty value per IP address exceeds the freeze threshold (10000), the endpoint state will
become Freeze (dampening) and the update of the endpoint is ignored. When the penalty value per IP address
drops below the reuse threshold (2500), the endpoint state becomes Normal (non-dampening). 10 minutes
must elapse for the penalty value to be decreased by 75% (10000 * 0.5 * 0.5 = 2500). The thresholds are not
user-configurable.

COOP Authentication

COOP data path communication provides high priority to transport using secured connections. To protect
COOP messages from malicious traffic injection, the Cisco APIC and switches support COOP protocol
authentication.

The COOP protocol supports two ZMQ authentication modes:
» Strict mode: COOP allows MDS5 authenticated ZMQ connections only.
« Compatible mode: COOP accepts both MD5 authenticated and non-authenticated ZMQ connections

for message transportation.

For additional information about COOP authentication, see the Cisco APIC Security Configuration Guide.

Viewing COOP Dampened Endpoints Using the GUI

Step 1
Step 2
Step 3
Step 4

Use this Cisco Application Policy Infrastructure Controller (APIC) GUI procedure to view all dampened
endpoints in a spine node.

Procedure

On the menu bar, click Fabric > Inventory.

In the Navigation pane, expand the pod and the spine node.
Expand Protocols > COOP and the COOP instance.
Click Endpoint Database to display the endpoints.
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Inspect the Dampened State column to find the dampened endpoints. The possible states are:

» Normal: The endpoint updates are normal.

« Critical: Enough updates have been received that the endpoint could be moved into the freeze state. If
an endpoint remains in the Critical state more than five minutes, the state changes to Freeze.

* Freeze: Updates from this endpoint are currently being ignored due to frequent unnecessary updates. A
fault has been generated.

Viewing COOP Dampened Endpoints Using the Switch CLI

Use this switch CLI procedure to view all dampened endpoints in a spine or leaf node.

Log in to the spine or leaf switch CLI and enter the following command:

show coop internal info repo ep dampening

Clearing COOP Dampened Endpoints Using the GUI

Use this Cisco Application Policy Infrastructure Controller (APIC) GUI procedure to clear and recover all
dampened endpoints in a spine or leaf node. This operation must be executed on all spine switches and on the
source leaf switch of the endpoint. If the dampened endpoint is still in the endpoint table on the leaf switch,
the endpoint is published to the spine switch COOP database. If not, the dampened endpoint is deleted from
the spine switch COOP database after two minutes.

Procedure

Step 1 On the menu bar, click Fabric > Inventory.

Step 2 In the Navigation pane, expand the pod and the spine or leaf node.
Step 3 Right-click the node and choose Clear Dampened Endpoints.
Step 4 Click Yes to confirm the action.

Clearing a COOP Dampened Endpoint Using the Switch CLI

Use this procedure to clear and recover a dampened endpoint in a spine or leaf node. The procedure recovers
a single endpoint whose dampening state is Freeze. This operation must be executed on all spine switches
and on the source leaf switch of the endpoint.

Log in to the spine or leaf switch CLI and enter the following command:

clear coop internal info repo ep dampening key <bd> <mac>

Disabling COOP Endpoint Dampening Using the REST API
This procedure shows how to disable or enable COOP EP dampening using the APIC REST API.
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COOP endpoint dampening is enabled by default, but in some situations it can be necessary to disable it. An
example is when you are expecting many IP updates for a single MAC address and ignoring those updates
could be disruptive to the network.

Use the following API, setting disableEpDampening="true" to disable COOP endpoint dampening.

<!-- api/policymgr/mo/.xml -->
<polUni>
<infraInfra>
<infraSetPol disableEpDampening="true"></infraSetPol>
</infralInfra>
</polUni>

All nodes in the fabric will disable COOP endpoint dampening and will recover any existing endpoints whose
dampened state is 'Freeze.'

Configuring COOP Authentication Using the APIC GUI

Step 1
Step 2
Step 3

Step 4

Procedure

On the menu bar, choose System > System Settings.
In the Navigation pane, click on COOP Group.

In the Work pane, under the Policy Property area in the Type field, choose the desired type from the
Compatible Type and Strict Type options.

Click Submit.
This completes the COOP authentication policy configuration.

Configuring COOP Authentication Using the Cisco NX-0S-Style CLI

Procedure

Configure the COOP authentication policy using the strict mode option.

Example:

apicl# configure

apicl (config) # coop-fabric

apicl (config-coop-fabric)# authentication type ?

compatible Compatible type

strict Strict type

apiclOl-apicl (config-coop-fabric)# authentication type strict
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Configuring COOP Authentication Using the REST API .

Configuring COOP Authentication Using the REST API

Procedure

Configure a COOP authentication policy.
In the example, the strict mode is chosen.

Example:
https://172.23.53.xx/api/node/mo/uni/fabric/pol-default.xml

<coopPol type="strict">
</coopPol>

Configure IP Aging

Step 1
Step 2
Step 3
Step 4

This topic describes how to enable an IP Aging policy. When enabled, the IP aging policy ages unused IPs
on an endpoint.

When the Administrative State is enabled, the IP aging policy sends ARP requests (for [Pv4) and neighbor
solicitations (for IPv6) to track IPs on endpoints. If no response is given, the policy ages the unused IPs.

Procedure

On the menu bar, click System > System Settings.

Click Endpoint Controls.

Click the Ip Aging tab.

To enable the policy, click Enabled in the Administrative State field.

What to do next

Create an End Point Retention policy, which is required, to specify the timer used for tracking IPs on endpoints.
Navigate to Tenants > tenant-name > > Policies > Protocol > End Point Retention.

Disable Remote Endpoint Learning

This topic describes how to enable or disable IP end point learning.
The scope of this policy is fabric-wide. After configuration, a policy is pushed to each leaf switch as it comes
up.

You should enable this policy in fabrics which include the Cisco Nexus 9000 series switches, 93128 TX, 9396
PX, or 9396 TX switches with the NOK-M12PQ uplink module, after all the nodes have been successfully
upgraded to APIC Release 2.2(2x) or higher.

After any of the following configuration changes, you may need to manually flush previously learned IP
endpoints:
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Step 1
Step 2
Step 3
Step 4

* Remote IP endpoint learning is disabled
» The VREF is configured for ingress policy enforcement

* At least one Layer 3 interface exists in the VRF
To manually flush previously learned IP endpoints, enter the following command on both VPC peers: vsh
-c "clear system internal epm endpoint vrf <vrf-name> remote"

To enable or disable IP end point learning, perform the following steps:

Procedure

On the menu bar, click System > System Settings.
Click Fabric Wide Setting.

Click the check box on Disable Remote EP Learn.
Click Submit.

Globally Enforce Subnet Checks

Step 1
Step 2
Step 3
Step 4

This topic describes how to enable or disable subnet checking. When enabled, IP address learning is disabled
outside of subnets configured in a VREF, for all other VRFs.

The scope of this policy is fabric-wide. After configuration, a policy is pushed to each leaf switch as it comes
up.

Procedure

On the menu bar, click System > System Settings.
Click Fabric Wide Setting.

Click the check box on Enforce Subnet Check.
Click Submit.

Reallocate a GIPo

This topic describes how to enable reallocating GIPos on non-stretched bridge domains to make room for
stretched bridge domains.

With the introduction of Cisco ACI Multi-Site, there was a need to change the GIPo allocation scheme to
provide the following benefits:

1. Minimize the number of bridge domains that have the same GIPo.

2. GIPos that are assigned to Cisco ACI Multi-Site stretched bridge domains do not overlap with GIPos that
are assigned to non-stretched bridge domains.
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Step 1
Step 2
Step 3
Step 4

Globally Enforce Domain Validation .

To achieve this allocation, Cisco ACI introduced different pools whose sizes change based on amount of
stretched and non-stretched bridge domains.

For a fresh installation of Cisco ACI, the Cisco APIC guarantees that both #1 and #2 are accomplished. During
a Cisco ACI upgrade from a release prior to 2.3(1), the old schema is maintained to avoid fabric disruption
because the existing GIPos might already be used for non-stretched bridge domains. As a result, Cisco ACI
cannot guarantee that #2 is accomplished.

Enabling the Reallocate GIPo knob in Cisco APIC's fabric-wide setting policy causes Cisco APIC to re-allocate
GIPos and use the newer allocation scheme. Enabling the knob is a one-time operation. Afterward, the GIPos
will not overlap. This knob is relevant only in a Cisco ACI Multi-Site Orchestrator deployment if you upgrade
from a release that is earlier than 2.3(1) to the 3.0(1) release or later.

The scope of this policy is fabric-wide. After configuration, a policy is pushed to each leaf switch as it comes
up.

Procedure

On the menu bar, click System > System Settings.
Click Fabric Wide Setting.

Click the check box on Reallocate Gipo.

Click Submit.

Globally Enforce Domain Validation

Step 1
Step 2
Step 3
Step 4

This topic describes how to enforce domain validation. When enabled, a validation check is performed when
a static path is added, to determine if no domain is associated with an EPG.

The scope of this policy is fabric-wide. After configuration, a policy is pushed to each leaf switch as it comes
up.

Procedure

On the menu bar, click System > System Settings.
Click Fabric Wide Setting.

Click the check box on Enforce Domain Validation.
Click Submit.

Enable OpFlex Client Authentication

This topic describes how to enable OpFlex client authentication for GOLF and Linux.

To deploy GOLF or Linux Opflex clients in an environment where the identity of the client cannot be guaranteed
by the network, you can dynamically validate the client’s identity based on a client certificate.
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\)

Note When you enable certificate enforcement, connectivity with any GOLF or Linux Opflex client that does not
support client authentication is disabled.

The scope of this policy is fabric-wide. After configuration, a policy is pushed to each leaf switch as it comes
up.

Procedure

Step 1 On the menu bar, click System > System Settings.
Step 2 Click Fabric Wide Setting.

Step 3 Click the check box on OpFlex Client Authentication to enable or disable enforcing client certificate
authentication for GOLF and Linux Opflex clients.

Step 4 Click Submit.

Endpoint Listen Policy

About the Endpoint Listen Policy

Beginning in the 4.2(4) release, you can configure an endpoint listen policy to detect untagged traffic that
gets sent from anonymous endpoints to Cisco Application Centric Infrastructure (ACI) leaf switches that do
not have an enforced policy. By default, if a policy is not deployed for a port, all endpoint traffic gets dropped
on that port. If you configure an endpoint listen policy, this policy gets deployed on all leaf switch ports that
do not have an existing enforced policy. The endpoint listen policy enables Cisco ACI to detect untagged
traffic that arrives on those ports, such that Cisco ACI will know the MAC address or IP address of the
anonymous endpoints. This allows the Cisco ACI administrator to decide in which EPG to put those endpoints.
The Cisco Application Policy Infrastructure Controller (APIC) GUI displays all detected anonymous endpoints
on the Global Endpoints configuration screen.

\)

Note The endpoint listen policy is a beta feature. There is no guarantee that this feature will work as intended. Use
at your own risk.

Configuring the Endpoint Listen Policy Using the GUI

This procedure configures an endpoint listen policy, which detects untagged traffic that gets sent from
anonymous endpoints to Cisco Application Centric Infrastructure (ACI) leaf switches that do not have an
enforced policy.

\)

Note The endpoint listen policy is a beta feature. There is no guarantee that this feature will work as intended. Use
at your own risk.
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Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Fabric Load Balancing .

Procedure

On the menu bar, choose System > System Settings.

In the Navigation pane, choose Global Endpoints.

In the Work pane, put a check in the End Point Listen Policy check box.
In the End Point Listen Encap drop-down list, choose VLAN.

In the End Point Listen Encap text field, enter the VLAN ID. Valid values are from 1 to 4094. This should
be a reserved VLAN encap, such that it can not be used by any EPGs.

Click Submit.

Fabric Load Balancing

The ACI fabric provides several load balancing options for balancing the traffic among the available uplink
links. This topic describes load balancing for leaf to spine switch traffic.

Static hash load balancing is the traditional load balancing mechanism used in networks where each flow is
allocated to an uplink based on a hash of its 5-tuple. This load balancing gives a distribution of flows across
the available links that is roughly even. Usually, with a large number of flows, the even distribution of flows
results in an even distribution of bandwidth as well. However, if a few flows are much larger than the rest,
static load balancing might give suboptimal results.

ACI fabric Dynamic Load Balancing (DLB) adjusts the traffic allocations according to congestion levels. It
measures the congestion across the available paths and places the flows on the least congested paths, which
results in an optimal or near optimal placement of the data.

DLB can be configured to place traffic on the available uplinks using the granularity of flows or flowlets.
Flowlets are bursts of packets from a flow that are separated by suitably large gaps in time. If the idle interval
between two bursts of packets is larger than the maximum difference in latency among available paths, the
second burst (or flowlet) can be sent along a different path than the first without reordering packets. This idle
interval is measured with a timer called the flowlet timer. Flowlets provide a higher granular alternative to
flows for load balancing without causing packet reordering.

DLB modes of operation are aggressive or conservative. These modes pertain to the timeout value used for
the flowlet timer. The aggressive mode flowlet timeout is a relatively small value. This very fine-grained load
balancing is optimal for the distribution of traffic, but some packet reordering might occur. However, the
overall benefit to application performance is equal to or better than the conservative mode. The conservative
mode flowlet timeout is a larger value that guarantees packets are not to be re-ordered. The tradeoff is less
granular load balancing because new flowlet opportunities are less frequent. While DLB is not always able
to provide the most optimal load balancing, it is never worse than static hash load balancing.

\)

Note

Although all Nexus 9000 Series switches have hardware support for DLB, the DLB feature is not enabled in
the current software releases for second generation platforms (switches with EX, FX, and FX2 suffixes).

The ACI fabric adjusts traffic when the number of available links changes due to a link going off-line or
coming on-line. The fabric redistributes the traffic across the new set of links.
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In all modes of load balancing, static or dynamic, the traffic is sent only on those uplinks or paths that meet
the criteria for equal cost multipath (ECMP); these paths are equal and the lowest cost from a routing
perspective.

Dynamic Packet Prioritization (DPP), while not a load balancing technology, uses some of the same mechanisms
as DLB in the switch. DPP configuration is exclusive of DLB. DPP prioritizes short flows higher than long

flows; a short flow is less than approximately 15 packets. Because short flows are more sensitive to latency

than long ones, DPP can improve overall application performance.

For intra-leaf switch and inter-leaf switch traffic, all DPP-prioritized traffic is marked CoS 0 regardless of a
custom QoS configuration.

GPRS tunneling protocol (GTP) is used mainly to deliver data on wireless networks. Cisco Nexus switches
are places in Telcom Datacenters. When packets are being sent through Cisco Nexus 9000 switches in a
datacenter, traffic needs to be load-balanced based on the GTP header. When the fabric is connected with an
external router through link bundling, the traffic is required to be distributed evenly between all bundle
members (For example, Layer 2 port channel, Layer 3 ECMP links, Layer 3 port channel, and L3Out on the
port channel). GTP traffic load balancing is performed within the fabric as well.

To achieve GTP load balancing, Cisco Nexus 9000 Series switches use 5-tuple load balancing mechanism.
The load balancing mechanism takes into account the source IP, destination IP, protocol, Layer 4 resource
and destination port (if traffic is TCP or UDP) fields from the packet. In the case of GTP traffic, a limited
number of unique values for these fields restrict the equal distribution of traffic load on the tunnel.

To avoid polarization for GTP traffic in load balancing, a tunnel endpoint identifier (TEID) in the GTP header
is used instead of a UDP port number. Because the TEID is unique per tunnel, traffic can be evenly load
balanced across multiple links in the bundle.

The GTP load balancing feature overrides the source and destination port information with the 32-bit TEID
value that is present in GTPU packets.

GTP tunnel load balancing feature adds support for:

* GTP with IPv4/IPv6 transport header on physical interface
* GTPU with UDP port 2152

The ACI fabric default configuration uses a traditional static hash. A static hashing function distributes the
traffic between uplinks from the leaf switch to the spine switch. When a link goes down or comes up, traffic
on all links is redistributed based on the new number of uplinks.

Leaf/Spine Dynamic Load Balancing Algorithms

The following table provides the default non-configurable algorithms used in Leaf/Spine dynamic load
balancing.
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Table 7: ACI Leaf/Spine Dynamic Load Balancing

Traffic Type Hashing Data Points

Leaf/Spine IP unicast * Source MAC address

* Destination MAC address
* Source IP address

* Destination IP address

* Protocol type

* Source Layer 4 port

* Destination Layer 4 port

* Segment ID (VXLAN VNID) or VLAN ID

Leaf/Spine Layer 2 * Source MAC address
* Destination MAC address

* Segment ID (VXLAN VNID) or VLAN ID

Creating a Load Balancer Policy Using the Cisco APIC GUI

Step 1
Step 2
Step 3

Step 4

This topic describes how to configure the default Load Balancer policy.

The load balancing policy options balance traffic among the available uplink ports. Static hash load balancing
is the traditional load balancing mechanism used in networks where each flow is allocated to an uplink based
on a hash of its 5-tuple. This load balancing gives a distribution of flows across the available links that is
roughly even. Usually, with a large number of flows, the even distribution of flows results in an even distribution
of bandwidth as well. However, if a few flows are much larger than the rest, static load balancing might give
suboptimal results.

Procedure

On the menu bar, click System > System Settings.

Click Load Balancer.

Choose the Dynamic Load Balancing Mode.

The dynamic load balancer (DLB) mode adjusts the traffic allocations according to congestion levels. It
measures the congestion across the available paths and places the flows on the least congested paths, which
results in an optimal or near optimal placement of the data. DLB can be configured to place traffic on the

available uplinks using the granularity of flows or of flowlets. Flowlets are bursts of packets from a flow that
are separated by intervals. The mode can be Aggressive, Conservative, or Off (the default).

Enable or disable Dynamic Packet Prioritization by choosing On or Off (the default).

Dynamic Packet Prioritization (DPP) prioritizes short flows higher than long flows; a short flow is less than
approximately 15 packets. Short flows are more sensitive to latency than long ones. DPP can improve overall
application performance.
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Step 5 Choose the Load Balancing Mode. The mode can be Link Failure or Traditional (the default).

The load balancer administrative state. In all modes of load balancing, static or dynamic, the traffic is sent
only on those uplinks or paths that meet the criteria for equal cost multipath (ECMP); these paths are equal
and the lowest cost from a routing perspective.

Step 6 Click Submit.

Creating a Load Balancer Policy Using the CLI

Creating a Dynamic Load Balancer Policy Using the CLI

There are two dynamic load balancer modes: dynamic-aggressive and dynamic-conservative. The
dynamic-aggressive mode enables a shorter flowlet timeout interval, and the dynamic-conservative mode

enables a longer flowlet timeout interval. For more information about these commands, see the Cisco APIC
NX-OS Style CLI Command Reference.

This section demonstrates how to configure a dynamic load balancer policy using the CLI.

Procedure

Step 1 To enable aggressive mode dynamic load balancing:

apicl# conf t
apicl# (config)# system dynamic-load-balance mode dynamic-aggressive

Step 2 To enable conservative mode dynamic load balancing:

apicl# conf t
apicl# (config)# system dynamic-load-balance mode dynamic-conservative

Creating a Dynamic Packet Prioritization Policy Using the CLI
This section demonstrates how to enable dynamic packet prioritization using the CLI. For more information
about this command, see the Cisco APIC NX-OS Style CLI Command Reference.

Procedure

Enable dynamic packet prioritization:

apicl# conf t
apicl# (config)# system dynamic-load-balance mode packet-prioritization

Creating a GTP Load Balancer Policy Using the CLI

This section demonstrates how to create a GTP load balancer policy using the CLI. For more information
about this command, see the Cisco APIC NX-OS Syle CLI Command Reference.
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Procedure

Enable dynamic packet prioritization:

apicl# conf t
apicl# (config)# ip load-sharing address source destination gtpu

Creating a Load Balancer Policy Using the REST API

This section demonstrates how to enable a DLB, DPP, and a GTP load balancer policy. For a list of all possible
property values, see the Cisco APIC Management Information Model Reference.

Procedure

To enable a DLB, DPP, and GTP load balancer policy:

https://apic-ip-address/api/mo/uni.xml

<polUni>

<fabricInst>

<lbpPol name="default" hashGtp="yes" pri="on" dlbMode="aggressive">
</lbpPol>

</fabricInst>

</polUni>

Enable a Time Precision Policy

This topic describes how to enable Precision Time Protocol (PTP), a time synchronization protocol for nodes
distributed across a network. Its hardware timestamp feature provides greater accuracy than other time
synchronization protocols such as Network Time Protocol (NTP).

PTP is a distributed protocol that specifies how real-time PTP clocks in the system synchronize with each
other. These clocks are organized into a master-member synchronization hierarchy with the grandmaster
clock, the clock at the top of the hierarchy, determining the reference time for the entire system. Synchronization
is achieved by exchanging PTP timing messages, with the members using the timing information to adjust
their clocks to the time of their master in the hierarchy. PTP operates within a logical scope called a PTP
domain.

Prior to release 4.2(5), the PTP function was supported only within the Cisco ACI fabric. Beginning in release
4.2(5), the PTP function is now supported outside of the Cisco ACI fabric, where a grandmaster and clients
outside of the Cisco ACI fabric can be connected to front-panel ports on switches in the Cisco ACI fabric.

\}

Note

You can connect only one external grandmaster switch to a switch inside the Cisco ACI fabric that has been
configured as a client to that grandmaster switch. Connecting multiple external grandmaster switches to a
single client switch is not supported at this time.
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Step 1
Step 2
Step 3

Step 4

Procedure

On the menu bar, click System > System Settings.
Click Precision Time Protocol.
Choose Enabled or Disabled.

If you choose disable PTP, NTP time is used to sync the fabric. If you enable PTP, a spine is automatically
chosen as a master to which the entire site gets synced.

Click Submit.

Enable a Global System GIPo Policy

Step 1
Step 2
Step 3

This topic describes how to use the infra tenant GIPo as the system GIPo.

An ACI multipod deployment requires the 239.255.255.240 system Global IP Outside (GIPo) to be configured
on the inter-pod network (IPN) as a PIM BIDIR range. This 239.255.255.240 PIM BIDIR range configuration
on the IPN devices can be avoided by using the infra GIPo as System GIPo.

Before you begin

Upgrade all of the switches in the ACI fabric, including the leaf switches and spine switches, to the latest
APIC release.

Procedure

On the menu bar, click System > System Settings.
Choose Enabled or Disabled (the default) on Use Infra GIPo as System GIPo
Click Submit.

Configure a Fabric Port Tracking Policy

Step 1
Step 2
Step 3

Uplink failure detection can be enabled in the fabric access fabric port tracking policy. The port tracking
policy monitors the status of links between leaf switches and spine switches. When an enabled port tracking
policy is triggered, the leaf switches take down all access interfaces on the switch that have EPGs deployed
on them. For more information about fabric port tracking, see the Cisco APIC Layer 2 Networking Configuration
Guide.

Procedure

On the menu bar, click System > System Settings.
On the Navigation pane, choose Port Tracking.
Enable port tracking by setting the Port tracking state to on.
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Step 4
Step 5
Step 6

Provisioning Global Fabric Access Policies .

(Optional) Change the Daily restore timer value.
Configure the Number of active spine links that triggers port tracking parameter.
Click Submit.

Provisioning Global Fabric Access Policies

Create a Global Attachable Access Entity Profile

Step 1
Step 2
Step 3
Step 4
Step 5

An Attachable Entity Profile (AEP) represents a group of external entities with similar infrastructure policy
requirements. The infrastructure policies consist of physical interface policies that configure various protocol
options, such as Cisco Discovery Protocol (CDP), Link Layer Discovery Protocol (LLDP), or Link Aggregation
Control Protocol (LACP).

An AEP is required to deploy VLAN pools on leaf switches. Encapsulation blocks (and associated VLANSs)
are reusable across leaf switches. An AEP implicitly provides the scope of the VLAN pool to the physical
infrastructure.

The following AEP requirements and dependencies must be accounted for in various configuration scenarios,
including network connectivity, VMM domains, and multipod configuration:

» The AEP defines the range of allowed VLANSs but it does not provision them. No traffic flows unless
an EPG is deployed on the port. Without defining a VLAN pool in an AEP, a VLAN is not enabled on
the leaf port even if an EPG is provisioned.

* A particular VLAN is provisioned or enabled on the leaf port that is based on EPG events either statically
binding on a leaf port or based on VM events from external controllers such as VMware vCenter or
Microsoft Azure Service Center Virtual Machine Manager (SCVMM).

* Attached entity profiles can be associated directly with application EPGs, which deploy the associated
application EPGs to all those ports associated with the attached entity profile. The AEP has a configurable
generic function (infraGeneric), which contains a relation to an EPG (infraRsFuncToEpg) that is deployed
on all interfaces that are part of the selectors that are associated with the attachable entity profile.

A virtual machine manager (VMM) domain automatically derives physical interface policies from the interface
policy groups of an AEP.

Before you begin

Create the tenant, VRF instance, application profiles, and EPGs to associate to the attached entity profile.

Procedure

On the menu bar, click Fabric > Access Policies.

On the navigation bar, expand Policies and Global.

Right-click Attachable Access Entity Profile and choose Create Attachable Access Entity Profile.
Enter a name for the policy.

Click the + icon on Domains table.
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Step 6

Step 7
Step 8
Step 9

Step 10
Step 11
Step 12
Step 13

Enter a physical domain, a previously created physical, Layer 2, Layer 3, or Fibre Channel domain, or create
one.

Enter the encapsulation for the domain and click Update.
Click the + icon on the EPG DEPLOYMENT table.

Enter the tenant, application profile, EPG, encapsulation (such as vlan-1), primary encapsulation (primary
encapsulation number) and interface mode (trunk, Access (802.1P, or Access (Untagged).

Click Update.

Click Next.

Choose the interfaces to associate to the attachable entity profile.
Click Finish.

Configure the Global QoS Class Policy

Step 1
Step 2
Step 3
Step 4
Step 5

The global QoS Class policy can be used to:

* Preserve the CoS priority level, to guarantee that the CoS value in 802.1P packets which enter and transit
the ACI fabric is preserved. 802.1P CoS preservation is supported in single pod and multipod topologies.
In multipod topologies, CoS Preservation can be used where you want to preserve the QoS priority
settings of 802.1P traffic entering POD 1 and egressing out of POD 2, but you are not concerned with
preserving the CoS/DSCP settings in interpod network (IPN) traffic between the pods. To preserve
CoS/DSCP settings when multipod traffic is transitting an IPN, use a DSCP policy (configured at
Tenants > infra> > Policies > Protocol > DSCP class-cos translation policy for L3 traffic)

* Reset the properties for the default QoS class levels, such as the MTU, Queue Limit, or Scheduling
Algorithm.

Procedure

On the menu bar, click Fabric > External Access Policies.

On the navigation bar, expand Policies and Global.

Click QOS Class.

To enable 802.1P CoS preservation, click the Preserve COS check box.

To change the default settings for a QoS class, double-click on it. Enter the new settings and click Submit.

Create a Global DHCP Relay Policy

Step 1
Step 2

The global DHCP Relay policy identifies the DHCP Server for the fabric.

Procedure

On the menu bar, click Fabric > External Access Policies.
On the navigation bar, expand Policies and Global.
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Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Enable a Global MCP Instance Policy .

Right-click DHCP Relay and choose Create DHCP Relay Policy.
Enter a name for the policy.
Click the + icon on Providers.

Choose the EPG type, and for an application EPG, choose the tenant, application profile, and the EPG to be
the provider.

In the DHCP Server Address field, enter the IP address for the server.
Click OK.

Enable a Global MCP Instance Policy

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Enable a global Mis-Cabling Protocol (MCP) instance policy. In the current implementation, only one instance
of MCP runs in the system.

Procedure

On the menu bar, click Fabric > External Access Policies.
On the navigation bar, expand Policies and Global.

Click MCP Instance Policy default.

Change the Admin State to Enabled.

Set other properties as needed for your fabric.

Click Submit.

What to do next

Create an Error Disabled Recovery Policy

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

The error disabled recovery policy specifies the policy for re-enabling a port that was disabled due to one or
more pre-defined error conditions.

Procedure

On the menu bar, click Fabric > External Access Policies.
On the navigation bar, expand Policies and Global.

Click Error Disabled Recovery Policy..

Double-click on an event to enable it for the recovery policy.
Click the check box and click Update.

Optional. Repeat steps 4 and 5 for more events.

Optional. Reset the Error disable recovery interval (sec).
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Click Submit.

Per Port Policies

About Per Port Policies

A per port policy is an implicit policy that you use to configure the interfaces of a leaf switch using the Cisco
Application Policy Infrastructure Controller (APIC) GUI. A per port policy is simplified compared to the
standard policy-based model, which is useful when you are still learning how to use the Cisco APIC. Due to
this simplification, you cannot add new ports to an existing policy. Instead, you can only create new chunks
of a policy per interface.

The per port policy pane uses the NX-OS CLI in the background to create implicit and explicit objects. For
example, creating a new port channel creates an explicit port channel policy group as well as an implicit
override. Making any changes to an explicit policy group will not apply to port until the implicit policy group
is removed. We recommend that you do not mix using the CLI and GUI. Use the per port policy wizard to
learn about the Cisco Application Centric Infrastructure (ACI) policy model and unconfigure the port from
the same wizard when you want to move to advanced use cases for reusable policy configurations.

You can create a per port policy only from the following GUI location:

Fabric > Inventory > Pod-# > |eaf-switch-name > Interface tab

\Y

Note

pane.

Interface tab refers to the Interface tab in the work pane. This is not the Interfaces folder in the navigation

Configuring a Per Port Policy Using the GUI

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

This procedure configures a per port policy using the Cisco Application Policy Infrastructure Controller
(APIC) GUL

Procedure

On the menu bar, choose Fabric > Inventory.

In the Navigation pane, choose pod-# > |eaf-switch-name.
In the Work pane, choose the Interface tab.

In the Mode drop-down list, choose Configuration.

Click on one or more of the interface numbers to select those interfaces.

The buttons just under the tabs of the Work pane become active for any of the components that you can
configure for the selected interfaces.

Click the button for one of the components that you want to configure.

The Work pane displays the properties for that component.
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Step 7
Step 8
Step 9

Validating a Per Port Policy Using the GUI .

Set the properties as desired for the component.
Click Submit.

Configure any additional components for the selected interfaces, or select different interfaces and configure
the components.

Validating a Per Port Policy Using the GUI

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Step 8

This procedure instructs you on how to validate a per port policy using the Cisco Application Policy
Infrastructure Controller (APIC) GUI.

Before you begin

You must configure the Cisco APIC to show hidden policies. By default, the per port policies are hidden in
the Cisco APIC.

Procedure

On the menu bar, choose Fabric > Inventory.

In the Navigation pane, choose pod-# > |eaf-switch-name.
In the Work pane, choose the Interface tab.

In the Mode drop-down list, choose Configuration.

Click on an interface numbers to select that interface.

The buttons just under the tabs of the Work pane become active for any of the components that you can
configure for the selected interface.

Click the button for one of the components for which you want to view the properties.

The Work pane displays the properties for that component.

Verify that the properties are set correctly, and change any values that are not correct for your desired
configuration.

If you made any changes, click Submit. Otherwise, click Cancel.

Showing the Hidden Policies Using the GUI

Step 1

By default, some policies, such as per port policies, are hidden in the Cisco Application Policy Infrastructure
Controller (APIC). If you want to view these policies, you must configure the Cisco APIC to show hidden
policies.

Procedure

In the upper right corner of the GUI, choose Manage My Profile > Settings.
The Application Settings dialog opens.
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Step 2 Put a check in the Show Hidden Policies box.
Step 3 Click OK.
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CHAPTER 7

Basic User Tenant Configuration

This chapter contains the following sections:

* Tenants, on page 135

* Routing Within the Tenant, on page 136

* Creating Tenants, VRFs, and Bridge Domains, on page 147
* Deploying EPGs, on page 149

* Microsegmented EPGs, on page 159

* Deploying Application Profiles and Contracts, on page 169
* Optimize Contract Performance, on page 185

* Contract and Subject Exceptions, on page 188

* Intra-EPG Contracts, on page 192

* EPG Contract Inheritance, on page 199

* Contract Preferred Groups, on page 216

* Contracts with Permit and Deny Rules, on page 222

A tenant (fvTenant) is a logical container for application policies that enable an administrator to exercise
domain-based access control. A tenant represents a unit of isolation from a policy perspective, but it does not
represent a private network. Tenants can represent a customer in a service provider setting, an organization
or domain in an enterprise setting, or just a convenient grouping of policies. The following figure provides
an overview of the tenant portion of the management information tree (MIT).
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Figure 1: Tenants
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Tenants can be isolated from one another or can share resources. The primary elements that the tenant contains
are filters, contracts, outside networks, bridge domains, Virtual Routing and Forwarding (VRF) instances,
and application profiles that contain endpoint groups (EPGs). Entities in the tenant inherit its policies. VRFs
are also known as contexts; each VRF can be associated with multiple bridge domains.

\}

Note In the APIC GUI under the tenant navigation path, a VRF (context) is called a private network.

Tenants are logical containers for application policies. The fabric can contain multiple tenants. You must
configure a tenant before you can deploy any Layer 4 to Layer 7 services. The ACI fabric supports IPv4, IPv6,
and dual-stack configurations for tenant networking.

Routing Within the Tenant

The Application Centric Infrastructure (ACI) fabric provides tenant default gateway functionality and routes
between the fabric virtual extensible local area (VXLAN) networks. For each tenant, the fabric provides a
virtual default gateway or Switched Virtual Interface (SVI) whenever a subnet is created on the APIC. This
spans any switch that has a connected endpoint for that tenant subnet. Each ingress interface supports the
default gateway interface and all of the ingress interfaces across the fabric share the same router IP address
and MAC address for a given tenant subnet.
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Layer 3 VNIDs Facilitate Transporting Inter-subnet Tenant Traffic

The ACI fabric provides tenant default gateway functionality that routes between the ACI fabric VXLAN
networks. For each tenant, the fabric provides a virtual default gateway that spans all of the leaf switches
assigned to the tenant. It does this at the ingress interface of the first leaf switch connected to the endpoint.
Each ingress interface supports the default gateway interface. All of the ingress interfaces across the fabric
share the same router IP address and MAC address for a given tenant subnet.

The ACI fabric decouples the tenant endpoint address, its identifier, from the location of the endpoint that is
defined by its locator or VXLAN tunnel endpoint (VTEP) address. Forwarding within the fabric is between
VTEPs. The following figure shows decoupled identity and location in ACI.

Figure 2: ACI Decouples Identity and Location
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VXLAN uses VTEP devices to map tenant end devices to VXLAN segments and to perform VXLAN
encapsulation and de-encapsulation. Each VTEP function has two interfaces:

* A switch interface on the local LAN segment to support local endpoint communication through bridging

* An IP interface to the transport IP network

The IP interface has a unique IP address that identifies the VTEP device on the transport IP network known
as the infrastructure VLAN. The VTEP device uses this IP address to encapsulate Ethernet frames and transmit
the encapsulated packets to the transport network through the IP interface. A VTEP device also discovers the
remote VTEPs for its VXLAN segments and learns remote MAC Address-to-VTEP mappings through its IP
interface.

The VTEP in ACI maps the internal tenant MAC or IP address to a location using a distributed mapping
database. After the VTEP completes a lookup, the VTEP sends the original data packet encapsulated in
VXLAN with the destination address of the VTEP on the destination leaf switch. The destination leaf switch
de-encapsulates the packet and sends it to the receiving host. With this model, ACI uses a full mesh, single
hop, loop-free topology without the need to use the spanning-tree protocol to prevent loops.

The VXLAN segments are independent of the underlying network topology; conversely, the underlying IP
network between VTEPs is independent of the VXLAN overlay. It routes the encapsulated packets based on
the outer IP address header, which has the initiating VTEP as the source IP address and the terminating VTEP
as the destination IP address.

The following figure shows how routing within the tenant is done.
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Figure 3: Layer 3 VNIDs Transport ACI Inter-subnet Tenant Traffic
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For each tenant VRF in the fabric, ACI assigns a single L3 VNID. ACI transports traffic across the fabric
according to the L3 VNID. At the egress leaf switch, ACI routes the packet from the L3 VNID to the VNID
of the egress subnet.

Traffic arriving at the fabric ingress that is sent to the ACI fabric default gateway is routed into the Layer 3
VNID. This provides very efficient forwarding in the fabric for traffic routed within the tenant. For example,
with this model, traffic between 2 VMs belonging to the same tenant, on the same physical host, but on
different subnets, only needs to travel to the ingress switch interface before being routed (using the minimal
path cost) to the correct destination.

To distribute external routes within the fabric, ACI route reflectors use multiprotocol BGP (MP-BGP). The
fabric administrator provides the autonomous system (AS) number and specifies the spine switches that
become route reflectors.

Router Peering and Route Distribution

As shown in the figure below, when the routing peer model is used, the leaf switch interface is statically
configured to peer with the external router’s routing protocol.
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Bridged Interface to an External Router .

Figure 4: Router Peering
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The routes that are learned through peering are sent to the spine switches. The spine switches act as route
reflectors and distribute the external routes to all of the leaf switches that have interfaces that belong to the
same tenant. These routes are longest prefix match (LPM) summarized addresses and are placed in the leaf
switch's forwarding table with the VTEP IP address of the remote leaf switch where the external router is
connected. WAN routes have no forwarding proxy. If the WAN routes do not fit in the leaf switch's forwarding
table, the traffic is dropped. Because the external router is not the default gateway, packets from the tenant
endpoints (EPs) are sent to the default gateway in the ACI fabric.

348520

Bridged Interface to an External Router

As shown in the figure below, when the leaf switch interface is configured as a bridged interface, the default
gateway for the tenant VNID is the external router.
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Figure 5: Bridged External Router
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The ACI fabric is unaware of the presence of the external router and the APIC statically assigns the leaf switch
interface to its EPG.

Configuring Route Reflectors

ACI fabric route reflectors use multiprotocol BGP (MP-BGP) to distribute external routes within the fabric.
To enable route reflectors in the ACI fabric, the fabric administrator must select the spine switches that will
be the route reflectors, and provide the autonomous system (AS) number. It is recommended to configure at
least two spine nodes per pod as MP-BGP route reflectors for redundancy.

After route reflectors are enabled in the ACI fabric, administrators can configure connectivity to external
networks through leaf nodes using a component called Layer 3 Out (L3Out). A leaf node configured with an
L3Out is called a border leaf. The border leaf exchanges routes with a connected external device via a routing
protocol specified in the L3Out. You can also configure static routes via L3Outs.

After both L3Outs and spine route reflectors are deployed, border leaf nodes learn external routes via L3Outs,
and those external routes are distributed to all leaf nodes in the fabric via spine MP-BGP route reflectors.

Check the Verified Scalability Guide for Cisco APIC for your release to find the maximum number of routes
supported by a leaf.
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Configuring External Connectivity Using a Layer 3 Qut

This section provides a step-by-step configuration required for the ACI fabric to connect to an external routed
network through L3Outs and MP-BGP route reflectors.

This example uses Open Shortest Path First (OSPF) as the routing protocol in an L30ut under the 'mgmt'
tenant.

Configuring an MP-BGP Route Reflector Using the GUI

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6
Step 7
Step 8

Step 9

Procedure

On the menu bar, choose System > System Settings.

In the Navigation pane, right-click BGP Route Reflector, and click Create Route Reflector Node Policy
EP.

In the Create Route Reflector Node Policy EP dialog box, from the Spine Node drop-down list, choose the
appropriate spine node. Click Submit.

Note Repeat the above steps to add additional spine nodes as required.

The spine switch is marked as the route reflector node.
In the BGP Route Reflector properties area, in the Autonomous System Number field, choose the appropriate
number. Click Submit.

Note The autonomous system number must match the leaf connected router configuration if Border
Gateway Protocol (BGP) is configured on the router. If you are using routes learned using static
or Open Shortest Path First (OSPF), the autonomous system number value can be any valid value.

On the menu bar, choose Fabric > Fabric Policies > POD Policies.
In the Navigation pane, expand and right-click Policy Groups, and click Create POD Policy Group.
In the Create POD Policy Group dialog box, in the Name field, enter the name of a pod policy group.

In the BGP Route Reflector Policy drop-down list, choose the appropriate policy (default). Click Submit.
The BGP route reflector policy is associated with the route reflector pod policy group, and the BGP process
is enabled on the leaf switches.

In the Navigation pane, choose Pod Policies > Profiles > default. In the Work pane, from the Fabric Policy
Group drop-down list, choose the pod policy that was created earlier. Click Submit.
The pod policy group is now applied to the fabric policy group.

Configuring an MP-BGP Route Reflector for the ACI Fabric

To distribute routes within the ACI fabric, an MP-BGP process must first be operating, and the spine switches
must be configured as BGP route reflectors.

The following is an example of an MP-BGP route reflector configuration:
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\)

Note In this example, the BGP fabric ASN is 100. Spine switches 104 and 105 are chosen as MP-BGP
route-reflectors.

apicl (config) # bgp-fabric
apicl (config-bgp-fabric)# asn 100
apicl (config-bgp-fabric) # route-reflector spine 104,105

Configuring an MP-BGP Route Reflector Using the REST API

Procedure

Step 1 Mark the spine switches as route reflectors.

Example:
POST https://apic-ip-address/api/policymgr/mo/uni/fabric.xml

<bgpInstPol name="default">
<bgpAsP asn="1" />
<bgpRRP>
<bgpRRNodePEp id=“<spine id1>"/>
<bgpRRNodePEp id=“<spine id2>"/>
</bgpRRP>
</bgpInstPol>

Step 2 Set up the pod selector using the following post.

Example:
For the FuncP setup—

POST https://apic-ip-address/api/policymgr/mo/uni.xml

<fabricFuncP>
<fabricPodPGrp name="bgpRRPodGrp”>
<fabricRsPodPGrpBGPRRP tnBgpInstPolName="default" />
</fabricPodPGrp>
</fabricFuncP>

Example:
For the PodP setup—

POST https://apic-ip-address/api/policymgr/mo/uni.xml

<fabricPodP name="default">
<fabricPodS name="default" type="ALL">
<fabricRsPodPGrp tDn="uni/fabric/funcprof/podpgrp-bgpRRPodGrp"/>
</fabricPodS>
</fabricPodP>
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Verifying the MP-BGP Route Reflector Configuration

Step 1

Step 2

Procedure

Verify the configuration by performing the following actions:
a) Use secure shell (SSH) to log in as an administrator to each leaf switch as required.
b) Enter the show processes | grep bgp command to verify the state is S.

If the state is NR (not running), the configuration was not successful.

Verify that the autonomous system number is configured in the spine switches by performing the following
actions:

a) Use the SSH to log in as an administrator to each spine switch as required.
b) Execute the following commands from the shell window

Example:

cd /mit/sys/bgp/inst

Example:
grep asn summary

The configured autonomous system number must be displayed. If the autonomous system number value
displays as 0, the configuration was not successful.

Creating an OSPF L30ut for Management Tenant Using the GUI

Step 1
Step 2
Step 3

Step 4

* You must verify that the router ID and the logical interface profile IP address are different and do not
overlap.

* The following steps are for creating an OSPF L3Out for a management tenant. To create an OSPF L3Out
for a tenant, you must choose a tenant and create a VRF for the tenant.

* For more details, see Cisco APIC and Transit Routing.

Procedure

On the menu bar, choose Tenants > mgmt.
In the Navigation pane, expand Networking > L30uts.
Right-click L30Outs, and click Create L3Out.

The Create L30Out wizard appears.

In the Identity window in the Create L30Out wizard, perform the following actions:
a) Inthe Name field, enter a name (RtdOut).
b) In the VRF field, from the drop-down list, choose the VRF (inb).

Note This step associates the routed outside with the in-band VRF.
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c)
d)

e)

2)
h)

From the L3 Domain drop-down list, choose the appropriate domain.
Check the OSPF check box.

In the OSPF Area ID field, enter an area ID.

In the OSPF Area Control field, check the appropriate check box.
In the OSPF Area Type field, choose the appropriate area type.

In the OSPF Area Cost field, choose the appropriate value.

Click Next.

The Nodes and Interfaces window appears.

Step 5 In the Nodes and Interfaces window, perform the following actions:

a)

b)
<)
d)
e)

2)

h)
i)
)

k)

)

Uncheck the Use Defaults box.
This allows you to edit the Node Profile Name field.

In the Node Profile Name field, enter a name for the node profile. (borderLeaf).
In the Node ID field, from the drop-down list, choose the first node. (leafl).
In the Router ID field, enter a unique router ID.

In the Loopback Address field, use a different IP address or leave this field empty if you do not want to
use the router ID for the loopback address.

Note The Loopback Address field is automatically populated with the same entry that you provide
in the Router ID field. This is the equivalent of the Use Router 1D for Loopback Address
option in previous builds. Use a different IP address or leave this field empty if you do not
want to use the router ID for the loopback address.

Enter the appropriate information in the Interface, IP Address, Interface Profile Name and MTU fields
for this node, if necessary.

In the Nodes field, click + icon to add a second set of fields for another node.

Note You are adding a second node ID.

In the Node ID field, from the drop-down list, choose the first node. (leafl).
In the Router ID field, enter a unique router ID.

In the Loopback Address field, use a different IP address or leave this field empty if you do not want to
use the router ID for the loopback address.

Note The Loopback Address field is automatically populated with the same entry that you provide
in the Router ID field. This is the equivalent of the Use Router ID for Loopback Address
option in previous builds. Use a different IP address or leave this field empty if you do not
want to use the router ID for the loopback address.

Enter the appropriate information in the Interface, IP Address, Interface Profile Name and MTU fields
for this node, if necessary.

Click Next.

The Protocols window appears.

Step 6 In the Protocols window, in the Policy area, click default, then click Next.

The External EPG window appears.

Step 7 In the External EPG window, perform the following actions:
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a) Inthe Name field, enter a name for the external network (extMgmt).
b) Uncheck the Default EPG for all external networks field.

The Subnets area appears.

¢) Click + to access the Create Subnet dialog box.

d) In the Create Subnet dialog box, in the IP address field, enter an IP address and mask for the subnet.
e) Inthe Scope field, check the desired check boxes. Click OK.

f) In the External EPG dialog box, click Finish.

Note In the Work pane, in the L30Outs area, the L30ut icon (RtdOut) is now displayed.

Creating an OSPF External Routed Network for a Tenant Using the NX-0S CLI

Step 1

Step 2

Configuring external routed network connectivity involves the following steps:

1. Create a VRF under Tenant.

2. Configure L3 networking configuration for the VRF on the border leaf switches, which are connected to
the external routed network. This configuration includes interfaces, routing protocols (BGP, OSPF,
EIGRP), protocol parameters, route-maps.

3. Configure policies by creating external-L3 EPGs under tenant and deploy these EPGs on the border leaf
switches. External routed subnets on a VRF which share the same policy within the ACI fabric form one
"External L3 EPG" or one "prefix EPG".

Configuration is realized in two modes:
* Tenant mode: VRF creation and external-L3 EPG configuration

* Leaf mode: L3 networking configuration and external-L3 EPG deployment

The following steps are for creating an OSPF external routed network for a tenant. To create an OSPF external
routed network for a tenant, you must choose a tenant and then create a VRF for the tenant.

\)

Note The examples in this section show how to provide external routed connectivity to the "web" epg in the

"OnlineStore" application for tenant "exampleCorp".

Procedure

Configure the VLAN domain.

Example:

apicl (config)# vlan-domain dom exampleCorp
apicl (config-vlan)# vlan 5-1000
apicl (config-vlan) # exit

Configure the tenant VRF and enable policy enforcement on the VRF.
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Example:

apicl (config) # tenant exampleCorp

apicl (config-tenant)# vrf context
exampleCorp_vl

apicl (config-tenant-vrf) # contract enforce
apicl (config-tenant-vrf) # exit

Configure the tenant BD and mark the gateway IP as “public”. The entry "scope public" makes this gateway
address available for advertisement through the routing protocol for external-L3 network.

Example:

apicl
apicl
apicl
apicl
apicl
apicl

config-tenant) # bridge-domain exampleCorp bl
config-tenant-bd)# vrf member exampleCorp vl
config-tenant-bd) # exit

config-tenant) # interface bridge-domain exampleCorp bl
config-tenant-interface)# ip address 172.1.1.1/24 scope public
config-tenant-interface)# exit

Configure the VRF on a leaf.

Example:

apicl (config)# leaf 101
apicl (config-leaf)# vrf context tenant exampleCorp vrf exampleCorp vl

Configure the OSPF area and add the route map.

Example:

apicl (config-leaf) # router ospf default

apicl (config-leaf-ospf)# vrf member tenant exampleCorp vrf exampleCorp vl
apicl (config-leaf-ospf-vrf)# area 0.0.0.1 route-map maplO0 out

apicl (config-leaf-ospf-vrf)# exit

apicl (config-leaf-ospf) # exit

Assign the VRF to the interface (sub-interface in this example) and enable the OSPF area.

Example:

Note For the sub-interface configuration, the main interface (ethernet 1/11 in this example) must be
converted to an L3 port through “no switchport” and assigned a vlan-domain (dom_exampleCorp
in this example) that contains the encapsulation VLAN used by the sub-interface. In the
sub-interface ethernet1/11.500, 500 is the encapsulation VLAN.

config-leaf)# interface ethernet 1/11

config-leaf-if)# no switchport

config-leaf-if)# vlan-domain member dom exampleCorp
config-leaf-if)# exit

config-leaf)# interface ethernet 1/11.500

config-leaf-if)# vrf member tenant exampleCorp vrf exampleCorp vl
config-leaf-if)# ip address 157.10.1.1/24

config-leaf-if)# ip router ospf default area 0.0.0.1

apicl
apicl
apicl
apicl
apicl
apicl
apicl
apicl

Configure the external-L3 EPG policy. This includes the subnet to match for identifying the external subnet
and consuming the contract to connect with the epg "web".

Example:
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apicl (config)# tenant tl100

apicl (config-tenant)# external-13 epg 13epgl00

apicl (config-tenant-13ext-epg)# vrf member v100

apicl (config-tenant-13ext-epqg) # match ip 145.10.1.0/24
apicl (config-tenant-13ext-epg)# contract consumer web
apicl (config-tenant-13ext-epg) # exit

apicl (config-tenant) fexit

Step 8 Deploy the external-L3 EPG on the leaf switch.

Example:

apicl (config)# leaf 101
apicl (config-leaf)# vrf context tenant t100 vrf v100
apicl (config-leaf-vrf)# external-13 epg 13epgl00

Creating Tenants, VRFs, and Bridge Domains

Tenants Overview

* A tenant contains policies that enable qualified users domain-based access control. Qualified users can
access privileges such as tenant administration and networking administration.

* A user requires read/write privileges for accessing and configuring policies in a domain. A tenant user
can have specific privileges into one or more domains.

* In a multitenancy environment, a tenant provides group user access privileges so that resources are
isolated from one another (such as for endpoint groups and networking). These privileges also enable
different users to manage different tenants.

Tenant Creation

A tenant contains primary elements such as filters, contracts, bridge domains, and application profiles that
you can create after you first create a tenant.

VRF and Bridge Domains

You can create and specify a VRF and a bridge domain for the tenant. The defined bridge domain element
subnets reference a corresponding Layer 3 context.

For details about enabling IPv6 Neighbor Discovery seel Pv6 and Neighbor Discovery in Cisco APIC Layer
3 Networking Guide.

Creating a Tenant, VRF, and Bridge Domain Using the GUI

If you have a public subnet when you configure the routed outside, you must associate the bridge domain
with the outside configuration.
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Step 1
Step 2

Step 3

Step 4

Step 5

Procedure

On the menu bar, choose Tenants > Add Tenant.
In the Create Tenant dialog box, perform the following tasks:

a)
b)
c)
d)

In the Name field, enter a name.
Click the Security Domains + icon to open the Create Security Domain dialog box.
In the Name field, enter a name for the security domain. Click Submit.

In the Create Tenant dialog box, check the check box for the security domain that you created, and click
Submit.

In the Navigation pane, expand Tenant-name > Networking, and in the Work pane, drag the VRF icon to
the canvas to open the Create VRF dialog box, and perform the following tasks:

a)
b)

In the Name field, enter a name.
Click Submit to complete the VRF configuration.

In the Networking pane, drag the BD icon to the canvas while connecting it to the VRF icon. In the Create
Bridge Domain dialog box that displays, perform the following tasks:

a)
b)

¢)

d)

In the Name field, enter a name.
Click the L3 Configurations tab.

Expand Subnets to open the Create Subnet dialog box, enter the subnet mask in the Gateway IP field
and click OK.

Click Submit to complete bridge domain configuration.

In the Networks pane, drag the L3 icon down to the canvas while connecting it to the VRF icon. In the Create
Routed Outside dialog box that displays, perform the following tasks:

a)
b)
c)
d)
e)
f)
g)
h)
i)
J)
k)
)

m)

In the Name field, enter a name.

Expand Nodes And Interfaces Protocol Profiles to open the Create Node Profile dialog box.
In the Name field, enter a name.

Expand Nodes to open the Select Node dialog box.

In the Node ID field, choose a node from the drop-down list.

In the Router ID field, enter the router ID.

Expand Static Routes to open the Create Static Route dialog box.

In the Prefix field, enter the IPv4 or IPv6 address.

Expand Next Hop Addresses and in the Next Hop IP field, enter the IPv4 or IPv6 address.
In the Preference field, enter a number, then click UPDATE and then OK.

In the Select Node dialog box, click OK.

In the Create Node Profile dialog box, click OK.

Check the BGP, OSPF, or EIGRP check boxes if desired, and click NEXT. Click OK to complete the
Layer 3 configuration.

To confirm L3 configuration, in the Navigation pane, expand Networking > VRFs.
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Deploying EPGs

Statically Deploying an EPG on a Specific Port

This topic provides a typical example of how to statically deploy an EPG on a specific port when using Cisco
APIC.

Deploying an EPG on a Specific Node or Port Using the GUI

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Step 7

Before you begin
The tenant where you deploy the EPG is already created.

You can create an EPG on a specific node or a specific port on a node.

Procedure

Log in to the Cisco APIC.

Choose Tenants > tenant .

In the left navigation pane, expand tenant , Application Profiles, and the application profile.
Right-click Application EPGs and choose Create Application EPG.

In the Create Application EPG STEP 1 > Identity dialog box, complete the following steps:
a) In the Name field, enter a name for the EPG.

b) From the Bridge Domain drop-down list, choose a bridge domain.

¢) Check the Statically Link with Leaves/Paths check box.

This check box allows you to specify on which port you want to deploy the EPG.

d) Click Next.
e) From the Path drop-down list, choose the static path to the destination EPG.

In the Create Application EPG STEP 2 > Leaves/Paths dialog box, from the Physical Domain drop-down
list, choose a physical domain.

Complete one of the following sets of steps:

Option Description

If you want to deploy | Then

the EPG on...

A node a. Expand the Leaves area.

b. From the Node drop-down list, choose a node.
c. Inthe Encap field, enter the appropriate VLAN.

d. (Optional) From the Deployment Immediacy drop-down list, accept the default
On Demand or choose Immediate.
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Option Description

e. (Optional) From the Mode drop-down list, accept the default Trunk or choose
another mode.

A port on the node a. Expand the Paths area.
b. From the Path drop-down list, choose the appropriate node and port.

c. (Optional) In the Deployment Immediacy field drop-down list, accept the
default On Demand or choose Immediate.

d. (Optional) From the Mode drop-down list, accept the default Trunk or choose
another mode.

e. Inthe Port Encap field, enter the secondary VLAN to be deployed.
f. (Optional) In the Primary Encap field, enter the primary VLAN to be deployed.

Step 8 Click Update and click Finish.
Step 9 In the left navigation pane, expand the EPG that you created.
Step 10 Complete one of the following actions:

« If you created the EPG on a node, click Static Leafs, and in the work pane view details of the static
binding paths.

* If you created the EPG on a port of the node, click Static Ports, and in the work pane view details of
the static binding paths.

Deploying an EPG on a Specific Port with APIC Using the NX-0S Style CLI

This procedure deploys an EPG on a specific port with Cisco Application Policy Infrastructure Controller
(APIC) using the NX-OS-style CLI.

)

Note Do not mix using the GUI and the CLI when configuring per-interface on the Cisco APIC. Configurations
that you perform in the GUI might only partially work in the NX-OS-style CLI.

Procedure

Step 1 Configure a VLAN domain:

Example:

apicl (config)# vlan-domain doml
apicl (config-vlan)# wvlan 10-100

Step 2 Create a tenant:

Example:
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Step 3

Step 4

Step 5

Step 6

Deploying an EPG on a Specific Port with APIC Using the REST API .

apicl# configure
apicl (config)# tenant tl

Create a private network/VRF instance:

Example:

apicl (config-tenant)# vrf context ctxl
apicl (config-tenant-vrf) # exit

Create a bridge domain:

Example:

apicl (config-tenant) # bridge-domain bdl
apicl (config-tenant-bd) # vrf member ctxl
apicl (config-tenant-bd) # exit

Create an application profile and an application EPG:

Example:

apicl
apicl
apicl
apicl
apicl
apicl

config-tenant) # application APl
config-tenant-app) # epg EPG1l
config-tenant-app-epg) # bridge-domain member bdl
config-tenant-app-epg) # exit

config-tenant-app) # exit

config-tenant) # exit

Associate the EPG with a specific port:

Example:

apicl (config)# leaf 1017

apicl (config-leaf) # interface ethernet 1/13

apicl (config-leaf-if)# vlan-domain member doml

apicl (config-leaf-if)# switchport trunk allowed vlan 20 tenant tl application APl epg EPG1l

Note The vlan-domain and vlan-domain member commands in the example are a prerequisite for
deploying an EPG on a port.

Deploying an EPG on a Specific Port with APIC Using the REST API

Before you begin

The tenant where you deploy the EPG is created.

Procedure

Deploy an EPG on a specific port.

Example:
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<fvTenant name="<tenant name>" dn="uni/tn-testl" >
<fvCtx name="<network name>" pcEnfPref="enforced" knwMcastAct="permit"/>
<fvBD name="<bridge domain name>" unkMcastAct="flood" >
<fvRsCtx tnFvCtxName="<network name>"/>
</fvBD>
<fvAp name="<application profile>" >
<fvAEPg name="<epg name>" >
<fvRsPathAtt tDn="topology/pod-1/paths-1017/pathep-[ethl/13]" mode="regular"
instrImedcy="immediate" encap="vlan-20"/>
</fvAEPg>
</fvAp>
</fvTenant>

Creating Domains, Attach Entity Profiles, and VLANs to Deploy an EPG on a
Specific Port

This topic provides a typical example of how to create physical domains, Attach Entity Profiles (AEP), and
VLANS that are mandatory to deploy an EPG on a specific port.

All endpoint groups (EPGs) require a domain. Interface policy groups must also be associated with Attach
Entity Profile (AEP), and the AEP must be associated with a domain, if the AEP and EPG have to be in same
domain. Based on the association of EPGs to domains and of interface policy groups to domains, the ports
and VLANSs that the EPG uses are validated. The following domain types associate with EPGs:

* Application EPGs

* Layer 3 external outside network instance EPGs

* Layer 2 external outside network instance EPGs

* Management EPGs for out-of-band and in-band access
The APIC checks if an EPG is associated with one or more of these types of domains. If the EPG is not
associated, the system accepts the configuration but raises a fault. The deployed configuration may not function

properly if the domain association is not valid. For example, if the VLAN encapsulation is not valid for use
with the EPG, the deployed configuration may not function properly.

)

Note EPG association with the AEP without static binding does not work in a scenario when you configure the
EPG as Trunk under the AEP with one end point under the same EPG supporting Tagging and the other end
point in the same EPG does not support VLAN tagging. While associating AEP under the EPG, you can
configure it as Trunk, Access (Tagged) or Access (Untagged).

Creating Domains, and VLANS to Deploy an EPG on a Specific Port Using the GUI

Before you begin

* The tenant where you deploy the EPG is already created.

* An EPQG is statically deployed on a specific port.
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Step 1
Step 2
Step 3
Step 4

Step 5

Creating Domains, and VLANS to Deploy an EPG on a Specific Port Using the GUI .

Procedure

On the menu bar, click Fabric > Access Policies.
In the Navigation pane, click Quick Start.
In the Work pane, click Configure an Interface, PC, and vPC.

In the Configure an Interface, PC, and vPC dialog box, click the + icon to select switches and perform the
following actions:

a)
b)

¢)
d)
e)

2)
h)

i)
)
k)
1)

From the Switches drop-down list, check the check box for the desired switch.
In the Switch Profile Name field, a switch name is automatically populated.

Note Optionally, you can enter a modified name.

Click the + icon to configure the switch interfaces.

In the Interface Type field, click the Individual radio button.

In the Interfaces field, enter the range of desired interfaces.

In the Interface Selector Name field, an interface name is automatically populated.

Note Optionally, you can enter a modified name.

In the Interface Policy Group field, choose the Create One radio button.
From the Link Level Policy drop-down list, choose the appropriate link level policy.

Note Create additional policies as desired, otherwise the default policy settings are available.

From the Attached Device Type field, choose the appropriate device type.
In the Domain field, click the Create One radio button.

In the Domain Name field, enter a domain name.

In the VLAN field, click the Create One radio button.

m) In the VLAN Range field, enter the desired VLAN range. Click Save, and click Save again.

n)

Click Submit.

On the menu bar, click Tenants. In the Navigation pane, expand the appropriate Tenant_name > Application
Profiles > Application EPGs > EPG_name and perform the following actions:

a)
b)

<)

Right-click Domains (VMs and Bare-Metals), and click Add Physical Domain Association.

In the Add Physical Domain Association dialog box, from the Physical Domain Profile drop-down list,
choose the appropriate domain.

Click Submit.

The AEP is associated with a specific port on a node and with a domain. The physical domain is associated
with the VLAN pool and the Tenant is associated with this physical domain.

The switch profile and the interface profile are created. The policy group is created in the port block under
the interface profile. The AEP is automatically created, and it is associated with the port block and with the
domain. The domain is associated with the VLAN pool and the Tenant is associated with the domain.
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Creating AEP, Domains, and VLANSs to Deploy an EPG on a Specific Port Using the NX-0S Style

CLI

Step 1

Step 2

Step 3

Step 4

Before you begin

* The tenant where you deploy the EPG is already created.

» An EPG is statically deployed on a specific port.

Procedure

Create a VLAN domain and assign VLAN ranges:

Example:

apicl (config)# vlan-domain domP
apicl (config-vlan) # vlan 10
apicl (config-vlan) # vlan 25
apicl (config-vlan)# vlan 50-60
apicl (config-vlan) # exit

Create an interface policy group and assign a VLAN domain to the policy group:

Example:

apicl (config) # template policy-group PortGroup
apicl (config-pol-grp-if)# vlan-domain member domP

Create a leaf interface profile, assign an interface policy group to the profile, and assign the interface IDs on
which the profile will be applied:

Example:

apicl (config)# leaf-interface-profile InterfaceProfilel
apicl (config-leaf-if-profile)# leaf-interface-group range
apicl (config-leaf-if-group)# policy-group PortGroup

apicl (config-leaf-if-group)# interface ethernet 1/11-13
apicl (config-leaf-if-profile)# exit

Create a leaf profile, assign the leaf interface profile to the leaf profile, and assign the leaf IDs on which the
profile will be applied:

Example:

apicl (config)# leaf-profile SwitchProfile-1019

apicl (config-leaf-profile)# leaf-interface-profile InterfaceProfilel
apicl (config-leaf-profile)# leaf-group range

apicl (config-leaf-group)# leaf 1019

apicl (config-leaf-group) #
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Creating AEP, Domains, and VLANSs to Deploy an EPG on a Specific Port Using the REST API

Before you begin

* The tenant where you deploy the EPG is already created.

» An EPG is statically deployed on a specific port.

Procedure

Step 1 Create the interface profile, switch profile and the Attach Entity Profile (AEP).

Example:

<infralInfra>

<infraNodeP name="<switch profile name>" dn="uni/infra/nprof-<switch profile name>"

>
<infralLeafS name="SwitchSeletor" descr="" type="range">
<infraNodeBlk name="nodeBlkl" descr="" to ="1019" from ="1019"/>
</infraLeafS>
<infraRsAccPortP tDn="uni/infra/accportprof-<interface profile name>"/>
</infraNodeP>

<infraAccPortP name="<interface profile name>"
dn="uni/infra/accportprof-<interface profile name>" >
<infraHPortS name="portSelector" type="range">
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accportgrp-<port group name>"
fexId="101"/>
<infraPortBlk name="block2" toPort="13" toCard="1" fromPort="11"
fromCard="1"/>
</infraHPortS>
</infraAccPortP>

<infraAccPortGrp name="<port group_ name>"
dn="uni/infra/funcprof/accportgrp-<port group name>" >
<infraRsAttEntP tDn="uni/infra/attentp-<attach entity profile name>"/>
<infraRsHIfPol tnFabricHIfPolName="1GHifPol"/>
</infraAccPortGrp>

<infraAttEntityP name="<attach entity profile name>"
dn="uni/infra/attentp-<attach entity profile name>" >
<infraRsDomP tDn="uni/phys-<physical domain name>"/>
</infraAttEntityP>

<infralInfra>

Step 2 Create a domain.

Example:

<physDomP name="<physical domain name>" dn="uni/phys-<physical domain name>">
<infraRsVlanNs tDn="uni/infra/vlanns-[<vlan pool name>]-static"/>
</physDomP>

Step 3 Create a VLAN range.

Example:

<fvnsVlanInstP name="<vlan pool name>" dn="uni/infra/vlanns-[<vlan pool name>]-static"
allocMode="static">
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<fvnsEncapBlk name="" descr="" to="vlan-25" from="vlan-10"/>
</fvnsVlanInstP>

Step 4 Associate the EPG with the domain.

Example:

<fvTenant name="<tenant name>" dn="uni/tn-" >
<fvAEPg prio="unspecified" name="<epg name>" matchT="AtleastOne"
dn="uni/tn-testl/ap-APl/epg-<epg name>" descr="">
<fvRsDomAtt tDn="uni/phys-<physical domain name>" instrImedcy="immediate"
resImedcy="immediate" />
</ fvAEPg>
</fvTenant>

Deploying an Application EPG through an AEP or Interface Policy Group to
Multiple Ports

Through the APIC Advanced GUI and REST API, you can associate attached entity profiles directly with
application EPGs. By doing so, you deploy the associated application EPGs to all those ports associated with
the attached entity profile in a single configuration.

Through the APIC REST API or the NX-OS style CLI, you can deploy an application EPG to multiple ports
through an Interface Policy Group.

Deploying an EPG through an AEP to Multiple Interfaces Using the APIC GUI

You can quickly associate an application with an attached entity profile to quickly deploy that EPG over all
the ports associated with that attached entity profile.

Before you begin

* The target application EPG is created.

» The VLAN pools has been created containing the range of VLANs you wish to use for EPG Deployment
on the AEP.

* The physical domain has been created and linked to the VLAN Pool and AEP.

* The target attached entity profile is created and is associated with the ports on which you want to deploy
the application EPG.

Procedure

Step 1 Navigate to the target attached entity profile.

a) Open the page for the attached entity profile to use. In the GUI, click Fabric > Access Policies > Policies >
Global > Attachable Access Entity Profiles.

b) Click the target attached entity profile to open its Attachable Access Entity Profile window.

Step 2 Click the Show Usage button to view the leaf switches and interfaces associated with this attached entity
profile.
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the application EPGs associated with this attached entity profile are deployed to all the ports on all the switches
associated with this attached entity profile.

Step 3 Use the Application EPGs table to associate the target application EPG with this attached entity profile. Click
+ to add an application EPG entry. Each entry contains the following fields:

Field Action
Application EPGs Use the drop down to choose the associated Tenant, Application Profile, and target
application EPG.
Encap Enter the name of the VLAN over which the target application EPG will
communicate.
Primary Encap If the application EPG requires a primary VLAN, enter the name of the primary
VLAN.
Mode Use the drop down to specify the mode in which data is transmitted:
* Trunk -- Choose if traffic from the host is tagged with a VLAN ID.
* Access -- Choose if traffic from the host is tagged with an 802.1p tag.
* Access Untagged -- Choose if the traffic from the host is untagged.

Step 4 Click Submit.
the application EPGs associated with this attached entity profile are deployed to all the ports on all the switches
associated with this attached entity profile.

Deploying an EPG through an Interface Policy Group to Multiple Interfaces Using the NX-0S Style
cu

In the NX-OS CLI, an attached entity profile is not explicitly defined to associate with an EPG for rapid
deployment; instead the interface policy group is defined, assigned a domain, applied to all the ports associated
with a VLAN and configured to include the application EPG to be deployed over that VLAN.

Before you begin

* The target application EPG is created.

» The VLAN pools has been created containing the range of VLANs you wish to use for EPG Deployment
on the AEP.

* The physical domain has been created and linked to the VLAN Pool and AEP.

* The target attached entity profile is created and is associated with the ports on which you want to deploy
the application EPG.

Procedure

Step 1 Associate the target EPG with the interface policy group.
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Step 2

The sample command sequence specifies an interface policy group pg3 associated with VLAN domain,
domainl, and with VLAN 1261. The application EPG, epg47 is deployed to all interfaces associated with
this policy group.

Example:

apicl# configure terminal

apicl (config) # template policy-group pg3

apicl (config-pol-grp-if) # vlan-domain member domainl

apicl (config-pol-grp-if)# switchport trunk allowed vlan 1261 tenant tnl0 application podl-AP

epg epgd’7

Check the target ports to ensure deployment of the policies of the interface policy group associated with
application EPG.

The output of the sample show command sequence indicates that policy group pg3 is deployed on Ethernet
port 1/20 on leaf switch 1017.

Example:

apicl# show run leaf 1017 int eth 1/20
# Command: show running-config leaf 1017 int eth 1/20
# Time: Mon Jun 27 22:12:10 2016
leaf 1017
interface ethernet 1/20
policy-group pg3
exit
exit
ifav28-ifcl#

Deploying an EPG through an AEP to Multiple Interfaces Using the REST API

The interface selectors in the AEP enable you to configure multiple paths for an AEPg. The following can be
selected:

1. A node or a group of nodes
2. Aninterface or a group of interfaces
The interfaces consume an interface policy group (and so an infra:AttEntity?P).
3. The infra: AttEntityP is associated to the AEPg, thus specifying the VLANS to use.
An infra: AttEntityP can be associated with multiple AEPgs with different VLANS.
When you associate the infra: AttEntityP with the AEPg, as in 3, this deploys the AEPg on the nodes selected
in 1, on the interfaces in 2, with the VLAN provided by 3.
In this example, the AEPg uni/tn-coke/ap-AP/epg-EPG1 is deployed on interfaces 1/10, 1/11, and 1/12 of
nodes 101 and 102, with vlan-102.

Before you begin

* Create the target application EPG (aEpg).

* Create the VLAN pool containing the range of VLANSs you wish to use for EPG deployment with the
Attached Entity Profile (AEP).
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* Create the physical domain and link it to the VLAN pool and AEP.

Procedure

To deploy an AEPg on selected nodes and interfaces, send a post with XML such as the following:

Example:

<infraInfra dn="uni/infra">
<infraNodeP name=“NodeProfile">
<infraLeafS name=“NodeSelector" type="range">
<infraNodeBlk name=“NodeBlok" from ="101" to_=%“102"/>
<infraRsAccPortP tDn="uni/infra/accportprof-InterfaceProfile"/>
</infralLeafS>
</<infraNodeP>

<infraAccPortP name="InterfaceProfile">
<infraHPortS name="InterfaceSelector" type="range">
<infraPortBlk name=" InterfaceBlock" fromCard="1" toCard="1" fromPort="10"
toPort="12"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accportgrp-PortGrp" />
</infraHPortS>
</infraAccPortP>

<infraFuncP>
<infraAccPortGrp name="PortGrp”>
<infraRsAttEntP tDn="uni/infra/attentp-AttEntityProfile"/>
</infraAccPortGrp>
</infraFuncP>

<infraAttEntityP name=“AttEntityProfile” >
<infraGeneric name=“default” >
<infraRsFuncToEpg tDn=“uni/tn-Coke/ap-AP/epg-EPGl” encap=“vlan-102"/>
</infraGeneric>
</infraAttEntityP>
</infralInfra>

Microsegmented EPGs

Using Microsegmentation with Network-based Attributes on Bare Metal

You can use Cisco APIC to configure Microsegmentation with Cisco ACI to create a new, attribute-based
EPG using a network-based attribute, a MAC address or one or more [P addresses. You can configure
Microsegmentation with Cisco ACI using network-based attributes to isolate VMs or physical endpoints
within a single base EPG or VMs or physical endpoints in different EPGs.

Using an IP-based Attribute

You can use an [P-based filter to isolate a single IP address, a subnet, or multiple of noncontiguous IP addresses
in a single microsegment. You might want to isolate physical endpoints based on IP addresses as a quick and
simply way to create a security zone, similar to using a firewall.
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Using a MAC-based Attribute

You can use a MAC-based filter to isolate a single MAC address or multiple MAC addresses. You might
want to do this if you have a server sending bad traffic int he network. By creating a microsegment with a
MAC-based filter, you can isolate the server.

Configuring Network-based Microsegmented EPGs in a Bare-Metal environment Using the GUI

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Step 7
Step 8

Step 9
Step 10

Step 11

You can use Cisco APIC to configure microsegmentation to put physical endpoint devices that belong to
different base EPGs or the same EPG into a new attribute-based EPG.

Procedure

Log into the Cisco APIC.
Choose Tenants and then choose the tenant within which you want to create a microsegment.

In the tenant navigation pane, expand the tenant folder, the Application Profiles folder, the profile folder,
and the Application EPGs folder.

Take one of the following actions:
* If you want to put physical endpoint devices from the same base EPG into a new, attribute-based EPG,
click the base EPG containing the physical endpoint devices.
« If you want to put physical endpoint devices from different base EPGs into a new, attribute-based EPG,
click one of the base EPG containing the physical endpoint devices.
The properties for the base EPG appear in the work pane.
In the work pane, click the Operational tab at the top right of the screen.

Below the Operational tab, ensure that the Client End-Points tab is active.
The work pane displays all the physical endpoints that belong to the base EPG.

Note the IP address or MAC address for the endpoint device or endpoint devices that you want to put into a
new microsegment.

If you want to put endpoint devices from different base EPGs into a new attribute-based EPG, repeat Step 4
through Step 7 for each of the base EPGs.

In the tenant navigation pane, right-click the uSeg EPGs folder, and then choose Create uSeg EPG.

Complete the following series of steps to begin creation of an attribute-based EPG for one of the groups of
endpoint devices:

a) Inthe Create uSeg EPG dialog box, in the Name field, enter a name.
We recommend that you choose a name that indicates that the new attribute-based EPG is a microsegment.
b) In the intra-EPG isolation field, select enforced or unenforced.

If you select enforced, ACI prevents all communication between the endpoint devices within this uSeg
EPG.

¢) Inthe Bridge Domain area, choose a bridge domain from the drop-down list.

d) Inthe uSeg Attributes area, choose IP Address Filter or MAC Address Filter from the + drop-down
list on the right side of the dialog box.

Complete one of the following series of steps to configure the filter.
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If you want to use... Then...

An IP-based attribute |a. Inthe Create IP Attribute dialog box, in the Name field, enter a name.

We recommend that you choose a name that reflects the filter's function.

b. Inthe IP Address field, enter an IP address or a subnet with the appropriate
subnet mask.

c. Click OK.
d. (Optional) Create a second IP Address filter by repeating Step 10 ¢ through
Step 11 c.

You might want to do this to include discontinuous IP addresses in the
microsegment.

e. Inthe Create uSeg EPG dialog box, click Submit.

A MAC-based attribute | a. In the Create MAC Attribute dialog box, in the Name field, enter a name.
We recommend that you choose a name that reflects the filter's function.

b. Inthe MAC Address field, enter a MAC address.
Click OK.
d. Inthe Create uSeg EPG dialog box, click Submit.

134

Step 12 Complete the following steps to associate the uSeg EPG with a physical domain.
a) In the navigation pane, ensure that the uSeg EPG folder is open and then open the container for the
microsegment that you just created.
b) Click the folder Domains (VMs and Bare-Metals).

¢) On the right side of the work pane, click Actions and then choose Add Physical Domain Association
from the drop-down list.

d) Inthe Add Physical Domain Association dialog box, choose a profile from the Physical Domain Profile
drop-down list.

e) In the Deploy Immediacy area, accept the default On Demand.
f) In the Resolution Immediacy area, accept the default Immediate.
g) Click Submit.
Step 13 Associate the uSeg EPG with the appropriate leaf switch.
a) In the navigation pane, ensure the uSeg EPG folder is open then click Static Leafs.
b) In the Static Leafs window, click Actions > Statically Link with Node
c) In the Statically Link With Node dialog, select the leaf node and mode.
d) Click Submit.

Step 14 Repeat Step 9 through Step 13 for any other network attribute-based EPGs that you want to create.

What to do next
Verify that the attribute-based EPG was created correctly.

If you configured an IP-based or MAC-based attribute, make sure that traffic is running on the end pont
devices that you put into the new microsegments.
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Configuring a Network-Based Microsegmented EPG in a Bare-Metal Environment Using the NX-0S
Style CLI

This section describes how to configure microsegmentation with Cisco ACI using network-based attributes
(IP address or MAC address) within a base EPG in a bare-metal environment.

Procedure

Command or Action Purpose
Step 1 In the CLI, enter configuration mode:

Example:

apicl# configure

apicl (config) #
Step 2 Create the microsegment:

Example:

This example uses a filter based on an IP
address.

apicl (config) # tenant cli-tenl
apicl (config-tenant)# application cli-al
apicl (config-tenant-app) # epg cli-uepgl
type micro-segmented
apicl (config-tenant-app-uepg) #
bridge-domain member cli-bdl
apicl (config-tenant-app-uepg) # attribute
cli-upg-att match ip <X.X.X.X>
#Schemes to express the ip
A.B.C.D IP Address
A.B.C.D/LEN IP Address and mask

Example:

This example uses a filter based on a MAC
address.

apicl (config) # tenant cli-tenl

apicl (config-tenant)# application cli-al
apicl (config-tenant-app)# epg cli-uepgl
type micro-segmented

apicl (config-tenant-app-uepqg) #

bridge-domain member cli-bdl

apicl (config-tenant-app-uepg) # attribute
cli-upg-att match mac
<FF-FF-FF-FF-FF-FF>

#Schemes to express the mac

E.E.E MAC address (Option 1)
EE-EE-EE-EE-EE-EE MAC address (Option 2)
EE:EE:EE:EE:EE:EE MAC address (Option 3)
EEEE.EEEE.EEEE MAC address (Option 4)

Example:

This example uses a filter based on a MAC
address and enforces intra-EPG isolation
between all members of this uSeg EPG:
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Command or Action

Purpose

apicl (config) # tenant cli-tenl

apicl (config-tenant)# application cli-al
apicl (config-tenant-app) # epg cli-uepgl
type micro-segmented

apicl (config-tenant-app-uepg) # isolation
enforced

apicl (config-tenant-app-uepg) #

bridge-domain member cli-bdl

apicl (config-tenant-app-uepg) # attribute
cli-upg-att match mac
<FF-FF-FF-FF-FF-FF>

#Schemes to express the mac

Step 3

E.E.E MAC address (Option 1)
EE-EE-EE-EE-EE-EE MAC address (Option 2)
EE:EE:EE:EE:EE:EE MAC address (Option 3)
EEEE.EEEE.EEEE MAC address (Option 4)
Deploy the EPG.

Example:

This example deploys the EPG and bids to the
leaf.

apicl (config) # leaf 101

apicl (config-leaf)# deploy-epg tenant
cli-tenl application cli-al epg cli-uepgl
type micro-segmented

Step 4

Verify the microsegment creation:

Example:

apicl (config-tenant-app-uepg) # show
running-config
# Command: show running-config tenant
cli-tenl application cli-appl epg
cli-uepgl type micro-segmented
# Time: Thu Oct 8 11:54:32 2015
tenant cli-tenl
application cli-appl
epg cli-esxlbu type micro-segmented|

bridge-domain cli-bdl
attribute cli-uepg-att match mac|
00:11:22:33:44:55
exit
exit
exit

Configuring a Network-Based Microsegmented EPG in a Bare-Metal Environment Using the REST

API

This section describes how to configure network attribute microsegmentation with Cisco ACI in a bare-metal
environment using the REST API.
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Procedure

Step 1 Log in to the Cisco APIC.
Step 2 Post the policy to https://apic-ip-address/api/node/mo/.xml.
Example:

A: The following example configures a microsegment named 41-subnet using an IP-based attribute.

<polUni>
<fvTenant dn="uni/tn-User-T1" name="User-T1">
<fvAp dn="uni/tn-User-T1l/ap-Base-EPG" name="Base-EPG">
<fvAEPg dn="uni/tn-User-T1l/ap-Base-EPG/epg-41l-subnet" name="4l-subnet"
pcEnfPref="enforced” isAttrBasedEPg="yes" >
<fvRsBd tnFvBDName="BD1" />
<fvCrtrn name="Securityl">
<fvIpAttr name="41-filter" ip="12.41.0.0/16"/>
</fvCrtrn>
</fvAEPg>
</fvAp>
</fvTenant>
</polUni>

Example:
This example is for base EPG for Example A: .

<polUni>
<fvTenant dn="uni/tn-User-T1" name="User-T1">
<fvAp dn="uni/tn-User-T1l/ap-Base-EPG" name="Base-EPG">
<fvAEPg dn="uni/tn-User-T1l/ap-Base-EPG/baseEPG” name=“baseEPG” pcEnfPref="enforced”

<fvRsBd tnFvBDName="BD1" />
</fvAEPg>
</fvAp>
</fvTenant>
</polUni>

Example:
B: The following example configures a microsegment named useg-epg using a MAC-based attribute.

<polUni>
<fvTenant name="User-T1">
<fvAp name="customer">
<fvAEPg name="useg-epg" isAttrBasedEPg="true">
<fvRsBd tnFvBDName="BD1"/>
<fvRsDomAtt instrImedcy="immediate" resImedcy="immediate" tDn="uni/phys-phys"

/>
<fvRsNodeAtt tDn="topology/pod-1/node-101" instrImedcy="immediate" />
<fvCrtrn name="default">
<fvMacAttr name="mac" mac="00:11:22:33:44:55" />
</fvCrtrn>
</fvAEPg>
</fvAp>
</fvTenant>
</polUni>
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IP Address-Based Microsegmented EPG as a Shared Resource

You can configure an IP address-based microsegemented EPG as a resource that can be accessed from both
within and without the VRF on which it is located. The method of doing so is to configure an existing IP
address-based microsegmented EPG with a subnet (assigned a unicast IP address) and enable that subnet for
being advertised and shared by devices located on VRFs other than the one on which this EPG is native. Then
you define an IP attribute with an option enabled that associates the EPG with the IP address of the shared
subnet.

Configuring an IP-based Microsegmented EPG as a Shared Resource Using the GUI

Step 1

Step 2

Step 3

You can configure a microsegmented EPG with an IP-Address with 32 bit mask as a shared service, accessible
by clients outside of the VRF and the current fabric.

Before you begin

The following GUI description of configuring assumes the preconfiguration of an IP address-based
microsegmented EPG configured whose subnet mask is /32.

\}

Note * For directions on configuring an IP address based EPG in a physical environment, see Using
Microsegmentation with Network-based Attributes on Bare Metal, on page 159

* For directions on configuring an IP address based EPG in a virtual environment, see Configuring
Microsegmentation with Cisco ACI in the Cisco ACI Virtualization Guide.

Procedure

Navigate to the target IP-address-based EPG.

a) Inthe APIC GUI, click Tenant > tenant_name > uSeg EPGs > uSeg_epg_name to display the EPG's
Properties dialog.

For the target EPG, configure an IP attribute to match the EPG subnet address.

a) In the Properties dialog, locate the uSeg Attributes table, and click +. When prompted, choose IP
Address Filter to display the Create IP Attribute dialog.

b) Enter a name in the Name field
¢) Check the box for Use FV Subnet.

Enabling this option, indicates that the IP attribute value matches the IP address of a shared subnet.
d) Click Submit.

Create a shared subnet for the target EPG.

a) With the folder for the target IP address-based uSeg EPG still open in the APIC navigation pane, right-click
the Subnets folder and select Create EPG Subnets.

b) Inthe Default Gateway field, enter the IP address/mask of the IP address-based microsegmented EPG.
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Note
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« In all cases the subnet mask must be /32.

* In the context of an IP address-based EPG, you are not actually entering the default
address for a gateway, rather you are entering the IP address for the shared EPG subnet.

¢) Select Treat as a virtual IP address.
d) Under Scope select Advertised Externally and Shared between VRFs.
e) Click Submit.

Configuring an IP-based Microsegmented EPG as a Shared Resource Using the NX-0S CLI

Before you begin

The following GUI description of configuring assumes the preconfiguration of an IP address-based
microsegmented EPG configured whose subnet mask is /32.

Procedure

Command or Action

Purpose

Step 1

Enable the IP address microsegmented EPG for
shared service by associating the EPG with the
IP address of its subnet.

Example:

apic-1(config)# tenant tO
apic-1(config-tenant-app) # epg cli-epg
type micro-segmented
apic-1(config-tenant-app-uepg) #

bridge-domain member b0
apic-1(config-tenant-app-uepg) # attribute|
ip match ip-use-epg-subnet

apic-1(config-tenant-app-uepg) # show run
# Command: show running-config tenant tO
application a0 epg cli-epg type
micro-segmented
# Time: Thu Sep
tenant t0
application a0
epg cli-epg type micro-segmented
bridge-domain member b0
attribute ip match
ip-use-epg-subnet
exit
exit
Exit

22 00:17:07 2016

In this example, microsegmented EPG, cli-epg,
is configured with the ip-use-epg-subnet
option (useFvSubnet), thus associating the EPG
with the IP address of its subnet. APIC then

advertises that subnet address, thus making the
EPG accessible as a service to devices on VRFs
other than the one on which the EPG is native.

Step 2

Deploy the EPG to a leaf.
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In this example, microsegmented EPG, cli-epg,
is deployed to leaf 102.

apic-1(config)# leaf 102
apic-1(config-leaf)# deploy-epg tenant
t0 application a0 epg cli-epg type
micro-segmented
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Command or Action Purpose

apic-1(config-leaf)# show run
# Command: show running-config leaf 102
# Time: Thu Sep 22 00:18:46 2016
leaf 102
deploy-epg tenant t0 application a0
epg cli-epg type micro-segmented

Configuring an IP-based Microsegmented EPG as a Shared Resource Using the REST API

You can configure a microsegmented EPG with an IP-Address with 32 bit mask as a shared service, accessible
by clients outside of the VRF and the current fabric.

Procedure

To configure an IP address-attribute microsegmented EPG epg3 with a shared subnet, with an IP address and
32-bit mask, send a post with XML such as the following example. In the IP attributes, the attribute usefvSubnet
is set to "yes."

Example:

<fvAEPg descr="" dn="uni/tn-t0/ap-al0/epg-epg3" fwdCtrl=""
isAttrBasedEPg="yes" matchT="AtleastOne" name="epg3" pcEnfPref="unenforced"
prefGrMemb="exclude"prio="unspecified">
<fvRsCons prio="unspecified" tnVzBrCPName="ip-epg"/>

<fvRsNodeAtt descr="" encap="unknown" instrImedcy="immediate" mode="regular"
tDn="topology/pod-2/node-106"/>
<fvSubnet ctrl="" descr="" ip="56.4.0.2/32" name="" preferred="no"
scope="public,shared" virtual="no"/>
<fvRsDomAtt classPref="encap" delimiter="" encap="unknown" encapMode="auto"

instrImedcy="immediate"
primaryEncap="unknown" resImedcy="immediate" tDn="uni/phys-vpc"/>
<fvRsCustQosPol tnQosCustomPolName=""/>
<fvRsBd tnFvBDName="b2"/>

<fvCrtrn descr="" match="any" name="default" ownerKey="" ownerTag="" prec="0">
<fvIpAttr descr="" ip="1.1.1.3" name="ipv4" ownerKey="" ownerTag=""
usefvSubnet="yes” />
</fvCrtrn>

<fvRsProv matchT="AtleastOne" prio="unspecified" tnVzBrCPName="ip-epg"/>
<fvRsProv matchT="AtleastOne" prio="unspecified" tnVzBrCPName="shared-svc"/>
</fvAEPg>

Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the GUI

When you unconfigure an IP address-Based microsegmented EPG as a shared service, you must remove the
shared subnet and also disable the option to use that subnet as a shared resource.

Before you begin

Before you unconfigure an IP address-based microsegmented EPG as a shared service, you should know the
following:
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Step 1

Step 2

» Know which subnet is configured as a shared service address for the IP address-based microsegmented

EPG.

» Know which IP attribute is configured with the Use FV Subnet option enabled.

Procedure

Remove subnet from the IP addressed-based microsegmented EPG.

a)
b)
¢)

d)

In the APIC GUI, click Tenant > tenant_name > Application Profiles > epg_name > uSeg EPGs >
uSeg EPGs > uSeg_epg_name.

With the folder for the target IP address-based uSeg EPG still open in the APIC navigation pane, click
the Subnets folder.

In the Subnets window, select the subnet that is advertised and shared with other VRFs and click Actions
> Delete. then

Click Yes to confirm the deletion.

Disable the Use FV Subnet option.

a)

b)

¢)
d)

e)

With the folder for the target IP address-based uSeg EPG still open in the APIC navigation pane, click
the name of the micro-segmented EPG to display the to display the EPG's Properties dialog.

In the Properties dialog, locate the uSeg Attributes table, and locate the IP attribute item with the Use
FV Subnet option enabled.

Double-click that item to display the Edit IP Attribute dialog.
Inthe Edit IP Attribute dialog, deselect the Use FV Subnet option.
Assign another IP address attribute in the IP Address field.

Note This address must be a unicast address with a 32 bit mask (for example: 124.124.124.123/32).
Click Submit.

Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the NX-0S Style

CLI

To unconfigure an IP address-based microsegmented EPG as a shared service, disable the ip-use-epg-subnet
option for that EPG.

Before you begin

Procedure

Command or Action Purpose

Step 1 Disable the ip-use-epg-subnet option. The example code disables the

ip-use-epg-subnet option for the

Example: microsegmented EPG cli-epg.

apic-1(config)# tenant tO
apic-1(config-tenant-app) # epg cli-epg
type micro-segmented
apic-1(config-tenant-app-uepg)# no
attribute ip match ip-use-epg-subnet
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Command or Action Purpose

apic-1(config-tenant-app-uepg)# exit
apic-1(config-tenant-app) # exit

Unconfiguring an IP-based Microsegmented EPG as a Shared Resource Using the REST API

You can disable an IP address-based microsegmented EPG by setting the usefvSubnet property to "no."

Procedure

In the API structure for the microsegmented EPG currently configured as a shared service, change the value
of the usefvSubnet property from "yes" to "no."

In the example, the IP address-based microsegmented EPG, epg3, is disabled as a shared service.

Example:

<fvAEPg descr="" dn="uni/tn-t0/ap-al0/epg-epg3" fwdCtrl="" isAttrBasedEPg="yes"
matchT="AtleastOne" name="epg3" pcEnfPref="unenforced" prefGrMemb="exclude"prio="unspecified">

<fvRsCons prio="unspecified" tnVzBrCPName="ip-epg"/>

<fvRsNodeAtt descr="" encap="unknown" instrImedcy="immediate" mode="regular"
tbn="topology/pod-2/node-106"/>

<fvSubnet ctrl="" descr="" ip="56.4.0.2/32" name="" preferred="no" scope="public, shared"
virtual="no"/>

<fvRsDomAtt classPref="encap" delimiter="" encap="unknown" encapMode="auto"

instrImedcy="immediate" primaryEncap="unknown" resImedcy="immediate" tDn="uni/phys-vpc"/>
<fvRsCustQosPol tnQosCustomPolName=""/>
<fvRsBd tnFvBDName="b2"/>

<fvCrtrn descr="" match="any" name="default" ownerKey="" ownerTag="" prec="0">
<fvIpAttr descr="" ip="1.1.1.3" name="ipv4" ownerKey="" ownerTag="" usefvSubnet="no”/>
</fvCrtrn>

<fvRsProv matchT="AtleastOne" prio="unspecified" tnVzBrCPName="ip-epg"/>
<fvRsProv matchT="AtleastOne" prio="unspecified" tnVzBrCPName="shared-svc"/>
</fvAEPg>

Deploying Application Profiles and Contracts

Security Policy Enforcement

As traffic enters the leaf switch from the front panel interfaces, the packets are marked with the EPG of the
source EPG. The leaf switch then performs a forwarding lookup on the packet destination IP address within
the tenant space. A hit can result in any of the following scenarios:

1. A unicast (/32) hit provides the EPG of the destination endpoint and either the local interface or the remote
leaf switch VTEP IP address where the destination endpoint is present.

2. A unicast hit of a subnet prefix (not /32) provides the EPG of the destination subnet prefix and either the
local interface or the remote leaf switch VTEP IP address where the destination subnet prefix is present.
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3. A multicast hit provides the local interfaces of local receivers and the outer destination IP address to use
in the VXLAN encapsulation across the fabric and the EPG of the multicast group.

\)

Note Multicast and external router subnets always result in a hit on the ingress leaf switch. Security policy
enforcement occurs as soon as the destination EPG is known by the ingress leaf switch.

A miss result in the forwarding table causes the packet to be sent to the forwarding proxy in the spine switch.
The forwarding proxy then performs a forwarding table lookup. If it is a miss, the packet is dropped. If it is
a hit, the packet is sent to the egress leaf switch that contains the destination endpoint. Because the egress leaf
switch knows the EPG of the destination, it performs the security policy enforcement. The egress leaf switch
must also know the EPG of the packet source. The fabric header enables this process because it carries the
EPG from the ingress leaf switch to the egress leaf switch. The spine switch preserves the original EPG in
the packet when it performs the forwarding proxy function.

On the egress leaf switch, the source IP address, source VTEP, and source EPG information are stored in the
local forwarding table through learning. Because most flows are bidirectional, a return packet populates the
forwarding table on both sides of the flow, which enables the traffic to be ingress filtered in both directions.

Contracts Contain Security Policy Specifications

In the ACI security model, contracts contain the policies that govern the communication between EPGs. The
contract specifies what can be communicated and the EPGs specify the source and destination of the
communications. Contracts link EPGs, as shown below.

Endpoints in EPG 1 can communicate with endpoints in EPG 2 and vice versa if the contract allows it. This
policy construct is very flexible. There can be many contracts between EPG 1 and EPG 2, there can be more
than two EPGs that use a contract, and contracts can be reused across multiple sets of EPGs, and more.

There is also directionality in the relationship between EPGs and contracts. EPGs can either provide or consume
a contract. An EPG that provides a contract is typically a set of endpoints that provide a service to a set of
client devices. The protocols used by that service are defined in the contract. An EPG that consumes a contract
is typically a set of endpoints that are clients of that service. When the client endpoint (consumer) tries to
connect to a server endpoint (provider), the contract checks to see if that connection is allowed. Unless
otherwise specified, that contract would not allow a server to initiate a connection to a client. However, another
contract between the EPGs could easily allow a connection in that direction.

This providing/consuming relationship is typically shown graphically with arrows between the EPGs and the
contract. Note the direction of the arrows shown below.

The contract is constructed in a hierarchical manner. It consists of one or more subjects, each subject contains
one or more filters, and each filter can define one or more protocols.
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Figure 6: Contract Filters

CONTRACT FILTER
e L GNP A— A “ \

Al?_p"A‘R‘P’ request

http
https

500013

The following figure shows how contracts govern EPG communications.

Figure 7: Contracts Determine EPG to EPG Communications
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For example, you may define a filter called HTTP that specifies TCP port 80 and port 8080 and another filter
called HTTPS that specifies TCP port 443. You might then create a contract called webCtrct that has two sets
of subjects. openProv and openCons are the subjects that contain the HTTP filter. secureProv and secureCons
are the subjects that contain the HTTPS filter. This webCtrct contract can be used to allow both secure and
non-secure web traffic between EPGs that provide the web service and EPGs that contain endpoints that want
to consume that service.

These same constructs also apply for policies that govern virtual machine hypervisors. When an EPG is placed
in a virtual machine manager (VMM) domain, the APIC downloads all of the policies that are associated with
the EPG to the leaf switches with interfaces connecting to the VMM domain. For a full explanation of VMM
domains, see the Virtual Machine Manager Domains chapter of Application Centric Infrastructure
Fundamentals. When this policy is created, the APIC pushes it (pre-populates it) to a VMM domain that
specifies which switches allow connectivity for the endpoints in the EPGs. The VMM domain defines the set
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of switches and ports that allow endpoints in an EPG to connect to. When an endpoint comes on-line, it is
associated with the appropriate EPGs. When it sends a packet, the source EPG and destination EPG are derived
from the packet and the policy defined by the corresponding contract is checked to see if the packet is allowed.
If yes, the packet is forwarded. If no, the packet is dropped.

Contracts consist of 1 or more subjects. Each subject contains 1 or more filters. Each filter contains 1 or more
entries. Each entry is equivalent to a line in an Access Control List (ACL) that is applied on the Leaf switch
to which the endpoint within the endpoint group is attached.

In detail, contracts are comprised of the following items:

» Name—All contracts that are consumed by a tenant must have different names (including contracts
created under the common tenant or the tenant itself).

* Subjects—A group of filters for a specific application or service.

» Filters—Used to classify traffic based upon layer 2 to layer 4 attributes (such as Ethernet type, protocol
type, TCP flags and ports).

* Actions—Action to be taken on the filtered traffic. The following actions are supported:
* Permit the traffic (regular contracts, only)
» Mark the traffic (DSCP/CoS) (regular contracts, only)
* Redirect the traffic (regular contracts, only, through a service graph)
* Copy the traffic (regular contracts, only, through a service graph or SPAN)
* Block the traffic (taboo contracts)

With Cisco APIC Release 3.2(x) and switches with names that end in EX or FX, you can alternatively
use a subject Deny action or Contract or Subject Exception in a standard contract to block traffic
with specified patterns.

* Log the traffic (taboo contracts and regular contracts)

+ Aliases—(Optional) A changeable name for an object. Although the name of an object, once created,
cannot be changed, the Alias is a property that can be changed.

Thus, the contract allows more complex actions than just allow or deny. The contract can specify that traffic
that matches a given subject can be re-directed to a service, can be copied, or can have its QoS level modified.
With pre-population of the access policy in the concrete model, endpoints can move, new ones can come
on-line, and communication can occur even if the APIC is off-line or otherwise inaccessible. The APIC is
removed from being a single point of failure for the network. Upon packet ingress to the ACI fabric, security
policies are enforced by the concrete model running in the switch.

Three-Tier Application Deployment

A filter specifies the data protocols to be allowed or denied by a contract that contains the filter. A contract
can contain multiple subjects. A subject can be used to realize uni- or bidirectional filters. A unidirectional
filter is a filter that is used in one direction, either from consumer-to-provider (IN) or from provider-to-consumer
(OUT) filter. A bidirectional filter is the same filter that is used in both directions. It is not reflexive.

Contracts are policies that enable inter-End Point Group (inter-EPG) communication. These policies are the
rules that specify communication between application tiers. If no contract is attached to the EPG, inter-EPG
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communication is disabled by default. No contract is required for intra-EPG communication because intra-EPG
communication is always allowed.

Application profiles enable you to model application requirements that the APIC then automatically renders
in the network and data center infrastructure. The application profiles enable administrators to approach the
resource pool in terms of applications rather than infrastructure building blocks. The application profile is a
container that holds EPGs that are logically related to one another. EPGs can communicate with other EPGs
in the same application profile and with EPGs in other application profiles.

To deploy an application policy, you must create the required application profiles, filters, and contracts.
Typically, the APIC fabric hosts a three-tier application within a tenant network. In this example, the application
is implemented by using three servers (a web server, an application server, and a database server). See the
following figure for an example of a three-tier application.

The web server has the HTTP filter, the application server has the Remote Method Invocation (RMI) filter,
and the database server has the Structured Query Language (SQL) filter. The application server consumes the
SQL contract to communicate with the database server. The web server consumes the RMI contract to
communicate with the application server. The traffic enters from the web server and communicates with the
application server. The application server then communicates with the database server, and the traffic can
also communicate externally.

Figure 8: Three-Tier Application Diagram
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Parameters to Create a Filter for http

The parameters to create a filter for http in this example is as follows:

04258

Parameter Name Filter for http
Name http
Number of Entries 2
Entry Name Dport-80
Dport-443
Ethertype IP
Protocol tep
tep
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Parameter Name

Filter for http

Destination Port

http
https

Parameters to Create Filters for rmi and sql

The parameters to create filters for rmi and sql in this example are as follows:

Parameter Name Filter for rmi Filter for sql
Name rmi sql

Number of Entries 1 1

Entry Name Dport-1099 Dport-1521
Ethertype 1P IP

Protocol tep tep
Destination Port 1099 1521

Example Application Profile Database

The application profile database in this example is as follows:

EPG Provided Contracts Consumed Contracts
web web rmi

app rmi sql

db sql -

Creating an Application Profile Using the GUI

Procedure

Step 1 On the menu bar, choose TENANTS. In the Navigation pane, expand the tenant, right-click Application
Profiles, and click Create Application Profile.

Step 2 In the Create Application Profile dialog box, in the Name field, add the application profile name (OnlineStore).

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



| Basic User Tenant Configuration

Creating EPGs Using the GUI [JJj}

Creating EPGs Using the GUI

The port the EPG uses must belong to one of the VM Managers (VMM) or physical domains associated with
the EPG.

Step 1
Step 2

Step 3

Step 4

Procedure

On the menu bar, choose Tenants and the tenant where you want to create an EPG.

In the navigation pane, expand the folder for the tenant, the Application Profiles folder, and the folder for
the application profile.

Right-click the Application EPG folder, and in the Create Application EPG dialog box, perform the following

actions:

a) Inthe Name field, add the EPG name (db).

b) In the Bridge Domain field, choose the bridge domain from the drop-down list (bd1).

¢) Check the Associate to VM Domain Profiles check box. Click Next.

d) Inthe STEP 2 > Domains area, expand Associate VM Domain Profiles and from the drop-down list,
choose the desired VMM domain.

e) From the Deployment Immediacy drop-down list, accept the default or choose when policies are deployed
from Cisco APIC to the physical leaf switch.

f) From the Resolution Immediacy drop-down list, choose when policies are deployed from the physical
leaf switch to the virtual leaf.

If you have Cisco AVS, choose Immediate or On Demand; if you have Cisco ACI Virtual Edge or
VMware VDS, choose Immediate, On Demand, or Pre-provision.

g) (Optional) In the Delimiter field, enter one of the following symbols: |, ~, !, @, *, +, or =.

If you do not enter a symbol, the system uses the default | delimiter in the VMware portgroup name.

h) Ifyou have Cisco ACI Virtual Edge or Cisco AVS, from the Encap Mode drop-down list, choose an
encapsulation mode.

You can choose one of the following encapsulation modes:
* VXLAN:This overrides the domain's VLAN configuration, and the EPG uses VXLAN encapsulation.
However, a fault is for the EPG if a multicast pool is not configured on the domain.
* VLAN: This overrides the domain's VXLAN configuration, and the EPG uses VLAN encapsulation.
However, a fault is triggered for the EPG if a VLAN pool is not configured on the domain.
* Auto: This causes the EPG to use the same encapsulation mode as the VMM domain. This is the
default configuration.

i) If you have Cisco ACI Virtual Edge, from the Switching Mode drop-down list, choose native or AVE.
If you choose native, the EPG is switched through the VMware VDS; if you choose AVE, the EPG is
switched through the Cisco ACI Virtual Edge. The default is native.

j) Click Update and then click Finish.

In the Create Application Profile dialog box, create two more EPGs. Create the three EPGs—db, app, and
web—in the same bridge domain and data center.
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Configuring Contracts Using the APIC GUI

Guidelines and Limitations for Contracts and Filters

If your fabric consists of first-generation Cisco Nexus 9300 leaf switches, such as Cisco Nexus 93128TX,
93120TX, 9396TX, 9396PX, 9372PX, 9372PX-E, 9372TX and 9372TX-E, only IP as an EtherType match
is supported with contract filters. The capability to match more granular options, such as IPv4 or IPV6, in the
EtherType field for contract filters is supported only on leaf switch models with -EX, -FX, or -FX2 at the
end of the switch name.

Creating a Filter Using the GUI

Step 1

Step 2

Step 3

Step 4

Create three separate filters. In this example they are HTTP, RMI, SQL. This task shows how to create the
HTTP filter. The task is identical for creating the other filters.

Before you begin

Verify that the tenant, network, and bridge domain have been created.

Procedure

On the menu bar, choose Tenants. In the Navigation pane, expand the tenant-name > Contracts, right-click
Filters, and click Create Filter.

Note In the Navigation pane, you expand the tenant where you want to add filters.

In the Create Filter dialog box, perform the following actions:

a) Inthe Name field, enter the filter name (http).

b) Expand Entries, and in the Name field, enter the name (Dport-80).

¢) From the EtherType drop-down list, choose the EtherType (IP).

d) From the IP Protocol drop-down list, choose the protocol (tcp).

e) From the Destination Port/Range drop-down lists, choose http in the From and To fields. (http)

f) Click Update, and click Submit.
The newly added filter appears in the Navigation pane and in the Work pane.

Expand Entries in the Name field. Follow the same process to add another entry with HTTPS as the
Destination port, and click Update.
This new filter rule is added.

Follow the same process in the earlier steps to create two more filters (rmi and sql) and use the parameters
provided in Parameters to Create Filters for rmi and sql, on page 174.
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Creating a Contract Using the GUI

Step 1

Step 2
Step 3

Step 4
Step 5

Procedure

On the menu bar, choose Tenants and the tenant name on which you want to operate. In the Navigation pane,
expand the tenant-name > Contracts.

Right-click Standard > Create Contract.
In the Create Contract dialog box, perform the following tasks:

a) Inthe Name field, enter the contract name (web).

b) Click the + sign next to Subjects to add a new subject.

¢) Inthe Create Contract Subject dialog box, enter a subject name in the Name field. (web)
d) Note This step associates the filters created that were earlier with the contract subject.

In the Filter Chain area, click the + sign next to Filters.
e) In the dialog box, from the drop-down menu, choose the filter name (http), and click Update.
In the Create Contract Subject dialog box, click OK.

Create two more contracts for rmi and for sql following the same steps in this procedure. For the rmi contract,
choose the rmi subject and for sql, choose the sql subject.

Consuming and Providing Contracts Using the GUI

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

You can associate contracts that were created earlier to create policy relationships between the EPGs.

When you name the provided and consumed contracts, verify that you give the same name for both provided
and consumed contracts.

Procedure

Note The db, app, and web EPGs are displayed as icons.
Click and drag across the APIC GUI window from the db EPG to the app EPG.
The Add Consumed Contract dialog box is displayed.

In the Name field, from the drop-down list, choose sql contract. Click OK.

This step enables the db EPG to provide the sql contract and the app EPG to consume the sql contract.
Click and drag across the APIC GUI screen from the app ePG to the web EPG.

The Add Consumed Contract dialog box is displayed.

In the Name field, from the drop-down list, choose rmi contract. Click OK.

This step enables the app EPG to provide the rmi contract and the web EPG to consume the rmi contract.
Click the web EPG icon, and click the + sign in the Provided Contracts area.

The Add Provided Contract dialog box is displayed.

In the Name field, from the drop-down list, choose web contract. Click OK. Click Submit.

You have created a three-tier application profile called OnlineStore.

To verify, in the Navigation pane, navigate to and click OnlineStore under Application Profiles.
In the Work pane, you can see the three EPGs app, db, and web are displayed.
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Step 8 In the Work pane, choose Operational > Contracts.
You can see the EPGs and contracts displayed in the order that they are consumed and provided.

Configuring Contracts Using the NX-0S Style CLI

Configuring Contracts
Contracts are configured under a tenant with the following tasks:
* Define filters as access lists
* Define the contract and subjects

* Link the contract to an EPG

The tasks need not follow this order. For example, you can link a contract name to an EPG before you have
defined the contract.

\}

Note Filters (ACLs) in APIC use match instead of permit | deny as in the traditional NX-OS ACL. The purpose
of a filter entry is only to match a given traffic flow. The traffic will be permitted or denied when the ACL is
applied on a contract or on a taboo contract.

Procedure
Command or Action Purpose
Step 1 configure Enters configuration mode.
Example:
apicl# configure
Step 2 tenant tenant-name Creates a tenant if it does not exist and enters
the tenant configuration mode.
Example:
tenant exampleCorp
Step 3 access-list acl-name Creates an access list (filter) that can be used
in a contract.
Example:
apicl (config-tenant) # access-list
http_acl
Step 4 (Optional) match {arp | icmp | ip} Creates a rule to match traffic of the selected
Example: protocol.
apicl (config-tenant-acl) # match arp
Step 5 (Optional) match {tcp | udp} [src from[-to]] | Creates a rule to match TCP or UDP traffic.
[dest from[-to]]
Example:
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Command or Action

Purpose

apicl (config-tenant-acl) # match tcp dest]
80

apicl (config-tenant-acl) # match tcp dest]
443

Step 6

(Optional) match raw options

Example:

apicl (config-tenant-acl) #

Creates a rule to match a raw vzEntry.

Step 7

exit
Example:

apicl (config-tenant-acl) # exit

Returns to the tenant configuration mode.

Step 8

contract contract-name

Example:

apicl (config-tenant) # contract web80

Creates a contract and enters the contract
configuration mode.

Step 9

subject subject-name

Example:

apicl (config-tenant-contract)# subject
web80

Creates a contract subject and enters the
subject configuration mode.

Step 10

(Optional) [no] access-group acl-name[in |
out | both]
Example:

apicl (config-tenant-contract-subj) #
access-group http_acl both

Adds (removes) an access list from the
contract, specifying the direction of the traffic
to be matched.

Step 11

(Optional) [no] label name label-name
{provider | consumer}

Example:

apicl (config-tenant-contract-subj) #

Adds (removes) a provider or consumer label
to the subject.

Step 12

(Optional) [no] label match {provider |
consumer} [any | one | all | none]

Example:

apicl (config-tenant-contract-subj) #

Specifies the match type for the provider or
consumer label:

» any—Match if any label is found in the
contract relation.

» one—Match if exactly one label is found
in the contract relation.

« all—Match if all labels are found in the
contract relation.

* none—Match if no labels are found in
the contract relation.
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Command or Action

Purpose

Step 13

exit
Example:

apicl (config-tenant-contract-subj) # exit]

Returns to the contract configuration mode.

Step 14

exit
Example:

apicl (config-tenant-contract) # exit

Returns to the tenant configuration mode.

Step 15

application app-name

Example:

apicl (config-tenant)# application
OnlineStore

Enters application configuration mode.

Step 16

€pg epg-name

Example:

apicl (config-tenant-app) # epg
exampleCorp_webepgl

Enters configuration mode for the EPG to be
linked to the contract.

Step 17

bridge-domain member bd-name

Example:

apicl (config-tenant-app-epg) #
bridge-domain member exampleCorp_bdl

Specifies the bridge domain for this EPG.

Step 18

contract provider provider-contract-name

Example:

apicl (config-tenant-app-epg) # contract
provider web80

Specifies the provider contract for this EPG.
Communication with this EPG can be initiated
from other EPGs as long as the communication
complies with this provider contract.

Step 19

contract consumer consumer-contract-name

Example:

apicl (config-tenant-app-epg) # contract
consumer rmi99

Specifies the consumer contract for this EPG.
The endpoints in this EPG may initiate
communication with any endpoint in an EPG
that is providing this contract.

Examples

This example shows how to create and apply contracts to an EPG.

apicl# configure
apicl (config)# tenant exampleCorp

# CREATE
apicl (config
apicl (config
apicl (config
apicl (config

# CREATE

FILTERS

-tenant) # access-list http_acl
-tenant-acl)# match tcp dest 80
-tenant-acl)# match tcp dest 443
-tenant-acl)# exit

CONTRACT WITH FILTERS
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apicl (config-tenant)# contract web80

apicl (config-tenant-contract)# subject web80

apicl (config-tenant-contract-subj)# access-group http _acl both
apicl (config-tenant-contract-subj)# exit

apicl (config-tenant-contract) # exit

# ASSOCIATE CONTRACTS TO EPG
apicl (config-tenant)# application OnlineStore
apicl (config-tenant-app) # epg exampleCorp_ webepgl
apicl (config-tenant-app-epg) # bridge-domain member exampleCorp_ bdl
apicl (config-tenant-app-epg) # contract consumer rmi99
apicl (config-tenant-app-epg) # contract provider web80
apicl (config-tenant-app-epg) # exit
apicl (config-tenant-app) #exit
apicl (config-tenant) fexit

# ASSOCIATE PORT AND VLAN TO EPG
apicl (config) #leaf 101
apicl (config-leaf) # interface ethernet 1/4
apicl (config-leaf-if)# switchport trunk allowed vlan 102 tenant exampleCorp application
OnlineStore epg exampleCorp_ webepgl

This example shows a simpler method for defining a contract by declaring the filters inline in the
contract itself.

apicl# configure

apicl (config) # tenant exampleCorp

apicl (config-tenant) # contract web80

apicl (config-tenant-contract)# match tcp 80
apicl (config-tenant-contract)# match tcp 443

Exporting a Contract to Another Tenant

You can export a contract from one tenant and import it to another. In the tenant that imports the contract, the
contract can be applied only as a consumer contract. The contract can be renamed during the export.

Procedure
Command or Action Purpose
Step 1 configure Enters configuration mode.
Example:
apicl# configure
Step 2 tenant tenant-name Enters the tenant configuration mode for the
exporting tenant.
Example: P &
apicl (config) # tenant RedCorp
Step 3 contract contract-name Enters the contract configuration mode for the
contract to be exported.
Example:
apicl (config-tenant)# contract web80

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Exporting a Contract to Another Tenant

Basic User Tenant Configuration |

Command or Action

Purpose

Step 4

scope {application | exportable | tenant | vrf}

Example:

apicl (config-tenant-contract)# scope
exportable

Configures how the contract can be shared.
The scope can be:

» application—Can be shared among the
EPGs of the same application.

» exportable—Can be shared across
tenants.

* tenant—Can be shared among the EPGs
of the same tenant.

* virf—Can be shared among the EPGs of
the same VRF.

Step 5

export to tenant other-tenant-name as
new-contract-name
Example:

apicl (config-tenant-contract) # export
to tenant BlueCorp as webContractl

Exports the contract to the other tenant. You
can use the same contract name or you can
rename it.

Step 6

exit
Example:

apicl (config-tenant-contract) # exit

Returns to the tenant configuration mode.

Step 7

exit
Example:

apicl (config-tenant) # exit

Returns to the global configuration mode.

Step 8

tenant tenant-name

Example:
tenant BlueCorp

Enters the tenant configuration mode for the
importing tenant.

Step 9

application app-name

Example:

apicl (config-tenant) # application
BlueStore

Enters application configuration mode.

Step 10

€pg epg-name
Example:

apicl (config-tenant-app) # epg BlueWeb

Enters configuration mode for the EPG to be
linked to the contract.

Step 11

contract consumer consumer-contract-name
imported
Example:

apicl (config-tenant-app-epg) # contract
consumer webContractl imported

Specifies the imported consumer contract for
this EPG. The endpoints in this EPG may
initiate communication with any endpoint in
an EPG that is providing this contract.
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Examples

This example shows how to export a contract from the tenant RedCorp to the tenant BlueCorp, where
it will be a consumer contract.

apic# configure

apicl (config) # tenant RedCorp

apicl (config-tenant) # contract web80

apicl (config-tenant-contract)# scope exportable

apicl (config-tenant-contract)# export to tenant BlueCorp as webContractl
apicl (config-tenant-contract) # exit

apicl (config-tenant) # exit

apicl (config)# tenant BlueCorp

apicl (config-tenant)# application BlueStore

apicl (config-tenant-application) # epg BlueWeb

apicl (config-tenant-application-epg)# contract consumer webContractl imported

Configuring Contracts Using the REST API

Configuring a Contract Using the REST API

Procedure

Configure a contract using an XML POST request similar to the following example:

Example:

<vzBrCP name="webCtrct">

<vzSubj name="http" revFltPorts="true" provmatchT="All">
<vzRsSubjFiltAtt tnVzFilterName="Http"/>
<vzRsSubjGraphAtt graphName="Gl" termNodeName="TProv"/>
<vzProvSubjLbl name="openProv"/>
<vzConsSubjLbl name="openCons"/>

</vzSubij>

<vzSubj name="https" revFltPorts="true" provmatchT="Al1l">
<vzProvSubjLbl name="secureProv"/>
<vzConsSubjLbl name="secureCons"/>
< vzRsSubjFiltAtt tnVzFilterName="Https"/>
<vzRsOutTermGraphAtt graphName="G2" termNodeName="TProv"/>

</vzSubij>

</vzBrCP>

Configuring a Taboo Contract Using the REST API

Before you begin
The following objects must be created:

« The tenant that will be associated with this Taboo Contract
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* An application profile for the tenant

* At least one EPG for the tenant

Procedure

To create a taboo contract with the REST API, use XML such as in the following example:

Example:

<vzTaboo ownerTag="" ownerKey="" name="VRF64 Taboo Contract"
dn="uni/tn-Tenant64/taboo-VRF64 Taboo Contract" descr=""><vzTSubj
name="EPG_ subject" descr=""><vzRsDenyRule tnVzFilterName="default"
directives="log"/>

</vzTSubj>

</vzTaboo>

Verifying Contracts, Taboo Contracts, and Filters Using the REST API

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

This topic provides the REST API XML to verify contracts, taboo contracts, and filters.

Procedure

Verify a contract for an EPG or an external network with XML such as the following example for a provider:
Example:

QUERY https://apic-ip-address/api/node/class/fvRsProv.xml

Verify a contract on an EPG with XML such as the following example for a consumer:

Example:
QUERY https://apic-ip-address/api/node/class/fvRsCons.xml

Verify exported contracts using XML such as the following example:
Example:

QUERY https://apic-ip-address/api/node/class/vzCPif.xml
Verify contracts for a VRF with XML such as the following example:
Example:

QUERY https://apic-ip-address/api/node/class/vzBrCP.xml
Verify taboo contracts with XML such as the following example:

Example:
QUERY https://apic-ip-address/api/node/class/vzTaboo.xml

For taboo contracts for an EPG, use the same query as for contracts for EPGs.

Verify filters using XML such as the following example:

Example:
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QUERY https://apic-ip-address/api/node/class/vzFilter.xml

Optimize Contract Performance

Optimize Contract Performance

Starting with Cisco APIC, Release 3.2, you can configure bidirectional contracts that support more efficient
hardware TCAM storage of contract data. With optimization enabled, contract statistics for both directions
are aggregated.

TCAM Optimization is supported on the second generation Cisco Nexus 9000 Series top of rack (TOR)
switches, which are those with suffixes of EX, FX, and FX2, and later (for example, N9K-C93180LC-EX or
NI9K-C93180YC-FX).

To configure efficient TCAM contract data storage, you enable the following options:
» Mark the contracts to be applied in both directions between the provider and consumer.
* For filters with IP TCP or UDP protocols, enable the reverse port option.

» When configuring the contract subjects, select the Enable Policy Compression directive, which adds
the no_stats option to the action attribute of the actr1:Rule managed object.

Limitations

With the Enable Policy Compression (no_stats) option selected, per-rule statistics are lost. However,
combined rule statistics for both directions are present in the hardware statistics.

After upgrading to Cisco APIC 3.2(1), to add the no _stats option to a pre-upgrade contract subject (with
filters or filter entries), you must delete the contract subject and reconfigure it with the Enable Policy
Compression directive. Otherwise, compression does not occur.

For each contract with a bi-directional subject filter, Cisco NX-OS creates 2 rules:
* A rule with an sPcTag and dpcTag that is marked direction=bi-dir, which is programmed in hardware

* A rule marked with direction=uni-dir-ignore which is not programmed

Rules with the following settings are not compressed:
* Rules with priority other than fully qual

* Opposite rules (bi-dir and uni-dir-ignore marked) with non-identical properties, such as action
including directives, prio, qos or markDscp

* Rule with ITmplicit or implarp filters

* Rules with the actions pDeny, Redir, Copy, OF Deny-log

The following MO query output shows the two rules for a contract, that is considered for compression:

apicl# moquery -c actrlRule
Total Objects shown: 2

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



. Optimize Contract Performance

# actrl.Rule
scopeld
sPcTag

dPcTag

fltid

action
actrlCfgFailedBmp
actrlCfgFailedTs
actrlCfgState
childAction
ctrctName
descr
direction

dn

id

1cOwn
markDscp
modTs
monPolDn

name
nameAlias
opersSt
operStQual
prio

gosGrp

rn

status

type

# actrl.Rule
scopeld
sPcTag

dPcTag

fltid

action
actrlCfgFailedBmp
actrlCfgFailedTs
actrlCfgState
childAction
ctrctName
descr
direction

dn

id

1cOwn
markDscp
modTs
monPolDn

name
nameAlias
opersSt
operStQual
prio

qosGrp

rn

status

type
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2588677

16388

49156

67
no_stats,permit

00:00:00:00.000
0

bi-dir
sys/actrl/scope-2588677/rule-2588677-s-16388-d-49156-f-67
4112

implicit

unspecified

2019-04-27T09:01:33.152-07:00
uni/tn-common/monepg-default

enabled

fully qual
unspecified
rule-2588677-s-16388-d-49156-£-67

tenant

2588677

49156

16388

64
no_stats,permit

00:00:00:00.000
0

uni-dir-ignore
sys/actrl/scope-2588677/rule-2588677-s-49156-d-16388-f-64
4126

implicit

unspecified

2019-04-27T09:01:33.152-07:00
uni/tn-common/monepg-default

enabled
fully qual
unspecified

rule-2588677-s-49156-d-16388-f-64

tenant
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Table 8: Compression Matrix

Configure a Contract with Optimized TCAM Usage Using the GUI .

Reverse Filter Port TCP or UDP Source Port | TCP or UCP Destination | Compressed
Enabled Port

Yes Port A Port B Yes

Yes Unspecified Port B Yes

Yes Port A Unspecified Yes

Yes Unspecified Unspecified Yes

No Port A Port B No

No Unspecified Port B No

No Port A Unspecified No

No Unspecified Unspecified Yes

Configure a Contract with Optimized TCAM Usage Using the GUI

Step 1

Step 2
Step 3

This procedure describes how to configure a contract that optimizes TCAM storage of contract data on

hardware.

Before you begin

* Create the tenant, VRF, and EPGs that will provide and consume the contract.

* Create one or more filters that define the traffic to be permitted or denied by this contract.

Procedure

On the menu bar, choose Tenants and the tenant name on which you want to operate. In the Navigation pane,

expand the tenant-name and Contracts.

Right-click Standard > Create Contract.
In the Create Contract dialog box, perform the following tasks:
a) In the Name field, enter the contract name.

b) Click the + icon next to Subjects to add a new subject.
¢) Inthe Create Contract Subject dialog box, enter a subject name in the Name field.

Note

This step associates filters with the contract subject.

d)

2)

To enable the TCAM-contract usage optimization feature, ensure that Apply Both Directions and Reverse
Filter Ports are enabled.

Click the + icon to expand Filters.

In the dialog box, from the drop-down menu, choose a default filter, a previously configured filter, or
Create Filter.

In the Directives field, choose Enable Policy Compression
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Step 4
Step 5

h) In the Action field, choose Permit or Deny.

Note Currently, the Deny action is not supported. Optimization only occurs for the Permit action.

i) (Optional) In the Priority field, choose the priority level.
j) Click Update.

In the Create Contract Subject dialog box, click OK.
In the Create Contract dialog box, click Submit.

Configure a Contract with Optimized TCAM Usage Using the REST API

Before you begin

Create the tenant, VRF, and EPGs that will provide and consume the contract.

Procedure

To configure a filter and contract that optimizes TCAM storage of contract data on hardware, send a post with
XML similar to the following example:

Example:

<vzFilter dn="uni/tn-Tenant64/flt-webFilter" name="webFilter>
<vzEntry applyToFrag="no" dFromPort="https" dToPort="https"
dn="uni/tn-Tenant64/flt-webFilter/e-https" etherT="ip" name="https" prot="tcp"
stateful="no"/>
</vzFilter>
<vzBrCP dn="uni/tn-Tenant64/brc-OptimizedContract” name="OptimizedContract"
provMatchT="AtleastOne" revFltPorts="yes">
<vzSubj consMatchT="AtleastOne" dn="uni/tn-Tenant64/brc-OptimizedContract/subj-WebSubj"
lcOwn="1ocal" name="WebSubj"
provMatchT="AtleastOne" revFltPorts="yes">
<vzRsSubjFiltAtt action="permit" directives="no stats" forceResolve="yes"
lcOwn="1local" tCl="vzFilter"
tDn="uni/tn-Tenant64/flt-webFilter" tRn="flt-webFilter" tType="name"
tnVzFilterName="webFilter"/>
</vzSubj>
</vzBrCpP>

Contract and Subject Exceptions

Configuring Contract or Subject Exceptions for Contracts

In Cisco APIC Release 3.2(1), contracts between EPGs are enhanced to enable denying a subset of contract
providers or consumers from participating in the contract. Inter-EPG contracts and Intra-EPG contracts are
supported with this feature.
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You can enable a provider EPG to communicate with all consumer EPGs except those that match criteria
configured in a subject or contract exception. For example, if you want to enable an EPG to provide services
to all EPGs for a tenant, except a subset, you can enable those EPGs to be excluded. To configure this, you
create an exception in the contract or one of the subjects in the contract. The subset is then denied access to
providing or consuming the contract.

Labels, counters, and permit and deny logs are supported with contracts and subject exceptions.

To apply an exception to all subjects in a contract, add the exception to the contract. To apply an exception
only to a single subject in the contract, add the exception to the subject.

When adding filters to subjects, you can set the action of the filter (to permit or deny objects that match the
filter criteria). Also for Deny filters, you can set the priority of the filter. Permit filters always have the default
priority. Marking the subject-to-filter relation to deny automatically applies to each pair of EPGs where there
is a match for the subject. Contracts and subjects can include multiple subject-to-filter relationships that can
be independently set to permit or deny the objects that match the filters.

Exception Types

Contract and subject exceptions can be based on the following types and include regular expressions, such as

the * wildcard:

Exception criteria exclude these |Example Description
objects as defined in the Consumer
Regex and Provider Regex fields
Tenant <vzException consRegex= This example, excludes EPGs using
“common” field= “Tenant” name= |the common tenant from consuming
“excep03” provRegex= “t1” /> |contracts provided by the t1 tenant.
VRF <vzException consRegex= “ctx1” | This example excludes members of
field= “Ctx” name= “excep05” |ctxl from consuming the services
provRegex= “ctxl” /> provided by the same VRF.
EPG <vzException consRegex= The example assumes that multiple
“EPgPa.*” field= “EPg” name= |EPGs exist, with names starting
“excep03” provRegex= “EPg03” |with EPGPa, and they should all be
/> denied as consumers for the
contract provided by £pg03
Dn <vzException consRegex= This example excludes epg193 from
“uni/tn-t36/ap-customer/epg-epgl93” | consuming the contract provided
field= “Dn” name=“excep04” by epg200.
provRegex=
“uni/tn-t36/ap-customer/epg-epg200”
/>
Tag <vzException consRegex= “red” | The example excludes objects
field= “Tag” name= “excep01” |marked with the red tag from
provRegex= “green” /> consuming and those marked with
the green tag from participating in
the contract.
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Configure a Contract or Subject Exception Using the GUI

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7
Step 8
Step 9

Step 10

In this task, you configure a contract that will allow most of the EPGs to communicate, but deny access to a
subset of them.

Before you begin

Configure the tenant, VRF, application profile, and EPGs that provide and consume the contract.

Procedure

Click Tenants > All Tenants on the menu bar.
Double-click the tenant in which you are creating the contract.
On the navigation bar, expand Contracts, right-click Filter, and choose Create Filter.

A filter is essentially an Access Control List (ACL) that defines the traffic that is permitted or denied access
through the contract. You can create multiple filters that define objects that can be permitted or denied.

Enter the filter name and add the criteria that define the traffic to permit or deny, then click Submit.
Right-click Standard, and choose Create Contract.

Enter the contract name, set the scope, and click the + icon to add a subject.

Repeat to add another subject.

Click Submit

To add an exception to all subjects in the contract, perform the following steps:

a) Click the contract, then click Contract Exception.

b) Add subjects and set them to be permitted or denied.

c) Click the + icon to add a contract exception.

d) Enter the exception name and type.

e) Add regular expressions in the Consumer Regex and Provider Regex fields to define the EPGs to be
excluded from all subjects in the contract.

To add an exception to one subject in the contract, perform the following steps:
a) Click the subject, then click Subject Exception.

b) Click the + icon to add a contract exception.

¢) Enter the exception name and type.

d) Add regular expressions in the Consumer Regex and Provider Regex to define the EPGs to be excluded
from all subjects in the contract.

Configure a Contract or Subject Exception Using the NX-0S Style CLI

In this task, you configure a contract that will allow most of the EPGs to communicate, but deny access to a
subset of them. Multiple exceptions can be added to a contract or a subject.

Before you begin

Configure the tenant, VRF, application profile, and EPGs to provide and consume the contract.
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Procedure

Step 1 Configure filters for HTTP and HTTPS, using commands as in the following example:

Example:

apicl (config)# tenant t2

apicl (config-tenant)# access-1list acl

apicl (config-tenant-acl)# match ip

apicl (config-tenant-acl)# match tcp dest 80
apicl (config-tenant-acl)# exit

apicl (config-tenant)# access-1list ac2

apicl (config-tenant-acl)# match ip

apicl (config-tenant-acl) # match tcp dest 443

Step 2 Configure a contract that excludes Epg01 from consuming it and Epg03 from providing it.

Example:

apicl (config-tenant)# contract webCtrct

apicl (config-tenant-contract)# subject https-subject

apicl (config-tenant-contract-subj)# exception name EPG consumer-regexp EPgOl field EPg
provider-regexp EPg03

apicl (config-tenant-contract-subj)# access-group acl in blacklist

apicl (config-tenant-contract-subj)# access-group ac2 in whitelist

Configure a Contract or Subject Exception Using the REST API

In this task, you configure a contract that will allow most of the EPGs to communicate, but deny access to a
subset of them. Multiple exceptions can be added to a contract or a subject.

Before you begin

Configure the tenant, VRF, application profile, and EPGs to provide and consume the contract.

Procedure

Step 1 Create a filter by sending a post with XML, such as the following example:

Example:

<vzFilter name='http-filter'>
<vzEntry name='http-e' etherT='ip' prot='tcp'/>
<vzEntry name='https-e' etherT='ip' prot='tcp'/>
</vzFilter>

Step 2 Create a contract that excludes Epgo1 from consuming the subject and £pg03 from providing it, by sending a
post with XML, such as the following example:

The vzException MO can be contained by the vzBrCP or vzSubj MOs.

Example:

<vzBrCP name="httpCtrct" scope="context">
<vzSubj name="subjl"
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<vzException consRegex="EPg0l" field="EPg" name="excepOl" provRegex=EPg03"/>
<vzSubj/>
<vzRsSubjFiltAtt tnVzFilterName="http-filter" Action="deny"/>
<vzRsSubjFiltAtt tnVzFilterName="https-filter" Action="permit"/>
</vzSubj>
</vzBrCP>

Intra-EPG Contracts

Intra-EPG Contracts

You can configure contracts to control communication between EPGs. Beginning in Cisco APIC Release
3.0(1), you can also configure contracts within an EPG.

Without intra-EPG contracts, communication between endpoints in an EPG is all-or-nothing. Communication
is unrestricted by default, or you can configure intra-EPG isolation to bar any communication between
endpoints.

However, with intra-EPG contracts, you can control communication between endpoints in the same EPG,
allowing some traffic and barring the rest. For example, you may want to allow web traffic but block the rest.
Or you can allow all ICMP traffic and TCP port 22 traffic while blocking all other traffic.

Guidelines and Limitations for Intra-EPG Contracts

Observe the following guidelines and limitations when planning intra-EPG contracts:

* Intra-EPG contracts can be configured for application EPGs and microsegment EPGs (uSegs) on VMware
VDS, Open vSwitch (OVS), and baremetal servers.

\)

Note OVS is available in the Kubernetes integration with Cisco Application Centric
Infrastructure (ACI) feature. In Kubernetes, you can create EPGs and assign
namespaces to them. You can then apply intra-EPG policies to the EPGs in Cisco
Application Policy Infrastructure Controller (APIC) as you would for VMware
VDS or baremetal servers.

* Intra-EPG contracts require that the leaf switch support proxy Address Resolution Protocol (ARP).
Intra-EPG contracts are supported on Cisco Nexus 9000 Series switches with EX or FX at the end of
their model name or later models.

* Intra-EPG Contracts are not supported in Cisco Application Virtual Switch, Cisco ACI Virtual Edge,
and Microsoft domains. Attempting to set intra-EPG contracts to be enforced in these domains may cause
ports to go into a blocked state.

* Intra-EPG contracts in service graphs:

* A service graph cannot be associated with a subject of an intra-EPG contract that has an action of
deny.
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* Support for intra-EPG contracts in service graphs is limited to single node one-arm mode policy-based
redirect and copy service.

Adding an Intra-EPG Contract to an Application EPG Using the GUI

After you configure a contract, you can add the contract to an EPG as an intra-EPG contract. The procedure
is the same for VMware VDS, OVS, and baremetal servers.
Before you begin

* You must have an application EPG configured.

* You must have a contract with filters configured for this application. See Creating a Contract Using the
GUI, on page 177.

Procedure

Step 1 Log in to the APIC GUL
Step 2 Go to Tenants > tenant .
Step 3 Complete one of the following sets of steps, depending on the type of EPG:

If you want to apply an Then...
intra-EPG contract to...

An application EPG Then...

a. In the left navigation pane, expand Application Profiles > application
profile > Application EPGs > epg .

b. Right-click the Contracts folder and then choose Add Intra-EPG Contract.

¢. Inthe Add Intra-EPG Contract dialog box, from the Contract drop-down
list, choose a contract.

d. Click Submit.

A uSeg EPG a. In the left navigation pane, expand Application Profiles > application
profile >uSeqg EPGs > epg .

b. Right-click the Contracts folder and then choose Add Intra-EPG Contract.

c. Inthe Add Intra-EPG Contract dialog box, from the Contract drop-down
list, choose a contract.

d. Click Submit.

Cisco APIC Basic Configuration Guide, Release 4.2(x) .



Basic User Tenant Configuration |
. Adding an Intra-EPG Contract to an Application EPG Using the NX-0S-Style CLI

Adding an Intra-EPG Contract to an Application EPG Using the NX-0S-Style
CLI

After you configure a contract, you can configure the contract as an intra-EPG contract. The procedure is the
same for VMware VDS, OVS, and baremetal servers.

Before you begin

* You must have an EPG configured.

* You must have a contract with filters configured.

Procedure

Step 1 Enter the configuration mode.

Example:

apicl# configure
Step 2 Create or choose a tenant.

Example:

apicl (config)# tenant Tenant-13out
Step 3 Create or choose an external Layer 3 EPG.

Example:

apicl (config-tenant)# external-13 epg ext-epg
Step 4 Bind the external EPG to a VRF instance.

Example:

apicl (config-tenant-13ext-epg)# vrf member vrfl
Step 5 Enable intra-EPG isolation.

Example:

(config-tenant-13ext-epg)# isolation enforce
Afterward, if necessary, you can disable intra-EPG isolation by preceding the command with no.
Example:
(config-tenant-13ext-epg)# no isolation enforce
Step 6 Assign a contract to the intra-external EPG to allow the desired traffic between the endpoints.

Example:

apicl (config-tenant-13ext-epg) # contract intra-epg contr-intra
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Adding an Intra-EPG Contract to an Application EPG Using the REST API

Step 1

After you configure a contract, you can add the contract to an EPG as an intra-EPG contract. The procedure
is the same for VMware VDS, OVS, and baremetal servers.

Before you begin

* You must have configured an EPG.

* You must have configured a contract with filters.

Procedure

Configure the selectors using an XML POST request similar to the following example:

Example:

<?xml version="1.0" encoding="UTF-8"7?>
<polUni>
<infralInfra>

<infraAccPortP name="Ports-1-12" status="deleted"/>

<!-- VMM VLAN range -->

<fvnsVlanInstP name="test" allocMode="dynamic">
<fvnsEncapBlk name="encap" from="vlan-10" to="vlan-100"/>

</fvnsVlanInstP>

<!-- Static VLAN range -->
<fvnsVlanInstP name="test" allocMode="static">

<fvnsEncapBlk name="default" from="vlan-101" to="vlan-4095"/>
</fvnsVlanInstP>

<infraAttEntityP name="test">
<infraRsDomP tDn="uni/phys-test"/>
<infraRsDomP tDn="uni/l3dom-test"/>
<infraRsDomP tDn="uni/vmmp-VMware/dom-test"/>
</infraAttEntityP>

<!-- Node profile -->
<infraNodeP name="test">
<infraLeafS name="test" type="range">
<infraNodeBlk name="default" from ="101" to ="102"/>

</infralLeafS>

<infraRsAccPortP tDn="uni/infra/accportprof-test"/>
</infraNodeP>
<!-- Port profile -->
<infraAccPortP name="test">

<!-- 12 regular ports -->

<infraHPortS name="portslThroughl2" type="range">
<infraPortBlk name="default" fromCard="1" toCard="1" fromPort="1" toPort="12"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accportgrp-test"/>

</infraHPortS>

<!-- 2 ports in PC -->

<infraHPortS name="portsForPcl" type="range">
<infraPortBlk name="default" fromCard="1" toCard="1" fromPort="13" toPort="14"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accbundle-testPc"/>

</infraHPortS>
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<!-- 2 ports in PC -->

<infraHPortS name="portsForPc2" type="range">
<infraPortBlk name="blkl" fromCard="1" toCard="1" fromPort="15" toPort="16"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accbundle-pc"/>

</infraHPortS>

<!-- 2 ports in PC for FEX -->
<infraHPortS name="portsForFex" type="range">
<infraPortBlk name="blkl" fromCard="1" toCard="1" fromPort="17" toPort="18"/>
<infraRsAccBaseGrp tDn="uni/infra/fexprof-default/fexbundle-test" fexId="111"/>
</infraHPortS>

<!-- 2 ports in PC for VPC -->
<infraHPortS name="portsForVpc" type="range">
<infraPortBlk name="blkl" fromCard="1" toCard="1" fromPort="19" toPort="20"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accbundle-testvVpc"/>
</infraHPortS>
</infraAccPortP>

<!-- FEX profile -->
<infraFexP name="default">
<infraFexBndlGrp name="default"/>

<!-- 12 FEX ports -->

<infraHPortS name="portslThroughl2" type="range">
<infraPortBlk name="default" fromCard="1" toCard="1" fromPort="1" toPort="12"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accportgrp-test"/>

</infraHPortS>

<!-- 3 ports in FEX PC -->
<infraHPortS name="portsForPc" type="range">
<infraPortBlk name="blkl" fromCard="1" toCard="1" fromPort="13" toPort="16"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accbundle-testPcOnFex"/>
</infraHPortS>

<!-- 3 ports in FEX VPC -->
<infraHPortS name="portsForVpc" type="range">
<infraPortBlk name="blkl" fromCard="1" toCard="1" fromPort="17" toPort="19"/>
<infraRsAccBaseGrp tDn="uni/infra/funcprof/accbundle-testVpcOnFex"/>
</infraHPortS>
</infraFexP>

<!-- Functional profile -->
<infraFuncP>
<!-- Regular port group —-->
<infraAccPortGrp name="test">
<infraRsAttEntP tDn="uni/infra/attentp-test"/>
</infraAccPortGrp>

<!-- PC -—>

<infraAccBndlGrp name="testPc" lagT="1link">
<infraRsLacpPol tnLacpLagPolName="testPc"/>
<infraRsAttEntP tDn="uni/infra/attentp-test"/>

</infraAccBndlGrp>

<!-- VPC -->

<infraAccBndlGrp name="testVpc" lagT="node">
<infraRsLacpPol tnlLacplLagPolName="testVpc"/>
<infraRsAttEntP tDn="uni/infra/attentp-test"/>

</infraAccBndlGrp>

<!-- PC on FEX -->

<infraAccBndlGrp name="testPcOnFex" lagT="1link">
<infraRsLacpPol tnlLacplagPolName="testPcOnFex"/>
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<infraRsAttEntP tDn="uni/infra/attentp-test"/>
</infraAccBndlGrp>

<!-- VPC on FEX -->
<infraAccBndlGrp name="testVpcOnFex" lagT="node">
<infraRsLacpPol tnLacpLagPolName="testVpcOnFex"/>
<infraRsAttEntP tDn="uni/infra/attentp-test"/>
</infraAccBndlGrp>
</infraFuncP>

<!-- Link aggregation policies -->

<lacpLagPol name="testPc" minLinks='l' maxLinks='10"'/>

<lacpLagPol name="testVpc" minLinks='l' maxLinks='10'/>

<lacpLagPol name="testPcOnFex" minLinks='2' maxLinks='5"'/>

<lacpLagPol name="testVpcOnFex" minLinks='2' maxLinks='10"'/>
</infralInfra>

<fabricInst>
<fabricProtPol name="testVpc">
<fabricExplicitGEp name="testVpc" id="101">
<fabricNodePEp id="101"/>
<fabricNodePEp id="102"/>
</fabricExplicitGEp>
</fabricProtPol>
</fabricInst>

<physDomP name="test">
<infraRsVlanNs tDn="uni/infra/vlanns-test-static"/>
</physDomP>

<13extDomP name="test">
<infraRsVlanNs tDn="uni/infra/vlanns-test-static"/>
</13extDomP>
</polUni>

Step 2 Configure the tenant using an XML POST request similar to the following example:

Example:

<?xml version="1.0" encoding="UTF-8"?>
<polUni>
<fvTenant name="Tenant-13out">
<vzBrCP intent="install" name="contr-intra" scope="context">
<vzSubj consMatchT="AtleastOne" name="subj" revFltPorts="yes">
<vzRsSubjFiltAtt action="permit" priorityOverride="default"
tnVzFilterName="flt-ssh" />
</vzSubj>
</vzBrCpP>
<vzBrCP intent="install" name="contr2" scope="context">
<vzSubj consMatchT="AtleastOne" name="contr2-subj" revFltPorts="yes">
<vzRsSubjFiltAtt action="permit" priorityOverride="default"
tnVzFilterName="flt-ftp" />
</vzSubj>
</vzBrCpP>
<vzBrCP intent="install" name="contrl" scope="context">
<vzSubj consMatchT="AtleastOne" name="subj-http" revFltPorts="yes">
<vzRsSubjFiltAtt action="deny" priorityOverride="default"
tnVzFilterName="flt-http" />
</vzSubj>
</vzBrCpP>
<13extOut enforceRtctrl="export" mplsEnabled="no" name="13outl">
<13extRsL3DomAtt tDn="uni/l3dom-test" />
<13extRsEctx tnFvCtxName="vrfl" />
<1l3extLNodeP name="1l3outl nodeProfile" tag="yellow-green">
<13extRsNodeL30utAtt rtrId="172.16.0.1" rtrIdLoopBack="yes"
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tDn="topology/pod-1/node-101" />
<13extLIfP name="13outl interfaceProfile" tag="yellow-green">
<1l3extRsPathL30utAtt addr="192.168.15.1/24" autostate="disabled"
encap="unknown" encapScope="local" ifInstT="13-port" ipvé6Dad="enabled"
isMultiPodDirect="no" 11Addr="::" mac="00:22:BD:F8:19:FF"
mode="regular" mtu="inherit"
tDn="topology/pod-1/paths-101/pathep-[ethl/10]" />
</13extLIfP>
</13extLNodeP>

<l=-
Set pcEnfPref to "enforced" to enable intra-Ext-EPG isolation.
Set pcEnfPref to "unenforced" to disable intra-Ext-EPG isolation.
-—>
<13extInstP floodOnEncap="disabled" matchT="AtleastOne"
name="13epgl" pcEnfPref="unenforced" prefGrMemb="exclude">
<1l3extSubnet ip="172.16.0.0/16" scope="import-security" />
<fvRsCons tnVzBrCPName="contr2" />
<fvRsIntraEpg tnVzBrCPName="contr-intra" />
</13extInstP>
</13extOut>
<fvCtx bdEnforcedEnable="no" ipDataPlanelearning="enabled" knwMcastAct="permit"
name="vrfl" pcEnfDir="egress" pcEnfPref="unenforced" vrfIndex="0">
<fvRsVrfVvalidationPol />
<vzAny matchT="AtleastOne" prefGrMemb="disabled" />
</fvCtx>
<fvBD OptimizeWanBandwidth="no" arpFlood="yes" epClear="no" hostBasedRouting="no"
intersiteBumTrafficAllow="no" intersitel2Stretch="no" ipLearning="yes"
ipv6McastAllow="no" limitIpLearnToSubnets="yes" 1l1Addr="::"
mac="00:22:BD:F8:19:FF" mcastAllow="no" multiDstPktAct="bd-flood" name="bd-web"
type="regular" unicastRoute="yes" unkMacUcastAct="proxy" unkMcastAct="flood"
vounkMcastAct="flood" vmac="not-applicable">
<fvSubnet ip="192.168.1.254/24" ipDPLearning="enabled" preferred="no"
scope="private" virtual="no" />
<fvRsCtx tnFvCtxName="vrfl" />
<fvRsBdToEpRet resolveAct="resolve" />
</fvBD>
<fvBD OptimizeWanBandwidth="no" arpFlood="yes" epClear="no" hostBasedRouting="no"
intersiteBumTrafficAllow="no" intersitel2Stretch="no" ipLearning="yes"
ipv6McastAllow="no" limitIpLearnToSubnets="yes" 1l1Addr="::"
mac="00:22:BD:F8:19:FF" mcastAllow="no" multiDstPktAct="bd-flood" name="bd-app"
type="regular" unicastRoute="yes" unkMacUcastAct="proxy" unkMcastAct="flood"
vounkMcastAct="flood" vmac="not-applicable">
<fvSubnet ip="192.168.2.254/24" ipDPLearning="enabled" preferred="no"
scope="private" virtual="no" />
<fvRsCtx tnFvCtxName="vrfl" />
<fvRsBdToEpRet resolveAct="resolve" />
</fvBD>
<vzFilter name="flt-ftp">
<vzEntry applyToFrag="no" arpOpc="unspecified" dFromPort="ftpData"
dToPort="ftpData" etherT="ipv4" icmpv4T="unspecified" icmpvéT="unspecified"
matchDscp="unspecified" name="ftp" prot="tcp" sFromPort="unspecified"
sToPort="unspecified" stateful="no" />
</vzFilter>
<vzFilter name="flt-ssh">
<vzEntry applyToFrag="no" arpOpc="unspecified" dFromPort="ssh" dToPort="ssh"
etherT="ipv4" icmpv4T="unspecified" icmpv6T="unspecified"
matchDscp="unspecified" name="ssh" prot="tcp" sFromPort="unspecified"
sToPort="unspecified" stateful="no" />
</vzFilter>
<vzFilter name="flt-http">
<vzEntry applyToFrag="no" arpOpc="unspecified" dFromPort="http" dToPort="http
etherT="ipv4" icmpv4T="unspecified" icmpv6T="unspecified"
matchDscp="unspecified" name="fltl" prot="tcp" sFromPort="unspecified"

"
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sToPort="unspecified" stateful="no" />
</vzFilter>
<fvAp name="ap-appl">
<fvAEPg floodOnEncap="disabled" hasMcastSource="no" isAttrBasedEPg="no"
matchT="AtleastOne" name="epg-app" pcEnfPref="unenforced"
prefGrMemb="exclude" shutdown="no">
<fvRsProv intent="install" matchT="AtleastOne" tnVzBrCPName="contr2" />
<fvRsProv intent="install" matchT="AtleastOne" tnVzBrCPName="contrl" />
<fvRsPathAtt encap="vlan-103" instrImedcy="immediate" mode="native"
primaryEncap="unknown" tDn="topology/pod-1/paths-101/pathep-[ethl/3]1" />
<fvRsDomAtt bindingType="none" classPref="encap" encap="unknown"
encapMode="auto" epgCos="Cos0" epgCosPref="disabled" instrImedcy="lazy"
netflowDir="both" netflowPref="disabled" numPorts="0" portAllocation="none"
primaryEncap="unknown" primaryEncapInner="unknown" resImedcy="immediate"
secondaryEncapInner="unknown" switchingMode="native" tDn="uni/phys-test"
untagged="no" vnetOnly="no" />
<fvRsBd tnFvBDName="bd-app" />
</fvAEPg>
<fvAEPg floodOnEncap="disabled" hasMcastSource="no"
isAttrBasedEPg="no" matchT="AtleastOne" name="epg-web" pcEnfPref="unenforced"
prefGrMemb="exclude" shutdown="no">
<fvRsPathAtt encap="vlan-104" instrImedcy="immediate" mode="native"
primaryEncap="unknown" tDn="topology/pod-1/paths-101/pathep-[ethl/4]1" />
<fvRsDomAtt bindingType="none" classPref="encap" encap="unknown"
encapMode="auto" epgCos="Cos0" epgCosPref="disabled" instrImedcy="lazy"
netflowDir="both" netflowPref="disabled" numPorts="0" portAllocation="none"
primaryEncap="unknown" primaryEncapInner="unknown" resImedcy="immediate"
secondaryEncapInner="unknown" switchingMode="native" tDn="uni/phys-test"
untagged="no" vnetOnly="no" />
<fvRsCons intent="install" tnVzBrCPName="contrl" />
<fvRsBd tnFvBDName="bd-web" />
</fvAEPg>
</fvAp>
</fvTenant>
</polUni>

EPG Contract Inheritance

About Contract Inheritance

To streamline associating contracts to new EPGs, you can now enable an EPG to inherit all the (provided and
consumed) contracts associated directly to another EPG in the same tenant. Contract inheritance can be
configured for application, microsegmented, L20Out, and L30ut EPGs.

With release 3.x, you can also configure contract inheritance for Inter-EPG contracts, both provided and
consumed. Inter-EPG contracts are supported on Cisco Nexus 9000 Series switches with EX or FX at the end
of their model name or later models.

You can enable an EPG to inherit all the contracts associated directly to another EPG, using the APIC GUI,
NX-OS style CLI, and the REST APIL
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Figure 9: Contract Inheritance

Contract

Inherits Provided-Contract 1 - Owns Provided-Contract 1
Inherits Provided-Contract 2 e Owns Provided-Contract 2
Inherits Consumed-Contract 3 EPG A Owns Consumed-Confract 3

501340

In the diagram above, EPG A is configured to inherit Provided-Contract 1 and 2 and Consumed-Contract 3
from EPG B (contract master for EPG A).

Use the following guidelines when configuring contract inheritance:

* Contract inheritance can be configured for application, microsegmented (uSeg), external L20ut EPGs,
and external L30ut EPGs. The relationships must be between EPGs of the same type.

* Both provided and consumed contracts are inherited from the contract master when the relationship is
established.

* Contract masters and the EPGs inheriting contracts must be within the same tenant.

» Changes to the masters’ contracts are propagated to all the inheritors. If a new contract is added to the
master, it is also added to the inheritors.

* An EPG can inherit contracts from multiple contract masters.

* Contract inheritance is only supported to a single level (cannot be chained) and a contract master cannot
inherit contracts.

* Labels with contract inheritance is supported. When EPG A inherits a contract from EPG B, if different
subject labels are configured under EPG A and EPG B, APIC uses the label configured under EPG B
for the contract inherited from EPG B. APIC uses the label configured under EPG A for the contract
where EPG A is directly involved.

* Whether an EPG is directly associated to a contract or inherits a contract, it consumes entries in TCAM.
So contract scale guidelines still apply. For more information, see the Verified Scalability Guide for your
release.

* vzAny security contracts and taboo contracts are not supported.

* Beginning in Cisco APIC release 4.2(6), contract inheritance with a service graph is supported if the
contract and EPGs are in the same tenant.

For information about configuring Contract Inheritance and viewing inherited and standalone contracts, see
Cisco APIC Basic Configuration Guide.
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Configuring EPG Contract Inheritance Using the GUI

Configuring Application EPG Contract Inheritance Using the GUI

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

Step 8

To configure contract inheritance for an application EPG, in the APIC Basic or Advanced mode GUI, use the
following steps.

Before you begin

Configure the tenant and application profile to be used by the EPGs.

Optional. Configure the bridge domain to be used by the EPG that will inherit contracts.
Configure at least one application EPG, to serve as the EPG Contract Master.

Configure the contracts to be shared, and associate them to the contract master.

Procedure

Navigate to Tenants > tenant-name > Application Profiles, and expand AP-name
Right-click Application EPGs and select Create Application EPG.
Type the name of the EPG that will inherit contracts from the EPG Contract Master.

On the Bridge Domain field, select the common/default bridge domain or a previously created bridge domain,
or create a bridge domain for this EPG.

On the EPG Contract Master field, click the + symbol, select the previously configured Application Profile
and EPG, and click Update.

Click Finish.

To view information about the EPG, including the contract master, navigate to Tenants > tenant-name >
Application Profiles> AP-name > Application EPGs > EPG-name. To view the EPG Contract Master,
click General.

To view information about the inherited contracts, expand EPG-name and click Contracts.

Configuring uSeg EPG Contract Inheritance Using the GUI

To configure contract inheritance for a uSeg EPG, in the APIC Basic or Advanced mode GUI, use the following
steps.

Before you begin
Configure the tenant and application profile to be used by the EPGs.
Optional. Configure the bridge domain to be used by the EPG that will inherit contracts.

Configure the uSeg EPG, to serve as the EPG Contract Master.

Configure the contracts to be shared, and associate them to the contract master.
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Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Procedure

Navigate to Tenants > tenant-name > Application Profiles, expand AP-name.
Right-click uSeg EPGs and select Create uSeg EPG.
Type the name of the EPG that will inherit contracts from the contract master.

On the Bridge Domain field, select the common/default bridge domain or a previously created bridge domain,
or create a bridge domain for this EPG.

Click uSeg-EPG-name. In the EPG Contract Master field, click the + symbol, select the Application
Profile and EPG (to serve as contract master), and click Update.

Click Finish.

To view information about the contracts, navigate to Tenants > tenant-name > Application Profiles >
AP-name > uSeg EPGs >, expand the EPG-name and click Contracts..

Configuring L20ut EPG Contract Inheritance Using the GUI

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10
Step 11

To configure contract inheritance for an external L20ut EPG, in the APIC Advanced mode GUI, use the
following steps.

Before you begin
Configure the tenant and application profile to be used by the EPGs.

Configure an external bridged network (L20ut) and the External Network Instance Profile (L2extInstP) that
will serve as the L20ut Contract Master.

Configure the contracts to be shared, and associate them to the contract master.

Procedure

To configure contract inheritance for an external L20ut EPG, navigate to Tenants > tenant-name >
Networking > External Bridged Networks, and perform the following steps:

Expand the L20ut-name.

Right-click Networks and select Create External Network.

Type the name of the external network and optionally add other attributes.

Click Submit.

Expand Networks.

Click the network-name.

In the External Network Instance Profile panel, click the + symbol on the L20ut Contract Masters field.
Select the L20ut and the L20ut Contract Master for this external L20ut EPG.

Click Update.

To view the contracts inherited by this external L20Out EPG, click on the External Network Instance Profile
name and click Contracts > Inherited Contracts.
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Configuring External L30ut EPG Contract Inheritance Using the Advanced GUI

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10
Step 11

To configure contract inheritance for an external L30ut EPG, in the APIC Advanced mode GUI, use the
following steps.

Before you begin
Configure the tenant and application profile to be used by the EPGs.

Configure an external routed network (L3Out) and the external network instance profile (L3extInstP) that
will serve as the L30ut Contract Master.

Configure the contracts to be shared, and associate them to the contract master.

Procedure

To configure contract inheritance for an external L30ut EPG, navigate to Tenants > tenant-name >
Networking > External Routed Networks, and perform the following steps:

Expand the L30ut-name leading to the external L30ut EPG.

Right-click Networks and select Create External Network.

Type the name of the external network and optionally add subnets and other attributes.

Click Submit.

Expand Networks.

Click the network-name.

In the External Network Instance Profile panel, click the + symbol on the L30Out Contract Masters field.
Select the L30ut and Interface Profile to serve as L3Out contract master for this external L30ut EPG.
Click Update.

To view the contracts inherited by this external L3Out EPG, click on the External Network Instance Profile
name and click Contracts > Inherited Contracts.

Configuring Contract Inheritance Using the NX-0S Style CLI

Configuring Application or uSeg EPG Contract Inheritance Using the NX-0S Style CLI

To configure contract inheritance for application or uSeg EPGs, use the following commands:

Before you begin
Configure the tenant, application profile, and bridge-domain to be used by the EPGs.
Configure the contracts to be shared by the EPGs at the VRF level.
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Procedure
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Command or Action

Purpose

Step 1

configure

Example:

apicl# configure

Enters configuration mode.

Step 2

tenant tenant-name

Example:
apicl# (config) tenant Tnl

Creates or specifies the tenant to be configured,
and enters into tenant configuration mode.

Step 3

application application-name

Example:

apicl (config-tenant) # application AP1L

Creates or specifies an application and enters
into application mode.

Step 4

epg epg-name [type micro-segmented]

Example:
apicl (config-tenant-app)# epg AEPg403

Creates or specifies the application or uSeg
EPG to be configured and enters into EPG
configuration mode. For uSeg EPGs add the

type.

In this example, this is the application EPG
contract master.

Step 5

bridge-domain member bd-name

Example:

apicl (config-tenant-app-epg) #
bridge-domain member T1BD1

Associates the EPG with the bridge domain.

Step 6

contract consumer contract-name

Example:

apicl (config-tenant-app-epg)# contract
consumer cctrb

Adds a contract to be consumed by this EPG.

Step 7

contract provider [label label]

Example:

apicl (config-tenant-app-epg) # contract
provider Tlctrl cif

Adds a contract to be provided by this EPG,
including an optional list of subject or EPG
labels (must be previously configured).

Step 8

exit
Example:
apicl (config-tenant-app-epg) # exit

Exits the configuration mode

Step 9

epg epg-name [type micro-segmented]

Example:
apicl (config-tenant-app) # epg AEPg404

Creates or specifies the application or uSeg
EPG to be configured and enters into EPG
configuration mode. For uSeg EPGs add the

type.

In this example, this is the EPG inheriting
contracts.
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Command or Action Purpose
Step 10 bridge-domain member bd-name Associates the EPG with the bridge domain.
Example:

apicl (config-tenant-app-epg) #
bridge-domain member T1BD1

Step 11 inherit-from-epg application Configures this EPG to inherit contracts from
application-nameepg the EPG contract master.
EPG-contract-master-name]

Example:

apicl (config-tenant-app-epg) #
inherit-from-epg application APl epg
AEPg403

Step 12 exit Exits the configuration mode

Example:
apicl (config-tenant-app-epg) # exit

Step 13 epg epg-name [type micro-segmented] Creates or specifies the application or uSeg
EPG to be configured and enters into EPG

Example: .
P configuration mode.

apicl (config-tenant-app) # epg

uSegl 403 10 type micro-segmented In this example, this is the uSeg EPG contract
master.
Step 14 bridge-domain member bd-name Associates the EPG with the bridge domain.
Example:

apicl (config-tenant-app-epg) #
bridge-domain member T1BD1

Step 15 contract provider [label label] Adds a contract to be provided by this EPG,
including an optional list of subject or EPG

Example: labels (must be previously configured).

apicl (config-tenant-app-epg) # contract
provider Tlctrl uSeg l3out

Step 16 attribute-logical-expression Adds a logical expression to the uSeg EPG as
logical-expression matching criteria.
Example:

apicl (config-tenant-app-epg) #
attribute-logical-expression 'ip equals
192.168.103.10 force'

Step 17 exit Exits the configuration mode

Example:
apicl (config-tenant-app-epg) # exit
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Command or Action

Purpose

Step 18

epg epg-name [type micro-segmented]

Example:

apicl (config-tenant-app) # epg
uSegl 403 30 type micro-segmented

Creates or specifies the application or uSeg
EPG to be configured and enters into EPG
configuration mode.

In this example, this is the uSeg EPG that
inherits contracts from the EPG contract
master.

Step 19

bridge-domain member bd-name

Example:

apicl (config-tenant-app-epg) #
bridge-domain member T1BD1

Associates the EPG with the bridge domain.

Step 20

attribute-logical-expression
logical-expression

Example:

apicl (config-tenant-app-epg) #
attribute-logical-expression 'ip equals
192.168.103.30 force'

Adds a logical expression to the uSeg EPG as
criteria.

Step 21

inherit-from-epg application
application-name epg
EPG-contract-master-name

Example:

apicl (config-tenant-app-epg) #
inherit-from-epg application APl epg
uSegl 403 10

Configures this EPG to inherit contracts from
the EPG contract master.

Step 22

exit

Example:

apicl (config-tenant-app-epg) # exit

Exits the configuration mode

Step 23

exit
Example:
apicl (config-tenant-app) # exit

Exits the configuration mode

Step 24

exit

Example:

apicl (config-tenant) # exit

Exits the configuration mode

Step 25

exit
Example:

apicl (config) # exit

Exits the configuration mode
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Example

ifav90-ifcl# show running-config tenant Tnl application AP1
# Command: show running-config tenant Tnl application AP1
# Time: Fri Apr 28 17:28:32 2017
tenant Tnl
application AP1
epg AEPg403
bridge-domain member T1BD1
contract consumer cctr5 imported
contract provider Tlctrl cif
exit
epg AEPg404
bridge-domain member T1BD1
inherit-from-epg application APl epg AEPg403
exit
epg uSegl 403 10 type micro-segmented
bridge-domain member T1BD1
contract provider T1Ctrl uSeg 1l3out
attribute-logical-expression 'ip equals 192.168.103.10 force'
exit
epg uSegl 403 30 type micro-segmented
bridge-domain member T1BD1
attribute-logical-expression 'ip equals 192.168.103.30 force'
inherit-from-epg application APl epg uSegl 403 10
exit
exit
exit

Configuring L20ut EPG Contract Inheritance Using the NX-0S Style CLI

To configure contract inheritance for an external L20Out EPG, use the following commands:

Before you begin

Configure the tenant, VRF, and bridge-domain to be used by the EPGs.
Configure the Layer 2 outside network (L2Out) that the EPGs will use.
Configure the contracts to be shared by the EPGs, at the VRF level.

Procedure
Command or Action Purpose
Step 1 configure Enters configuration mode.
Example:
apicl# configure
Step 2 tenant tenant-name Creates or specifies the tenant to be configured,;
and enters into tenant configuration mode.
Example:
apicl (config) # tenant Tnl
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Command or Action Purpose
Step 3 external-12 epg external-12-epg-name Configures or specifies an external L20Out
EPG. In this example, this is the L2out contract
Example:
master.

apicl (config-tenant)# external-12 epg
120utl:12Ext1

Step 4 bridge-domain member bd-name Associates the L20ut EPG with a bridge

Example: domain.

apicl (config-tenant-12ext-epqg) #
bridge-domain member T1BD1

Step 5 contract provider contract-name [label [abel] | Adds a contract to be provided by this EPG.

Example:

apicl (config-tenant-12ext-epg) # contract
provider Tlctr tcp

Step 6 exit Exits the configuration mode

Example:
apicl (config-tenant-12ext-epg) # exit

Step 7 external-12 epg external-12-epg-name Configures an external L20ut EPG. In this
example, this is the EPG that inherits contracts

Example: from the L2out contract master.

apicl (config-tenant)# external-12 epg
L2outl2:12Ext12

Step 8 bridge-domain member bd-name Associates the L2out EPG with the bridge

Example: domain.

apicl (config-tenant-12ext-epg) #
bridge-domain member T1BD1

Step 9 inherit-from-epg Configures this EPG to inherit contracts from
L20ut-contract-master-name the L20Out contract master.
Example:

apicl (config-tenant-12ext-epqg) #
inherit-from-epg epg l2outl:12Extl

Step 10 exit Exits the configuration mode

Example:

apicl (config-tenant-12ext-epg)# exit

Example

The steps above are taken from the following example:

apicl# show running-config tenant Tnl external-12
# Command: show running-config tenant Tnl external-12
# Time: Thu May 11 13:10:14 2017
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tenant Tnl

external-12 epg l2outl:12Extl
bridge-domain member T1BD1
contract provider Tlctr tcp
exit

external-12 epg 1l20utl0:12Ext1l0
bridge-domain member T1BD10
contract provider Tlctr tcp
exit

external-12 epg l2outll:12Extll
bridge-domain member T1BD11
contract provider Tlctr udp
exit

external-12 epg l2outl2:12Extl2
bridge-domain member T1BD12

Configuring L20ut EPG Contract Inheritance Using the NX-0S Style CLI .

inherit-from-epg epg l2outl:12Extl
inherit-from-epg epg 120outl0:12Ext10
inherit-from-epg epg l2outll:12Extll
inherit-from-epg epg l2out2:12Ext2
inherit-from-epg epg l2out3:12Ext3
inherit-from-epg epg l2outd:12Ext4
inherit-from-epg epg l2out5:12Ext5
inherit-from-epg epg l2out6:12Ext6
inherit-from-epg epg l2out7:12Ext7
inherit-from-epg epg l2out8:12Ext8
inherit-from-epg epg l2out9:12Ext9

exit

external-12 epg l2out2:12Ext2
bridge-domain member T1BD2
contract provider Tlctr tcp
exit

external-12 epg l2out3:12Ext3
bridge-domain member T1BD3
contract provider Tlctr tcp
exit

external-12 epg l2out4:12Ext4
bridge-domain member T1BD4
contract provider Tlctr tcp
exit

external-12 epg l2out5:12Ext5
bridge-domain member T1BD5
contract provider Tlctr tcp
exit

external-12 epg l2out6:12Ext6
bridge-domain member T1BD6
contract provider Tlctr tcp
exit

external-12 epg l2out7:12Ext7
bridge-domain member T1BD7
contract provider Tlctr tcp
exit

external-12 epg l2out8:12Ext8
bridge-domain member T1BDS8
contract provider Tlctr tcp
exit

external-12 epg 1l20ut9:12Ext9
bridge-domain member T1BD9
contract provider Tlctr tcp
exit

exit
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Configuring External L30ut EPG Contract Inheritance Using the NX-0S Style CLI

To configure contract inheritance for an external L30ut EPG, use the following commands:

Before you begin

Configure the tenant, VRF, and bridge-domain to be used by the EPGs.

Configure the Layer 3 outside network (L3Out) that the EPGs will use.

Configure the contracts to be shared by the EPGs, at the VRF level.

Procedure

Command or Action

Purpose

Step 1

configure

Example:

apicl# configure

Enters configuration mode.

Step 2

tenant tenant-name

Example:

apicl (config) # tenant Tnl

Creates or specifies the tenant to be configured;
and enters into tenant configuration mode.

Step 3

external-13 epg external-13-epg-name 13out
[3out-name
Example:

apicl (config-tenant-app) # external-13
epg 13Ext108 13out T1L3outl

Configures an external L30ut EPG. In this
example, this is the L3out contract master.

Step 4

vrf member vrf-name

Example:

apicl (tenant-13out)# vrf member Tlctxl

Associates the L3out with the VRF.

Step 5

match ip ip-address-and-mask

Example:

apicl (config-tenant-13ext-epg) # match
ip 192.168.110.0/24 shared

Adds a subnet that identifies hosts as part of
the EPG and adds the optional shared scope
for the subnet.

Step 6

contract provider contract-name[label label]

Example:

apicl (config-tenant-13ext-epg) # contract
provider Tlctrl-L3out

Adds a contract to be provided by this EPG.

Step 7

exit

Example:

apicl (config-tenant-13ext-epg)# exit

Exits the configuration mode
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Command or Action Purpose
Step 8 external-13 epg external-13-epg-name I3out | Configures an external L30ut EPG. In this
[3out-name example, this is the EPG that inherits contracts

from the L3out contract master.
Example:

apicl (config-tenant-app) # external-13
epg 13Ext110 13out T1L3outl

Step 9 vrf member vrf-name Associates the L3out with the VRF.

Example:

apicl (tenant-13out) # vrf member Tlctxl

Step 10 match ip ip-address-and-mask Adds a subnet that identifies hosts as part of
the EPG and adds the optional shared scope

Example: for the subnet.

apicl (config-tenant-13ext-epqg) # match
ip 192.168.112.0/24 shared

Step 11 inherit-from-epg Configures this EPG to inherit contracts from
L30ut-contract-master-name the L3Out contract master.
Example:

apicl (config-tenant-13ext-epqg) #
inherit-from-epg 13Ext108

Step 12 exit Exits the configuration mode

Example:
apicl (config-tenant-13ext-epg) # exit

Example

ifav90-ifcl# show running-config tenant Tnl external-13 epg 13Extl10
# Command: show running-config tenant Tnl external-13 epg 13Extl10
# Time: Fri Apr 28 17:36:15 2017
tenant Tnl
external-13 epg 13Ext108 13out T1L3outl
vrf member Tlctxl
match ip 192.168.110.0/24 shared
contract provider Tlctrl-L3out
exit
external-13 epg 13Ext110 13out T1lL3outl
vrf member Tlctxl
match ip 192.168.112.0/24 shared
inherit-from-epg epg 13Ext108
exit
exit
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Configuring EPG Contract Inheritance Using the REST API
Configuring Application EPG Contract Inheritance Using the REST API

Before you begin
Configure the tenant and application profile to be used by the EPGs.
Configure the application EPG, to serve as the EPG Contract Master.

Configure the contracts to be shared, and associate them to the contract master.

Procedure

To configure contract inheritance using the REST API, send a post with XML such as the following XML
and JSON examples, with a URL directed to the EPG that will inherit the contracts:

Example:
XML Example

<?xml version="1.0" encoding="UTF-8"7?>
<!-- /api/node/mo/uni/tn-coke/ap-AP/epg-EPg B.xml -->
<polUni>

<fvEPg>

<fvRsSecInherited tDn="uni/tn-coke/ap-AP/epg-EPg B/>
</fvEPg>
</polUni>

JSON Example

https://192.168.200.10/api/node/mo/uni/tn-coke/ap-AP/epg-EPg B.json
fvAEPg": {"attributes": {
"dn":"uni/tn-coke/ap-AP/epg-EPg B", "name":"EPg C",
"rn":"epg-EPg C",
"status":"created"},
"children": [{
"fvRsBd": {"attributes": {
"tnFvBDName" :"default",
"status":"created,modified"},
"children":[1}},{
"fvRsSecInherited":{"attributes":{
"tDn":"uni/tn-coke/ap-AP/epg-EPg B",

"status":"created"},
"children":[]1}}1}}

Configuring uSeg EPG Contract Inheritance Using the REST API

Before you begin
Configure the tenant and application profile to be used by the EPGs.

Configure the application EPG, to serve as the EPG Contract Master.
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Configure the contracts to be shared, and associate them to the contract master.

Procedure

To configure uSeg contract inheritance using the REST API, send a post with XML such as the following
example:

Example:

<polUni>
<fvTenant name="Tnl" >
<fvAEPg descr="" dn="uni/tn-Tnl/ap-APl/epg-uSegl 301 120" fwdCtrl=""

isAttrBasedEPg="yes" matchT="AtleastOne" name="uSegl 301 120" pcEnfPref="unenforced"

prefGrMemb="exclude" prio="unspecified">
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 100" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 110" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 50" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 60" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 30" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 10" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 40" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 70" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 90" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 20" />
<fvRsSecInherited tDn="uni/tn-Tnl/ap-APl/epg-uSegl 301 80" />

<fvRsNodeAtt descr="" encap="unknown" instrImedcy="immediate" mode="regular"
tDn="topology/pod-1/node-108" />

<fvRsNodeAtt descr="" encap="unknown" instrImedcy="immediate" mode="regular"
tDn="topology/pod-1/node-109" />

<fvRsDomAtt classPref="encap" delimiter="" encap="vlan-301" encapMode="auto"

instrImedcy="immediate" netflowPref="disabled" primaryEncap="unknown" resImedcy="immediate"
tDn="uni/phys-PhysDoml" />

<fvRsCustQosPol tnQosCustomPolName="" />
<fvRsBd tnFvBDName="T1BD21" />
<fvCrtrn descr="" match="any" name="default" nameAlias="" ownerKey="" ownerTag=""
prec="0">
<fvIpAttr descr="" ip="192.14.1.120" name="0" nameAlias="" ownerKey=""

ownerTag="" usefvSubnet="no" />

</fvCrtrn>

</fvAEPg>
</fvTenant>

</polUni>
What to do next

Configuring L20ut EPG Contract Inheritance Using the REST API

Before you begin
Configure the tenant and application profile to be used by the EPGs.
Configure the L20ut EPG, to serve as the L20ut Contract Master.

Configure the contracts to be shared, and associate them to the contract master.
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Procedure

To configure L20ut EPG contract inheritance using the REST API, send a post with XML such as the following
example:

Example:

<polUni>
<fvTenant name="Tnl" >
<l2extOut name="12outl">
<12extRsERd encap="vlan-51" tnFvBDName="T1BD1" />
<12extRsL2DomAtt tDn="uni/l2dom-12Doml" />
<l2extLNodeP name="default" >
<12extLIfP name="default" >
<l2extRsPathL20utAtt tDn="topology/pod-1/protpaths-108-109/pathep-[VPC83]"
/>
</12extLIfpP>
</12extLNodeP>
<1l2extInstP matchT="AtleastOne" name="12Extl1">
<fvSubnet ctrl="nd" ip="192.13.1.10/24" preferred="no" scope="public,shared"
virtual="no" />
<fvRsProv tnVzBrCPName="Tlctr tcp" />
</1l2extInstP>
</1l2extOut>

<l2extOut name="1l2out2">
<12extRsEBd encap="vlan-53" tnFvBDName="T1BD3" />
<12extRsL2DomAtt tDn="uni/l2dom-12Doml" />
<l2extLNodeP name="default" >
<12extLIfP name="default" >
<l2extRsPathL20utAtt tDn="topology/pod-1/protpaths-108-109/pathep-[VPC84]"
/>
</12extLIfpP>
</12extLNodeP>
<1l2extInstP matchT="AtleastOne" name="12Ext3" prefGrMemb="exclude">
<fvSubnet ctrl="nd" ip="192.13.2.10/24" preferred="no" scope="public, shared"
virtual="no" />
<fvRsSecInherited tDn="uni/tn-Tnl/l12out-12outl/instP-12Extl" />
</l2extInstP>
</1l2extOut>

</fvTenant>
</polUni>

Configuring L30ut EPG Contract Inheritance Using the REST API

Before you begin
Configure the tenant and application profile to be used by the EPGs.
Configure the L30ut EPG, to serve as the L30Out Contract Master.

Configure the contracts to be shared, and associate them to the contract master.
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Procedure

To configure L30ut EPG contract inheritance using the REST API, send a post with XML such as the following
example:

Example:

<polUni>
<fvTenant name="Tné6" >

<!— L3out creation -->
<ospfIfPol deadIntvl="40" helloIntvl="10" name="ospfl" pfxSuppress="inherit" prio="1"
rexmitIntvl="5" xmitDelay="1" />
<13extOut enforceRtctrl="export" name="T6L3out821">
<ospfExtP areaCost="1" areaCtrl="redistribute,summary" areald="0.0.0.1"
areaType="regular" />
<13extRsL3DomAtt tDn="uni/l3dom-L3Doml" />
<13extRsEctx tnFvCtxName="T6ctx21" />
<1l3extLNodeP name="l3out vpc82 prof" >
<13extRsNodeL30utAtt rtrId="1.1.1.8" rtrIdLoopBack="yes"
tDn="topology/pod-1/node-108">
<13extInfraNodeP fabricExtCtrlPeering="no" />
</13extRsNodeL30OutAtt>
<13extRsNodeL30utAtt rtrId="1.1.1.9" rtrIdLoopBack="yes"
tDn="topology/pod-1/node-109">
<13extInfraNodeP fabricExtCtrlPeering="no" />
</13extRsNodeL30OutAtt>
<13extLIfP name="ospfl" >
<ospfIfP authKeyId="1" authType="none" >
<ospfRsIfPol tnOspfIfPolName="ospfl" />
</ospfIfP>
<13extRsPathL30utAtt encap="vlan-551" ifInstT="ext-svi" mode="regular"
mtu="1500" tDn="topology/pod-1/protpaths-108-109/pathep-[VPC82]" >
<13extMember addr="192.16.51.1/24" 11Addr="0.0.0.0" side="B" />
<13extMember addr="192.16.51.2/24" 11Addr="0.0.0.0" side="A" />
</13extRsPathL30utAtt>
<13extRsNdIfPol tnNdIfPolName="" />
</13extLIfP>
</13extLNodeP>

<13extInstP matchT="AtleastOne" name="T613Ext821">
<fvRsProv tnVzBrCPName="Té6ctr UDP TCP2" />
<fvRsCons tnVzBrCPName="T6ctr UDP TCP1" />
<l3extSubnet ip="192.16.51.0/24"
scope="import-security, shared-rtctrl, shared-security" />
<l3extSubnet ip="192.16.61.0/24"
scope="import-security, shared-rtctrl, shared-security" />
<vzConsSubjlLbl name="tcp" tag="green" />
<vzProvSubjlLbl name="tcp" tag="green" />
</13extInstP>

<13extInstP matchT="AtleastOne" name="T613Ext823">
<fvRsSecInherited tDn="uni/tn-Tn6/out-T6L3out821/instP-T613Ext821" />
<l3extSubnet ip="192.16.63.0/24"
scope="import-security, shared-rtctrl, shared-security" />
</13extInstP>
</13extOut>

</fvTenant>
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</polUni>

Contract Preferred Groups

About Contract Preferred Groups

There are two types of policy enforcements available for EPGs in a VRF with a contract preferred group
configured:

* Included EPGs: EPGs can freely communicate with each other without contracts, if they have membership
in a contract preferred group. This is based on the source-any-destination-any-permit default rule.

* Excluded EPGs: EPGs that are not members of preferred groups require contracts to communicate with
each other. Otherwise, the default source-any-destination-any-deny rule applies.

The contract preferred group feature enables greater control of communication between EPGs in a VREF. If
most of the EPGs in the VRF should have open communication, but a few should only have limited
communication with the other EPGs, you can configure a combination of a contract preferred group and
contracts with filters to control inter-EPG communication precisely.

EPGs that are excluded from the preferred group can only communicate with other EPGs if there is a contract
in place to override the source-any-destination-any-deny default rule.
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Figure 10: Contract Preferred Group Overview

Included EPGs

Excluded EPGs

About Contract Preferred Groups .
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Source |Destination | Filter | Action
any any implicit | permit
GA any implicit| deny
any GA implicit| deny
GB any implicit| deny
any GB implicit| deny
GC any implicit| deny
any GC implicit| deny
Service Graph Support

Source |Destination | Filter | Action
GC GA mongo | permit
GA GC mongo | permit
GC GB http | permit
GB GC hitp | permit

501168

As of APIC release 4.0(1), EPGs created by service graphs can be included in contract preferred groups. A
new policy (Service EPG Policy) is available for defining the preferred group membership type (include or

exclude). Once configured, it can be applied through the device selection policy or through the application of

a service graph template.

Also, shadow EPGs can now be configured to be included or excluded in preferred groups.

Limitations

The following limitations apply to contract preferred groups:

* In topologies where an L3Out and application EPG are configured in a Contract Preferred Group, and
the EPG is deployed only on a VPC, you may find that only one leaf switch in the VPC has the prefix

entry for the L3Out. In this situation, the other leaf switch in the VPC does not have the entry, and

therefore drops the traffic.

To workaround this issue, you can do one of the following:

* Disable and reenable the contract group in the VRF

* Delete and recreate the prefix entries for the L30ut EPG
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* Also, where the provider or consumer EPG in a service graph contract is included in a contract group,
the shadow EPG can not be excluded from the contract group. The shadow EPG will be permitted in the
contract group, but it does not trigger contract group policy deployment on the node where the shadow
EPG is deployed. To download the contract group policy to the node, you deploy a dummy EPG within
the contract group .

* Due to CSCvm63145, an EPG in a Contract Preferred Group can consume a shared service contract, but
cannot be a provider for a shared service contract with an L30ut EPG as consumer.

Guidelines for Contract Preferred Groups

When configuring contract preferred groups, refer to the following guidelines:

* If the (s, g) entry is installed on a border leaf switch, you might see drops in unicast traffic that comes
from the fabric to this source outside the fabric when the following conditions are met:

* Preferred group is used on the L30ut EPG

» Unicast routing table for the source is using the default route 0.0.0.0/0

This behavior is expected.

* Contract Preferred Group-included EPGs are not supported with a 0/0 prefix in external EPG (InstP). If,
for the external EPG (InstP) to Tenant EPG, a 0/0 prefix is required with the use of Contract Preferred
Group, then 0/0 can be split to 0/1 and 128/1.

* Contract Preferred Group-EPGs are not supported with the GOLF feature. Communication between an
application EPG and the L30ut EPG for GOLF must be governed by explicit contracts.

Configuring Contract Preferred Groups Using the GUI

Before you begin

Create the tenants and VRF, and EPGs that will consume the contract preferred group.

Procedure

Step 1 On the menu bar, click Tenants > tenant_name.

Step 2 In the Navigation pane, expand the tenant, Networking, and VRFs.

Step 3 Click the VRF name for which you are configuring the contract preferred group.

Step 4 In the Preferred Group Member field, click Enabled.

Step 5 Click Submit.

Step 6 In the Navigation pane, expand Application Profiles and create or expand an application profile for the
tenant VRF.

Step 7 Expand Application EPGs and click the EPG that will consume the contract preferred group.

Step 8 Select the Policy and General tab.

Step 9 In the Preferred Group Member field, click Include.
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Step 10 Click Submit.

What to do next

Enable membership in the preferred group for other EPGs that should have unlimited communication with
this EPG. You can also configure appropriate contracts to control communication between the EPGs in the
preferred group and other EPGs that may not be members.

\ )

Note If you want to support preferred group members through L4-L7 service graphs, you must create a L4-L7
service EPG policy. For more information regarding creating an L4-L7 Service EPG Policy, see Creating an
L4-L7 Service EPG Policy Using the GUI, on page 221.

Configuring Contract Preferred Groups Using the NX-0S Style CLI

You can use the APIC NX-OS style CLI to configure a contract preferred group. In this example, a contract
preferred group is configured for a VRF. One of the EPGs using the VRF is included in the preferred group.

Before you begin

Create the tenants, VRFs, and EPGs that will consume the contract preferred group.

Procedure
Command or Action Purpose
Step 1 configure Enters configuration mode
Example:
apicl# configure
apicl (config) #
Step 2 tenanttenant-name Creates a tenant or enters into tenant
configuration mode
Example:
apicl (config) # tenant tenanté64
Step 3 vrf context vrf-name Creates a VRF or enters into VRF
configuration mode.
Example:
apicl (config-tenant)# vrf context vrf64
Step 4 whitelist-blacklist-mix Enables a contract preferred group for the VRF
and then returns to tenant configuration mode.
Example:
apicl (config-tenant-vrf) #
whitelist-blacklist-mix
apicl (config-tenant-vrf)# exit
Step 5 bridge-domain bd-name Creates a bridge-domain for the VRF or enters
into BD configuration mode.
Example:
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Command or Action

Purpose

apicl (config-tenant) # bridge-domain
bd64

Step 6

vrf member vrf-name

Example:

apicl (config-tenant-bd) # vrf member
vrfed
apicl (config-tenant-bd) # exit

Associates the VRF with the bridge-domain
and returns to teanant configuration mode.

Step 7

application app-name

Example:

apicl (config-tenant) # application
app-ldap

Creates an application or enters into application
configuration mode.

Step 8

€pg epg-name

Example:
apicl (config-tenant-app) # epg epg-ldap

Creates an EPG or enters into EPG tenant-app
EPG configuration mode.

Step 9

bridge-domain member bd-name

Example:

apicl (config-tenant-app-epg) #
bridge-domain member bdé4

Associates the EPG with the bridge-domain .

Step 10

vrf-blacklist-mode

Example:

apicl (config-tenant-app-epg) #
vrf-blacklist-mode

Configures this EPG to be included in the
contract preferred group.

Example

The following example creates a contract preferred group for vrfea and includes epg-1dap in it.

apicl# configure

apicl (config
apicl (config
apicl (config
apicl (config

apicl (config
apicl (config
apicl (config

apicl
apicl
apicl
apicl

config
config

config

)# tenant tenant64

-tenant) # vrf context vrf64
-tenant-vrf)# whitelist-blacklist-mix
-tenant-vrf) # exit

-tenant) # bridge-domain bd64
-tenant-bd) # vrf member vrf64
-tenant-bd) # exit

-tenant) # application app-ldap
-tenant-app) # epg epg-ldap

config-tenant-app-epg) # bridge-domain member bd64
-tenant-app-epg) # vrf-blacklist-mode
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Configuring Contract Preferred Groups Using the REST API

The following example creates a contract preferred group in vrfe4, and creates three EPGs in the VRF:
* epg-1dap—Included in the preferred group
* mail—Included in the preferred group

* radius—Excluded from the preferred group

Before you begin

Create the tenants, VRFs, and the EPGs in the VRF.

Procedure

Create a contract preferred group by sending a post, with XML such as the example:

Example:

<polUni>
<fvTenant name="tenant6c4">
<fvCtx name="vrf64"> <vzAny prefGrMemb="enabled"/> </fvCtx>
<fvBD name="bd64"> <fvRsCtx tnFvCtxName="vrfe64"/> </fvBD>
<fvAp name="app-1lldp">
<fvAEPg name="epg-ldap" prefGrMemb="include">
<fvRsBd tnFvBDName="bd64"/>
<fvRsPathAtt tDn="topology/pod-1/paths-101/pathep-[ethl/3]" encap="vlan-113"
instrImedcy="immediate"/>
</fvAEPg>
<fvAEPg name="mail" prefGrMemb="include">
<fvRsBd tnFvBDName="bd64"/>
<fvRsPathAtt tDn="topology/pod-1/paths-101/pathep-[ethl/4]" encap="vlan-114"
instrImedcy="immediate"/>
</fvAEPg>
<fvAEPg name="radius" prefGrMemb="exclude">
<fvRsBd tnFvBDName="bd64"/>
<fvRsPathAtt tDn="topology/pod-1/paths-101/pathep-[ethl/5]" encap="vlan-115"
instrImedcy="immediate"/>
</fvAEPg>
</fvAp>
</fvTenant>
</polUni>

What to do next

Create a contract governing the communication of the radius EPG with other EPGs.

Creating an L4-L7 Service EPG Policy Using the GUI

This task creates a policy that defines if EPGs are to be included in, or excluded from, a preferred group.
Preferred groups membership allows endpoints to communicate with each other without requiring a contract.
After the policy is created, it can be selected during the application of a service graph template to the EPGs.
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Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

Before you begin

You must have configured a tenant.

Procedure

On the Menu bar, choose Tenants > tenant_name.

In the Navigation pane, choose Policies > Protocol > L4-L7 Service EPG Policy.

In the Navigation pane, right-click L4-L7 Service EPG Policy and choose Create L4-L7 Service EPG
Policy.

The Create L4-L7 Service EPG Policy dialog box appears.

Enter a unique name for the policy in the Name field.

Optional. Enter a description of the policy in the Description field.

Choose whether to exclude or include EPGs as preferred members in the Preferred Group Member field.
Click Submit.

The newly created policy appears in the L4-L7 Service EPG Policy Work pane list. To edit a policy in the
Work pane, double-click the list line containing the policy.

What to do next

The new L4-L7 service EPG policy can now be selected in a service graph template when applying the graph
to EPGs. Refer to Applying a Service Graph Template to Endpoint Groups Using the GUI in the Using the
GUI chapter of the Cisco APIC Layer 4 to Layer 7 Services Deployment Guide.

Contracts with Permit and Deny Rules

About Contracts with Permit and Deny Rules

Starting with the Cisco Application Policy Infrastructure Controller (Cisco APIC) release 3.2, You can
configure contracts with both permit and deny actions, instead of just permit. You can configure the deny
action with different priorities: default, highest, medium and lowest.

Rule conflicts are resolved as follows:
* The implicit deny has the lowest priority of all rules.
* Contracts between vzAny have higher priority than the implicit deny.

* Contracts between specific EPG pairs win over contracts with vzAny, because EPG-to-EPG contract
rules have higher priority than vzAny-to-vzAny rules.

* Deny rules with the default priority for a contract between a specific EPG pair have the same level of
priority as the permit rules for that EPG pair. When traffic matches both a permit and a deny rule with
the same priority, the deny rule wins.
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* Deny rules with the default priority for a contract between vzAny has the same level of priority as the
permit rules for the vzAny pair. When traffic matches both a permit and a deny rule with the same priority,
the deny rule wins.

* Deny rules with the highest priority are handled at the same level as EPG-to-EPG contracts.
* Deny rules with medium priority are handled at the same level as vzAny-to-EPG contracts.
* Deny rules with the lowest priority are handled at the same level as vzAny-to-vzAny contracts.

* If the deny priority is lowered in a contract between EPGs, a permit rule match between EPGs would
win over deny.
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APPENDIX A

Configuring the Cisco APIC Using the CLI

* Configuring the Cisco APIC Cluster, on page 225
* Fabric Initialization and Switch Discovery, on page 228

Configuring the Cisco APIC Cluster

Cluster Management Guidelines

The Cisco Application Policy Infrastructure Controller (APIC) cluster comprises multiple Cisco APICs that
provide operators a unified real time monitoring, diagnostic, and configuration management capability for
the Cisco Application Centric Infrastructure (ACI) fabric. To assure optimal system performance, use the
following guidelines when making changes to the Cisco APIC cluster:

* Prior to initiating a change to the cluster, always verify its health. When performing planned changes to
the cluster, all controllers in the cluster should be healthy. If one or more of the Cisco APICs' health
status in the cluster is not "fully fit," remedy that situation before proceeding. Also, assure that cluster
controllers added to the Cisco APIC are running the same version of firmware as the other controllers
in the Cisco APIC cluster.

» We recommend that you have at least 3 active Cisco APICs in a cluster, along with additional standby
Cisco APICs. In most cases, we recommend a cluster size of 3, 5, or 7 Cisco APICs. We recommend 4
Cisco APICs for a two site multi-pod fabric that has between 80 to 200 leaf switches.

* Disregard cluster information from Cisco APICs that are not currently in the cluster; they do not provide
accurate cluster information.

* Cluster slots contain a Cisco APIC chassisIp. Once you configure a slot, it remains unavailable until
you decommission the Cisco APIC with the assigned chassisIb.

* [f a Cisco APIC firmware upgrade is in progress, wait for it to complete and the cluster to be fully fit
before proceeding with any other changes to the cluster.

* When moving a Cisco APIC, first ensure that you have a healthy cluster. After verifying the health of
the Cisco APIC cluster, choose the Cisco APIC that you intend to shut down. After the Cisco APIC has
shut down, move the Cisco APIC, re-connect it, and then turn it back on. From the GUI, verify that the
all controllers in the cluster return to a fully fit state.
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Note  Only move one Cisco APIC at a time.

» When moving a Cisco APIC that is connected to a set of leaf switches to another set of leaf switches or
when moving a Cisco APIC to different port within the same leaf switch, first ensure that you have a
healthy cluster. After verifying the health of the Cisco APIC cluster, choose the Cisco APIC that you
intend to move and decommission it from the cluster. After the Cisco APIC is decomissioned, move the
Cisco APIC and then commission it.

* Before configuring the Cisco APIC cluster, ensure that all of the Cisco APICs are running the same
firmware version. Initial clustering of Cisco APICs running differing versions is an unsupported operation
and may cause problems within the cluster.

* Unlike other objects, log record objects are stored only in one shard of a database on one of the Cisco
APICs. These objects get lost forever if you decommission or replace that Cisco APIC.

* When you decommission a Cisco APIC, the Cisco APIC loses all fault, event, and audit log history that
was stored in it. If you replace all Cisco APICs, you lose all log history. Before you migrate a Cisco
APIC, we recommend that you manually backup the log history.

Replacing a Cisco APIC in a Cluster Using the CLI

Step 1
Step 2
Step 3

Step 4

\)

Note * For more information about managing clusters, see Cluster Management Guidelines.

* When you replace an APIC, the password will always be synced from the cluster. When replacing APIC
1, you will be asked for a password but it will be ignored in favor of the existing password in the cluster.
When replacing APIC 2 or 3, you will not be asked for a password.

Before you begin

Before replacing an APIC, ensure that the replacement APIC is running the same firmware version as the
APIC to be replaced. If the versions are not the same, you must update the firmware of the replacement APIC
before you begin. Initial clustering of APICs running differing versions is an unsupported operation and may
cause problems within the cluster.

Procedure

Identify the APIC that you want to replace.
Note the configuration details of the APIC to be replaced by using the acidiag avread command.
Decommission the APIC using the controller controller-id decommission command.

Note Decommissioning the APIC removes the mapping between the APIC ID and Chassis ID. The
new APIC typically has a different APIC ID, so you must remove this mapping in order to add
a new APIC to the cluster.

To commission the new APIC, follow these steps:
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a) Disconnect the old APIC from the fabric.
b) Connect the replacement APIC to the fabric.

The new APIC controller appears in the APIC GUI menu System > Controllers > apic_controller_name
> Cluster as Seen by Node in the Unauthorized Controllers list.

¢) Commission the new APIC using the controller controller-id commission command.
d) Boot the new APIC.
e) Allow several minutes for the new APIC information to propagate to the rest of the cluster.

The new APIC controller appears in the APIC GUI menu System > Controllers > apic_controller_name
> Cluster as Seen by Node in the Active Controllers list.

Switching Over Active APIC with Standby APIC Using CLI

Use this procedure to switch over an active APIC with a standby APIC.

Procedure

Step 1 replace-controller replace ID number Backup serial number
Replaces an active APIC with an standby APIC.

Example:

apicl#replace-controller replace 2 FCH1804V27L
Do you want to replace APIC 2 with a backup? (Y/n): Y

Step 2 replace-controller reset ID number
Resets fail over status of the active controller.

Example:

apicl# replace-controller reset 2
Do you want to reset failover status of APIC 2? (Y/n): Y

Verifying Cold Standby Status Using the CLI

Procedure

To verify the Cold Standby status of APIC, log in to the APIC as admin and enter the command show
controller .

apicl# show controller

Fabric Name : vegas
Operational Size : 3
Cluster Size : 3
Time Difference : 496
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Fabric Security Mode : strict

ID Pod Address In-Band IPv4 In-Band IPv6 O0OB IPv4

OOB IPv6 Version Flags Serial Number Health

1* 1 10.0.0.1 0.0.0.0 fc00::1 172.23.142.4
fe80::26e9:b3ff:fe9l:cd4e0 2.2(0.172) crva- FCH1748VODF fully-fit

2 1 10.0.0.2 0.0.0.0 fc00::1 172.23.142.6
fe80::26e9:bf8f:fe91:f37c 2.2(0.172) crva- FCH1747VOYF fully-fit

3 1 10.0.0.3 0.0.0.0 fc00::1 172.23.142.8
fe80::4e00:82ff:fead:bcb6 2.2(0.172) crva- FCH1725V2DK fully-fit

21~ 10.0.0.21

————— FCH1734V2DG

Flags - c:Commissioned | r:Registered | v:Valid Certificate | a:Approved | f/s:Failover
fail/success

(*)Current (~)Standby

Fabric Initialization and Switch Discovery

Switch Discovery

Registering an Unregistered Switch Using the CLI

Use this procedure to register a switch from the Nodes Pending Registration tab on the Fabric Membership
work pane using the CLI.

)

Note This procedure is identical to "Adding a Switch Before Discovery Using the CLI". When you execute the
command, the system determines if the node exists and, if not, adds it. If the node exists, the system registers

1it.
Procedure
Command or Action Purpose
Step 1 [no] system switch-id serial-number switch-id | Adds the switch to the pending registration list.
name pod id role leaf node-type tier-2-leaf

Adding a Switch Before Discovery Using the CLI

Use this procedure to add a switch to the Nodes Pending Registration tab on the Fabric Membership work
pane using the CLI.
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\)

Note This procedure is identical to "Registering an Unregistered Switch Using the CLI". When you execute the
command, the system determines if the node exists and, if not, adds it. If the node does exist, the system
registers it.

Procedure

[no] system switch-id serial-number switch-id name pod id role leaf node-type tier-2-leaf

Adds the switch to the pending registration list.

Graceful Insertion and Removal (GIR) Mode

Removing a Switch to Maintenance Mode Using the CLI

Use this procedure to remove a switch to maintenance mode using the CLI.

)

Note While the switch is in maintenance mode, CLI 'show' commands on the switch show the front panel ports as
being in the up state and the BGP protocol as up and running. The interfaces are actually shut and all other
adjacencies for BGP are brought down, but the displayed active states allow for debugging.

Procedure

[no]debug-switch node id or node name

Removes the switch to maintenance mode.

Inserting a Switch to Operation Mode Using the CLI

Use this procedure to insert a switch to operational mode using the CLI.

Procedure

[no]no debug-switch node_id or node_name

Inserts the switch to operational mode.
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Configuring the Cisco APIC Using the REST API

* Configuring the Cisco APIC Cluster, on page 231
* Fabric Initialization and Switch Discovery, on page 232

Configuring the Cisco APIC Cluster

Expanding the APIC Cluster Using the REST API

Step 1

Step 2

The cluster drives its actual size to the target size. If the target size is higher than the actual size, the cluster
size expands.

Procedure

Set the target cluster size to expand the APIC cluster size.

Example:

POST
https://<IP address>/api/node/mo/uni/controller.xml
<infraClusterPol name='default' size=3/>

Physically connect the APIC controllers that you want to add to the cluster.

Contracting the APIC Cluster Using the REST API

Step 1

The cluster drives its actual size to the target size. If the target size is lower than the actual size, the cluster
size contracts.

Procedure

Set the target cluster size so as to contract the APIC cluster size.

Example:
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Step 2

Step 3

POST
https://<IP address>/api/node/mo/uni/controller.xml
<infraClusterPol name='default' size=1/>

Decommission APIC3 on APIC1 for cluster contraction.

Example:

POST
https://<IP address>/api/node/mo/topology/pod-1/node-1/av.xml
<infraWiNode i1d=3 adminSt='out-of-service'/>

Decommission APIC2 on APIC1 for cluster contraction.

Example:

POST
https://<IP address>/api/node/mo/topology/pod-1/node-1/av.xml
<infraWiNode id=2 adminSt='out-of-service'/>

Switching Over Active APIC with Standby APIC Using REST API

Use this procedure to switch over an active APIC with standby APIC using REST APIL.

Procedure

Switch over active APIC with standby APIC.

URL for POST: https://ip
address/api/node/mo/topology/pod-initiator pod id/node-initiator id/av.xml
Body: <infraWiNode id=outgoing apic id targetMbSn=backup-serial-number/>
where initiator id = id of an active APIC other than the APIC being replaced.
pod-initiator pod id = pod ID of the active APIC

backup-serial-number = serial number of standby APIC

Example:

https://ip address/api/node/mo/topology/pod-1/node-1/av.xml
<infraWiNode id=2 targetMbSn=FCH1750vV00Q/>

Fabric Initialization and Switch Discovery

Switch Discovery

Registering an Unregistered Switch Using the REST API

Use this procedure to register a switch from the Nodes Pending Registration tab on the Fabric Membership
work pane using the REST APIL.

. Cisco APIC Basic Configuration Guide, Release 4.2(x)



| Configuring the Cisco APIC Using the REST API
Adding a Switch Before Discovery Using the REST API .

\)

Note This procedure is identical to "Adding a Switch Before Discovery Using the REST API". When you apply
the code, the system determines if the node exists and, if not, adds it. If the node does exist, the system registers
it.

Procedure

Add a switch description.

Example:

POST
https://<IP address>/api/policymgr/mo/uni.xml

<!-- /api/policymgr/mo/uni.xml -->
<polUni>
<ctrlrInst>
<fabricNodeIdentPol>
<fabricNodeIdentP nodeType="tier-2-leaf" podId="1" serial="XXXXXXXXX"
name="tier-2-leaf-leafl" nodeId="101"/>

</fabricNodeIdentPol>

</ctrlrInst>
</polUni>

Adding a Switch Before Discovery Using the REST API

Use this procedure to add a switch to the Nodes Pending Registration tab on the Fabric Membership work
pane using the REST API.

N

Note This procedure is identical to "Registering an Unregistered Switch Using the REST API". When you apply
the code, the system determines if the node exists and, if not, adds it. If the node does exist, the system registers
it.

Procedure

Add a switch description.

Example:

POST
https://<IP address>/api/policymgr/mo/uni.xml

<!-- /api/policymgr/mo/uni.xml -->
<polUni>
<ctrlrInst>
<fabricNodeIdentPol>
<fabricNodeIdentP nodeType="tier-2-leaf" podId="1" serial="XXXXXXXXX"
name="tier-2-leafl" nodeId="101"/>
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</fabricNodeIdentPol>
</ctrlrInst>
</polUni>

Graceful Insertion and Removal (GIR) Mode

Removing a Switch to Maintenance Mode Using the REST API

Use this procedure to remove a switch to maintenance mode using the REST API.

Procedure

Remove a switch to maintenance mode.

Example:

POST
https://<IP address>/api/node/mo/uni/fabric/outofsvc.xml

<fabricOOServicePol
descr=""
dn=""
name="default"
nameAlias=""
ownerKey=""
ownerTag="">
<fabricRsDecommissionNode
debug="yes"
dn=""
removeFromController="no"
tDn="topology/pod-1/node-102"/>
</fabricOOServicePol>

Inserting a Switch to Operational Mode Using the REST API

Use this procedure to insert a switch to operational mode using the REST API.

Procedure

Insert a switch to operational mode.

Example:
POST
https://<IP address>/api/node/mo/uni/fabric/outofsvc.xml

<fabricOOServicePol
descr=""
dn=""
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name="default"

nameAlias=""
ownerKey=""
ownerTag="">
<fabricRsDecommissionNode
debug="yes"
dn=""

removeFromController="no"

tDn="topology/pod-1/node-102"

status="deleted"/>
</fabricOOServicePol>
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